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1.01 System requirements and product details 

System requirements Windows XP, Vista, 7, 8, 8.1 or 10; for Mac OS X, 
a Windows emulator is required 

Licence One-time purchase, unlimited use 
Delivery Registration key via email 
Available languages Arabic, Chinese, Czech, Danish, Dutch, English, 

French, German, Hindi, Italian, Japanese, Korean, 
Norwegian, Polish, Portuguese, Russian, Spanish, 
Swedish, Turkish 

File formats TactileView files (.bpx); import .txt, .svg, .jpg, 
.png, .bmp, .tiff or .gif 

Internet requirements TactileView can be used offline, but specific 
functions (e.g. map maker, designs catalog) require 
internet access 

Software security A registration key is valid for software registration 
on one computer only 

Supported printers 

Supported embossers Index (V2, V3 and V4), ViewPlus (all models), 
Enabling (all models), Elotype, Puma, Gemini, 
Mountbatten Brailler 
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File formats TactileView files (.bpx); import .txt, .svg, .jpg,
.png, .bmp, .tiff or .gif

Internet requirements TactileView can be used offline, but specific
functions (e.g. map maker, designs catalog) require
internet access

Software security  A registration key is valid for software registration
on one computer only

 

Supported printers

Supported embossers Index (V2, V3 and V4), ViewPlus (all models),
Enabling (all models), Elotype, Puma, Gemini,
Mountbatten Brailler
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1.02 Downloading TactileView 

The Tactileview software is available for download and installation on Windows computers. 

The software is compatible with Windows XP, Windos 7, 8 and 8.1. For use with other operating 
systems, you will need a Windows emulator (such as Boot Camp or Parallels for Mac OS X). 

Free trial 

The software can be launched in demonstration mode without registration. All features are available, 
however files cannot be saved and prints will contain watermarks. In order to run the software in full 
version, you need a software product code (SPC). You can purchase a software product code (SPC) in the 
Thinkable shop. 

Download 

,o, 
=I 

Click here to visit the download page in case you have not yet downloaded the software. 

Please note that administrator rights are required to install the software on your computer. 
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1.02 Downloading TactileView

The Tactileview software is available for download and installation on Windows computers.

The software is compatible with Windows XP, Windos 7, 8 and 8.1. For use with other operating
systems, you will need a Windows emulator (such as Boot Camp or Parallels for Mac OS X).

Free trial

The software can be launched in demonstration mode without registration. All features are available,
however files cannot be saved and prints will contain watermarks. In order to run the software in full
version, you need a software product code (SPC). You can purchase a software product code (SPC) in the
Thinkable shop.

Download

Click here to visit the download page in case you have not yet downloaded the software.

Please note that administrator rights are required to install the software on your computer.
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1.03 Installing software 

To install the software after downlngslinv launch the TactileView installer from the USB drive or 
download folder. Follow the on-screen prompts to complete the installation. In the last dialog choose 
'Finish', then launch the software from the Windows Start menu. 

Shmiagailigignsigui 

TactileView 2, 2, 0, 0 

TactileView 2, 2, 0, 0 

Publisher: Thinkable 
Web site: www.tactileview.com 
Email address: info@tactileview.com 

InstallMate will install or upgrade TactileView on your computer. 

Click Next to continue. 

Copyright (C) 2015 Thinkable 

This program is protected by copyright law and international 
treaties. Unauthorized reproduction or distribution of this 
program, or any portion of it, is a violation of applicable laws. 

_90G;... < Back 

Step 1: Software details. Click Nest to proceed 

Next > Cancel 
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1.03 Installing software

To install the software after downloading, launch the TactileView installer from the USB drive or
download folder. Follow the on-screen prompts to complete the installation. In the last dialog, choose
'Finish', then launch the software from the Windows Start menu.

Show installation steps

Step 1: Software details. Click 'Next' to proceed.
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TactileView 2, 2, 0, 0 x 

Installation options 
These options determine how the application will be installed. 

2 TactileView 
O Older Files (mostly Dutch) 

Installation folder: 

This installs TactileView 

Option size: 
Install size: 
Remove size: 
Disk space: 

31,85518 
31,85518 

018 
302, 286, 236 KB 

C: \Program Files (x86) \TactileView 

Mist:: • • 

< Back 

Browse... 

Install [ Cancel 

Step 2: Installation cptions. Select the folder ii which TactileView will be installed if necessary and click 
'Install' to proceed 
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Step 2: Installation options. Select the folder in which TactileView will be installed if necessary and click
'Install' to proceed.
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TactileView 2, 2, 0, 0 

Operation in progress 

Please wait while TactileView is being processed. 

Waiting for the tninstallatim to finish... 

• 

InstallMate® 

< Back Next Cancel 

Step Terailefiew installation. This will be completed automatically. 

TactileView 2, 2, 0, 0 x 

Installation completed 

TactileView has been successfully installed on your computer. 

I-  Start the application (disabled) 

Click Finish to dose InstallMate. 

< Back Finish Cancel 

71276 
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Step 3: TactileView installation. This will be completed automatically.
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Step 4: Installation has finished. Mot Finish' to dose the installer 

First 'smell 

During the first launch you will be asked to select your user language. Select your language from the list, 
then click 'Or to confirm Please keep in mind that a number of these user languages have been 
automatically translated and might riot be completely correct. 

show language selection 

Set User Language 

taw 
Dank 
Deutsch 
En•lish 
Espanol 
Francais 
Italian 
Nederlands 
Norsk 
Polski 
Portugues 
PyccKmA R3bIK 
Svenska 
Turk 

(Arabic) 
441 (Hindi) 
%el 
cl:CI (Chinese) 
Boo

OK 

Cancel 

Set uses language when knmchblg Taalleilew for theft's: time. 
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Step 4: Installation has finished. Click 'Finish' to close the installer.

 

 

First launch

During the first launch you will be asked to select your user language. Select your language from the list,
then click 'OK' to confirm. Please keep in mind that a number of these user languages have been
automatically translated and might not be completely correct.

Show language selection

Set user language when launching TactileView for the first time.
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1.04 Installing updates and beta versions 

A new version of the TactileView software is released periodically. You will automatically be notified by 
email when a new release is available for downloading. The Release notes section will give you an 
overview of the new software features and bug fixes that are included in each of the public release 
versions. 

You can simply launch the downloaded software installer to update your TactileView installation (you do 
not need to uninstall the previously installed version). The same applies to development versions that are 
not publicly available. 

When you launch TactileView after installation, you will be asked to verify your contact details. The 
configuration wizard will then open. We recommend to have a look at the steps in the wizard, as some 
settings might have been added or changed. 
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1.04 Installing updates and beta versions

A new version of the TactileView software is released periodically. You will automatically be notified by
email when a new release is available for downloading. The Release notes section will give you an
overview of the new software features and bug fixes that are included in each of the public release
versions.

You can simply launch the downloaded software installer to update your TactileView installation (you do
not need to uninstall the previously installed version). The same applies to development versions that are
not publicly available.

When you launch TactileView after installation, you will be asked to verify your contact details. The
configuration wizard will then open. We recommend to have a look at the steps in the wizard, as some
settings might have been added or changed.
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1.05 Transfer installation or uninstall TactileView 

The software product code (SPC) allows the software to run on one computer. In case you need to have 
the software running in full version on another computer as well, an extra SPC is required. 

Visit our shop to purchase an extra software licence. 

Reinstalling on another computer 

You might want to transfer the software installation to a different computer, using the same SPC. By 
sending us an e-mail, we can delete the currently registered computer data, allowing the SPC to be 
reinstalled on another system. An e-mail confirmation is sent to the mail address that was entered in the 
registration form. 

Uninstall TactileView 

If you wish to uninstall the software from the current computer, open the Control Panel, click 'Programs', 
then select 'Programs and Features'. Select TactileView from the list and click 'Uninstall'. 
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1.05 Transfer installation or uninstall TactileView

The software product code (SPC) allows the software to run on one computer. In case you need to have
the software running in full version on another computer as well, an extra SPC is required.

Visit our shop to purchase an extra software licence.

Reinstalling on another computer

You might want to transfer the software installation to a different computer, using the same SPC. By
sending us an e-mail, we can delete the currently registered computer data, allowing the SPC to be
reinstalled on another system. An e-mail confirmation is sent to the mail address that was entered in the
registration form.

Uninstall TactileView

If you wish to uninstall the software from the current computer, open the Control Panel, click 'Programs',
then select 'Programs and Features'. Select TactileView from the list and click 'Uninstall'.
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1.06 Download and installation troubleshooting 

TactileView software has been around for overt' decade and is completely safe in use, but due to the 
limited number of users, some virus &camera, web browsers or Windows may automatically block 
TactileView. Here are a few ways to solve the most commonproblems when downloading and installing 
the software. 

Downloading the software- browsers 

Some browsers might block a downloaded file when it is not downloaded regularly. 

Goozle Chromq 

After downloading TactileView, Google Chrome might block launching the downloaded 

O TactileViewInstall22O....exe is not commonly 
downloaded and could be dangerous. 

Discard 

Keep 

Learn more 

This is encountered mostly with new releases or development versions of TactileView. Click on the small 
arrow on the right to show more options, then choose 'Keep' to dismiss this message. 

Internet P.xplorer 

When the security level in Internet Explorer is set to 'Hight, a message will appear when you download 
TactileView. 

Security Alert x 

I Your current security settings do not allow this file to be downloaded. 

OK 

11l
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1.06 Download and installation troubleshooting

TactileView software has been around for over a decade and is completely safe in use, but due to the
limited number of users, some virus scanners, web browsers or Windows may automatically block
TactileView. Here are a few ways to solve the most common problems when downloading and installing
the software.

Downloading the software - browsers

Some browsers might block a downloaded file when it is not downloaded regularly.

Google Chrome

After downloading TactileView, Google Chrome might block launching the downloaded file.

This is encountered mostly with new releases or development versions of TactileView. Click on the small
arrow on the right to show more options, then choose 'Keep' to dismiss this message. 

 

Internet Explorer

When the security level in Internet Explorer is set to 'High', a message will appear when you download
TactileView.
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To solve this, click on the gear icon in the top right corner and go to Internet Options. In the Security tab, 
reduce the security level to 'Medium-high'. You can now retry to download the software installer. Next, 

choose to save or run the TactileView installer. 

Other browsers 

In case another web browser blocks your downloaded file, check the security settings of the browser or 
any *us scanner add-ons. If these are too strict, try to lower the security level and retry to download the 
file. 

Installing the software 

Windows SmartScreen 

Windows protected your PC 
Windows SmartScreen prevented an unrecognised application from starting. Running this application might 
put your PC at risk. 

OK 

Windows StrartScreen will often block when the TactileView installer is launched for the first time. 
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To solve this, click on the gear icon in the top right corner and go to Internet Options. In the Security tab,
reduce the security level to 'Medium-high'. You can now retry to download the software installer. Next,
choose to save or run the TactileView installer. 

 

Other browsers

In case another web browser blocks your downloaded file, check the security settings of the browser or
any virus scanner add-ons. If these are too strict, try to lower the security level and retry to download the
file.

 

 

Installing the software

Windows SmartScreen

Windows SmartScreen will often block when the TactileView installer is launched for the first time.
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Windows protected your PC 
Windows SmartScreen prevented an unrecognised application from starting. Running this application might 
put your PC at risk. 

Publisher: Unknown Publisher 
Application: TactileViewlnstall2200.exe 

Run a nyway Don't run 

To continue with the installation, click on 'More info', then select 'Run anyway'. 

Virus scanners 

As with browses, the security level of your virus scanner will determine whether launching Tactile View 
will be allowed. Lowering the security level will usually solve the problem. The example below shows 
how to resolve the problem when a lower security level will still block Tactile View. In this example AVG 
is shown, but other virus scanners will provide similar options. 
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To continue with the installation, click on 'More info', then select 'Run anyway'. 

 

Virus scanners

As with browsers, the security level of your virus scanner will determine whether launching TactileView
will be allowed. Lowering the security level will usually solve the problem. The example below shows
how to resolve the problem when a lower security level will still block TactileView. In this example AVG
is shown, but other virus scanners will provide similar options.
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AVG. Anti Virus FREE ri Join us on Facebook Reports 7 Support 

(..? You are protect 

"iseph, 

el  Q9 9), 

Computer Web 
PROTECTED PROTECTED 

0 Scan now a 

Identity 
PROTECTED 

Fix performance 
ON, 

Maximize your protection with PRO. 
Includes Enhanced Firewall, Anti-Spam, Data Safe and more.

options • 

Scan computer 

Scan selected folder... 

Scan file... 

Update 

Update from directory... 

Virus Vault 

History 

Advanced settings... 

Help contents 

Get support 

Your AVG Web 

About Viruses and Threats 

Buy now 

Activate 

Register AVG AntiVirus Free Edition 2015 

NlyAccount 

Premium Support 

About AVG 

1. Go to 'Options' and select 'Advanced settings'. 
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1. Go to 'Options' and select 'Advanced settings'.
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#( 0 X 
AVG. AntiVirus FREE Advanced Settings 

Appearance 

Sounds 

Temporarily Disable AVG Protection 

CI Computer Protection 

AntiVirus 

Expert Settings 

Anti-Rootkit 

Cache Server 

U Email Protection 

CI Web Browsing Protection 

LinkScanner Surf-Shield 

Identity Protection 

U Scans 

U Schedules 

U Update 

Exceptions 

Virus Vault 

AVG Self Protection 

Privacy Preferences 

Ignore Error Status 

Advisor - Known Networks 

O Default 

Exceptions 

• Object Type Used by Component Da 

Add exception EcP TI Remove Remove all 

0 OK Cancel 0 Apply 

2. From the list of options, select 'Exceptions' and click on 'Add exception'. 
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2. From the list of options, select 'Exceptions' and click on 'Add exception'.
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InAVG. AntiVirus FREE 

Exception type: 

Select exception type 

OK Cancel 

3. Select'Application or File' as Exception type. 
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3. Select 'Application or File' as Exception type.
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MAIM AntiVirus FREE 

Exception type: 

Application or File 

Choose the file you do NOT want to be scanned 

CAProgram Files lx861\TactileViewVractileV.exe 

Ignore this file: 

0 Even when the file is moved to a new location 

2  Even when the file has been changed or updated€ 

Use this exception for: 

2 Resident Shield (if checked, AVG will NOT scan the file or app when opened) 

2 Manual and Scheduled Scan (if checked, AVG will NOT scan this file during scans) 

2 Identity Protection (if checked, AVG will NOT monitor the app for malicious behavior) 

OK 

Browse 

Cancel 

4. In the list of options that appears,brovne to the location of the TactileView executable file; by default 
this will be CAProgram Res (x86)1TactileVieMTactileV.exe. Check 'Even when the file has been 
duanged a updated' to avoid having to repeat this process after a software update. Click 'OK' to confirm. 
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4. In the list of options that appears, browse to the location of the TactileView executable file; by default
this will be C:\Program Files (x86)\TactileView\TactileV.exe. Check 'Even when the file has been
changed or updated' to avoid having to repeat this process after a software update. Click 'OK' to confirm.
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AVG. AntiVirus FREE Advanced Settings 

Appearance 

Sounds 

Temporarily Disable AVG Protection 

U Computer Protection 

• Email Protection 

U Web Browsing Protection 

Identity Protection 

U Scans 

U Schedules 

U Update 

Exceptions 

Virus Vault 

AVG Self Protection 

Privacy Preferences 

Ignore Error Status 

Advisor - Known Networks 

5 Default 

Exceptions 

• Object Type Used by Component Da 

IS <any content>CAP...WactileV.exe Application or... Resident Shield, Identity ... 24, 

Add exception Edit Remove Remove all 

OK Cancel • Apply 

5. You will now see TactileView in the list of exceptions. You. need administrator rights to confirm the 
changes by clicking 'OK'. 
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5. You will now see TactileView in the list of exceptions. You need administrator rights to confirm the
changes by clicking 'OK'.
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2.01 Configuration wizard 

Once TactileView has been install at you will be prompted with the Configuration wizard, which will 
guide you through registration and the most important settings for optimal use of the software. Each of 
the 4 steps in the configuration wizard are 'Computer registration, 'Printer setup, 'Configuration' and 
'External software'. In each step, there is a list with the essential settings. By selecting one from this list, 
you can read the description on the right. Click on 'Open selected option' to go to the selected settings 
dialog. 

You can launch the Configuration wizard at any lime later on by selecting it from the Help menu. 

In the manual section Settinv mem]  you can find a more detailed list of all the settings menu option. 

Welcome to TactileView x 

You are using the TactileView design and production software •with version number: 2.223a. 
Default values might have changed or new features could have been added to the software. We advise you to take a moment 
to follow this configuration •wizard or review the individual options in the Settings menu. 

These four steps in configuration wizard •will help you to use the TactileView software to its full extent: 

1. Computer registration; With your software product code (SPC), the computer on which the software •will be used is 
registered on the TactileView website. You will also be asked to enter or confirm your contact details. TactileView is already 
registered. 

2. Printer setup; The installation and preparation of a printer or braille embosser for your computer. 

3. Configuration; Selection of the optimal software settings to suit your personal use. 

4. External software; Extend the functionality of TactileView by combining it with external software. 

Start configuration wizard Skip configuration wizard 

Configuration wizard: Introduction. Ms window gives an overview of the different steps in the 
configunition wizard. Click on 'Start configuration wizard' to proceed. 
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2.01 Configuration wizard

Once TactileView has been installed, you will be prompted with the Configuration wizard, which will
guide you through registration and the most important settings for optimal use of the software. Each of
the 4 steps in the configuration wizard are 'Computer registration', 'Printer setup', 'Configuration' and
'External software'. In each step, there is a list with the essential settings. By selecting one from this list,
you can read the description on the right. Click on 'Open selected option' to go to the selected settings
dialog.

You can launch the Configuration wizard at any time later on by selecting it from the Help menu.

In the manual section Settings menu, you can find a more detailed list of all the settings menu option.

Configuration wizard: Introduction. This window gives an overview of the different steps in the
configuration wizard. Click on 'Start configuration wizard' to proceed.
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Step 1/4: Computer Registration 

With your Softwa•e Product Code (SPC) you can register the computer on which the software will run on the TactileView website. This 
SPC is valid for ore computer and can be found in your licence document or in the email that you received. Please keep your SPC for use 
in future updates 
The registration is valid for all users on this computer if you have administrator rights during registration. Otherwise the registration 
needs to be repeated with the same SPC for other users. 
Without registration, TactileView runs as a demonstration version with full &awing functionality. However, designs cannot be saved cr 
copied and will contain watermarks on prints. 

Reaistration via distributor (TactileView is reoistered) 

gpen selected option 

Description 

Pc49.3tcr thc 3oftworc on thc ToctdcVicwAtbsitc •with your 
name and SPC. 

Previous Next Cancel 

Configuration wizard step 1/4: Computer registration. In this step, you can register your software licence. 

Step 2/4: Printer setup 

To produce the designs that you have created, you can either print them on an ordinary printer using micro capsule paper (svvellpape.) or 
on a braille embosser. 
Some braille embcssers (e.g. Index V4 and viewPlus) have their own drivers that need to be installed with the supplied installer. The 
printer can then to selected from the list via Print Setup. For other printers that do not supply their own drivers, choose Install Braille 
Printer' to select one of the drivers developed by TactileView. 
For specific driver and installation details we refer you to the documentation of the printer or the supplier's website. 

Print Seto 
Install Braille Printer 
Braille Tables 
Text label presentation: on print 

gpen selected option 

Cescription 

Fast install the driver that comes with your printer or 
embosser using the supplied installer. Once the driver has 
been installed, you can then select the printer or embosser 
from this list and configure the printer settings. 

Previous Next Cancel 

Configuration wizard step 2/4: Printer setup. This second step will help you to configure the steps 
required for printing your tactile designs. 
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Configuration wizard step 1/4: Computer registration. In this step, you can register your software licence.

Configuration wizard step 2/4: Printer setup. This second step will help you to configure the steps
required for printing your tactile designs.
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Step 3/4: Configuration 

We strongly recommend you to take some time to check the various settings. An optimal configuration Mill give you the best possible user 
experience. Also be aware that some of the settings will affect the tactile readability of the desings that you create. For the usage and 
configuration of extra hardware or changes later on, visit the options in menu Settings. 

General 
Languages 
Text label presentation: on screen 
Alignment frame and grids 
Update TactileView Components 
Sign up for Newdetter 

gpen selected option 

Description 

Scicct the units of measurement and other general 3ctbngs 

fo. optimal use of the software. 

Previous Next Cancel 

Configuration wizard step 3/4: Configuration. All basic settings for operating the software are included in 
this third step. 

Step 4/4: External software 

The functionality of the TactileView software can be extended even further by incorporating third party software. This software might 
already be installed on your computer, otherwise we refer you to the supplier of the software. 

InsertTactileView in Ted File 
Mathematical notation (equation editor) 

gpen selected option 

Cescription 

Duxbury Braille Translator (DBT) is a braille editor and 
translator for text. Designs made in TactileView can be 
induded in DBT documents, allowing you to create combined 
text and graphics documents. 

Previous Finish 

Configuration wizard step 4/4: External software. This final step will help you to extend the functionality 
of TactileView with external software. 
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Configuration wizard step 3/4: Configuration. All basic settings for operating the software are included in
this third step.

Configuration wizard step 4/4: External software. This final step will help you to extend the functionality
of TactileView with external software.
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2.02 Software registration with SPC via internet 

Once you have downloaded and installed the TactileView software, it will operate in demonstration mode 
at first. To run the software in full version, a software product code (SPC) is required. This SPC is 
provided by your dealer or has been sent by email after you purchased a software licence in the Thinkable 

.ur 
I= 

shop.

The easiest and fastest method to register the software with your SPC is registration via the internet. 
However, TactileView also provides a registration option that does not require an internet connection; see 
Software registration via distributor (no internet access). 

Each SPC is valid for one computer only. If you wish to use TactileView on multiple systems, you will 
need to purchase additional SPCs. For registration on multiple user accounts on the same computer, 
see Registration for multiple user accounts on single computer. 

Software Product Code (SPC) 

You will need to register the software using a Software product code (SPC) in order to get access to the 
complete set of software features. After purchasing a TactileView software licence, you will receive an 
SPC, either by email from the TactileView website, in a licence document from your dealer, etc. Make 
sure to store this code carefully, as you might need it later on for software updates or customer support. 

Registration steps 

1. Select 'Registration via internet' in step 1 of the Configuration wizard. Alternatively, choose 
'Computer registration' from the Settings menu and make sure 'Registration via internet' is selected 
in the dialog that opens. 

2. Enter your SPC, choose a User/company name and click on 'Register now'. 
3. Choose whether you wish to register the software for all users on the computer (requires 

administrator rights) or the current user only. 
4. Enter and confirm the required contact details for customer support and optimal use of the 

software. You are now ready to start using the fully registered TactileView software. 
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2.02 Software registration with SPC via internet

Once you have downloaded and installed the TactileView software, it will operate in demonstration mode
at first. To run the software in full version, a software product code (SPC) is required. This SPC is
provided by your dealer or has been sent by email after you purchased a software licence in the Thinkable

shop. 

The easiest and fastest method to register the software with your SPC is registration via the internet.
However, TactileView also provides a registration option that does not require an internet connection; see
Software registration via distributor (no internet access).

Each SPC is valid for one computer only. If you wish to use TactileView on multiple systems, you will
need to purchase additional SPCs. For registration on multiple user accounts on the same computer,
see Registration for multiple user accounts on single computer.

Software Product Code (SPC)

You will need to register the software using a Software product code (SPC) in order to get access to the
complete set of software features. After purchasing a TactileView software licence, you will receive an
SPC, either by email from the TactileView website, in a licence document from your dealer, etc. Make
sure to store this code carefully, as you might need it later on for software updates or customer support.

Registration steps

1. Select 'Registration via internet' in step 1 of the Configuration wizard. Alternatively, choose
'Computer registration' from the Settings menu and make sure 'Registration via internet' is selected
in the dialog that opens.

2. Enter your SPC, choose a User/company name and click on 'Register now'.
3. Choose whether you wish to register the software for all users on the computer (requires

administrator rights) or the current user only.
4. Enter and confirm the required contact details for customer support and optimal use of the

software. You are now ready to start using the fully registered TactileView software.

                                 22 / 226



TactileView software manual 
Visit us at https://thinkable.nl 

2.03 Software registration via distributor (no internet access) 

When you are unable to connect to the internet with the computer on which you wish to register 
TactileView, you can register your software licence via your distributor. For regular registration via 
internet, see Software registration with SPC via internet. 

1. Select 'Registration via distributor' from step 1 of the Configuration wizard. Alternatively, choose 
'Computer registration' from the Settings menu and make sure that 'Registration via distributor' is 
selected in the dialog that opens. 

2. Supply your distributor with the following information: 
- Your SPC 
- A user or company name 
- Version number and Computer identification code (both can be copied from the registration 
dialog) 
- Contact details: full name*, company, address, country* and email address* (information with 
an asterisk* is required) 

3 Your supplier will contact the TactileView development team and provide you with a Registration 
code that can be used to register without an internet connection. Enter your SPC, a user or 
company name, and the received Registration code in the Settings > Computer registration dialog. 
Once you have filled this all in, select 'Register now'. 

You are now ready to start using the fully registered TactileView software. The registration is valid for all 
users on this computer if you have administrator rights during registration. Otherwise the registration 
needs to be repeated with the same SPC for other users. 
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2.03 Software registration via distributor (no internet access)

When you are unable to connect to the internet with the computer on which you wish to register
TactileView, you can register your software licence via your distributor. For regular registration via
internet, see Software registration with SPC via internet.

1. Select 'Registration via distributor' from step 1 of the Configuration wizard. Alternatively, choose
'Computer registration' from the Settings menu and make sure that 'Registration via distributor' is
selected in the dialog that opens.

2. Supply your distributor with the following information:
- Your SPC
- A user or company name
- Version number and Computer identification code (both can be copied from the registration
dialog)
- Contact details: full name*, company, address, country* and email address* (information with
an asterisk* is required)

3. Your supplier will contact the TactileView development team and provide you with a Registration
code that can be used to register without an internet connection. Enter your SPC, a user or
company name, and the received Registration code in the Settings > Computer registration dialog.
Once you have filled this all in, select 'Register now'.

You are now ready to start using the fully registered TactileView software. The registration is valid for all
users on this computer if you have administrator rights during registration. Otherwise the registration
needs to be repeated with the same SPC for other users.
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2.04 Registration for multiple user accounts on single computer 

Your Software Registration Code (SPC), the registration code with which the TactileView software is 
registered, is valid for registration on one computer. However, multiple user accounts on the same 
computer can all make use of the same SPC to register TactileView. 

Administrator rights 

Administrator rights are required to register TactileView for all users on this computer. Otherwise the registration will need to be repeated 
with the same SPC for all users. 

For which users do you want to register the software? 

All users (requires adnin rights) Current user only Cancel 

There are two ways to complete the registration for each Windows user account on the computer: 

1. Register for all users. This requires a Windows account with administrator rights. During 
registration, choose 'All users' to activate the registration for all user account on the same 
computer simultaneously. 

2. Current user only. This option can be used when you have no administrator rights. However, the 
registration will need to be repeated using the same SPC for all other user accounts that wish to 
use TactileView. 

For full installation and registration instructions, see Installing software and Software registration with 
software product code (SPC), 
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2.04 Registration for multiple user accounts on single computer

Your Software Registration Code (SPC), the registration code with which the TactileView software is
registered, is valid for registration on one computer. However, multiple user accounts on the same
computer can all make use of the same SPC to register TactileView.

There are two ways to complete the registration for each Windows user account on the computer:

1. Register for all users. This requires a Windows account with administrator rights. During
registration, choose 'All users' to activate the registration for all user accounts on the same
computer simultaneously.

2. Current user only. This option can be used when you have no administrator rights. However, the
registration will need to be repeated using the same SPC for all other user accounts that wish to
use TactileView.

For full installation and registration instructions, see Installing software and Software registration with
software product code (SPC).
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2.05 Free demonstration mode 

For a free trial version of the software, you can simply download TactileView for free and install it on 
your computer (requires administrator rights). This allows you to use the software in demonstration mode 
without registration and to explore the great features in the software for creating tactile graphics. In 
demonstration mode, all software features are available. The only restrictions will be that printed designs 
will contain watermarks and files cannot be saved. 

,u, 
I= 

To download the free trial version of TactileView, click here. 

Configuration for demonstration mode 
After launching the software for the first time, the configuration wizard will automatically guide you 
through the most important settings. To start using TactileView in demonstration mode, you can skip step 
1 of 4 in the wizard. We strongly advise you to take the time to go through the remaining three steps, 
which present you with the settings that will give you the optimal user experience. You can revisit these 
and other setting via the Settings menu. 

Read more about the Configuration wizard > 

Upgrading to a full software version 
After having played with the software, we hope you like it so much so you will contact one of our dealers 
or buy your licence in the Thinkable shop. 
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2.05 Free demonstration mode

For a free trial version of the software, you can simply download TactileView for free and install it on
your computer (requires administrator rights). This allows you to use the software in demonstration mode
without registration and to explore the great features in the software for creating tactile graphics. In
demonstration mode, all software features are available. The only restrictions will be that printed designs
will contain watermarks and files cannot be saved.

To download the free trial version of TactileView, click here.

Configuration for demonstration mode
After launching the software for the first time, the configuration wizard will automatically guide you
through the most important settings. To start using TactileView in demonstration mode, you can skip step
1 of 4 in the wizard. We strongly advise you to take the time to go through the remaining three steps,
which present you with the settings that will give you the optimal user experience. You can revisit these
and other setting via the Settings menu.

Read more about the Configuration wizard >

Upgrading to a full software version
After having played with the software, we hope you like it so much so you will contact one of our dealers
or buy your licence in the Thinkable shop.
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2.06 Settings menu 

Settings 

Computer Registration (TactileView is registered) 

General 

Languages 

Braille Tables 

Sign up for Newsletter 

Update TactileView Components 

Text label presentation: on screen 

Text label presentation: on print 

Alignment grids 

Line view/dot view 

Mathematical notation (equation editor) 

Insert TactileView Design in Text File 

Figures 

Speech 

TactileView Digital Pen 

Scanner 

Webcam 

Microphone 

Touch Tablet 

Production Requests (Remote Printer) 

Thasanfiglicatiansazusl leads you through the initial steps forgetting up the software to accommodate 
your needs. However, additional optima/dialogs can be found in the Settings menu. In this main menu, all 
the different settings of the software can be found, including those that are p gat of the configuration 
wizard. 

Moat option names will probably speak for themselves. Each settings dialog has an =Amatory 
introduction that will help to select the bestsetup for you. The list below gives an overview of the 
fituctionality of each option in the Settings menu and provides a general description of the impose for the 
menu items. 

Computer registration 

The software product code (SPC) has to be entered in the registration window. After selecting 
`Registration via interned', your registration data will be checked on the TactileView website to verify 
the validity of the registration. Please note that each SPC is valid for only one computer. 

CorOguration wizard: step 
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2.06 Settings menu

The configuration wizard leads you through the initial steps for setting up the software to accommodate
your needs. However, additional options/dialogs can be found in the Settings menu. In this main menu, all
the different settings of the software can be found, including those that are part of the configuration
wizard.

Most option names will probably speak for themselves. Each settings dialog has an explanatory
introduction that will help to select the best setup for you. The list below gives an overview of the
functionality of each option in the Settings menu and provides a general description of the purpose for the
menu items.

Computer registration

The software product code (SPC) has to be entered in the registration window. After selecting
‘Registration via internet’, your registration data will be checked on the TactileView website to verify
the validity of the registration. Please note that each SPC is valid for only one computer.

Configuration wizard: step 1
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General 

The units for the preferred measurement system can be set, as well as the reference position for these 
measurements. The size of the markers that can be `grabbed' with the mouse to modify objects can be 
adjusted. A marker size of 5 pixels is the default. 

The internet gateway to the TactileView internet catalog can be tested and configured. The name and e-
mail address of the author that is uploading designs to the catalog can be entered here. The TactileView 
Viewmaster will send feedback on the graphic aspects and tactile usability of the designs to this e-mail 
address. 

Configuration wizard: step 3 

Languages 

The user language in which the software texts are displayed can be set, as well as the language in which 
the text labels are written in the design. Setting the text label correct language is important for uploading 
the designs to the catalog, as text labels are translated in all the available languages. 

Configuration wizard: step 3 

Braille tables 

The conventions for texts in braille differ per country or language. Select a braille table as the main braille 
from the extended list of the Liblouis set of tables (includes contracted braille). When entering a text label 
in the design with the drawing tool 'Add text label', the braille characters will be automatically generated 
according to the selected braille table. 

Configuration wizard: step 2 

Sign up for newsletter 

The Thinkable newsletter is a resource in which we announce events and share ideas about the usage of 
TactileView and various other products by Thinkable. Our regular newsletter is a great way to stay in 
touch with our work and everything that's going on at Thinkable, so we invite you to sign up and leave 
your feedback. 

Configuration wizard: step 3 

Update TactileView components 

Technically the software is set up as a modular system. The various modules, such as the software texts 
that you find in menus and dialogs, are stored and maintained on a non-public section of the TactileView 
website. TactileView will download any new updates automatically each time the software is launched. 
This setup offers great flexibility and convenience to provide minor updates without requiring any action, 
so it is advised to have this setting switched on. Please note that an internet connection is required to 
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General

The units for the preferred measurement system can be set, as well as the reference position for these
measurements. The size of the markers that can be ‘grabbed’ with the mouse to modify objects can be
adjusted. A marker size of 5 pixels is the default.

The internet gateway to the TactileView internet catalog can be tested and configured. The name and e-
mail address of the author that is uploading designs to the catalog can be entered here. The TactileView
Viewmaster will send feedback on the graphic aspects and tactile usability of the designs to this e-mail
address.

Configuration wizard: step 3

Languages

The user language in which the software texts are displayed can be set, as well as the language in which
the text labels are written in the design. Setting the text label correct language is important for uploading
the designs to the catalog, as text labels are translated in all the available languages.

Configuration wizard: step 3

Braille tables

The conventions for texts in braille differ per country or language. Select a braille table as the main braille
from the extended list of the Liblouis set of tables (includes contracted braille). When entering a text label
in the design with the drawing tool 'Add text label', the braille characters will be automatically generated
according to the selected braille table.

Configuration wizard: step 2

Sign up for newsletter

The Thinkable newsletter is a resource in which we announce events and share ideas about the usage of
TactileView and various other products by Thinkable. Our regular newsletter is a great way to stay in
touch with our work and everything that's going on at Thinkable, so we invite you to sign up and leave
your feedback.

Configuration wizard: step 3

Update TactileView components

Technically the software is set up as a modular system. The various modules, such as the software texts
that you find in menus and dialogs, are stored and maintained on a non-public section of the TactileView
website. TactileView will download any new updates automatically each time the software is launched.
This setup offers great flexibility and convenience to provide minor updates without requiring any action,
so it is advised to have this setting switched on. Please note that an internet connection is required to
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receive updates. 

Configuration wizard: step 3 

Text label presentation: on screen 

The appearance of braille is quite different from the standard font and is hard to read for sighted users. 
Therefore the text that is added as a text label in the design can be displayed in standard font as well as in 
the equivalent braille characters, based on the selected braille table. The colour of the standard font 
(default green) can be changed or can be switched off completely. 

Configuration wizard: step 3 

Text label presentation: on print 

Text labels printed on swellpaper can be represented both in braille and standard font, similar to the 
display on screen. The braille dots are printed in black. The visual font can be switched off or set to any 
preferred colour. For printing on swellpaper, make sure that the selected colour has no grey or black 
appearance. 

Configuration wizard: step 2 

Line view/dot View 

Depending on the selected embosser type, the positioning and distance between the braille dots will vary. 
During the design phase it might be easier to work with continuous lines. For a close check of the tactile 
layout it can be useful to switch to dot view. While switching from one mode to the other an explanatory 
message will be displayed. 

Mathematical notation (equation editor) 

The MathType equation editor can be used to prepare mathematical equations in their spatial layout. The 
mathML expression is copied/pasted into TactileView. The equation can be expressed in braille using 
several mathematical notations. The preferred math notation is selected here. 

Configuration wizard: step 4 

Insert TactileView design in text file 

TactileView designs can be embedded in documents that are produced with the Duxbury Braille 
Translator (DBT) See for more details also the section thirdparty software. 

Configuration wizard: step 4 

Figures 
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receive updates.

Configuration wizard: step 3

Text label presentation: on screen

The appearance of braille is quite different from the standard font and is hard to read for sighted users.
Therefore the text that is added as a text label in the design can be displayed in standard font as well as in
the equivalent braille characters, based on the selected braille table. The colour of the standard font
(default green) can be changed or can be switched off completely.

Configuration wizard: step 3

Text label presentation: on print

Text labels printed on swellpaper can be represented both in braille and standard font, similar to the
display on screen. The braille dots are printed in black. The visual font can be switched off or set to any
preferred colour. For printing on swellpaper, make sure that the selected colour has no grey or black
appearance.

Configuration wizard: step 2

Line view/dot View

Depending on the selected embosser type, the positioning and distance between the braille dots will vary.
During the design phase it might be easier to work with continuous lines. For a close check of the tactile
layout it can be useful to switch to dot view. While switching from one mode to the other an explanatory
message will be displayed.

Mathematical notation (equation editor)

The MathType equation editor can be used to prepare mathematical equations in their spatial layout. The
mathML expression is copied/pasted into TactileView. The equation can be expressed in braille using
several mathematical notations. The preferred math notation is selected here.

Configuration wizard: step 4

Insert TactileView design in text file

TactileView designs can be embedded in documents that are produced with the Duxbury Braille
Translator (DBT) See for more details also the section thirdparty software.

Configuration wizard: step 4

Figures
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Arrows, electrical or chemical symbols, smileys, etc. can be added to the design as a figure by selecting 
the drawing tool 'Import', then choosing `Add Figure'. A library of figures is included, but new 
categories or figures can be added. In this settings dialog you can set the folder for your personal library 
of figures. 

Speech 

The Text-to-Speech engine (TTS) is selected in this dialog and performs two tasks. 

The TTS vocalizes the software messages to support the use of a screen reader and is announcing the text 
that is supplied in the audio style for an object. 

A design, once embossed, is called tactile diagram. In addition to the tactile information, an extra layer of 
audio information can be added to the design. Specific areas can be provided with an audio style (See also 
Editing object properties). The TTS is used for when exploring the audible information in a diagram. 

TactileView digital pen 

The TactileView digital pen acts as a connection between the software and the TactiPad drawing board or 
the TactileView ClickPad. For both setups, the software is providing additional functionality in 
combination with the hardware. Attention has to be payed to the position of the receiver and the 
calibration. The usage for this setup is targeted for visually impaired users of the digital pen and requires 
a high skill level. 

See also the sections TactileView digital pen, TactiPad and ClickPad 

Scanner 

When a scanner is connected to the computer, it can be configured in this settings dialog. Select the 
option 'Quick scan with scanner' from the Portal menu or click on the scanner icon in the top toolbar to 
start the scanning process and insert the scan in the existing design or in a new document. For further 
processing use the drawing tools from the drawings tools icon bar. 

Webcam 

When the computer is equipped with a built-in webcam or an external one, select 'Activate webcam' from 
the Portal menu or click on the 'Activate webcam' icon in the top toolbar to start the webcam. The 
resulting image can be inserted in the existing design or in a new document. For further processing use 
the drawing tools from the drawings tools icon bar. 

Microphone 

The built in microphone or an external one can be configured for adding recordings as an audio style to an 
object. See: Editing object properties. 

Touch tablet 
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Arrows, electrical or chemical symbols, smileys, etc. can be added to the design as a figure by selecting
the drawing tool 'Import', then choosing ‘Add Figure’. A library of figures is included, but new
categories or figures can be added. In this settings dialog you can set the folder for your personal library
of figures.

Speech

The Text-to-Speech engine (TTS) is selected in this dialog and performs two tasks.

The TTS vocalizes the software messages to support the use of a screen reader and is announcing the text
that is supplied in the audio style for an object.

A design, once embossed, is called tactile diagram. In addition to the tactile information, an extra layer of
audio information can be added to the design. Specific areas can be provided with an audio style (See also
Editing object properties). The TTS is used for when exploring the audible information in a diagram.

TactileView digital pen

The TactileView digital pen acts as a connection between the software and the TactiPad drawing board or
the TactileView ClickPad. For both setups, the software is providing additional functionality in
combination with the hardware. Attention has to be payed to the position of the receiver and the
calibration. The usage for this setup is targeted for visually impaired users of the digital pen and requires
a high skill level.

See also the sections TactileView digital pen, TactiPad and ClickPad

Scanner

When a scanner is connected to the computer, it can be configured in this settings dialog. Select the
option 'Quick scan with scanner' from the Portal menu or click on the scanner icon in the top toolbar to
start the scanning process and insert the scan in the existing design or in a new document. For further
processing use the drawing tools from the drawings tools icon bar.

Webcam

When the computer is equipped with a built-in webcam or an external one, select 'Activate webcam' from
the Portal menu or click on the 'Activate webcam' icon in the top toolbar to start the webcam. The
resulting image can be inserted in the existing design or in a new document. For further processing use
the drawing tools from the drawings tools icon bar.

Microphone

The built in microphone or an external one can be configured for adding recordings as an audio style to an
object. See: Editing object properties.

Touch tablet
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A touch tablet can be connected to explore audio tactile diagrams. The settings are configured in this 
settings dialog. See also the section `Audio tactile diagrams'. 

Production requests (remote printer) 

Not everyone has access to a production facility (swellpaper or braille embosser) for tactile graphics. In 
combination with the TactileView website, printers can be made accessible for remote printing by other 
users. This feature requires a software and printer installation that is made available to others as a so-
called production facility. 

To upload your production requests to a remote printer, a customer code and teleprint code are required to 
keep track of which design has to be produced on which embosser for which customer. 

For the production facility, a customer code and an printer identification code are required to retrieve the 
production requests from the TactileView website. 
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A touch tablet can be connected to explore audio tactile diagrams. The settings are configured in this
settings dialog. See also the section ‘Audio tactile diagrams’.

Production requests (remote printer)

Not everyone has access to a production facility (swellpaper or braille embosser) for tactile graphics. In
combination with the TactileView website, printers can be made accessible for remote printing by other
users. This feature requires a software and printer installation that is made available to others as a so-
called production facility.

To upload your production requests to a remote printer, a customer code and teleprint code are required to
keep track of which design has to be produced on which embosser for which customer.

For the production facility, a customer code and an printer identification code are required to retrieve the
production requests from the TactileView website.
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3.01 Software window elements 

After launching TactileView, the software window will contain the following sections that provide all 
available functionality and allow you to operate all the functions in the software. 

Drawing area 

In the centre of the TactileView window you can find the drawing area of the design. The drawing area is 
surrounded with a red border, indicating the size of the printable area on the selected paper size for the 
selected printer. Some printers have larger margins along the edges of the paper that cannot be printed, 
resulting in a smaller area within the red border compared to other printers. 
The white area shows the actual size of the contents of your design. The size of the contents can be 
increased in size both horizontally and vertically to span multiple pages. If the white area does not fit 
within the red border of the printable area, you can reduce the size to make it fit within the page(s) using 
the purple markers on the four sides. The blue marker in the lower right corner is used to scale the entire 
design. 
All software functions are situated around this drawing area. 
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3.01 Software window elements

After launching TactileView, the software window will contain the following sections that provide all
available functionality and allow you to operate all the functions in the software.

Drawing area

In the centre of the TactileView window you can find the drawing area of the design. The drawing area is
surrounded with a red border, indicating the size of the printable area on the selected paper size for the
selected printer. Some printers have larger margins along the edges of the paper that cannot be printed,
resulting in a smaller area within the red border compared to other printers.
The white area shows the actual size of the contents of your design. The size of the contents can be
increased in size both horizontally and vertically to span multiple pages. If the white area does not fit
within the red border of the printable area, you can reduce the size to make it fit within the page(s) using
the purple markers on the four sides. The blue marker in the lower right corner is used to scale the entire
design.
All software functions are situated around this drawing area.
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Figure 1. Drawing area highkgked Us green. 

Top section: menus and borisiontal icon ban 

Above the drawing area, you can find three dements: the software menus, two horizontal icon bars and 
the names of the opened documents. The top row ofioons axe general functions for the software, whereas 
the second row contains fiuictions related to the design that you axe working on in the drawing area In 
some loons, a small arrow indicates that there is a dropdown toolbar with additional options Moat icons 
will depict the function that they represent To get more information, your can hover ova- the icon with 
the mouse Tooltipa in your selected language will be displayed, explaining which function will be 
activated when you click on the icon. 
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Figure 1. Drawing area highlighted in green.

Top section: menus and horizontal icon bars

Above the drawing area, you can find three elements: the software menus, two horizontal icon bars and
the names of the opened documents. The top row of icons are general functions for the software, whereas
the second row contains functions related to the design that you are working on in the drawing area. In
some icons, a small arrow indicates that there is a dropdown toolbar with additional options. Most icons
will depict the function that they represent. To get more information, your can hover over the icon with
the mouse. Tooltips in your selected language will be displayed, explaining which function will be
activated when you click on the icon.
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Figure 2. Menus, horizontal icon bars and file names. 

Left section: vett icon ban' 

On the left hand side you can find two vertical loon bas. The leftmost vertical icon tm- contains all the 
drawing tools to create graphics or modify the content of your design. By selecting one of these tools and 
clicking in the drawing area, different objects can beplaced. 
The right vertical icon tom-will show the range ofproperties for the cunent selection. This can eitherbe 
the drawing tool selected from the left toolbar, or the object in the design that has the focus. You can 
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Figure 2. Menus, horizontal icon bars and file names.

Left section: vertical icon bars

On the left hand side you can find two vertical icon bars. The leftmost vertical icon bar contains all the
drawing tools to create graphics or modify the content of your design. By selecting one of these tools and
clicking in the drawing area, different objects can be placed.
The right vertical icon bar will show the range of properties for the current selection. This can either be
the drawing tool selected from the left toolbar, or the object in the design that has the focus. You can
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(re)select an object by clicking on it in the design area.
Once again, tooltips will explain which functions are represented by the icons in the vertical toolbars.

Figure 3. Vertical icon bars give access to the drawing tools and the options for the selected tool or
element in the design.

Bottom section: status line
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Below the drawing area you will find the status line, showing inouseposition, dime:Dales:la, etc. for the 
selected drawing tool or object in the design. 
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Below the drawing area you will find the status line, showing mouse position, dimensions, etc. for the
selected drawing tool or object in the design.

Figure 4. Status bar near the bottom of the software window gives information about the selected element
or drawing tool.

https://www.youtube.com/watch?v=utxb8HktCS4
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3.02 After launching the software 

In this section you can find a first introduction to some of the first software functions you will come 
across when you create a tactile design. 

First impression 

Alter launching the software, the red border is showing the current paper site and orientation. 

The word Title' can be found in the top left corner. This is to make you aware of the importance of a title 
in your design, which will help the reader to understand the content of the diagram at hand. 

When you open a new design, you will see a tactile marker in the upper right comer. This so-called right-
up marker helps a blind reader to easily find out the paper orientation without having to explore its 
contents first. This the position of the right-up marker is always in the top right corner, independent of 
landscape or portrait orientation. On screen, the marker is shown as three blue lines at an angle of 45 
degrees. 

For most designs we advise you to include the right-up marker for ease of use. However, by clicking on 
the marker it can be turned off, which for example can be used if you want to print multiple designs in a 
bundle and bind them. A red marker will remain which can be activated to switch the marker on again. 

• 

Figure I. The top of the design shows the title text label, right-up marker and red border for paper size 
and orientation. 

Design orientation: landscape or portrait designs 

Choosing the right paper orientation for your design allows you to make optimal use of the available 
space on the paper. This way the image can be presented as large as possible in order to retain smaller 
details. You can change the paper orientation by clicking on the 'Change the orientation to 
landscapeiportrait' icon in the design toolbar (second vertical toolbar when nothing is selected). You can 
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3.02 After launching the software

In this section you can find a first introduction to some of the first software functions you will come
across when you create a tactile design.

First impression

After launching the software, the red border is showing the current paper size and orientation.

The word 'Title' can be found in the top left corner. This is to make you aware of the importance of a title
in your design, which will help the reader to understand the content of the diagram at hand.

When you open a new design, you will see a tactile marker in the upper right corner. This so-called right-
up marker helps a blind reader to easily find out the paper orientation without having to explore its
contents first. This the position of the right-up marker is always in the top right corner, independent of
landscape or portrait orientation. On screen, the marker is shown as three blue lines at an angle of 45
degrees.

For most designs we advise you to include the right-up marker for ease of use. However, by clicking on
the marker it can be turned off, which for example can be used if you want to print multiple designs in a
bundle and bind them. A red marker will remain which can be activated to switch the marker on again.

Figure 1. The top of the design shows the title text label, right-up marker and red border for paper size
and orientation.

 

Design orientation: landscape or portrait designs

Choosing the right paper orientation for your design allows you to make optimal use of the available
space on the paper. This way the image can be presented as large as possible in order to retain smaller
details. You can change the paper orientation by clicking on the 'Change the orientation to
landscape/portrait' icon in the design toolbar (second vertical toolbar when nothing is selected). You can
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also find this option in the Design menu. 

It is important to ]mow that Changing the paper orientation will not act ust the size of the image! This 
ensures that the tactile quality of the image is maintained However, you might need to adjust the width 
and/or height manually to fit the new paper orientation by dragging the markers around the design. 

'Change the orientation to kvidscape" icon: 

'Orange the orientation to portrait' icon: 

Portrait to landscape orientation 

When you start with a design with a tree in portrait mode and you decide you want to have it in 
landscape, you can char ge the paper orientation. The El= of the white design area that contains tic tree 
will stay the same. 

It is likely that the low part of your design will mw be outside the red bat and that you have two 
sheets of papa instead of one. Even though you could have a design spread over multiple sheets, chalices 
are you would nit to reduce the design size to fit a single sheet of paper. You can use tic blue marker in 
the low right corner to make the height of the tow fit Please note that your tree has become smaller, so 
make sure any smaller details are still adequate for tactile use. Nett, use the purple marker in the middle 
of the right side of your design to add paper to span the width of the paper. 

Landscape to portrait orientation 
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also find this option in the Design menu.

It is important to know that changing the paper orientation will not adjust the size of the image! This
ensures that the tactile quality of the image is maintained. However, you might need to adjust the width
and/or height manually to fit the new paper orientation by dragging the markers around the design.

'Change the orientation to landscape' icon: 

'Change the orientation to portrait' icon: 

Portrait to landscape orientation

When you start with a design with a tree in portrait mode and you decide you want to have it in
landscape, you can change the paper orientation. The size of the white design area that contains the tree
will stay the same.

It is likely that the lower part of your design will now be outside the red border and that you have two
sheets of paper instead of one. Even though you could have a design spread over multiple sheets, chances
are you would want to reduce the design size to fit a single sheet of paper. You can use the blue marker in
the lower right corner to make the height of the tree fit. Please note that your tree has become smaller, so
make sure any smaller details are still adequate for tactile use. Next, use the purple marker in the middle
of the right side of your design to add paper to span the width of the paper.

Landscape to portrait orientation
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The other way around, you might start with a tree that spans the height of a design in landscape 
orientation, but decide you want it to be in portrait to make better use of the length of the paper. In that 
case, you could increase the size of the image by using the blue marker in the lower right corner. You can 
use the purple markers in the middle of the two sides of the white area to trim any empty space left and 
right of the tree. 

For more information, see section 'Paper size vs. design size'. 

Line view and Dot view 

To get you familiar as soon as possible with the effect of creating designs for braille embossers, you can 
view the design on screen as it will be embossed in dots. 

For good visibility you can use the line view mode for the drawing. When you switch to dot view, all 
lines will be converted to individual dots, just as your braille embosser will do. 

You can read more in the section 'Design mode: dot view/line view'. 
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The other way around, you might start with a tree that spans the height of a design in landscape
orientation, but decide you want it to be in portrait to make better use of the length of the paper. In that
case, you could increase the size of the image by using the blue marker in the lower right corner. You can
use the purple markers in the middle of the two sides of the white area to trim any empty space left and
right of the tree.

For more information, see section 'Paper size vs. design size'.

Line view and Dot view

To get you familiar as soon as possible with the effect of creating designs for braille embossers, you can
view the design on screen as it will be embossed in dots.

For good visibility you can use the line view mode for the drawing. When you switch to dot view, all
lines will be converted to individual dots, just as your braille embosser will do.

You can read more in the section 'Design mode: dot view/line view'.
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Figure 2. A circle shown in line view (left) or dot view (right) shows the graphic capabilities of the 
selected embosser. 
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Figure 2. A circle shown in line view (left) or dot view (right) shows the graphic capabilities of the
selected embosser.
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3.03 Colours on screen 

General colour use in TactileView 

Green 

The colour green is used as a colour for information. Everything you see in this colour is NOT printed on 
the design. Examples are: the font 'beneath' tic braille dots of the textlabela, the alignment lines for the 
text labels, the grid for aligning object in the drawing area, the letters at the angles for the triangle. 

• Blue 

Objects created with one of the drawing tools (square, lirc, circle, dot, etc.) are presented in blue. 
Variations of blue are used to indicated tic selected dot height (for embossers that support varying dot 
heights). A lighterblue colour indicates a lower dot height. 

• mac* 

Linea that are created with the drawing tool 'Retouching: Adding linos', are drawn in black. This indicates 
that tic line is part of the underlying bitmap in tic design. The bitmap consists of individual pixels that 
can be erased by choosing 'Retouching Eraser. 

Any colours present in images inserted from file or from tic interrct will be converted to braille dots. 
These images should be processed using tic filters and be converted to black/white in order to print them 
in braille linos. 

• nupie 
Markers are placed on or around a selected object. These markers can be used to reposition or maize the 
object, or change its proportions. Markets with a different function will have a different colour instead of 
purple 

(-I Red 

A red border is surrounding tic drawing area, reflecting the printable area of a aicet of paper in the 
selected paper size. When tic designs exceeds this initial area, the red borders will signify that multiple 
anoets of paper will be printed that together will contain the design. 

Special cases 

Text labels 

A rounded marker precedes each text label to signify the type of input used for the specific label. 

Green is used for text labels entered with the regular computer keyboard; 
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3.03 Colours on screen

General colour use in TactileView

 Green

The colour green is used as a colour for information. Everything you see in this colour is NOT printed on
the design. Examples are: the font 'beneath' the braille dots of the textlabels, the alignment lines for the
text labels, the grid for aligning object in the drawing area, the letters at the angles for the triangle.

 Blue

Objects created with one of the drawing tools (square, line, circle, dot, etc.) are presented in blue.
Variations of blue are used to indicated the selected dot height (for embossers that support varying dot
heights). A lighter blue colour indicates a lower dot height.

 Black

Lines that are created with the drawing tool 'Retouching: Adding lines', are drawn in black. This indicates
that the line is part of the underlying bitmap in the design. The bitmap consists of individual pixels that
can be erased by choosing 'Retouching: Erase'.

Any colours present in images inserted from file or from the internet will be converted to braille dots.
These images should be processed using the filters and be converted to black/white in order to print them
in braille lines.

 Purple

Markers are placed on or around a selected object. These markers can be used to reposition or resize the
object, or change its proportions. Markers with a different function will have a different colour instead of
purple.

 Red

A red border is surrounding the drawing area, reflecting the printable area of a sheet of paper in the
selected paper size. When the designs exceeds this initial area, the red borders will signify that multiple
sheets of paper will be printed that together will contain the design.

Special cases

Text labels

A rounded marker precedes each text label to signify the type of input used for the specific label.

  Green is used for text labels entered with the regular computer keyboard;
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Orange for those that were created with Perkins style input; 

Grey/blue for mathematical tektlabels, created with the MathTypo equation editor. 

Formulas in graphs 

When multiple formulas are used in a graph, each formula in a graph will have its own colour (red, green, 
blue and yellow) to easily distinguish between them. These different colon are only used for display on 
the screen and will not lead to dint-m-1,QQ' on a print. 

• v• r. x 4. 
• • • • • • • • 

• • • • • • • •
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Figzore 1. Cologn are geed on screen to distinguish between different formulas. 

Braille tables 
In a single document, multiple braille tables can be used to accommodate for language variations. In the 
design toolbar (right vertical toolbar when nothing is selected), click Show used braille tables' to see an 
overview of the different braille tables in the design. Colours we used in the legend and design to 
distinguish the different braille tables. 

41/2245 

TactileView software manual
Visit us at https://thinkable.nl

  Orange for those that were created with Perkins style input;

  Grey/blue for mathematical textlabels, created with the MathType equation editor.

Formulas in graphs

When multiple formulas are used in a graph, each formula in a graph will have its own colour (red, green,
blue and yellow) to easily distinguish between them. These different colours are only used for display on
the screen and will not lead to differences on a print.

Figure 1. Colours are used on screen to distinguish between different formulas.

Braille tables
In a single document, multiple braille tables can be used to accommodate for language variations. In the
design toolbar (right vertical toolbar when nothing is selected), click 'Show used braille tables' to see an
overview of the different braille tables in the design. Colours are used in the legend and design to
distinguish the different braille tables.

                                 41 / 226



Taetilevilew software nape 
visa ® et bnixi://erinkablanl 

1 main table DUTCH2005 (1) 
en-us-gl.ctb (1) 
de-de-gl.ctb (1) 
Es-Es-gl.utb (1) 

• 

II 

I •  

• • V 

r; • 

• •
t  • • • 

, • • C • n • I 
H 1 

II . ili 
1 • • • • i• • • • ii 

• i E. n• (-4• • I. • • i • • • 
•Ge•p•ma nei 

 a - - - • • • • • • • 

• • •• 5 •• •a • 
n•ei

. 
• • • • • p  • 

Figure 2. The colours is the legend end tat labels signt the used braille tables. 

Audio styles 

Objects with audiestyles are presented with a light red/pink fill, 
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Figure 2. The colours in the legend and text labels signify the used braille tables.

Audio styles

Objects with audiostyles are presented with a light red/pink fill.
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Figure 3. The light red colour signifies that the circle contains an audio style. 
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Figure 3. The light red colour signifies that the circle contains an audio style.
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3.04 Keyboard shortcuts 

The following list of keyboard shortcuts are supported in TactileView. These shortcuts can be used to 
easily activate specific software functions, general operations, drawing tools and text editing functions. 
The list of shortcut keys for the drawing tools can be personalised to make them easier to remember (see 
below). 

See Scroll wheel and key combinations for keyboard combinations with the scroll wheel. 

TactileView shortcuts 
Ctrl+B Fuse selected object with the bitmap 
Ctrl+E Open current file in Explore mode: Speech and 

sound 
Ctrl+I Play audio style 
Ctrl+J Show properties of selected object 
Ctrl+K Open context menu 
Ctrl+L Start Menu driven design 
Ctrl+R Explore colour composition 
Ctrl+W Take webcam snapshot when activated 

Drawing tools (default set, see below for personalisation) 
T Text label 
S Select area 
H Detect shape 
F Filters 
U Retouching - adding lines 
E Retouching - eraser 
L Draw straight line 

Q Draw Square-Rectangle 
C Draw Circle-Ellipse 
N Draw Triangle 
P Draw Polygon 
D Draw free hand line or closed shape 
0 Draw Dots 
A Draw Table 
G Draw Graph 
I Import 
M Mammoth braille 
R Draw letters and digits 
V Add voice memo 

General shortcuts 
Ctrl+N New document 
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3.04 Keyboard shortcuts

The following list of keyboard shortcuts are supported in TactileView. These shortcuts can be used to
easily activate specific software functions, general operations, drawing tools and text editing functions.
The list of shortcut keys for the drawing tools can be personalised to make them easier to remember (see
below).

See Scroll wheel and key combinations for keyboard combinations with the scroll wheel.

TactileView shortcuts
Ctrl+B Fuse selected object with the bitmap
Ctrl+E Open current file in Explore mode: Speech and

sound
Ctrl+I Play audio style
Ctrl+J Show properties of selected object
Ctrl+K Open context menu
Ctrl+L Start Menu driven design
Ctrl+R Explore colour composition
Ctrl+W Take webcam snapshot when activated

Drawing tools (default set, see below for personalisation)
T Text label
S Select area
H Detect shape
F Filters
U Retouching - adding lines
E Retouching - eraser
L Draw straight line
Q Draw Square-Rectangle
C Draw Circle-Ellipse
N Draw Triangle
P Draw Polygon
D Draw free hand line or closed shape
O Draw Dots
A Draw Table
G Draw Graph
I Import
M Mammoth braille
R Draw letters and digits
V Add voice memo

General shortcuts
Ctrl+N New document
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Ctrl+O Open document 
Ctrl+S Save 
Ctr1+ Shift+ S 

Arrow keys Move object or anchor point by 1 pixel 
Shift+Arrow keys Move object or anchor point by 10 pixels 
Ctrl+X Cut 
Ctrl+C Copy 
Ctrl+P Print 
Ctrl+Z Undo 
Page Up Jump to previous page 
Page Down Jump to next page 
Esc Deactivate currently active drawing tool/deselect 

currently selected object 
Ctrl+Tab Switch between open designs 

Text editing 
Home Jump to front of text line 
End Jump to end of text line 
Ctrl+Home Jump to start of text label 
Ctrl+End Jump to end of text label 
Shift+Arrow keys Select text 
Shift+Left mouse click Select text between caret position and click 

position 
Del or Backspace Delete selected text 

Personalised drawing tools shortcuts 

Via menu Settings > Keyboard shortcuts, the list of shortcuts that activate the drawing tools in the left 
vertical toolbar can be edited. The left column in the dialog contains the list of drawing tools; by clicking 
on the right column, you can assign a keyboard key that will act as the shortcut for the corresponding 
drawing tool. You can always return to the default list of shortcut keys by clicking on the 'Reset default 
shortcut keys' button. 

Remember that each shortcut key can be used only once in the list, giving each drawing tool a unique 
key. 
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Ctrl+O Open document
Ctrl+S Save
Ctrl+Shift+S

 

Arrow keys Move object or anchor point by 1 pixel
Shift+Arrow keys Move object or anchor point by 10 pixels
Ctrl+X Cut
Ctrl+C Copy
Ctrl+P Print
Ctrl+Z Undo
Page Up Jump to previous page
Page Down Jump to next page
Esc Deactivate currently active drawing tool/deselect

currently selected object
Ctrl+Tab Switch between open designs

Text editing
Home Jump to front of text line
End Jump to end of text line
Ctrl+Home Jump to start of text label
Ctrl+End Jump to end of text label
Shift+Arrow keys Select text
Shift+Left mouse click Select text between caret position and click

position
Del or Backspace Delete selected text

Personalised drawing tools shortcuts

Via menu Settings > Keyboard shortcuts, the list of shortcuts that activate the drawing tools in the left
vertical toolbar can be edited. The left column in the dialog contains the list of drawing tools; by clicking
on the right column, you can assign a keyboard key that will act as the shortcut for the corresponding
drawing tool. You can always return to the default list of shortcut keys by clicking on the 'Reset default
shortcut keys' button.

Remember that each shortcut key can be used only once in the list, giving each drawing tool a unique
key.
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3.05 Scroll wheel and key combinations 

A number of software features are easily accessible by using the scroll wheel when operating the software 
with your mouse. The description below gives an overview of the different operations using the scroll 
wheel for better efficiency when drawing. 

Operation Shortcut 
Pan vertically through design Scroll up/down 
Zoom in Ctrl + scroll up 
Zoom out Ctrl + scroll down 
Rotate selected object 5 degrees Shift + scroll up/down 
Rotate selected object 1 degree Shift + alt + scroll up/down 
Increase/decrease line thickness Shift + scroll up/down 
Increase dot size Shift + scroll up/down 

Pan vertically through the design (Scroll up/down) 

When the mouse is in the design area, scrolling up or down with the mouse wheel (no keys pressed) will 
allow you to move vertically through the design. 

Zooming in/out (Ctrl + scroll up/down) 

To view a particular part of the design in more detail, you can zoom in by using Ctrl + scroll up. Ctrl + 
scroll down will zoom out in order to view a larger section of the design. 

Rotation of objects (Shift + scroll, Shift + Ctrl + scroll) 

Almost all objects (including textlabels) can be rotated any number of degrees. The angle for the rotation 
can be set in an edit field by clicking 'Rotation' in the object's toolbar. For easy access, a selected object 
can be rotated in steps of 5 degrees by using Shift + scroll wheel up/down. For more accuracy, Ctrl + shift 
+ scroll up/down will rotate the object in steps of 1 degree. 

Increase/decrease of line thickness or dot size (Shift + scroll up/down) 

The value for the line thickness, the eraser width or the size of the blue dots can be set by entering a value 
in the respective dialogs. While drawing, the size can be easily adjusted Shift + scroll wheel. 
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3.05 Scroll wheel and key combinations

A number of software features are easily accessible by using the scroll wheel when operating the software
with your mouse. The description below gives an overview of the different operations using the scroll
wheel for better efficiency when drawing.

Operation Shortcut
Pan vertically through design Scroll up/down
Zoom in Ctrl + scroll up
Zoom out Ctrl + scroll down
Rotate selected object 5 degrees Shift + scroll up/down
Rotate selected object 1 degree  Shift + alt + scroll up/down
Increase/decrease line thickness Shift + scroll up/down
Increase dot size Shift + scroll up/down

Pan vertically through the design (Scroll up/down)

When the mouse is in the design area, scrolling up or down with the mouse wheel (no keys pressed) will
allow you to move vertically through the design.

Zooming in/out (Ctrl + scroll up/down)

To view a particular part of the design in more detail, you can zoom in by using Ctrl + scroll up. Ctrl +
scroll down will zoom out in order to view a larger section of the design.

Rotation of objects (Shift + scroll, Shift + Ctrl + scroll)

Almost all objects (including textlabels) can be rotated any number of degrees. The angle for the rotation
can be set in an edit field by clicking 'Rotation' in the object's toolbar. For easy access, a selected object
can be rotated in steps of 5 degrees by using Shift + scroll wheel up/down. For more accuracy, Ctrl + shift
+ scroll up/down will rotate the object in steps of 1 degree.

Increase/decrease of line thickness or dot size (Shift + scroll up/down)

The value for the line thickness, the eraser width or the size of the blue dots can be set by entering a value
in the respective dialogs. While drawing, the size can be easily adjusted Shift + scroll wheel.
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3.06 Transparency and object stacking 

All blue objects with the exception of lines have two components: the outline (eg. the tree aides of a 
triangle) and the object's surface (the area in between those three lima). The object's surface can be given 
a combination of different properties, such as textures and transparency. 

The transparency comes into play when two or more objects are (partly) overlapping Win the object is 
transparent, all blue parts of the objects 'below' it will be visible and included on the print. When the 
object is seat transparent, (parts of) the object below will be covered. 

Select 'Change to cover underlying image (is now transparent)' fin the properties toolbar or context 
menu to make the object non-transparent. Vice versa, select Change to make the underlying image visible 
(is naw not transparent)' to make the object transparent. 

Figure 1. The circle cm the left is transparen4 revealing the square below; the arcle on the right is non-
transparent and coven the square. 

Mae object transparent' icon; 

Mae object non-transparent" icon; 

Conlin] overlap with Object Stacking 
By default, tie order in which the objects are placed in the design determines the stacking order, i.e. 
which object is 'on top' said will overlap %wee object(s). Objects that were placed later will be on top of 
earlier placed objects. 
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3.06 Transparency and object stacking

All blue objects with the exception of lines have two components: the outline (e.g. the tree sides of a
triangle) and the object's surface (the area in between those three lines). The object's surface can be given
a combination of different properties, such as textures and transparency.

The transparency comes into play when two or more objects are (partly) overlapping. When the object is
transparent, all blue parts of the objects 'below' it will be visible and included on the print. When the
object is not transparent, (parts of) the object below will be covered. 

Select 'Change to cover underlying image (is now transparent)' from the properties toolbar or context
menu to make the object non-transparent. Vice versa, select 'Change to make the underlying image visible
(is now not transparent)' to make the object transparent.

Figure 1. The circle on the left is transparent, revealing the square below; the circle on the right is non-
transparent and covers the square.
 

'Make object transparent' icon: 

'Make object non-transparent' icon: 

Control overlap with Object Stacking
By default, the order in which the objects are placed in the design determines the stacking order, i.e.
which object is 'on top' and will overlap 'lower' object(s). Objects that were placed later will be on top of
earlier placed objects.
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You can easily get an overview of tic stacking order of the objects in your design by selecting 'Screen 
elements' from tic second horizontal toolbar, then choosing 'Show object stacking. When this is 
activated, tic object order is indicated with green numbers for transparent objects and orange numbers for 
non-transparent objects. The lowest numbers will be on top, e.g. object 1 will cover object 3 when it is 
not transparent. 

If you want to reverse the object order, select the object that you wish to move below or on top of another 
object, then select To tack' or To front to move it below or on top of the attar object(s) respectively. 

Figure 2. The green and orange numbers show the stacking order of the circles and squares 

Screen elements' icon: 

Show object stacking' icon: 

'To front' icon: [5)

To back icon: IC)
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You can easily get an overview of the stacking order of the objects in your design by selecting 'Screen
elements' from the second horizontal toolbar, then choosing 'Show object stacking'. When this is
activated, the object order is indicated with green numbers for transparent objects and orange numbers for
non-transparent objects. The lowest numbers will be on top, e.g. object 1 will cover object 3 when it is
not transparent.

If you want to reverse the object order, select the object that you wish to move below or on top of another
object, then select 'To back' or 'To front' to move it below or on top of the other object(s) respectively.

Figure 2. The green and orange numbers show the stacking order of the circles and squares.
 

'Screen elements' icon: 

'Show object stacking' icon: 

'To front' icon: 

'To back' icon: 
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3.07 Bitmap and object drawing 

Any design in TactileView contains two layers: one is the underlying bitmap layer, the second contains 
the editable objects, figures and text labels that are placed 'on top' of the bitmap. Both layers will be 
visible on your prints, i.e. objects do not have to be fused in order to be printed. 

Retouching 

You can use the retouching tools (pen and eraser) to draw freehand lines or erase elements in the bitmap. 
Objects and figures are not affected by the retouching tools and need to be fused with the bitmap first to 
(partially) erase them. You can find out more by reading the 'Retouching tools (pen and eraser)' section. 

Fusing objects with the bitmap 

Editable objects can be fused to a bitmap at any time. To fuse an object to the bitmap, select it and then 
choose the 'Fuse with bitmap' icon from the second vertical toolbar at the left side of the screen, or right-
click it and choose 'Fuse with bitmap' from the context menu. You can also use Ctrl+B as a shortcut for 
fusing an object. 

The editing markers (purple and/or red squares around the object) will disappear and the object will turn 
black and no longer be editable. The object is now part of the bitmap layer in your design and can be 
edited with the retouching tools. 

If you accidentally fuse an editable object to the bitmap, you can choose 'Undo' from the Edit menu, press 
Ctrl+Z or click the 'Undo' icon from the tool bar across the top of the screen to undo this action and 
retrieve the editable object. 

Please note that when you apply one of the filters to the entire design, all objects will be fused with the 
bitmap. If you want to avoid any objects from no longer being editable, you can also apply a filter locally 
on a selected area. 

See also: 'Filters; editing an imported image' and 'Selecting area and editing parts of the design' 

Converting a selected area to an object 

Objects that are part of a fused bitmap appear in black, and it is not possible to select them. To convert a 
selected area to an editable object, choose the 'Select area' icon from the left vertical toolbar, or choose 
'Select area' from the Drawing Tools menu. Then click and drag the mouse to select a rectangular area 
around the part of the bitmap you wish to turn into an object. 

Once the area is selected, it will be surrounded by a black dashed rectangle. Right-click anywhere inside 
the selected area and choose 'Convert to figure', or click on the large red marker on one of the sides of the 
selection. The selected area is now converted to a figure, which may be edited in the same way as any 
other figure object (image). 

49 / 226 

TactileView software manual
Visit us at https://thinkable.nl

3.07 Bitmap and object drawing

Any design in TactileView contains two layers: one is the underlying bitmap layer, the second contains
the editable objects, figures and text labels that are placed 'on top' of the bitmap. Both layers will be
visible on your prints, i.e. objects do not have to be fused in order to be printed.

Retouching

You can use the retouching tools (pen and eraser) to draw freehand lines or erase elements in the bitmap.
Objects and figures are not affected by the retouching tools and need to be fused with the bitmap first to
(partially) erase them. You can find out more by reading the 'Retouching tools (pen and eraser)' section.

Fusing objects with the bitmap

Editable objects can be fused to a bitmap at any time. To fuse an object to the bitmap, select it and then
choose the 'Fuse with bitmap' icon from the second vertical toolbar at the left side of the screen, or right-
click it and choose 'Fuse with bitmap' from the context menu. You can also use Ctrl+B as a shortcut for
fusing an object. 

The editing markers (purple and/or red squares around the object) will disappear and the object will turn
black and no longer be editable. The object is now part of the bitmap layer in your design and can be
edited with the retouching tools.

If you accidentally fuse an editable object to the bitmap, you can choose 'Undo' from the Edit menu, press
Ctrl+Z or click the 'Undo' icon from the tool bar across the top of the screen to undo this action and
retrieve the editable object.

Please note that when you apply one of the filters to the entire design, all objects will be fused with the
bitmap. If you want to avoid any objects from no longer being editable, you can also apply a filter locally
on a selected area.

See also: 'Filters; editing an imported image' and 'Selecting area and editing parts of the design'

Converting a selected area to an object

Objects that are part of a fused bitmap appear in black, and it is not possible to select them. To convert a
selected area to an editable object, choose the 'Select area' icon from the left vertical toolbar, or choose
'Select area' from the Drawing Tools menu. Then click and drag the mouse to select a rectangular area
around the part of the bitmap you wish to turn into an object.

Once the area is selected, it will be surrounded by a black dashed rectangle. Right-click anywhere inside
the selected area and choose 'Convert to figure', or click on the large red marker on one of the sides of the
selection. The selected area is now converted to a figure, which may be edited in the same way as any
other figure object (image).

                                 49 / 226



TactileView software manual 
Visit us at https://thinkable.nl 

See also: 'Selecting area and editing parts of the design' 
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See also: 'Selecting area and editing parts of the design'
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4.01 The 7 ways of creating a design 

In TactileView, there are various ways of creating a tactile design, depending on the type of content you 
wish to create. For certain types of designs, specialised modules have been included in the software. 
All 7 methods described below can be combined whenever needed in your designs. 

1. Use premade designs from the TactileView catalog 
The TactileView catalog contains thousands of premade designs, ready to be printed and used. Designers 
have uploaded the tactually usable designs they created. You can search for a particular design that you 
want to use, download it and make modifications needed before you produce them. 
You can visit the TactileView designs catalog by selecting 'Download and edit design from catalog' from 
the Portal menu, or by clicking on the catalog icon in the top menu bar. 

'Download and edit design from TactileView catalog' icon: 1 

2. Convert images from the internet 
On the internet you can fmd an almost endless amount of images, many of which are suitable for 
production as tactile graphics. For some images only a minimum of effort is needed to adapt the image. 
By selecting the right image as a source, such as a line drawing instead of a more complex photo, a 
simple combination of applying filters and minimal use of retouching tools can be sufficient. 
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4.01 The 7 ways of creating a design

In TactileView, there are various ways of creating a tactile design, depending on the type of content you
wish to create. For certain types of designs, specialised modules have been included in the software.
All 7 methods described below can be combined whenever needed in your designs.

1. Use premade designs from the TactileView catalog
The TactileView catalog contains thousands of premade designs, ready to be printed and used. Designers
have uploaded the tactually usable designs they created. You can search for a particular design that you
want to use, download it and make modifications needed before you produce them.
You can visit the TactileView designs catalog by selecting 'Download and edit design from catalog' from
the Portal menu, or by clicking on the catalog icon in the top menu bar.

'Download and edit design from TactileView catalog' icon: 

2. Convert images from the internet
On the internet you can find an almost endless amount of images, many of which are suitable for
production as tactile graphics. For some images only a minimum of effort is needed to adapt the image.
By selecting the right image as a source, such as a line drawing instead of a more complex photo, a
simple combination of applying filters and minimal use of retouching tools can be sufficient.
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C• 

E. 

Figure I. Tactile diagram based on an image found on the Internet. 

3. Convert scanner and webcam images 
Images taken with a webcam or scanner can be used as a source for a tactile graphic. In most cases, the 
images that you scan or photograph will need to be processed for tactile use. By combining the filters and 
retouching tools, colours can be removed and the image converted to a line drawing. In the settings menu 
you can configure the setup for a scanner or webcam for the software. 

`Activate webcaire icon: 

`Quick scan with scanner' icon: 

4. Create a design from scratch 
With the series of drawing tools in the left vertical toolbar, a design can be partially or completely drawn 
from scratch in a blank design. This method often requires a little more effort than the previous three, but 
it gives the most flexibility in case no suitable images are available as a basis for your design. 
Most designs require a combination of different drawing tools. The objects (indicated in blue) for 
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Figure 1. Tactile diagram based on an image found on the internet.

3. Convert scanner and webcam images
Images taken with a webcam or scanner can be used as a source for a tactile graphic. In most cases, the
images that you scan or photograph will need to be processed for tactile use. By combining the filters and
retouching tools, colours can be removed and the image converted to a line drawing. In the settings menu
you can configure the setup for a scanner or webcam for the software.

'Activate webcam' icon: 

'Quick scan with scanner' icon: 

4. Create a design from scratch
With the series of drawing tools in the left vertical toolbar, a design can be partially or completely drawn
from scratch in a blank design. This method often requires a little more effort than the previous three, but
it gives the most flexibility in case no suitable images are available as a basis for your design.
Most designs require a combination of different drawing tools. The objects (indicated in blue) for

                                 52 / 226



TactfieView software menial 
Visit us at tate illth; nkatda.al 

example, give great precision and access to convenient properties such as textures. Text in the correct 
braille table can be added anywhere in the design as clarification. Special symbols can vastly be added 
from the figures library. 

5. Create graph based on an equation 
Graphs are widely used in mathematics and many other subjects, but there are a lot of factors that 
determine the tactile usability of a graph. The mathematics module in TacttleView will help you to vastly 
create a graph based on any given equation. This module can be accessed by selecting the Graphs menu 
a the Graphs icon in the left toolbar. 
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Figure 2. Tactile graph created with the mathematics module in Tactile View 

6. Create tactile maps 
Producing maps of an area of any size (part of a city, region, country a even a continent) can be done 
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example, give great precision and access to convenient properties such as textures. Text in the correct
braille table can be added anywhere in the design as clarification. Special symbols can easily be added
from the figures library.

5. Create graphs based on an equation
Graphs are widely used in mathematics and many other subjects, but there are a lot of factors that
determine the tactile usability of a graph. The mathematics module in TactileView will help you to easily
create a graph based on any given equation. This module can be accessed by selecting the Graphs menu
or the Graphs icon in the left toolbar.

Figure 2. Tactile graph created with the mathematics module in TactileView.

6. Create tactile maps
Producing maps of an area of any size (part of a city, region, country or even a continent) can be done
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with the map maker module in TactileView. Select 'Compose map' from the Portal menu, or click the map 
icon in the top toolbar. 
The maps are composed on the RouteTactile website by selecting the area you wish to include in the map 
or which features (streets, rivers, buildings, etc.) should be included. Keep in mind that including more 
elements will increase the complexity of the map. 

• 

• 

2O6 vt 

• 
• 

• 

Figure 3. Tactile map created with Route Tactile. 

7. Combine text and graphics in one document 
Texts can be included in TactileView documents, but for some purposes it is required to have a document 
where the graphics are part of a text book. The graphics can then be inserted in a braille editor such as 
Duxbury Braille Translator (D131). 
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with the map maker module in TactileView. Select 'Compose map' from the Portal menu, or click the map
icon in the top toolbar.
The maps are composed on the RouteTactile website by selecting the area you wish to include in the map
or which features (streets, rivers, buildings, etc.) should be included. Keep in mind that including more
elements will increase the complexity of the map.

Figure 3. Tactile map created with RouteTactile.

7. Combine text and graphics in one document
Texts can be included in TactileView documents, but for some purposes it is required to have a document
where the graphics are part of a text book. The graphics can then be inserted in a braille editor such as
Duxbury Braille Translator (DBT).

                                 54 / 226



TactileView software manual 
Visit us at https://thinkable.n1 

40; The Duxbury Braille Translator - [Untitled Braille Document 1] - o 

le File Edit View Layout Table Document Global Help UUL 

• 

Current Style: None °Page:2 °Lune:6 °Column:1 111<1 

Figure 4. TactileView design inserted in Duxbury Braille Translator. 
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Figure 4. TactileView design inserted in Duxbury Braille Translator.
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4.02 Creating and opening files 

TactileView off= a number of different ways to begin making great tactile materials. You can create a 
file from scratch or start from a picture on your computer. Or you could get a head start by beginning 
from a pre-installed example file or one of tic thousands of designs available in the online catalog. 

I.Cresifing a new file 

When you open the TactileView &efts...rare, a new, blank document is created automatically. You can 
begin working in this document iminmliately. To open another new file, select 'New' fin tic File menu 
orpress Ctri-I-N. You can also click on tic 'Create a new document' icon in the top horizontal toolbga-. 

Create a new document lean: 

2. Creating a new file by Impm•Wig a picture 

You can create a new document from a picture saved to your computer. To import a picture into 
TactileView, select 'Open' from the File menu or press Ctri+0. In the Open dialog, browse to tic location 
where your picture is stored and select it, tin choose 'Open'. A new TactileView document containing 
the picture is created. 

Open icon: 

3. Opening a pre-installed example file 

A number of example files are installed with tic TactileView software. To open one of these files, select 
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4.02 Creating and opening files

TactileView offers a number of different ways to begin making great tactile materials. You can create a
file from scratch or start from a picture on your computer. Or you could get a head start by beginning
from a pre-installed example file or one of the thousands of designs available in the online catalog.

1.Creating a new file

When you open the TactileView software, a new, blank document is created automatically. You can
begin working in this document immediately. To open another new file, select 'New' from the File menu
or press Ctrl+N. You can also click on the 'Create a new document' icon in the top horizontal toolbar.

Create a new document icon: 

2. Creating a new file by importing a picture

You can create a new document from a picture saved to your computer. To import a picture into
TactileView, select 'Open' from the File menu or press Ctrl+O. In the Open dialog, browse to the location
where your picture is stored and select it, then choose 'Open'. A new TactileView document containing
the picture is created.

Open icon: 

3. Opening a pre-installed example file

A number of example files are installed with the TactileView software. To open one of these files, select
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the 'Open TactileView Examples' option fin tic File menu. A dialog box will appear with a list of 
available sample files. Select a file from the list, then choose the 'Open' button to open it in TactileView. 

Open TactileView e:camples icon: 

4. Downloading and opening a file from the online catalog 

To download an existing file from the entry catalog, open the Portal menu and choose 'Download and 
Edit Design from Catalog'. This will launch a new window that will allow you to browse available files 
by category or aeamh for something specific using tic search field. Browsing by category is 
recommended for best results because of tic variety of languages used for file titles and keywords. 

Once you've chosen a category, select a design and choose the 'Closer Look' link (green arrow button) 
beneath it. This will launch a web browser window with a largerpreview of tic image in tic file. Select 
the 'Download & Edit' link. 

A dialog will pop up asking if you want to open or save the file. Select 'Open'. 

NOTE: 
If this is the first time you are downloading a file fin the TactileView catalog. Windows may open a 
dialog box asking what application to use to open the .bpx file. Choose the option that allows you to 
browse your computer for the desired application, and browse to CAProgram 
Files1TactileViewITactileV.exe on a 32-bit operating system or C: \Program Files 
(x86)1TactileViewITactileVexe on a 64-bit operating system. If there is a checkbox available to always 
use this program to open this type of file, make sure it is checked, tin select the 'OK' button. 

The file will now open in TactileView. 

Download and alit design from Tadileflew Catalog icon: 19
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the 'Open TactileView Examples' option from the File menu. A dialog box will appear with a list of
available sample files. Select a file from the list, then choose the 'Open' button to open it in TactileView.

Open TactileView examples icon: 

4. Downloading and opening a file from the online catalog

To download an existing file from the online catalog, open the Portal menu and choose 'Download and
Edit Design from Catalog'. This will launch a new window that will allow you to browse available files
by category or search for something specific using the search field. Browsing by category is
recommended for best results because of the variety of languages used for file titles and keywords.

Once you’ve chosen a category, select a design and choose the 'Closer Look' link (green arrow button)
beneath it. This will launch a web browser window with a larger preview of the image in the file. Select
the 'Download & Edit' link.

A dialog will pop up asking if you want to open or save the file. Select 'Open'.

NOTE:
If this is the first time you are downloading a file from the TactileView catalog, Windows may open a
dialog box asking what application to use to open the .bpx file. Choose the option that allows you to
browse your computer for the desired application, and browse to C:\Program
Files\TactileView\TactileV.exe on a 32-bit operating system or C:\Program Files
(x86)\TactileView\TactileV.exe on a 64-bit operating system. If there is a checkbox available to always
use this program to open this type of file, make sure it is checked, then select the 'OK' button.

The file will now open in TactileView.

Download and edit design from TactileView Catalog icon: 
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4.03 Importing images from the Internet 

Images from the internet often form a great source for a tactile image. The amount of different subjects 
that can be portrayed is virtually endless. However, selecting the right material from this vast resource 
can both improve the tactile quality and TrlinirrliZe the effort needed to convert the image into a tactile 
diagram. 

Understanding which image works best 

Virtually any image can be used as abasis for a tactile diagram, but some are more suitable than others. 
For example, some images are harder to understand when they converted to a tactile image. In general, a 
higher level of detail will result in a more difficult tactile diagram. Concepts such as shadows or three-
dimensional perspective can be very hard to understand for a blind reader. 

The second consideration is the amount of effort it takes to convert the image to a tactually usable design. 
Of course it depends greatly on the type of contents you wish to include in the image, but generally 'less 
is more': a simpler image takes less time to convert than a more detailed one. 

An image needs to have enough features that can be understood by touch. This means that images often 
need to be simplified by isolating individual lines from the In most cases, line images are preferred as a 
basis for a design. 
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Figure I. The image on the right has less fine detail and is less complex, making a tactile version easier 
to read and taking less effon to edit than the image on the left 

Make clever use Google image search 

Using Google, you can search for images that match any keywords that you enter. In most cases this will 
give thousands of results, so in many cases you will need to refine your search criteria. You could try 
searching for a synonym or closely related word (e.g. 'trete or 'woods' instead of 'forest"). If you speak 
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4.03 Importing images from the internet

Images from the internet often form a great source for a tactile image. The amount of different subjects
that can be portrayed is virtually endless. However, selecting the right material from this vast resource
can both improve the tactile quality and minimize the effort needed to convert the image into a tactile
diagram.

Understanding which image works best

Virtually any image can be used as a basis for a tactile diagram, but some are more suitable than others.
For example, some images are harder to understand when they converted to a tactile image. In general, a
higher level of detail will result in a more difficult tactile diagram. Concepts such as shadows or three-
dimensional perspective can be very hard to understand for a blind reader.

The second consideration is the amount of effort it takes to convert the image to a tactually usable design.
Of course it depends greatly on the type of contents you wish to include in the image, but generally 'less
is more': a simpler image takes less time to convert than a more detailed one.

An image needs to have enough features that can be understood by touch. This means that images often
need to be simplified by isolating individual lines from the In most cases, line images are preferred as a
basis for a design.

Figure 1. The image on the right has less fine detail and is less complex, making a tactile version easier
to read and taking less effort to edit than the image on the left.

Make clever use Google image search

Using Google, you can search for images that match any keywords that you enter. In most cases this will
give thousands of results, so in many cases you will need to refine your search criteria. You could try
searching for a synonym or closely related word (e.g. 'trees' or 'woods' instead of 'forest'). If you speak
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multiple languages it can be helpful to search for the same concept in another language. 

Google also provides some tools to refine the type of image you are looking for. You can find these by 
clicking on the 'Search tools' button. These allow you to make some useful selections for finding the right 
material for tactile use. The most important selections for tactile use are: 

- Size: larger images are generally better than smaller images, since they provide a better image quality in 
which more detail is retained when enlarged. You can also select 'Show sizes' under 'More tools' to get a 
quick overview of the image sizes. 

- Type: refine the type of images that are presented. tine drawing' or 'Clip art' both are highly suitable as 
a basis fora tactile image, as they are often already simplified into individual lines and will be closer to 
what is required for a tactile image. We always advise to check first if these types of images are available 
to minimize the amount of effort it takes to create a tactile image. 

The other search tools, such as colour and time can be used to further refine your search results. 
Appropriate usage rights can be selected if it concerns reproduction. 

4 

1 

• 

Figure 2. By making use of the Search Tools, you can select line drawings (right) instead of more 
complicated images, such as the photo on the left; the line drawing is much easier to read and edit. 

Placing the image in your TactileView design 

Once you have found a suitable image, right click on it to open the context menu, then select 'Copy 
image'. This will copy the image onto your clipboard. In TactileView, press Ctri+V to paste the image in 
your design. This willplace the image in the design area at the position of you mouse. You can also right 
click in an empty area of the design, then select Taste' to place the image on the position of the click. Or 
you can select Taste' from the Edit menu or click the Taste' icon in the top horizontal toolbar, which will 
place the image in the top left corner of the design. 
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multiple languages it can be helpful to search for the same concept in another language.

Google also provides some tools to refine the type of image you are looking for. You can find these by
clicking on the 'Search tools' button. These allow you to make some useful selections for finding the right
material for tactile use. The most important selections for tactile use are:

- Size: larger images are generally better than smaller images, since they provide a better image quality in
which more detail is retained when enlarged. You can also select 'Show sizes' under 'More tools' to get a
quick overview of the image sizes.

- Type: refine the type of images that are presented. 'Line drawing' or 'Clip art' both are highly suitable as
a basis for a tactile image, as they are often already simplified into individual lines and will be closer to
what is required for a tactile image. We always advise to check first if these types of images are available
to minimize the amount of effort it takes to create a tactile image.

The other search tools, such as colour and time can be used to further refine your search results.
Appropriate usage rights can be selected if it concerns reproduction.

Figure 2. By making use of the Search Tools, you can select line drawings (right) instead of more
complicated images, such as the photo on the left; the line drawing is much easier to read and edit.

Placing the image in your TactileView design

Once you have found a suitable image, right click on it to open the context menu, then select 'Copy
image'. This will copy the image onto your clipboard. In TactileView, press Ctrl+V to paste the image in
your design. This will place the image in the design area at the position of you mouse. You can also right
click in an empty area of the design, then select 'Paste' to place the image on the position of the click. Or
you can select 'Paste' from the Edit menu or click the 'Paste' icon in the top horizontal toolbar, which will
place the image in the top left corner of the design.
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If you have saved an image on your computer, you can choose 'Import' from the drawing tools loon bar, 
then select 'Import SVG' for svg images or 'Import image from file for bitmap image (jpg, ./mg ...) or 
select 'Import image from file from the File menu. Next, click in the design where you wish to insert the 
image. 

You can always =size or move the image to the required position in the design. Use the retouching tools 
(pen sad eraser), a combination of the filters from the drawing tools toolbar or the Filters menu, or any of 
the other drawing tools to make the required actustments to make the inserted image suitable for tactile 
use. 

Open link in new tab 

Open link in new window 

Open link in incognito window 

Save link as... 

Copy link address 

Save image as... 

Copy image URL 

Copy image 

Open image in new tab 

Search Google for this image 

Print... 

cl) AdBlock 

Block element 

Ctrl+P 

Inspect element Ctrl+Shift+1 

Figure 3. Ccocing the image from yourwelt browser. 
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If you have saved an image on your computer, you can choose 'Import' from the drawing tools icon bar,
then select 'Import SVG' for svg images or 'Import image from file' for bitmap image (.jpg, .png, ...), or
select 'Import image from file' from the File menu. Next, click in the design where you wish to insert the
image.

You can always resize or move the image to the required position in the design. Use the retouching tools
(pen and eraser), a combination of the filters from the drawing tools toolbar or the Filters menu, or any of
the other drawing tools to make the required adjustments to make the inserted image suitable for tactile
use.

Figure 3. Copying the image from your web browser.
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4.04 Importing images from file (Avg, .png, .jpg, ...) 

Saved images can be used as a basis for your tactile designs. These can be bitmap images (.bmp, .png, 
in etc.) or SVG images. There are two ways to insert these files into your design. 

Import image from file 

To import a bitmap or SVG image file, select 'Import' from the drawing tools toolbar, en choose 'Import 
SVG' or 'Import image from filer from tic context toolbar. A dialog will open in which you can browse 
;sixd select the image file that you wish to use. Select image files' ca- ravg files' as the type of file to limit 
the presented files to images suitable for importing. °MC you have selected the correct image, click 
'Open' to insert the image into your dtaign. Next, click in the design to position the image. 

riTiT'Import' .wan:  • 

'Import SYG' ianv 

'Import kictge from fde icon: IPHG

Copy from Windows File Explorer 
In Windows File Explorer, select the image file that you wish to insert in your design. Right click on the 
file and select 'Copy', or use tic aNntcut Ctri+C. In TactileView, position the mouse where you want to 
insert the file and press to paste tic image. Alternatively, you can also select 'Plaster from tic Edit 
menu, the top harizontal toolbar or by opening the context menu by right clicking in the design and 
selecting 'Paste'. 

'Pete' icon: 
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4.04 Importing images from file (.svg, .png, .jpg, ...)

Saved images can be used as a basis for your tactile designs. These can be bitmap images (.bmp, .png,
.jpg, etc.) or SVG images. There are two ways to insert these files into your design.

Import image from file

To import a bitmap or SVG image file, select 'Import' from the drawing tools toolbar, then choose 'Import
SVG' or 'Import image from file' from the context toolbar. A dialog will open in which you can browse
and select the image file that you wish to use. Select 'image files' or 'svg files' as the type of file to limit
the presented files to images suitable for importing. Once you have selected the correct image, click
'Open' to insert the image into your design. Next, click in the design to position the image.

'Import' icon: 

'Import SVG' icon: 

'Import image from file' icon: 

Copy from Windows File Explorer
In Windows File Explorer, select the image file that you wish to insert in your design. Right click on the
file and select 'Copy', or use the shortcut Ctrl+C. In TactileView, position the mouse where you want to
insert the file and press Ctrl+V to paste the image. Alternatively, you can also select 'Paste' from the Edit
menu, the top horizontal toolbar or by opening the context menu by right clicking in the design and
selecting 'Paste'.

'Paste' icon: 
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4.05 Capture scanner or webcam image 

Using a scanner or a webcam offers a flexible method to quickly import existing material you're your 
design. Both methods create a bitmap image that will need some processing to turn it into a tactile usable 
design. 

Settings menu — Scanner and Webcam 

Make sure the devices are configured in the settings menu dialogs 'Webcam' and 'Scanner'. A message 
will indicate when your device is not connected or configured when you try to start it. 

Scanner 

The scanner will create an image (bitmap) of the scanned document. This way, you can use existing 
images from text books or documents as a basis for your tactile graphics. 

'Quick scan with scanner' icon: 

Webcam 

The video content from the selected webcam is displayed in a small window beside the drawing area. The 
control buttons are available below this window. You can adjust the size of the webcam window by 
clicking 'Enlarge/reduce the webcam view'. Pressing the shutter button of the webcam ('Take webcam 
snapshot') will record a snapshot image. You can rotate the webcam image if necessary by clicking 
'Rotate the webcam view', and shut the webcam window down with 'Deactivate webcam'. 

Existing document or new document 

Once you have recorded your scanner or webcam image, you will be asked whether you want to add it to 
the existing design or insert it in a newly created design. The image will be placed in the top left corner of 
your design. As the image is inserted as a figure, the size and position of the image can be adjusted . 

Further processing 

As with all other images (copied from internet or imported from file) further processing is usually 
required. 
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4.05 Capture scanner or webcam image

Using a scanner or a webcam offers a flexible method to quickly import existing material you’re your
design. Both methods create a bitmap image that will need some processing to turn it into a tactile usable
design.

Settings menu – Scanner and Webcam

Make sure the devices are configured in the settings menu dialogs 'Webcam' and 'Scanner'. A message
will indicate when your device is not connected or configured when you try to start it.

Scanner

The scanner will create an image (bitmap) of the scanned document. This way, you can use existing
images from text books or documents as a basis for your tactile graphics.

'Quick scan with scanner' icon: 

Webcam

The video content from the selected webcam is displayed in a small window beside the drawing area. The
control buttons are available below this window. You can adjust the size of the webcam window by
clicking 'Enlarge/reduce the webcam view'. Pressing the shutter button of the webcam ('Take webcam
snapshot') will record a snapshot image. You can rotate the webcam image if necessary by clicking
'Rotate the webcam view', and shut the webcam window down with 'Deactivate webcam'.

Existing document or new document

Once you have recorded your scanner or webcam image, you will be asked whether you want to add it to
the existing design or insert it in a newly created design. The image will be placed in the top left corner of
your design. As the image is inserted as a figure, the size and position of the image can be adjusted .

Further processing

As with all other images (copied from internet or imported from file) further processing is usually
required.
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- Retouching (pen and eraser): fusing the image with the design bitmap allows you to refine parts of the 
image. 
- Apply filters: colours have to be removed and the image usually has to be converted to a line drawing. 
- Use text labels: add a title and other text labels to clarify the different parts of the image 

For a full description of the respective tools, see also the section 'Drawing tools toolbar. 

'Activate webcam' icon: 

TactileView - TactileViewl 

tile Design Edit View Filters portal Graphs Drawing Tools Window settings Help 
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Figure 1. A separate window shows the webcam is activated for capturing images; click on the image to 
enlarge. 

Figure 2. Webcam controls: 'Enlarge webcam view, 'Take webcam snapshot, 'Rotate webcam view' and 
'Deactivate webcam'. 
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- Retouching (pen and eraser): fusing the image with the design bitmap allows you to refine parts of the
image.
- Apply filters: colours have to be removed and the image usually has to be converted to a line drawing.
- Use text labels: add a title and other text labels to clarify the different parts of the image

For a full description of the respective tools, see also the section 'Drawing tools toolbar'.

'Activate webcam' icon: 

Figure 1. A separate window shows the webcam is activated for capturing images; click on the image to
enlarge.

Figure 2. Webcam controls: 'Enlarge webcam view', 'Take webcam snapshot', 'Rotate webcam view' and
'Deactivate webcam'.
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5.01 Layout tools 

In TactileView, several tools are available to facilitate a precise design process and cope with regulations 
and conventions that specify the layout of a tactile diagram. 

Right-up marker 
Once the design is printed and in tic hands of the reader, the right-up marker is twine marker in tic top 
right corner. This right-up marker helps to find the correct orientation of the diagram without having to 
explore the tactile diagram itself. This way you can easily find out if the design should be read in a 
portrait or landscape orientation. 

When the marker is presented in blue on semen, it will be printed. By clicking on the red marker in the 
top right corner of the screen, the right-up marker can be selected or =selected. Alternatively, you can 
select Thaw right-up marker' fin tic design toolbar (right vertical toolbar win nothing is selected) or 
the design context menu. 

Figure I. The right-up marker ws shown on screen. 

Draw right-up marker' icon: 

Alignment grids 

TactileView provides two alignment grids that make it easier to get the right layout in your document. 
The braille grid allows you to align text labels in a fixed grid throughout the design, whereas the 
measurements grid is used to visualise the dimensions in your document to align objects. The grids are 
allown in green on screen and will not be printed. You can arable or disable these grids in the second 
vertical toolbar. This option can also be found in the View menu. 

See: lagamcalguelsbaalksnrianimasuminc ' 

66 / 2245 

TactileView software manual
Visit us at https://thinkable.nl

5.01 Layout tools

In TactileView, several tools are available to facilitate a precise design process and cope with regulations
and conventions that specify the layout of a tactile diagram.

Right-up marker
Once the design is printed and in the hands of the reader, the right-up marker is tactile marker in the top
right corner. This right-up marker helps to find the correct orientation of the diagram without having to
explore the tactile diagram itself. This way you can easily find out if the design should be read in a
portrait or landscape orientation.

When the marker is presented in blue on screen, it will be printed. By clicking on the red marker in the
top right corner of the screen, the right-up marker can be selected or unselected. Alternatively, you can
select 'Draw right-up marker' from the design toolbar (right vertical toolbar when nothing is selected) or
the design context menu.

Figure 1. The right-up marker as shown on screen.

'Draw right-up marker' icon: 

Alignment grids

TactileView provides two alignment grids that make it easier to get the right layout in your document.
The braille grid allows you to align text labels in a fixed grid throughout the design, whereas the
measurements grid is used to visualise the dimensions in your document to align objects. The grids are
shown in green on screen and will not be printed. You can enable or disable these grids in the second
vertical toolbar. This option can also be found in the View menu.

See: Alignment grids - braille grid and measurements grid.

                                 66 / 226



TactileVIew software naval 
Visit os et bnosrilibinivoio nl

Figure 2. A section cf the mecaurements grid (left) and measurements grid 

Screen elements' icon: 

Show grid' grid' icon: 

Dot view f line view mode 
The graphic capabilities for tactile images differ for each individual production medium. Use the 'Design 
mode dot view/line view' to control the layout for the differentprim outputs. 

See: Design mode: dot view/line view. 

Text label alignment 
For racurateplacement of texts in your tactile graphics, text labels can be aligned horizontally or 
vertically with other labels in the design. You can select 'Switch text label alignment onfoff from the 
properties toolbar ofa selected text label, or when placing a new label in the design. 

As long as the alignment function is on, green 'magnetic' dotted lines will appear when moving a text 
label close to the horizontal or vertical position of another label in the design. The ten label on which the 
moved label will be aligned will be highlighted. When you let go at this position, the moved label will 
automatically 'snap' to this alignment. The same applies to placing a new text label in your design. Please 
note that aligned text labels are not 'connected' but can still be moved and edited separately. 
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Figure 2. A section of the measurements grid (left) and measurements grid.

'Screen elements' icon: 

'Show grid' icon: 

Dot view / line view mode
The graphic capabilities for tactile images differ for each individual production medium. Use the 'Design
mode: dot view/line view' to control the layout for the different print outputs.

See: Design mode: dot view/line view.

Text label alignment
For accurate placement of texts in your tactile graphics, text labels can be aligned horizontally or
vertically with other labels in the design. You can select 'Switch text label alignment on/off' from the
properties toolbar of a selected text label, or when placing a new label in the design.

As long as the alignment function is on, green 'magnetic' dotted lines will appear when moving a text
label close to the horizontal or vertical position of another label in the design. The text label on which the
moved label will be aligned will be highlighted. When you let go at this position, the moved label will
automatically 'snap' to this alignment. The same applies to placing a new text label in your design. Please
note that aligned text labels are not 'connected' but can still be moved and edited separately.

                                 67 / 226



TactileView software mane 
Visit es at kilos

 I' •
i4C 

it • t •   • • 
• a • 

—I 

Figure 3. Tea label alignment with green dutted lines. 

Centre object or text label 
All objects in the toolbar tool have a tuntre' option in their properties toolbar. With this option the 
object will move to the centre position of the paper. Win the paper width is changed, the object will no 
longer be centred. 

See: Editing object properties. 

Venire' km: 

Only move horizontally, vertically or diagsmally 
By holding the Shift key and dragging a selected object or textlabel, the movement will only be in a 
perfectly horizontal, vertical or diagonal direction. This can also be switched on or off permanently by 
selecting 'Restrict to horizontal, vertical and diagonal movement' from the properties toolbar or context 
menu of the object or label. 

See: Editing object properties. 
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Figure 3. Text label alignment with green dotted lines.

Centre object or text label
All objects in the toolbar tool have a ‘Centre’ option in their properties toolbar. With this option the
object will move to the centre position of the paper. When the paper width is changed, the object will no
longer be centred.

See: Editing object properties.

'Centre' icon: 

Only move horizontally, vertically or diagonally
By holding the Shift key and dragging a selected object or textlabel, the movement will only be in a
perfectly horizontal, vertical or diagonal direction. This can also be switched on or off permanently by
selecting 'Restrict to horizontal, vertical and diagonal movement' from the properties toolbar or context
menu of the object or label.

See: Editing object properties.
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Restrict to horizontal, vertical or diagonal movement' icon: '-

69 / 226 

TactileView software manual
Visit us at https://thinkable.nl

'Restrict to horizontal, vertical or diagonal movement' icon: 
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5.02 Portrait or landscape design 

For tactile graphics, the image size has a big influence on tactile usability. TactileView provides several 
options to control both design and paper size for optimal tactile quality. 

Multiple sheets of paper 
The maximum size of paper thatprinters generally can handle is A4, A3, US Letter or Tabloid. However, 
diagrams can be larger than the maximum paper size when an image needs to be enlarged to retain the 
level of detail in the original image. Multiple sheets can be placed in rows and or columns to allow for 
tactile diagrams of any large size. The red paper border will indicate the size of the design and the number 
of sheets. 

See also: Paper size vs. design size. 

Amount of details in a tactile diagram 
On one hand, the level of detail that can be presented in a tactile graphic is limited due the discriminatory 
capabilities of the fingertips. On the other hand, the relatively large size ofbraille dots and the minimal 
required distance in between dots also limit how much detail can be included. 

The larger the design therefore, the more detail can be retained when printed with an embosser. This will 
help to control the complexity of the designs. 
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5.02 Portrait or landscape design

For tactile graphics, the image size has a big influence on tactile usability. TactileView provides several
options to control both design and paper size for optimal tactile quality.

Multiple sheets of paper
The maximum size of paper that printers generally can handle is A4, A3, US Letter or Tabloid. However,
diagrams can be larger than the maximum paper size when an image needs to be enlarged to retain the
level of detail in the original image. Multiple sheets can be placed in rows and or columns to allow for
tactile diagrams of any large size. The red paper border will indicate the size of the design and the number
of sheets.

See also: Paper size vs. design size.

Amount of details in a tactile diagram
On one hand, the level of detail that can be presented in a tactile graphic is limited due the discriminatory
capabilities of the fingertips. On the other hand, the relatively large size of braille dots and the minimal
required distance in between dots also limit how much detail can be included.

The larger the design therefore, the more detail can be retained when printed with an embosser. This will
help to control the complexity of the designs.
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Figure I. This image shows the shape of a fern branch, but might not contain sufficient tactile detail in 
the leaves. A separate image could be used to display leaf details. 

Images as large as possible 
Although there is a limitation to the size of an image, it is best practice to use as much of the paper as 
possible. Matching the design orientation to the dimensions of the tactile graphic (i.e. using landscape for 
wide images and portrait for higher ones) allows for optimal positioning on the paper. Rotating from 
landscape to portrait or vice versa may give a 30% larger image, which greatly improves the tactile 
usability. 

:Ei f f el tower 

DOD 

:Ei ffel tower 

Figure 2. By choosing the right orientation, the image can be shown larger, maintaining more detail. 

When changing the design orientation, the image will not be scaled. this way, the size and position of the 
elements in your design will not change and details will not be lost. However, the design will 
automatically be extended with extra white space or trimmed of excess empty white space in order to fit 
the new paper orientation. 

It is best to think about the optimal size of the tactile diagram before starting the design: a higher level of 
detail will require a larger design size. Adjustments in size can always be made later by scaling the design 
with the purple markers around the edge. However, text labels have a fixed size. By scaling the image 
they might overlap the image or may end up too far from the elements in the drawing that they refer to. 
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Figure 1. This image shows the shape of a fern branch, but might not contain sufficient tactile detail in
the leaves. A separate image could be used to display leaf details.

Images as large as possible
Although there is a limitation to the size of an image, it is best practice to use as much of the paper as
possible. Matching the design orientation to the dimensions of the tactile graphic (i.e. using landscape for
wide images and portrait for higher ones) allows for optimal positioning on the paper. Rotating from
landscape to portrait or vice versa may give a 30% larger image, which greatly improves the tactile
usability.

Figure 2. By choosing the right orientation, the image can be shown larger, maintaining more detail.

When changing the design orientation, the image will not be scaled. This way, the size and position of the
elements in your design will not change and details will not be lost. However, the design will
automatically be extended with extra white space or trimmed of excess empty white space in order to fit
the new paper orientation.

It is best to think about the optimal size of the tactile diagram before starting the design: a higher level of
detail will require a larger design size. Adjustments in size can always be made later by scaling the design
with the purple markers around the edge. However, text labels have a fixed size. By scaling the image
they might overlap the image or may end up too far from the elements in the drawing that they refer to.

                                 71 / 226



TactileView software weal 
Visit es in Incs.ilthinkshiani 

5.03 Changing design orientation and size 

In TactileView, the 'design size' refers to the size of the tactile graphic, represented on screen by tic white 
area. Tic design size can be the size of a full sheet of paper, but can also be extended to span multiple 
pages; seec Paper size vs. design size. 

Chsuiging design Sae 

By deficit, when you open a new document, the design will have the same size as a full sheet of palcr. 
When you wish to add or remove white space to your design, you can drag the purple markers along the 
four sides of the design. Notice that this does not scale the contents of the design but only extends or 
narrows it. 

I 
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L 

.Figure I. Thug the pwple marken to enla7ge or reduce the design size 
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5.03 Changing design orientation and size

In TactileView, the 'design size' refers to the size of the tactile graphic, represented on screen by the white
area. The design size can be the size of a full sheet of paper, but can also be extended to span multiple
pages; see: Paper size vs. design size.

Changing design size

By default, when you open a new document, the design will have the same size as a full sheet of paper.
When you wish to add or remove white space to your design, you can drag the purple markers along the
four sides of the design. Notice that this does not scale the contents of the design but only extends or
narrows it.

Figure 1. Drag the purple markers to enlarge or reduce the design size.
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Resisizig the design 

The blue mewls/ in the bottom right comer can be used to scale the entire design, i.e. enlarge or reduce 
the design size aixi all elements. This will change the resolution of the design. Braille characters have a 
fixed size, so test labels will not be scaled. Keep in mind that text labels might start to overlap with other 
elements in the design. 

• 
QI

Figure 2. Drug the blue marker in the Ituttan; right corner to saile the design. 

Change page orientation 

The page orientation can be changed at any time to suit the dimensions of the design. The position and 
size of the image contents will mot change, but the edges of the white area will be adapted automatically 
to fit the design to one or more full pages in the new page orientation. You can change the page 
orientation in several ways select 'Change the orientation to landscaptiportraif fi-om the toolbar of the 
design (right vertical toolbar when nothing is selected), from the 'Page formatting toolbar in the second 
horizontal toolbar, or from the Design menu. 
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Resizing the design

The blue marker in the bottom right corner can be used to scale the entire design, i.e. enlarge or reduce
the design size and all elements. This will change the resolution of the design. Braille characters have a
fixed size, so text labels will not be scaled. Keep in mind that text labels might start to overlap with other
elements in the design.

Figure 2. Drag the blue marker in the bottom right corner to scale the design.

Change page orientation

The page orientation can be changed at any time to suit the dimensions of the design. The position and
size of the image contents will not change, but the edges of the white area will be adapted automatically
to fit the design to one or more full pages in the new page orientation. You can change the page
orientation in several ways: select 'Change the orientation to landscape/portrait' from the toolbar of the
design (right vertical toolbar when nothing is selected), from the 'Page formatting' toolbar in the second
horizontal toolbar, or from the Design menu.
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Pageformatting' icon: A• 

'Change the orientation to landscape' icon: 

'Change the orientation to portrait' icon; (W 

If the image contents fits within a single sheet of paper in the new page orientation, the excess white 
space will be trimmed in one direction, and added in the other. For example, when changing from portrait 
to landscape format, the white space on the bottom of the page will be trimmed and the design is 
widened. This change in page orientation is always reversible later on. 

Change 
page 
orientation 

�v��

White 
space 
added 

�v��

White space 
trimmed 

Original design size 

Figure I. The contents will fit on a single sheet (red border) after changing the page orientation,- the 
white space at the bottom will be trimmed the right side will be extended 

If on the other hand the original design would not fit within a single page in the new orientation, the 
design is automatically extended in both directions to fit on two pages. This change is also reversible. 
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'Page formatting' icon: 

'Change the orientation to landscape' icon: 

'Change the orientation to portrait' icon: 

If the image contents fits within a single sheet of paper in the new page orientation, the excess white
space will be trimmed in one direction, and added in the other. For example, when changing from portrait
to landscape format, the white space on the bottom of the page will be trimmed and the design is
widened. This change in page orientation is always reversible later on.

Figure 1. The contents will fit on a single sheet (red border) after changing the page orientation; the
white space at the bottom will be trimmed, the right side will be extended.

If on the other hand the original design would not fit within a single page in the new orientation, the
design is automatically extended in both directions to fit on two pages. This change is also reversible.
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Figure 2. The contents of the design )W11 only fit on two pages (red borders); the white space ate the 
bottom and right side )W11 be extended to fit the design across both pages. 

75 1226 

TactileView software manual
Visit us at https://thinkable.nl

Figure 2. The contents of the design will only fit on two pages (red borders); the white space ate the
bottom and right side will be extended to fit the design across both pages.

                                 75 / 226



TattleView software manual 
Visit DO at httpa:ilthintrable.ta 

5.04 Paper size vs. design size 

The maximum paper size thatprinters generally can handle is A4, A3, US Letter or Tabloid However, 
diagrams can be larger than the maximum paper size when an image needs to be enlarged to retain the 
level of detail in the original image. Multiple sheets can be placed in rows and or columns to allow for 
tactile diagrams of any large size. 

In your designs, the red paper border will indicate the size of the design and the number of sheets. 
Drag the purple markers on the edges of the design to add or remove white space in order to use more 
surface area for your design. Note that this only adds or removes a strip along the edge of the design, but 
does nut scale (enlarge or reduce) the design contents in this direction. The blue marker in the 
bottom right corner can be used to scale the entire design. 
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Figure 1. The map is printed across two sheets of paper side to side in order to include sufficient detail. 

By resizing the design, adding/removing space within the design or changing the paper orientation, it 
might become wider or higher than a full sheet of paper (i.e. the white space extends beyond the red 
border of the paper). If this excess strip does not contain design contents, it will be trimmed automatically 
when the file is printed. Hon the other hand the design is smaller than a full page (i.e. does nut reach 
completely to the red border), the page will be filled out by adding white space. 
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5.04 Paper size vs. design size

The maximum paper size that printers generally can handle is A4, A3, US Letter or Tabloid. However,
diagrams can be larger than the maximum paper size when an image needs to be enlarged to retain the
level of detail in the original image. Multiple sheets can be placed in rows and or columns to allow for
tactile diagrams of any large size.

In your designs, the red paper border will indicate the size of the design and the number of sheets.
Drag the purple markers on the edges of the design to add or remove white space in order to use more
surface area for your design. Note that this only adds or removes a strip along the edge of the design, but
does not scale (enlarge or reduce) the design contents in this direction. The blue marker in the
bottom right corner can be used to scale the entire design.

Figure 1. The map is printed across two sheets of paper side to side in order to include sufficient detail.

By resizing the design, adding/removing space within the design or changing the paper orientation, it
might become wider or higher than a full sheet of paper (i.e. the white space extends beyond the red
border of the paper). If this excess strip does not contain design contents, it will be trimmed automatically
when the file is printed. If on the other hand the design is smaller than a full page (i.e. does not reach
completely to the red border), the page will be filled out by adding white space.
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5.05 Alignment frame and grids 

The two alignment grids combined with the alignment frame are useful tools on screen that help to 
manage the layout of your design by aligning the text labels and/or drawn elements. The braille grid is 
primarily used to align text labels in a regular grid and conform to certain layout guidelines, whereas the 
measurem&nts yid is mostly used to align objects and visualize their size. The grids are shown in a light 
green colour on screen, but will not be printed or embossed. 

For more details, see' Meassumentsgridholtesialignmene and Braille grid (textalignment), 

Measurements grid 

6 

6 

8 

9 

26 

Braille grid 

Figure 1. Example: measurements grid without alignment frame on the right, 

The settings dialog for both grids can be accessed by clicking on the light green marker on the right hand 
side of the braille grid between text lines 2 and 3, or via menu Settings > Alignment grids. 

You can easily switch between the two grids by clicking on either of the grid icons in the second 
horizontal toolbar. Alternatively you can select 'Show braille grid or 'Show measurements grid' from the 
View menu or select a grid via the Alignment grids settings dialog. You can switch grids off by clicking 
once more on the currently active grid or deselect it via the View menu or in the grids settings dialog. 
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5.05 Alignment frame and grids

The two alignment grids combined with the alignment frame are useful tools on screen that help to
manage the layout of your design by aligning the text labels and/or drawn elements. The braille grid is
primarily used to align text labels in a regular grid and conform to certain layout guidelines, whereas the 
measurements grid is mostly used to align objects and visualize their size. The grids are shown in a light
green colour on screen, but will not be printed or embossed.

For more details, see: Measurements grid (object alignment) and Braille grid (text alignment).

Figure 1. Example: measurements grid without alignment frame on the right, 

The settings dialog for both grids can be accessed by clicking on the light green marker on the right hand
side of the braille grid between text lines 2 and 3, or via menu Settings > Alignment grids.

You can easily switch between the two grids by clicking on either of the grid icons in the second
horizontal toolbar. Alternatively you can select 'Show braille grid' or 'Show measurements grid' from the
View menu or select a grid via the Alignment grids settings dialog. You can switch grids off by clicking
once more on the currently active grid or deselect it via the View menu or in the grids settings dialog.

                                 77 / 226



TactileView software manual 
Visit us at https://thinkable.nl 

Alignment frame 

The alignment frame is a layout tool that can be used as a guide to limit the design to a specified area 
within the printable area of a page. This is presented in the design with a dashed red border, but will not 
be printed. 

The width and height of the frame are limited to a whole number of braille characters and lines of braille 
text, respectively. You can adjust the top and left margin of the frame by dragging the four green markers 
that are placed along the top and left side of the design. Alternatively, you can enter the values for the 
frame size by opening the 'Alignment frame and grids' settings dialog via the green marker on the right-
hand side of the design or via menu Settings. 

When the alignment frame is enabled, a selected alignment grid will only be shown within the area of the 
frame. Text labels will then be automatically adjusted in width to fit within the frame. 

Saving grid and frame settings as default 

The alignment frame and grids are very useful to create consistent page formatting between different 
designs. In the settings dialog, you can therefore save the current grid and frame settings as default values 
by choosing 'Save as default settings'. This ensures the same frame and grid size are used as the basis for 
all new documents. 

These settings are also saved in the document. This way, when you wish to edit the design later on, the 
margins and grid size still match the design, even when the default grid properties for new documents 
might have changed. 
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Alignment frame

The alignment frame is a layout tool that can be used as a guide to limit the design to a specified area
within the printable area of a page. This is presented in the design with a dashed red border, but will not
be printed.

The width and height of the frame are limited to a whole number of braille characters and lines of braille
text, respectively. You can adjust the top and left margin of the frame by dragging the four green markers
that are placed along the top and left side of the design. Alternatively, you can enter the values for the
frame size by opening the 'Alignment frame and grids' settings dialog via the green marker on the right-
hand side of the design or via menu Settings.

When the alignment frame is enabled, a selected alignment grid will only be shown within the area of the
frame. Text labels will then be automatically adjusted in width to fit within the frame.

Saving grid and frame settings as default

The alignment frame and grids are very useful to create consistent page formatting between different
designs. In the settings dialog, you can therefore save the current grid and frame settings as default values
by choosing 'Save as default settings'. This ensures the same frame and grid size are used as the basis for
all new documents.

These settings are also saved in the document. This way, when you wish to edit the design later on, the
margins and grid size still match the design, even when the default grid properties for new documents
might have changed.
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5.06 Measurements grid (object alignment) 

The measurements grid is composed of a regular grid of squares that visualize the physical dimensions of 
your design. This can be used for tic alignment of objects in your design. 

For a comparison with the braille grid, see iiligamtatlaunsigncla' or Braille grid (nl-dect aligamait) 

In tic 'Alignment grids' settings dialog, you can select tic size of the grid squares. The grid settings 
dialog can be opened by clicking on the light green markers on the righthand aide of the screen or via 

menu Settings > Alignment frame and grids. You can choose from a number of convenient the grid 
square sizes based on your selected units of measurement, which can be selected in menu Settings, > 

When tic alignment fie is enabled, the measurements grid will only be shown within this Erne. 
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.Figure 1. lifeetturemens grid shown across the entire design. 
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5.06 Measurements grid (object alignment)

The measurements grid is composed of a regular grid of squares that visualize the physical dimensions of
your design. This can be used for the alignment of objects in your design.

For a comparison with the braille grid, see: Alignment frame and grids or Braille grid (object alignment).

In the 'Alignment grids' settings dialog, you can select the size of the grid squares. The grid settings
dialog can be opened by clicking on the light green markers on the righthand side of the screen or via
menu Settings > Alignment frame and grids. You can choose from a number of convenient the grid
square sizes based on your selected units of measurement, which can be selected in menu Settings >
General.

When the alignment frame is enabled, the measurements grid will only be shown within this frame.

Figure 1. Measurements grid shown across the entire design.
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5.07 Braille grid (text alignment) 

The braille grid is used to align text labels in a regular grid for consistency and to conform to certain 
layout guidelines for braille documents. 

For a comparison with the measurements grid, we: Alignment grids or Measurements grid (object 
&gamma 
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.Figsre 1. Braille grid shown within the (optional) alignment frame. 

Aligning text labels 

The braille grid is composed of a regularpattem of cells the size of a braille character. This grid can be 
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5.07 Braille grid (text alignment)

The braille grid is used to align text labels in a regular grid for consistency and to conform to certain
layout guidelines for braille documents.

For a comparison with the measurements grid, see: Alignment grids or Measurements grid (object
alignment).

Figure 1. Braille grid shown within the (optional) alignment frame.

Aligning text labels

The braille grid is composed of a regular pattern of cells the size of a braille character. This grid can be
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used to align text labels in this regular pattern throughout your design. This will ensure all characters are 
aligned above each other and that the lines of tact we evenly spaced in tic entire document, as is required 
in some guidelines for braille documents. 

By default, text labels are 'magnetically' aligned (anapp4 to tic braille grid by dragging or placing tic 
label with its edges close to the grid lima. Dashed green lines will indicate when tic text label is aligned 
to tic grid. You can switch off tic alignment in the Alignment grids settings dialog by deselecting 'Align 
text labels to grid' orby disabling alignment in the context menu of a text label. Any text labels that 
extend beyond tic edge of the braille grid are automatically resized to fit within tic grid area. 

The lines and characters in each line are numbered along the aides of the braille grid. By default, the title 
label is placed at character 1 of lirc 1. 

Figure 1. Green dashed lines indicate the test label is aligned in the braille grid 

Braille cell size 

The size of a braille character has been standardized, but not all braille embossers have a printing 
resolution that allows text to be embossed =gaily matching this standard size. The grid cells on screen 
will represent the true size of the embossed braille characters. A red exclamation mark at tic top left 
comer of the braille grid will notify you when tic size of the embossed braille will differ from the 
standardized braille size. 

The size of tic grid cells will also be automatically adjusted when an 8 dot braille table is selected as the 
main braille table of the document. 
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used to align text labels in this regular pattern throughout your design. This will ensure all characters are
aligned above each other and that the lines of text are evenly spaced in the entire document, as is required
in some guidelines for braille documents.

By default, text labels are 'magnetically' aligned (snapped) to the braille grid by dragging or placing the
label with its edges close to the grid lines. Dashed green lines will indicate when the text label is aligned
to the grid. You can switch off the alignment in the Alignment grids settings dialog by deselecting 'Align
text labels to grid' or by disabling alignment in the context menu of a text label. Any text labels that
extend beyond the edge of the braille grid are automatically resized to fit within the grid area.

The lines and characters in each line are numbered along the sides of the braille grid. By default, the title
label is placed at character 1 of line 1.

Figure 1. Green dashed lines indicate the text label is aligned in the braille grid.

Braille cell size

The size of a braille character has been standardized, but not all braille embossers have a printing
resolution that allows text to be embossed exactly matching this standard size. The grid cells on screen
will represent the true size of the embossed braille characters. A red exclamation mark at the top left
corner of the braille grid will notify you when the size of the embossed braille will differ from the
standardized braille size.

The size of the grid cells will also be automatically adjusted when an 8 dot braille table is selected as the
main braille table of the document.
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Non-standard braille grid cell size 

2 

Figure 2. A red exclamation mark near the top left corner cf the grid signifies the truffle cells have a non-
standard size. 

Additional line spacing 

You can choose to use extra line spacing between lines of tett throughout the document. For =ample, a 
value of 0.5 will add an empty apace of half the height of a braille character between two lines of text. 
This line spacing is visible on screen in the braille grid 

This can be selected by clicking on the light green markers on the left hand side between text lines 2 and 
3. Alternatively, the value can be changed in the grid settings dialog or by selecting 'Additional line 
spacing' from theproperties toolbar or context menu of a selected text label. 
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Figure 2. A red exclamation mark near the top left corner of the grid signifies the braille cells have a non-
standard size.

Additional line spacing

You can choose to use extra line spacing between lines of text throughout the document. For example, a
value of 0.5 will add an empty space of half the height of a braille character between two lines of text.
This line spacing is visible on screen in the braille grid.

This can be selected by clicking on the light green markers on the left hand side between text lines 2 and
3. Alternatively, the value can be changed in the grid settings dialog or by selecting 'Additional line
spacing' from the properties toolbar or context menu of a selected text label.
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Additional line spacing adds white space between lines of text in the braille grid and text labels.
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5.08 Design mode: dot view/line view 

The graphic capabilities for tactile images differ for each individual production medium. Swellpaper has 
different properties than an embossed image, and each braille printer will differ in dot shape and 
placement 

'Design mode: dot view' in the second horizontal toolbar is used to display the specific graphic properties 
of the selected output medium_ With dot view selected, the dots are continuously repositioned to match 
the printed outputs as you add to your design_ This functions like a give print preview' in which you can 
directly edit your design and see the final output at the same time. 

If you. want to see the line drawing that the embossed image is based on or that is printed on swellpaper, 
simply go back to Design mode: line view'. 

TactileView - (Shark.bpx) 
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Figure 1. The difference between displaying a design in line view (left) and dot view (right). 
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5.08 Design mode: dot view/line view

The graphic capabilities for tactile images differ for each individual production medium. Swellpaper has
different properties than an embossed image, and each braille printer will differ in dot shape and
placement.

'Design mode: dot view' in the second horizontal toolbar is used to display the specific graphic properties
of the selected output medium. With dot view selected, the dots are continuously repositioned to match
the printed outputs as you add to your design. This functions like a 'live print preview' in which you can
directly edit your design and see the final output at the same time.

If you want to see the line drawing that the embossed image is based on or that is printed on swellpaper,
simply go back to 'Design mode: line view'.

Figure 1. The difference between displaying a design in line view (left) and dot view (right).
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6.01 How to use the drawing tools icon bar 
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The leftmost vertical icon bar offers you a numbcr of tools to add (graphic) objects, modify a selected 
area or apply a filter to the cnlirc design. The tools art clustered into groups of similar drawing tools. 
There arc two ways of composing your design: by modifying the bitmap and placing objects in the 
design, 
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6.01 How to use the drawing tools icon bar

The leftmost vertical icon bar offers you a number of tools to add (graphic) objects, modify a selected
area or apply a filter to the entire design. The tools are clustered into groups of similar drawing tools.
There are two ways of composing your design: by modifying the bitmap and placing objects in the
design.
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Drawing tools: manipulating the bitmap 
The retouching tools allow you to draw directly in the bitmap, where the lines you draw have a fixed 
position. The set of filters allows you to change colours or change the as an example the thickness of lines 
with filters. When you open a saved image file (e.g. a scanned image or an image saved from the internet) 
it needs to be fused with the bitmap in order to edit the image. 

Drawing tools: placing objects 
The list of available objects includes lines, squares, circles, triangles and dots, but also more complex 
objects such as tables and mathematical grids. These are represented in blue, indicating they are not 'fused 
with the bitmap' and can still be changed whenever you wish. 
A special category of tools allows you to add text to the design: text labels, mammoth braille and drawing 
letters and digits. These tools will allow adding text in braille or regular font to highlight certain elements 
in the design. 

Properties in second vertical toolbar 
Each tool has its own (second) vertical icon bar that will appear when you select a drawing tool or select 
the object (again) that was created with the tool. Most objects have some properties in common, such has 
position and size, whereas some other functions are specific for the tool or object. 

See: Editing object properties. 
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Drawing tools: manipulating the bitmap
The retouching tools allow you to draw directly in the bitmap, where the lines you draw have a fixed
position. The set of filters allows you to change colours or change the as an example the thickness of lines
with filters. When you open a saved image file (e.g. a scanned image or an image saved from the internet)
it needs to be fused with the bitmap in order to edit the image.

Drawing tools: placing objects
The list of available objects includes lines, squares, circles, triangles and dots, but also more complex
objects such as tables and mathematical grids. These are represented in blue, indicating they are not 'fused
with the bitmap' and can still be changed whenever you wish.
A special category of tools allows you to add text to the design: text labels, mammoth braille and drawing
letters and digits. These tools will allow adding text in braille or regular font to highlight certain elements
in the design.

Properties in second vertical toolbar
Each tool has its own (second) vertical icon bar that will appear when you select a drawing tool or select
the object (again) that was created with the tool. Most objects have some properties in common, such has
position and size, whereas some other functions are specific for the tool or object.

See: Editing object properties.
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6.02 Add text label (braille) 

Text labels are used to add texts in braille to your tactile diagrams, ranging from small texts labelling 
elements in the image to complete texts in braille. When using text labels, it is important to select the 
right braille table in order to get the correct braille output. 

There are three different types of text labels, which are described in the following manual sections: 

• Computer keyboard input; regular text input converted to braille output 
• Braille keyboard input; direct input of braille characters using Perkins style braille keyboard 
• Math input; use an equation editor or the keyboard as input for mathematical braille notation 

To place a text label in the design, select 'Add text label' from the drawing tools toolbar. The type of text 
label can be chosen from the right vertical properties toolbar. Click in the design to position the text label. 
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6.02 Add text label (braille)

Text labels are used to add texts in braille to your tactile diagrams, ranging from small texts labelling
elements in the image to complete texts in braille. When using text labels, it is important to select the
right braille table in order to get the correct braille output.

There are three different types of text labels, which are described in the following manual sections:

Computer keyboard input; regular text input converted to braille output
Braille keyboard input; direct input of braille characters using Perkins style braille keyboard
Math input; use an equation editor or the keyboard as input for mathematical braille notation

To place a text label in the design, select 'Add text label' from the drawing tools toolbar. The type of text
label can be chosen from the right vertical properties toolbar. Click in the design to position the text label.
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6.03 Select area; editing parts of the design 

The drawing tool 'Select area' enables you to manipulate a section of the design. After activating the tool, 
two types of functions become available: 'Select Rectangle' (default) and 'Insert or remove spate'. The 
rectangular selection allows you to make localized adjustments to the contents of your design. Inserting or 
removing horizontal/vertical space is used to locally acijust the size of the drawing canvas. 

Select rectangle - define the selection 

After choosing 'Select area' from the drawing tools icon bar or Drawing tools menu, move the mouse into 
the drawing area and click to set the first position of the first corner. Next, move the cursor and click a 
second time to complete the selection. Alternatively, you can also click and hold for the first position, 
then move the cursor and release at the second position. 

A dotted rectangle will indicate which area is selected. This selection can be adjtsted by dragging the 
purple markers around the selection. To reposition the selection, move the cursor over the rectangle, then 
dick and hold to drag the selection to another position. 

Alternatively, you can select 'Size and position' from the properties toolbar or context menu to adjust the 
selection. 

Figure 1. Selecting an area in the design. 

Select area icon.-
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6.03 Select area; editing parts of the design

The drawing tool 'Select area' enables you to manipulate a section of the design. After activating the tool,
two types of functions become available: 'Select Rectangle' (default) and 'Insert or remove space'. The
rectangular selection allows you to make localized adjustments to the contents of your design. Inserting or
removing horizontal/vertical space is used to locally adjust the size of the drawing canvas.

Select rectangle - define the selection

After choosing 'Select area' from the drawing tools icon bar or Drawing tools menu, move the mouse into
the drawing area and click to set the first position of the first corner. Next, move the cursor and click a
second time to complete the selection. Alternatively, you can also click and hold for the first position,
then move the cursor and release at the second position.

A dotted rectangle will indicate which area is selected. This selection can be adjusted by dragging the
purple markers around the selection. To reposition the selection, move the cursor over the rectangle, then
click and hold to drag the selection to another position.

Alternatively, you can select 'Size and position' from the properties toolbar or context menu to adjust the
selection.

 Figure 1. Selecting an area in the design.

Select area icon: 

                                 88 / 226



TactileVIew software mane 
Visit es et talps-mbintabio nt

Select rectangle lam: i.. 

Icons suntoad the selection for easy sweets 

A number of small items along the edges of the selection give quick access to a few functions for editing 
the selected area. 

Mirroring horizontally flips the selected image left to right, like turning apage in a book. Minoring 
vertically flips the image upside down, like turning a page in a wail calendar. 

Rotation and minoring the area can be p erformal by simply clicking on the corresponding loons. The 
large red is used to move the selected area of the bitmzp, whereas the blue marker allows you to move all 
objects and text labels that are (partially} within the selection. 

The right vertical toolbar will show the full list of options for manipulating the selected section of the 
design. 

Rotate selection itYPIS: 

Mtrror selection icons: 

Red markerfir moving the &map: 

Move the selected part of the bitmap 

Blue marker far mervtng objects: 

Move objects 
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Select rectangle icon: 

Icons around the selection for easy access 

A number of small icons along the edges of the selection give quick access to a few functions for editing
the selected area.

Mirroring horizontally flips the selected image left to right, like turning a page in a book. Mirroring
vertically flips the image upside down, like turning a page in a wall calendar.

Rotation and mirroring the area can be performed by simply clicking on the corresponding icons. The
large red is used to move the selected area of the bitmap, whereas the blue marker allows you to move all
objects and text labels that are (partially) within the selection.

The right vertical toolbar will show the full list of options for manipulating the selected section of the
design.

Rotate selection icons: 

Mirror selection icons: 

Red marker for moving the bitmap:

Blue marker for moving objects:
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Manipulate bitmap: crop, make selection white or fuse objects 

To isolate the contents of the selected area from the rest of the design, select 'Crop Area'. Only the content 
will remain as the design, as the area outside the selection will be removed. 

Select 'Paint Area Whiter to fill the selected part of the bitmap with white. Any objects in tic selection 
will not be affected and have to be fused first to make them white. You can either fuse all objects within 
the selection by selecting 'Fuse the selected objects with the bitmap', or fine objects individually by 
selecting and then fusing them. 

Crap area icon: a 
Paint area Write icon: 

Edit selected area as figure (move and resize) 

The selected stress of the bitmap can be resized and moved by choosing 'Convert to figure. The purple 
markers aroma this figure can be used to resize the selection. 

You can also choose 'Save as figure (file). to save the figure to reuse it in other designs. 

Save as figure (file) icon;  

Convert to figure icon:  
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Manipulate bitmap: crop, make selection white or fuse objects

To isolate the contents of the selected area from the rest of the design, select 'Crop Area'. Only the content
will remain as the design, as the area outside the selection will be removed.

Select 'Paint Area White'  to fill the selected part of the bitmap with white. Any objects in the selection
will not be affected and have to be fused first to make them white. You can either fuse all objects within
the selection by selecting 'Fuse the selected objects with the bitmap', or fuse objects individually by
selecting and then fusing them.

Crop area icon: 

Paint area white icon: 

Edit selected area as figure (move and resize)

The selected area of the bitmap can be resized and moved by choosing 'Convert to figure'. The purple
markers around this figure can be used to resize the selection.

You can also choose 'Save as figure (file)' to save the figure to reuse it in other designs.

Save as figure (file) icon: 

Convert to figure icon: 
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Apply filters 

The selected content can be processed using the range of filters. These have the same functionality as the 
list of filters in the Filters menu, but will only be applied to the selection instead of the entire design. 

See also Filters: editing an imported image (jpg..png....) 

p 

Figure 2. Local adjustments by applying a filter to the selected area. 

Addingfremoving a vertical or horizontal area 

The function `Selected strips' can be used to remove the selected vertical or horizontal area, or to add 
this amount of white space to the design. To use this tool, activate 'Select area', then 'Insert or remove 
space'. 

A crosshair cursor will appear when you move the mouse to the drawing area. By clicking once, the first 
outline of the selection is positioned, as indicated by the dotted green lines. Next, move the mouse 
horizontally or vertically and click a second time to complete the selection of the strip. Once again, you 
can also click and drag, then release at the second position to define the selection. 

The width of the horizontal or vertical selection can be adjusted by dragging the purple marker on the 
green dotted lines. 

A preview when hovering over the green plus sign will display the addition, whereas hovering over the 
red minus sign shows the design with the deleted area. Simply clicking on either sign will confirm the 
action. 
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Apply filters

The selected content can be processed using the range of filters. These have the same functionality as the
list of filters in the Filters menu, but will only be applied to the selection instead of the entire design.

See also Filters; editing an imported image (.jpg, .png, ...)

Figure 2. Local adjustments by applying a filter to the selected area.

Adding/removing a vertical or horizontal area

The function ‘Selected strips’ can be used to remove the selected vertical or horizontal area, or to add
this amount of white space to the design. To use this tool, activate 'Select area', then 'Insert or remove
space'.

A crosshair cursor will appear when you move the mouse to the drawing area. By clicking once, the first
outline of the selection is positioned, as indicated by the dotted green lines. Next, move the mouse
horizontally or vertically and click a second time to complete the selection of the strip. Once again, you
can also click and drag, then release at the second position to define the selection.

The width of the horizontal or vertical selection can be adjusted by dragging the purple marker on the
green dotted lines.

A preview when hovering over the green plus sign will display the addition, whereas hovering over the
red minus sign shows the design with the deleted area. Simply clicking on either sign will confirm the
action.
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PisanS Add or renew a horizontal arvertical area in the design. 

Insert ar remove space icon: 
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Figure 3. Add or remove a horizontal or vertical area in the design.

Insert or remove space icon: 
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6.04 Detect shape 

The 'Detect shape' tool is used to add surface properties such as textures to selected parts of tic design. 

The 'Detect Shape' tool, as the name suggests, detects the slope of an area within the elements in the 
design. Select the 'Detect shape' tool from the left vertical toolbar, then click in the centre of the area 
in the design that you wish to edit. A red dotted lime will indicate the contours of the detection, 

Pigure 1. Select* an area of the design with the Detect shape' tool 

Detect shape' icon: 

Fine-tuning the aelectiout 

In some cases, the shape detection might need some fine-tuning to get the exact shape you need, You can 
use the purple markers to adjust the anchor points of the shape, or click on 013C of the line segments to add 
another aneharpoirrt. 
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6.04 Detect shape

The 'Detect shape' tool is used to add surface properties such as textures to selected parts of the design.

The 'Detect Shape' tool, as the name suggests, detects the shape of an area within the elements in the
design. Select the 'Detect shape' tool from the left vertical toolbar, then click in the centre of the area
in the design that you wish to edit. A red dotted line will indicate the contours of the detection.

Figure 1. Selecting an area of the design with the 'Detect shape' tool.

'Detect shape' icon: 

Fine-tuning the selection

In some cases, the shape detection might need some fine-tuning to get the exact shape you need. You can
use the purple markers to adjust the anchor points of the shape, or click on one of the line segments to add
another anchor point.
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In other cases, the detection may not be successful because the area is not fully enclosed by lines or other 
parts of the design. Small gaps cause other areas to be linked to the area you wish to detect. 

You can compensate for small gaps by choosing 'Change shape detection criteria' from the toolbar or 
context menu. In the dialog that opens, you can readjust the levels for gap reduction. A higher will result 
in less gaps in the shape detection; however the detected shape will also have slightly more spacing 
around it. 

You can apply shape detection to coloured images as well. In the detection criteria, you can adjust the 
range of colours that will be included in the shape around the detection position. 

The detection criteria dialog contains a preview of the detected area, in which white signifies which area 
is part of the selection. Once you have adjusted the criteria, click Re-execute detection' to improve the 
detected shape. 

'Change shape detection criteria' icon: 4.

Shape Detection Criteria 

The window at the right shows a preview of the detected shape around the clicked point (blue cross). The shape is 
indicated as white. 
You can move the preview by dragging with the mouse. 

Adjust the range of different colours (in addition to the starting 
colour at the blue cross) that will become part of the shape. A 
higher value will indude more colours in the detection: 

The contour line of the shape may contain gaps. Increase this 
value to reduce the gaps in the edge of the shape: 

214 

Re-execute detection oK Cancel 

Figure 2. Use the 'Change shape detection criteria' dialog to finetune the detected shape; click on the 
image to enlarge. 
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In other cases, the detection may not be successful because the area is not fully enclosed by lines or other
parts of the design. Small gaps cause other areas to be linked to the area you wish to detect.

You can compensate for small gaps by choosing 'Change shape detection criteria' from the toolbar or
context menu. In the dialog that opens, you can readjust the levels for gap reduction. A higher will result
in less gaps in the shape detection; however the detected shape will also have slightly more spacing
around it.

You can apply shape detection to coloured images as well. In the detection criteria, you can adjust the
range of colours that will be included in the shape around the detection position.

The detection criteria dialog contains a preview of the detected area, in which white signifies which area
is part of the selection. Once you have adjusted the criteria, click 'Re-execute detection' to improve the
detected shape.

'Change shape detection criteria' icon: 

Figure 2. Use the 'Change shape detection criteria' dialog to finetune the detected shape; click on the
image to enlarge.
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Add properties 

When you are satisfied with the detected shape, you can add seveial properties to it, such as textures or an 
outline around the shape just like any of the other (blue) objects. 

See: Editing nliject propertica, 
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Figure 3. Add properties to the detected shapc such as tacture and line style 
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Add properties

When you are satisfied with the detected shape, you can add several properties to it, such as textures or an
outline around the shape, just like any of the other (blue) objects.

See: Editing object properties.

Figure 3. Add properties to the detected shape, such as texture and line style.
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6.05 Filters; editing an imported image cipg, .png, 

Images imported into TactileView need to be edited prior to printing using a combination of the filters 
and retouching tools. Because source images vary widely, it is helpful to experiment with the different 
filters to find out what works best for your image. If a filter does not produce the desired result, undo the 
action by selecting 'Undo' from the Edit mom orpressing CfRL+Z. 
You can activate one of the filters by selecting 'Filteraticon in the left vertical toolbar, or selecting one 
from the Filters menu. For some of the filters, a horizontal slider allows you to adjust the extent in which 
it is applied. The filters are applied to the entire design and will first all objects in the design. 

You can also apply filters to a selected area Sy, without affecting the mat of the design; see 'Select m 
szlitingziaanisbaskaigal. Please note; in the images on this page, the filters we Sy applied to the right-
hand aide of the image to sin the effect compared to the original image on the left. 

Filters' icon: 

Covert to line drawing 

One way to process the image so that it can better be embossed is to convert it to a line drawing. Select 
the Convert to Line Drawing option from the Filters menu. A slider bar will appear in the upper left 
corner of the screen. Drag the slit - left or right wail the image looks as desired. 
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6.05 Filters; editing an imported image (.jpg, .png, ...)

Images imported into TactileView need to be edited prior to printing using a combination of the filters
and retouching tools. Because source images vary widely, it is helpful to experiment with the different
filters to find out what works best for your image. If a filter does not produce the desired result, undo the
action by selecting 'Undo' from the Edit menu or pressing CTRL+Z.
You can activate one of the filters by selecting 'Filters' icon in the left vertical toolbar, or selecting one
from the Filters menu. For some of the filters, a horizontal slider allows you to adjust the extent in which
it is applied. The filters are applied to the entire design and will fuse all objects in the design.

You can also apply filters to a selected area only, without affecting the rest of the design; see 'Select area;
editing parts of the design'. Please note: in the images on this page, the filters are only applied to the right-
hand side of the image to show the effect compared to the original image on the left.

'Filters' icon: 

Convert to line drawing

One way to process the image so that it can better be embossed is to convert it to a line drawing. Select
the Convert to Line Drawing option from the Filters menu. A slider bar will appear in the upper left
corner of the screen. Drag the slider left or right until the image looks as desired.

                                 96 / 226



TactileVIew software naval 
Visit ® et imps -Mbinvabi nt 

Figure .1. 'Convert 0 line drawing' filter. 

Filter: convert 0 line drawing' icon:

Ccmvert to black and white 

Some images can come out better when converted to black and white rather than to a line drawing. Select. 
the Convert to Black and White option from the Filters menu. A slider bar will appear in the upper left 
corner of the screen. Drag the alit - left or right until the image looks as desired. 

o 
Figure 2. 'Convert 0 black and white' filter. 

Filter: convert 0 black and white' icon: 

Change line thickness 

Use this filter to increase or decrease line thicknesses in the image all at once. If your image contains a lot 
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Figure 1. 'Convert to line drawing' filter.

'Filter: convert to line drawing' icon: 

Convert to black and white

Some images can come out better when converted to black and white rather than to a line drawing. Select
the Convert to Black and White option from the Filters menu. A slider bar will appear in the upper left
corner of the screen. Drag the slider left or right until the image looks as desired.

Figure 2. 'Convert to black and white' filter.

'Filter: convert to black and white' icon: 

Change line thickness

Use this filter to increase or decrease line thicknesses in the image all at once. If your image contains a lot

                                 97 / 226



Tact'leVIew software Basal 
Visit ® to low/ Mt 

of light, thin lines or a dark, thick lines, this filter is helpful to make them all thicker or thinner at the 
same lime. Select Change Line Thickness from the Filters menu. When the slider appears at the upper left 
corn of the screen, slide it to the right to make lines thicker or to the left to make them thinner. 

Figzore 3. Thicker lines by app&ing the line thickness filter. 

Filter change line thiclatess" icon: 

Add contours 

This option allows you to add outlines around each different colored area in an image. Contours (black 
lines) are added at the transition pointbetween one color and another and the thicinoss of the contour 
lines is controlled using the slider that appears at the upper left corner of the screen when you select the 
filter. This filter can be helpful for simple drawings that have well-defined areas in distinct colon, but is 
less useful when applied to photos or other images where color fades from lighter to darker without a 
distinct transition point. 
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of light, thin lines or a dark, thick lines, this filter is helpful to make them all thicker or thinner at the
same time. Select Change Line Thickness from the Filters menu. When the slider appears at the upper left
corner of the screen, slide it to the right to make lines thicker or to the left to make them thinner.

Figure 3. Thicker lines by applying the line thickness filter.

'Filter: change line thickness' icon: 

Add contours

This option allows you to add outlines around each different colored area in an image. Contours (black
lines) are added at the transition point between one color and another and the thickness of the contour
lines is controlled using the slider that appears at the upper left corner of the screen when you select the
filter. This filter can be helpful for simple drawings that have well-defined areas in distinct colors, but is
less useful when applied to photos or other images where color fades from lighter to darker without a
distinct transition point.
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Figure 4. 'Add contours' adds Nadi centaur lines to dumges in colour M the image. 

Fitter: add wirtaws' isms: 

Blur image 

The use of this filter lets you soften or sharpen edges 13 con= areas of color in an image. Select Blur the 
Image from the Filters mean, then use the slider that appears at the upper left con= of the screen to 
atust tic image. Sliding the slider right will soften edges and sliding it left will sharpen the edges. 
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Figure 4. 'Add contours' adds black contour lines to changes in colour in the image.

'Filter: add contours' icon: 

Blur image

The use of this filter lets you soften or sharpen edges between areas of color in an image. Select Blur the
Image from the Filters menu, then use the slider that appears at the upper left corner of the screen to
adjust the image. Sliding the slider right will soften edges and sliding it left will sharpen the edges.
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Figure 5. Right-hand side cf the image is blurred With the Blur imttge' filter 

Filter: blur image' icon: 

Replace colours 

This filteris mostly used to remove certain colours in the image by converting them to white or black. In 
the dialog that appears, you can select which colour should be replaced from the list of colours that are 
present in the design. You can also adjust the colour range to include similar shades in the colour 
replacement Once you we finished replacing the desired colours, click 'OK' to confirm the changes. 

Figure 6 The red colour in the last olympic ?Mg has been replaced by a dark potpie colour. 

Filter: blur image' icon: 

Negative 
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Figure 5. Right-hand side of the image is blurred with the 'Blur image' filter.

'Filter: blur image' icon: 

Replace colours

This filter is mostly used to remove certain colours in the image by converting them to white or black. In
the dialog that appears, you can select which colour should be replaced from the list of colours that are
present in the design. You can also adjust the colour range to include similar shades in the colour
replacement. Once you are finished replacing the desired colours, click 'OK' to confirm the changes.

Figure 6. The red colour in the last olympic ring has been replaced by a dark purple colour.

'Filter: blur image' icon: 

Negative
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This option is mostly used when an image has a lot of black area. Choosing Negative from tic Filters 
menu will exchange all colors in the image file with their opposites. Black strung become white, blue areas 
become orange, red =as hector= green, etc. 

Figure 7. Negative' filter applied to the right-hand side of the fining 

'Filter: negative" icon: V 2

Rotating, mirroring and sealing the linage 

To rotate the entire image., select either 'Rotate Clockwise or 'Rotate anticlockwise' from the Filters 
menu. The image will rotate 90 degrees in the direction you selected. 

To mirror the image, select 'Mirror Horizontally' or 'Mirror Vertically' from tic Filters =MI. Mirroring 
horizontally flips the image left to right, like turning a page in a book. Mirroring vertically flips the image 
upside down, like turning a page in a wall calendar. 

To scale the image., select it and then drag the blue Kill= in the lower right corner of the design area 
diagonally to scale the image smaller or larger. 
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This option is mostly used when an image has a lot of black area. Choosing Negative from the Filters
menu will exchange all colors in the image file with their opposites. Black areas become white, blue areas
become orange, red areas become green, etc.

Figure 7. 'Negative' filter applied to the right-hand side of the image.

'Filter: negative' icon: 

Rotating, mirroring and scaling the image

To rotate the entire image, select either 'Rotate Clockwise' or 'Rotate anticlockwise' from the Filters
menu. The image will rotate 90 degrees in the direction you selected.

To mirror the image, select 'Mirror Horizontally' or 'Mirror Vertically' from the Filters menu. Mirroring
horizontally flips the image left to right, like turning a page in a book. Mirroring vertically flips the image
upside down, like turning a page in a wall calendar.

To scale the image, select it and then drag the blue square in the lower right corner of the design area
diagonally to scale the image smaller or larger.
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Filter: rotate clochvise/anticloclavise' icons: e \ 
A -a 'Filter: minter horizontallyherticalfr icon: 

Filter: scale design' icon: 

Filter: fuse all objects with Isitniap' icon: al 
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'Filter: rotate clockwise/anticlockwise' icons:  

'Filter: mirror horizontally/vertically' icon:  

'Filter: scale design' icon: 

'Filter: fuse all objects with bitmap' icon: 
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6.06 Retouching took; pen and eraser 

Retarmeldny adding and erasing lines 

All TactileView designs have a bitmap that ?Cu as the 'terse layer'. This bitmap layer can be edited using 
the retouching tools. 

See also: Working with fused bitmapa 

Retouching 

To draw freehand lines that are automatically part of the bitmap and not editable, select the 'Retouching 
Adding lines' icon from the toolbar on the left aide of the screen, orselect 'Retouching Adding lines' from 
the Drawing Tools menu. Select the line thick: less you would like to use p rior to starting to draw by using 
the slider next to thepropertiea toolbar. You can use Shift-Escroll wheel formore convenient size 
aclustmeut while drawing in the design. In theproperties toolbar or context menu, you can choose 
between a round ora square pen or eraser shape by selecting 'Apply circular tip' or 'Apply square tip'. 
You can also choose to draw straight or curved lines by choosing 'Use straight lines' or 'Free style (follow 
the mouse}'. 

You can now use the mouse to draw in the design area. Anything you draw with this tool will 
automatically bepart of the bitmap and will not be editable unless you select an area containing your 
drawing and convert it to a figure or use the Detect shape feature to create an editable object from a 
freehand closed shape. The retouching mode will continue until you select another mode or drawing tool, 
or wail you press the escape key on the keyboard 

Retouching: Adding lases' icca: 

'Line drialosess' icon: 
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6.06 Retouching tools; pen and eraser

Retouching: adding and erasing lines

All TactileView designs have a bitmap that acts as the 'base layer'. This bitmap layer can be edited using
the retouching tools.

See also: Working with fused bitmaps

Retouching

To draw freehand lines that are automatically part of the bitmap and not editable, select the 'Retouching
Adding lines' icon from the toolbar on the left side of the screen, or select 'Retouching: Adding lines' from
the Drawing Tools menu. Select the line thickness you would like to use prior to starting to draw by using
the slider next to the properties toolbar. You can use Shift+scroll wheel for more convenient size
adjustment while drawing in the design. In the properties toolbar or context menu, you can choose
between a round or a square pen or eraser shape by selecting 'Apply circular tip' or 'Apply square tip'.
You can also choose to draw straight or curved lines by choosing 'Use straight lines' or 'Free style (follow
the mouse)'.

You can now use the mouse to draw in the design area. Anything you draw with this tool will
automatically be part of the bitmap and will not be editable unless you select an area containing your
drawing and convert it to a figure or use the 'Detect shape' feature to create an editable object from a
freehand closed shape. The retouching mode will continue until you select another mode or drawing tool,
or until you press the escape key on the keyboard.

'Retouching: Adding lines' icon: 

'Line thickness' icon: 
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30 pixels 

4 

Figure I. Use the slider ar Ski t+ cTall wheel to &lust the line thaws. 

'Use straight hives' icon: 

'Freestyle ((affair the mouser icon: 1%.

L 

4 pixels 

Figure 2. Drawing straight or curvedknee. 

Apply einidar tip' icon: i ll

Apply square tip' icon: I I 

• 
4 
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Figure 1. Use the slider or Shift+Scroll wheel to adjust the line thickness.

'Use straight lines' icon: 

'Free style (follow the mouse)' icon: 

Figure 2. Drawing straight or curved lines.

'Apply circular tip' icon: 

'Apply square tip' icon: 
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Figure 3. Using a circular or square pen hp. 

Eraser 

To erase lines in the bitmap, select the 'Retouching: Bose' icon from the tool bar on the left aide of the 
screen, or select 'Retouching: Eraser from the Drawing Tools menu. The eraser width and shape can be 
adjusted in the same way as the line thickness of the pen, as well as using straight or curved lines and a 
circular or square eraser. 

Begin erasing by dragging the mouse ow the lines you would like to erase. The retouching mode will 
continue until you select anther made or drawing tool, or until you press the escape key on the keyboard. 
You can only erase any fines fused to the bitmap. Therefore, if you wish to erase a part of a blue object or 
inserted image, you will first need to fuse them with the bitmap. You can read more in the manual section 
Working with fuser] bitmaps 

!Retouching erase' icon: 

!Eraser width' icon: 

'Use straight lines' icon: 

"Free style (follow the mous4" icon: 

Figure 4. Using the eraser to retouch a section in the design. 
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Figure 3. Using a circular or square pen tip.

Eraser

To erase lines in the bitmap, select the 'Retouching: Erase' icon from the tool bar on the left side of the
screen, or select 'Retouching: Erase' from the Drawing Tools menu. The eraser width and shape can be
adjusted in the same way as the line thickness of the pen, as well as using straight or curved lines and a
circular or square eraser.

Begin erasing by dragging the mouse over the lines you would like to erase. The retouching mode will
continue until you select another mode or drawing tool, or until you press the escape key on the keyboard.
You can only erase any lines fused to the bitmap. Therefore, if you wish to erase a part of a blue object or
inserted image, you will first need to fuse them with the bitmap. You can read more in the manual section
Working with fused bitmaps.

'Retouching: erase' icon: 

'Eraser width' icon: 

'Use straight lines' icon: 

'Free style (follow the mouse)' icon: 

Figure 4. Using the eraser to retouch a section in the design.
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6.07 Draw objects; line, square, circle, ... 

The drawing tools icon bar contains all the drawing tools to create objects with specific shapes such as 
lines, dots, circles and squares. The objects provide accuracy in your drawings and are indicated in blue 
on screen. 

General operation for the took 

After selecting a drawing tool, a second vertical toolbar will appear. Depending on the tool, this toolbar 
will present you with a number of options that can be selected before the object is placed in tic design. 

To place the object, move the mouse to tic drawing area and click where the object should be placed. The 
cursor will also indicate tic selected drawing tool. Hold and drag or click in a second position to 
determine the size and position of tic object Purple markers on or =tund the objects allow for 
repositioning, resizing or changing the prop:a-lions. 

An object as a whole can be deleted by the delete key or selecting 'Delete from tic icon bar or context 
menu. It is notpossible to erase parts from the object unless it has been fixed to tic bitmap (see; 
'Working with fused bitmaps). 

After placing an object in the design, a second vertical toolbar will appear, presenting tic specific 
properties for the drawn object Reselecting the object later on will bring up the same properties icon bar. 

A number of properties are common for all objects. Those will be explained in a separate section: Editing 
attzsazmpatio. 

Drawing straight lines 

To draw a straight line, choose the 'Draw Straight Line icon from tic toolbar on tic left side of the 
screen. In the design area, click tic starting position for your line, then click the end position. 
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6.07 Draw objects; line, square, circle, ...

 
The drawing tools icon bar contains all the drawing tools to create objects with specific shapes such as
lines, dots, circles and squares. The objects provide accuracy in your drawings and are indicated in blue
on screen.

General operation for the tools

After selecting a drawing tool, a second vertical toolbar will appear. Depending on the tool, this toolbar
will present you with a number of options that can be selected before the object is placed in the design.

To place the object, move the mouse to the drawing area and click where the object should be placed. The
cursor will also indicate the selected drawing tool. Hold and drag or click in a second position to
determine the size and position of the object. Purple markers on or around the objects allow for
repositioning, resizing or changing the proportions.

An object as a whole can be deleted by the delete key or selecting 'Delete' from the icon bar or context
menu. It is not possible to erase parts from the object unless it has been fused to the bitmap (see:
'Working with fused bitmaps').

After placing an object in the design, a second vertical toolbar will appear, presenting the specific
properties for the drawn object. Reselecting the object later on will bring up the same properties icon bar.

A number of properties are common for all objects. These will be explained in a separate section: Editing
object properties.

Drawing straight lines

To draw a straight line, choose the 'Draw Straight Line' icon from the toolbar on the left side of the
screen. In the design area, click the starting position for your line, then click the end position.
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Figure 1. Drawing a straight line in the design. 

Draw straight line' icon: \ 

Donving sepaues and rectangles 

To draw a square, choose the Draw Square-Rectangle icon fi-om the tool bar on the left aide of the screen. 
Click in the design to mark the ppanion of the first comer, then move the mouse to determine the size of 
the square and click a second lime to confirm. Alternatively, you can click and drag then release at the 
opposite corner. 

By dragging the markers in one of the four corners the size can be increased or decreased. Dragging 
inwards or outwards with the markets in the middle of the four sides will In the square into a rectangle. 

Figure 2. A square and rectangle drawn in the design. 

Draw square-rectangle' icon: 

Drawing circles and ellipses 

To draw a circle, choose the Thaw Circle-Ellipse. icon from the left vertical tool bar on the ldt aide of the 
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Figure 1. Drawing a straight line in the design. 

'Draw straight line' icon: 

Drawing squares and rectangles

To draw a square, choose the Draw Square-Rectangle icon from the tool bar on the left side of the screen.
Click in the design to mark the position of the first corner, then move the mouse to determine the size of
the square and click a second time to confirm. Alternatively, you can click and drag, then release at the
opposite corner.

By dragging the markers in one of the four corners the size can be increased or decreased. Dragging
inwards or outwards with the markers in the middle of the four sides will turn the square into a rectangle.

Figure 2. A square and rectangle drawn in the design.

'Draw square-rectangle' icon: 

Drawing circles and ellipses

To draw a circle, choose the 'Draw Circle-Ellipse' icon from the left vertical tool bar on the left side of the
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screen. In the design area, click the location for the first position, then move the mouse until the circle is 
the desired size and click again to confirm. Alternatively, you can click and drag, then release at tic 
opposite corner. 

By dragging the markers in one of the four corners the size can be increased or decreased. Dragging 
inwards or outwards with tic markers in the middle of the four sides will In tic circle into an ellipse. 

0 
Figure 3. A circle and ellipse drawn in tic design. 

Draw circle-ellipse" loon: 

Drinving triangles 

To insert a triangle into your drawing select the 'Draw Triangle' icon from the left vertical toolbar. Next, 
select what type of triangle to insert from the right vertical properties toolbar that app;ars. 

The bottom four icons on this tool bar allow the available types of triangles. From top to bottom, the 
triangle types available in the tool bars= right, isosceles, equilateral and scalene. Triangles may be 
changed from one type to another after you have placed them in your drawing, but it is =lest to select 
the appropriate triangle type prior to inserting the shape. 

°MC you have selected the type of triangle you want, click the point in the design area where you want 
arc of the corners and then drag until the triangle is the desired size. Alternatively, you can click and 
drag, then release at the opposite corner. 

The 'Angles and lima' dialog can be used for a more mathematically oriented notation. The corners of the 
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screen. In the design area, click the location for the first position, then move the mouse until the circle is
the desired size and click again to confirm. Alternatively, you can click and drag, then release at the
opposite corner.

By dragging the markers in one of the four corners the size can be increased or decreased. Dragging
inwards or outwards with the markers in the middle of the four sides will turn the circle into an ellipse.

Figure 3. A circle and ellipse drawn in the design.

'Draw circle-ellipse' icon: 

Drawing triangles

To insert a triangle into your drawing, select the 'Draw Triangle' icon from the left vertical toolbar. Next,
select what type of triangle to insert from the right vertical properties tool bar that appears.

The bottom four icons on this tool bar show the available types of triangles. From top to bottom, the
triangle types available in the tool bar are right, isosceles, equilateral and scalene. Triangles may be
changed from one type to another after you have placed them in your drawing, but it is easiest to select
the appropriate triangle type prior to inserting the shape.

Once you have selected the type of triangle you want, click the point in the design area where you want
one of the corners and then drag until the triangle is the desired size. Alternatively, you can click and
drag, then release at the opposite corner.

The 'Angles and lines' dialog can be used for a more mathematically oriented notation. The corners of the
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triangle are marked with letters A, B and C. By default they will only show on screen (green colour, not 
embossed). By cMcking 'Characters A, B, C at corners' in tic 'Angles and lines' dialog, they will also be 
presented in braille characters once embossed. 

The comers of tic triangle can each be provided with 3 types of specific lima: altitude, median line and 
bisector, which will be embossed as dotted lines. 

NA 
Figure 4. Four different types 0 -triangles.. right isosceles, equilateral and scalene Equal or right 
corners we indicated in gm. 

"Draw triangle' icon: 

Drawling polygons 

A polygon consists of several lima that are connected as one object. To insert a polygon, choose the 
'Draw Polygon' icon fin the tool bar on the left aide of the screen. Click in a number of positions in the 
design area to draw a polygon. To finish the polygon, click on the first gaichorpoint (first purple marker) 
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triangle are marked with letters A, B and C. By default they will only show on screen (green colour, not
embossed). By checking 'Characters A, B, C at corners' in the 'Angles and lines' dialog, they will also be
presented in braille characters once embossed.

The corners of the triangle can each be provided with 3 types of specific lines: altitude, median line and
bisector, which will be embossed as dotted lines.

Figure 4. Four different types of triangles: right, isosceles, equilateral and scalene. Equal or right
corners are indicated in green.

'Draw triangle' icon: 

Drawing polygons

A polygon consists of several lines that are connected as one object. To insert a polygon, choose the
'Draw Polygon' icon from the tool bar on the left side of the screen. Click in a number of positions in the
design area to draw a polygon. To finish the polygon, click on the first anchor point (first purple marker)
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to close the polygon. Alternatively, you can click again on the last placed atichorpoint to make an open 
shape. You can also choose these two options from the toolbar or context menu by selecting 'Close 
polygon' or 'Finalize the polygon (leave the last connection open)'. 

When you have an open polygon selected, two green plus symbols on screen allow you to continue 
drawing at the ends of the polygon. You can also choose 'Continue drawing at first/last endpoint' from the 
context menu. The red bonder around a selected polygon can be used to maize itby dragging the purple 
markers. 

You can choose between straight and curved lines between the anchor points. This allows you to make 
use of rounded curves in your design. 

• - - - -IP 

-M - 

�v�� - -M -

- M - 

�v��

_Figure S. Two polygamy show the difference between straight arid curved tines. 

Draw polygon" icvn: 

Drawing freehand line or closed shape 

To draw freehand lines or closed shapes, choose the Draw Freehand Line or Closed Shape icon from the 
tool bgo- on the left aide of the screen. In the design area, click the desired starling location and drag the 
mouse to create the desired line. To create a closed shape, click the desired starting location and drag the 
mouse to create the desired shape, returning to the starting location before releasing the mouse button. 
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to close the polygon. Alternatively, you can click again on the last placed anchor point to make an open
shape. You can also choose these two options from the toolbar or context menu by selecting 'Close
polygon' or 'Finalize the polygon (leave the last connection open)'.

When you have an open polygon selected, two green plus symbols on screen allow you to continue
drawing at the ends of the polygon. You can also choose 'Continue drawing at first/last endpoint' from the
context menu. The red border around a selected polygon can be used to resize it by dragging the purple
markers.

You can choose between straight and curved lines between the anchor points. This allows you to make
use of rounded curves in your design.

Figure 5. Two polygons show the difference between straight and curved lines.

'Draw polygon' icon: 

Drawing freehand line or closed shape

To draw freehand lines or closed shapes, choose the Draw Freehand Line or Closed Shape icon from the
tool bar on the left side of the screen. In the design area, click the desired starting location and drag the
mouse to create the desired line. To create a closed shape, click the desired starting location and drag the
mouse to create the desired shape, returning to the starting location before releasing the mouse button.
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As with the polygon, you can choose between straight and curved lines between the anchor points. The 
dashed red border can be used to maize the entire object 

�v��

1 •

  t — 

Freehand line with arvai lines. 

Draw freehand line or closed shape' icon: 

Drawhig dots 

To grad round dots to your design, select the Thaw filled dots' from the let vertical toolbar, then click in 
your design to position tic dot. The sire of the dot can be changed with tic purple neuters. Tic dot size 
can range fin only orc braille dot up to  filled circle of multiple centimetres in diameter. 

• 

• 

• • 
Different sized ebb am mange from a single braille dot to several centimeters in diameter. 
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As with the polygon, you can choose between straight and curved lines between the anchor points. The
dashed red border can be used to resize the entire object.

Freehand line with curved lines.

'Draw freehand line or closed shape' icon: 

Drawing dots

To add round dots to your design, select the 'Draw filled dots' from the let vertical toolbar, then click in
your design to position the dot. The size of the dot can be changed with the purple markers. The dot size
can range from only one braille dot up to a large filled circle of multiple centimetres in diameter.

Different sized dots can range from a single braille dot to several centimeters in diameter.
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• 
'Draw filled dots' icon: •' 
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'Draw filled dots' icon: 

                                112 / 226



TactileView software manual 
Visit us at https://thinkable.nl 

6.08 Draw table 

TactileView includes a number of tools for drawing and working with tables. Most editing commands for 
tables are the same as for other drawing objects, including the methods with which to move, center or 
delete a table, change its line or fill style, add audio labels or fuse it to the bitmap. For more information 
on these topics, please refer to Editing object properties, Adding audio styles and Working with fused 
bitmaps. The features and commands described in this tutorial are specific to tables. 

Drawing a table 

To add a table to your file, choose the 'Draw table' icon from the toolbar on the left side of the screen, 
then click and drag the mouse in the design to insert a table into your document. Your table will be 
created with the default number of rows and columns, but you can add and/or remove rows and columns 
as desired after the table has been inserted. 

Another way to add a table to your file is to select 'Draw table' from the Drawing Tools menu. This 
launches a dialog, allowing you finer control over how the table is initially created. 

To insert a table using this method, enter the desired location of the upper left corner of the table, then 
specify the size parameters, the number of rows desired and the number of columns desired. When setting 
the size, choose the 'Enlarge/reduce' radio button if you would like the cells in your table to be square, or 
choose the 'Stretch' radio button to allow adjustment of the height and width independently. Enter the 
desired cell width (and the height, if using the 'Stretch' option), the desired number of rows and the 
desired number of columns, then choose 'OK' to close the dialog and insert the table into your drawing. 
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6.08 Draw table

TactileView includes a number of tools for drawing and working with tables. Most editing commands for
tables are the same as for other drawing objects, including the methods with which to move, center or
delete a table, change its line or fill style, add audio labels or fuse it to the bitmap. For more information
on these topics, please refer to Editing object properties, Adding audio styles and Working with fused
bitmaps. The features and commands described in this tutorial are specific to tables.

Drawing a table

To add a table to your file, choose the 'Draw table' icon from the toolbar on the left side of the screen,
then click and drag the mouse in the design to insert a table into your document. Your table will be
created with the default number of rows and columns, but you can add and/or remove rows and columns
as desired after the table has been inserted.

Another way to add a table to your file is to select 'Draw table' from the Drawing Tools menu. This
launches a dialog, allowing you finer control over how the table is initially created.

To insert a table using this method, enter the desired location of the upper left corner of the table, then
specify the size parameters, the number of rows desired and the number of columns desired. When setting
the size, choose the 'Enlarge/reduce' radio button if you would like the cells in your table to be square, or
choose the 'Stretch' radio button to allow adjustment of the height and width independently. Enter the
desired cell width (and the height, if using the 'Stretch' option), the desired number of rows and the
desired number of columns, then choose 'OK' to close the dialog and insert the table into your drawing.
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Figure 1. Drawing a table in the deign with the MOUSE 

Draw table' icon: 

Adjusting the table size 

Once you have inserted the table into your drawing, you can actust the overall table size The objects and 
text labels that areplaced within tic tale will be repoaitionad automatically so they remain positioned in 

the same cell (see below). 

To adjust the size of the table, select the table so thatpurple squares appear along the outside edges of the 
table. To scale the table and preserve the height to width ratio, click a purple square in one of the comers 
of the table and drag it. until the table is the desired size. The cells in the table will be scaled up or down 
automatically with the table and will maintain their height to width ratios. 

To adjust the overall table width, click the center purple square on the right or left edge of the table and 

drag it until the table is the desired width. The cells in the table will be scaled automatically to maintain 
equal widths. Similarly, you can adjust the overall table height by clicking the center purple square on the 

top orbottom edge of the table and dragging it until the table is the desired lright. The cells in the table 

will be scaled automatically to maintain equal heights. 
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Figure 1. Drawing a table in the design with the mouse.

'Draw table' icon: 

Adjusting the table size

Once you have inserted the table into your drawing, you can adjust the overall table size. The objects and
text labels that are placed within the table will be repositioned automatically so they remain positioned in
the same cell (see below).

To adjust the size of the table, select the table so that purple squares appear along the outside edges of the
table. To scale the table and preserve the height to width ratio, click a purple square in one of the corners
of the table and drag it until the table is the desired size. The cells in the table will be scaled up or down
automatically with the table and will maintain their height to width ratios.

To adjust the overall table width, click the center purple square on the right or left edge of the table and
drag it until the table is the desired width. The cells in the table will be scaled automatically to maintain
equal widths. Similarly, you can adjust the overall table height by clicking the center purple square on the
top or bottom edge of the table and dragging it until the table is the desired height. The cells in the table
will be scaled automatically to maintain equal heights.
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Adding and removing rows and columns 

By default, a new table has three columns and three rows; however, you can always adjust the number of 
rows and columns by inserting or deleting them. To do so, select 'Insert or delete rows and columns' from 
the properties toolbar or context menu. 

In the dialog that appears, first make a selection whether you wish to add or remove rows or columns. 
Next, you need to specify which row(s)/column(s) should be deleted or at what position the 
row(s)/column(s) should be inserted. 

- In the case of inserting, you can choose to place them 'In front' (i.e. on the left side of the table in the 
case of columns, on top for rows), 'At the end' (i.e. on the right or bottom) or after the specified 
column/row number (i.e. inside the table). You can choose to add a single or multiple rows or columns. 
- In the case of deleting, you have the choice between 'First' (again, the leftmost column or top row), 'Last' 
(rightmost column or bottom row) or after the specified row/column number. Again, you can choose to 
remove multiple rows at a time. 

Finally, you have to select if either: 
- the table dimensions need to remain constant, i.e. the outer dimensions of the table remain the same but 
the cell size is adjusted to accomodate the new number of rows/columns; or 
- the cell dimensions remain constant, i.e. the table size is adjusted to add or remove space for the new 
number of rows/columns. 

Once you have made all selections, choose 'OK' to confirm. 

'Insert or delete rows and columns' icon: L
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Adding and removing rows and columns

By default, a new table has three columns and three rows; however, you can always adjust the number of
rows and columns by inserting or deleting them. To do so, select 'Insert or delete rows and columns' from
the properties toolbar or context menu.

In the dialog that appears, first make a selection whether you wish to add or remove rows or columns.
Next, you need to specify which row(s)/column(s) should be deleted or at what position the
row(s)/column(s) should be inserted. 

- In the case of inserting, you can choose to place them 'In front' (i.e. on the left side of the table in the
case of columns, on top for rows), 'At the end' (i.e. on the right or bottom) or after the specified
column/row number (i.e. inside the table). You can choose to add a single or multiple rows or columns.
- In the case of deleting, you have the choice between 'First' (again, the leftmost column or top row), 'Last'
(rightmost column or bottom row) or after the specified row/column number. Again, you can choose to
remove multiple rows at a time.

Finally, you have to select if either:
- the table dimensions need to remain constant, i.e. the outer dimensions of the table remain the same but
the cell size is adjusted to accomodate the new number of rows/columns; or
- the cell dimensions remain constant, i.e. the table size is adjusted to add or remove space for the new
number of rows/columns.

Once you have made all selections, choose 'OK' to confirm.

'Insert or delete rows and columns' icon: 
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Entering table contents 

At any point after creating your table, you can enter contents into the cells. You can use the drawing tools 
from the left vertical toolbar or Drawing tool menu to place text labels or objects in the table. Objects 
inserted into a table may be edited just like objects that are not part of table contents (for more 
information, please refer to the 'Drawing tools' section of the manual). Inserting an object into the table 
contents will anchor it to the table, so that if you later move, stretch or scale the table, the object stays 
linked to the correct cell in the table. 

As an alternative to drawing the object with the mouse, select the table and choose the 'Table contents' 
icon from the properties toolbar, or right-click the table and choose 'Table contents' from the context 
menu. This launches a dialog from which you can control the table content. 

When you select an object type from this menu, a dialog will come up allowing you to give further 
information about the object you want to create. What is on the dialog will vary depending on which type 
of object you select. A size and position dialog will appear for straight lines, squares/rectangles, 
circles/ellipses, triangles, polygons, freehand lines/closed shapes, dots and tables. For the other objects, a 
dialog will appear in which the contents can be entered (e.g. text labels) or selected (e.g. figures). 

The dialogs are very similar to the ones that appear when you access the drawing tools from the Drawing 
Tools menu, except that they also have edit boxes that allow you to select which cell to place the object in 
by specifying the desired row and column for the object. 

This is the size and position dialog for inserting a square, but since it is being inserted into a table it has 
'Row in table' and 'Column in table' edit boxes at the bottom. Make the desired selections to create your 
object and place it in the appropriate cell, then choose 'OK' to close the dialog and insert the object into 
the table. It will also appear as a listing in the table contents menu. 
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Entering table contents

At any point after creating your table, you can enter contents into the cells. You can use the drawing tools
from the left vertical toolbar or Drawing tool menu to place text labels or objects in the table. Objects
inserted into a table may be edited just like objects that are not part of table contents (for more
information, please refer to the 'Drawing tools' section of the manual). Inserting an object into the table
contents will anchor it to the table, so that if you later move, stretch or scale the table, the object stays
linked to the correct cell in the table.

As an alternative to drawing the object with the mouse, select the table and choose the 'Table contents'
icon from the properties toolbar, or right-click the table and choose 'Table contents' from the context
menu. This launches a dialog from which you can control the table content.

When you select an object type from this menu, a dialog will come up allowing you to give further
information about the object you want to create. What is on the dialog will vary depending on which type
of object you select. A size and position dialog will appear for straight lines, squares/rectangles,
circles/ellipses, triangles, polygons, freehand lines/closed shapes, dots and tables. For the other objects, a
dialog will appear in which the contents can be entered (e.g. text labels) or selected (e.g. figures).

The dialogs are very similar to the ones that appear when you access the drawing tools from the Drawing
Tools menu, except that they also have edit boxes that allow you to select which cell to place the object in
by specifying the desired row and column for the object.

This is the size and position dialog for inserting a square, but since it is being inserted into a table it has
'Row in table' and 'Column in table' edit boxes at the bottom. Make the desired selections to create your
object and place it in the appropriate cell, then choose 'OK' to close the dialog and insert the object into
the table. It will also appear as a listing in the table contents menu.
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Figure 2. &Tab* or moving a table will automatically mpositioss the contents in the table. 

Table contents' icon: 
n

i 
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Figure 2. Scaling or moving a table will automatically reposition the contents in the table.

'Table contents' icon: 
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6.09 Draw graph 

The 'Draw graph' icon shows the list of options for creating a tactile mathematical graph. You can also 
find these options in the Graphs menu. From this list, you have a choice to either use an empty grid, 
create a graph by entering your own formula or using one of the TactileView example graphs. 

There are a lot of different aspects when it comes to mathematics in braille and creating or reading tactile 
graphs. The detailed introduction will explain everything you need to know about the background 
concepts. In the other entries in the 'Graphs and math' section of the manual you can read how to use 
different styles of graphs and learn how to create them using different input methods. 

'Draw graph' icon: 

.ii.. 
MIME 
�v��MEM
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6.09 Draw graph

The 'Draw graph' icon shows the list of options for creating a tactile mathematical graph. You can also
find these options in the Graphs menu. From this list, you have a choice to either use an empty grid,
create a graph by entering your own formula or using one of the TactileView example graphs.

There are a lot of different aspects when it comes to mathematics in braille and creating or reading tactile
graphs. The detailed introduction will explain everything you need to know about the background
concepts. In the other entries in the 'Graphs and math' section of the manual you can read how to use
different styles of graphs and learn how to create them using different input methods.

'Draw graph' icon: 
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6.10 Import (image from file, svg and figure) 

There axe several ways in which you can add an image to your TactileView design. 

• When you regularly use the same icons or images, 'Add figure 
• Saved SVG image files can be added with 'Import SVG' 
• Saved jpg, pug or otherbitmap images axe added with 'Import image from file 

These import fiuictious axe activated by selecting 'Import' from the leftvertical toolbar, then selecting the 
specific tool from the right vertical toolbar. 

: 
'Import' icon:

'Import SVG' icon: 

'Import image from file' icon: Xi 

Add figure 

Figures axe image objects that are useful when you wish to reuse certain symbols and shapes (such as 
arrows, electrical symbols, more abstract shapes, etc) in multiple docaments. Once you have activated the 
'Add figure drawing tool, a dialog will appear in which you can You can browse through the different 
categories raid select the figure you wish to use. 

Once you click 'OK' to confirm your choice, the figure will be visible at theposition of your mouse. Click 
anywhere to place the figure as an object in your desiguff the object is xbot the desired gist when it 
appears in the design area, you can edit it by dragging the purple markers on the outliers and sides. 

Settings - personal figures folder 
TactileView contains a set standard icons, symbols and other figures. By selecting 'Figures' from the 
Settings menu, you can also select additional folders that contain yourpersonal sets image files that you 
can use as figures 

Select area - Save as figure 
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6.10 Import (image from file, svg and figure)

There are several ways in which you can add an image to your TactileView design.

When you regularly use the same icons or images, 'Add figure'
Saved SVG image files can be added with 'Import SVG'
Saved jpg, png or other bitmap images are added with 'Import image from file'

These import functions are activated by selecting 'Import' from the left vertical toolbar, then selecting the
specific tool from the right vertical toolbar.

'Import' icon: 

'Import SVG' icon: 

'Import image from file' icon: 

Add figure

Figures are image objects that are useful when you wish to reuse certain symbols and shapes (such as
arrows, electrical symbols, more abstract shapes, etc) in multiple documents. Once you have activated the
'Add figure' drawing tool, a dialog will appear in which you can You can browse through the different
categories and select the figure you wish to use.

Once you click 'OK' to confirm your choice, the figure will be visible at the position of your mouse. Click
anywhere to place the figure as an object in your design.If the object is not the desired size when it
appears in the design area, you can edit it by dragging the purple markers on the corners and sides.

Settings - personal figures folder
TactileView contains a set standard icons, symbols and other figures. By selecting 'Figures' from the
Settings menu, you can also select additional folders that contain your personal sets image files that you
can use as figures.

Select area - Save as figure
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When using the Select area tool, you can select 'Save as figure' from the context menu or properties 
toolbar. This saves the selected area as a figure that can later be reused and will include the bitmap layer 
as well as any objects within the selection. Keep in mind that text labels are not included in the figure. 
See the manual section 'select area' for more information. 

Select a Figure 

Select an item 

9. arrows 
0 dosed arrows 
CI open arrows 

open arrow 0 i.png 
open arrow 02.png 
open arrow 03.png 
open arrow 04.png 

chess pieces 
rfl.. electrical symbols 

OD- signs 

0 small symbols 
• personal folder 
Tactileview website 

Search: 

Open arrow 
01 

22 cm x 9 cm 

Open arrow 
02 

23 cm x 11 cm 

Open arrow 
03 

20 cm x 17 cm 

Open arrow 
04 

22 cm x 9 cm 

Cancel 

Figure 1. From the dialog, choose one of the figures to insert in your design; click on the image to 
enlarge. 

Import SVG and Import image from file 

Vector graphics (svg files) as well as bitmap image files (jpg, png, bmp, etc.) can be imported in your 
design by selecting 'Import SVG' or 'Import image from file'. In the dialog that opens, browse to the 
image file you wish to use and double click or select 'Open' to confirm the selection. Next, click anywhere 
to place the image as an object in the design. You can use the purple markers on the corners in case the 
image needs to be resized. 
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When using the Select area tool, you can select 'Save as figure' from the context menu or properties
toolbar. This saves the selected area as a figure that can later be reused and will include the bitmap layer
as well as any objects within the selection. Keep in mind that text labels are not included in the figure.
See the manual section 'Select area' for more information.

Figure 1. From the dialog, choose one of the figures to insert in your design; click on the image to
enlarge.

Import SVG and Import image from file

Vector graphics (svg files) as well as bitmap image files (jpg, png, bmp, etc.) can be imported in your
design by selecting 'Import SVG' or 'Import image from file'. In the dialog that opens, browse to the
image file you wish to use and double click or select 'Open' to confirm the selection. Next, click anywhere
to place the image as an object in the design. You can use the purple markers on the corners in case the
image needs to be resized.
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6.11 Draw mammoth braille 

The dots of braille characters normally have a fixed distance, but this can be enlarged. In TratileView, the 
greatly enlarged braille is called 'mammoth braille' to distinguish from Jumbo braille (braille with 
increased dot distance). 

NOTE: Mammoth braille is not used to place braille texts in the design, but could be used for Turf 
applications such as writing a name in a large braille character type. The braille dots will be displayed in 
blue on screen. The character that is represented by the dots is shown in grey behind the braille dots. 

To draw a large braille in the design, select the Draw mammoth braille' icon from the left vertical toolbar. 
Click in the design where you wish to place the mammoth braille. Enter the contents in the dialog that 
appears and click 'OK'. You can use the purple markers to maize the enlarged braille. 

Mammoth braille, icon: Pfr 

• • • • • • • • • • 

L-n a • • • • • 
• • 

• • • • • • • 
• • • • • • • 

• • • 

Figure I. Mammoth braille inserted in the design. 

• • • • 
• • • • 

• • 

• • • • 
rai • C• 
• • ill 

Figure 2. The dot size of MlIMMOth braille care k enlarged, as opposed to regular braille 
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6.11 Draw mammoth braille

The dots of braille characters normally have a fixed distance, but this can be enlarged. In TactileView, the
greatly enlarged braille is called 'mammoth braille' to distinguish from Jumbo braille (braille with
increased dot distance).

NOTE: Mammoth braille is not used to place braille texts in the design, but could be used for 'fun'
applications such as writing a name in a large braille character type. The braille dots will be displayed in
blue on screen. The character that is represented by the dots is shown in grey behind the braille dots.

To draw a large braille in the design, select the 'Draw mammoth braille' icon from the left vertical toolbar.
Click in the design where you wish to place the mammoth braille. Enter the contents in the dialog that
appears and click 'OK'. You can use the purple markers to resize the enlarged braille.

'Mammoth braille' icon: 

Figure 1. Mammoth braille inserted in the design.

Figure 2. The dot size of mammoth braille can be enlarged, as opposed to regular braille.
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Idp • 0, 
'Braille dot size' icon. " 
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'Braille dot size' icon: 
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6.12 Draw letters and digits 

NOTE: Keep in mind that this drawing tool is not intended to present texts in braille, but as a tool to show 
the contours and shapes of visual text characters. Various font types and font sizes can be used to 
illustrate font attributes such as serif italic orbold 

To draw a text in the design, select the 'Draw letters and digits' icon from the left vertical toolbar. Click in 
the design where you wish to place the large text Enter the contents in the dialog that appears and click 
'Or. You can use the purple markers to reaize the text, which should be large enough for tactile use to 
distinguish the characters. 

Draw letters and digits' icon: 
Txt 

letters 
and digits 

Figure 1. Add large test to your design with Draw letters and digits' 

font 
. 

size 
Figure 2. Font type and size for letters and digits can be adjusted 

AAA 
'F ant type and size' icon: 
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6.12 Draw letters and digits

NOTE: Keep in mind that this drawing tool is not intended to present texts in braille, but as a tool to show
the contours and shapes of visual text characters. Various font types and font sizes can be used to
illustrate font attributes such as serif, italic or bold.

To draw a text in the design, select the 'Draw letters and digits' icon from the left vertical toolbar. Click in
the design where you wish to place the large text. Enter the contents in the dialog that appears and click
'OK'. You can use the purple markers to resize the text, which should be large enough for tactile use to
distinguish the characters.

'Draw letters and digits' icon: 

Figure 1. Add large text to your design with 'Draw letters and digits'

Figure 2. Font type and size for letters and digits can be adjusted.

'Font type and size' icon: 
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6.13 Editing object properties 

The drawing tools for placing objects described in the previous manual sections, allow you to place 
objects by clicking and dragging in the drawing area. The blue colour will indicate that an element in the 
design is an object. Below, you can find the common properties that are shared by these objects in 
TactileView. 

Properties in right vertical icon bar 

As soon as the drawing tool is activated in the left icon bar, or when the object is placed or is selected in 
the design, the properties icon bar for that selection will appear. For most objects, the first icon in this bar 
allows you to determine the size and position by entering the values via edit fields. 

'Size and position' icon: L/ I:(

Resizing objects (all object types) 

Purple markers can be found on the corners and along the sides of the object. By dragging the markers on 
one of the four sides, you can adjust the width or height. For example, a square will become a rectangle. 
The markers in all four corners will scale the entire shape (both the width and height) maintaining the 
same aspect ratio. 

For polygons and freehand lines, a red dashed box will appear around the object. The markers on the 
corners and sides of this box can be used to resize the entire object. The purple markers on the corners of 
the polygon or anchor points of the line are used to adjust the shape of the object. 

Alternatively, all objects can be resized by selecting 'Size and position' (or similar) from the context menu 
or properties toolbar. In the 'Size' section of the dialog, choose the 'Enlarge/Reduce' radio button if you 
want to scale the entire object, or 'Stretch' to independently adjust the width and size without retaining 
their ratio. Next, specify the desired width or height and choose 'OK' to resize the object. 
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6.13 Editing object properties

The drawing tools for placing objects described in the previous manual sections, allow you to place
objects by clicking and dragging in the drawing area. The blue colour will indicate that an element in the
design is an object. Below, you can find the common properties that are shared by these objects in
TactileView.

Properties in right vertical icon bar

As soon as the drawing tool is activated in the left icon bar, or when the object is placed or is selected in
the design, the properties icon bar for that selection will appear. For most objects, the first icon in this bar
allows you to determine the size and position by entering the values via edit fields.

'Size and position' icon: 

 

Resizing objects (all object types)

Purple markers can be found on the corners and along the sides of the object. By dragging the markers on
one of the four sides, you can adjust the width or height. For example, a square will become a rectangle.
The markers in all four corners will scale the entire shape (both the width and height) maintaining the
same aspect ratio.

For polygons and freehand lines, a red dashed box will appear around the object. The markers on the
corners and sides of this box can be used to resize the entire object. The purple markers on the corners of
the polygon or anchor points of the line are used to adjust the shape of the object.

Alternatively, all objects can be resized by selecting 'Size and position' (or similar) from the context menu
or properties toolbar. In the 'Size' section of the dialog, choose the 'Enlarge/Reduce' radio button if you
want to scale the entire object, or 'Stretch' to independently adjust the width and size without retaining
their ratio. Next, specify the desired width or height and choose 'OK' to resize the object.
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Figure I. Red2ing a square :rasing the purple mashers. 

Moving objects (all object types) 

You can move objects by holding the left mouse button and dragging it to anoticrpositicm, as indicated 
by the four-way arrow cursor. A gm= line will indicate the distance over which tic object has moved. 
For more precise placement, you can use the arrow keys to move tic object by 1 pixel or Shift-Earrow 
keys for steps of 10 pixels. 
Alternatively, select 'Size and position' (or similar) from the properties toolbar or context menu of an 
object to enter the position values via the 'Size and position' dialog. Enter the position relative to the top 
left corner of the design and click 'OK' to reposition the object. 

Two additional functions in the properties toolbar help you to position an object in a specific way: you 
can either choose to horizontally centre it in the design, or only move it horizontally, vertically or 
diagonally (alternative: hold shift while moving the object). 
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Figure 1. Resizing a square using the purple markers.

Moving objects (all object types)

You can move objects by holding the left mouse button and dragging it to another position, as indicated
by the four-way arrow cursor. A green line will indicate the distance over which the object has moved.
For more precise placement, you can use the arrow keys to move the object by 1 pixel or Shift+arrow
keys for steps of 10 pixels.
Alternatively, select 'Size and position' (or similar) from the properties toolbar or context menu of an
object to enter the position values via the 'Size and position' dialog. Enter the position relative to the top
left corner of the design and click 'OK' to reposition the object.

Two additional functions in the properties toolbar help you to position an object in a specific way: you
can either choose to horizontally centre it in the design, or only move it horizontally, vertically or
diagonally (alternative: hold shift while moving the object).
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Figure 2. The green line indicates the moved distance when nerving an object with the mouse 

'Centre' icon: 

Restrict to horizontal vertical or diagonal movement' 

Rotation 

The object can rotate over 360 degrees. Scrolling with the mouse while holding down the Shift key will 
ro tate p er 5 degrees, or use Shill.+Ctri-Emouse wheel for more nominate rotation per degree. You can also 
set the rotation to a certain value by choosing the 'Rotation' icon and entering the angle in the dialog that 
appears. 

Rotation' icon: 
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Figure 2. The green line indicates the moved distance when moving an object with the mouse.

'Centre' icon: 

'Restrict to horizontal, vertical or diagonal movement' icon: 

Rotation

The object can rotate over 360 degrees. Scrolling with the mouse while holding down the Shift key will
rotate per 5 degrees, or use Shift+Ctrl+mouse wheel for more accurate rotation per degree. You can also
set the rotation to a certain value by choosing the 'Rotation' icon and entering the angle in the dialog that
appears.

'Rotation' icon: 
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Line style part 1: Solid and dashed lines 

The outer border of the object will be a solid line of a certain (narrow) thickness. The line style will allow 
fora variation in pattern, thickness and texture for the border. Choose 'Line style' from the properties 
toolbar, then select your style elements from the dialog. 

To change the line style, select the object and choose 'Line style' from tic properties tool bar or contact 
menu. In the dialog that opens, you can set the line properties for the object, including the line pattern 
(solid or dashed) and thickness in pixels. Tic dialog includes a preview of how your line will look as you 
make changes. Choose 'OK' to apply your changes to the object and close the dialog. 

Keep in mind that thicker hues do not always benefit the tactile usability of your design; it is best to 
experiment which line styles work best for your embosser or printer. 

r 

L 

Figure 3. Squares with different line styles: caniinuaus lines (default) or &shed line style 

'Line style' icon: / 

Line style part 2: Line textures 

Besides solid and dashed line styles, you can also apply different line textures to the object outline. These 
incluse a series of waves, zigzag lines, double limit and various other patterns. To apply a line texture to 
the object, first choose 'Lire style' from the properties toolbar or context =rat. In tic dialog. set the radio 
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Line style part 1: Solid and dashed lines

The outer border of the object will be a solid line of a certain (narrow) thickness. The line style will allow
for a variation in pattern, thickness and texture for the border. Choose 'Line style' from the properties
toolbar, then select your style elements from the dialog.

To change the line style, select the object and choose 'Line style' from the properties tool bar or context
menu. In the dialog that opens, you can set the line properties for the object, including the line pattern
(solid or dashed) and thickness in pixels. The dialog includes a preview of how your line will look as you
make changes. Choose 'OK' to apply your changes to the object and close the dialog.

Keep in mind that thicker lines do not always benefit the tactile usability of your design; it is best to
experiment which line styles work best for your embosser or printer.

Figure 3. Squares with different line styles: continuous lines (default) or dashed line style.

'Line style' icon: 

 

Line style part 2: Line textures

Besides solid and dashed line styles, you can also apply different line textures to the object outline. These
incluse a series of waves, zigzag lines, double lines and various other patterns. To apply a line texture to
the object, first choose 'Line style' from the properties toolbar or context menu. In the dialog, set the radio
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button under 'Line texture' to 'Apply line texture'. Next, click the button 'Choose texturd to select the 
specific line texture you wish to use. 

Most line textures require a sufficiently large line thickicas to fed the characteristics of the pattern. The 
tactile result may vary for each embosser model or type of awellpaper, so it is advisable to experiment 
with different textures and sizes to get a feel for which settings work best for your embosser orprinter. 

Squares, triangles and polygons have straight lima that meet at the corners. Depending on the length of 
the line segment, the line pattern repeats a certain number of times and starts again on the next lirc 
segment. This means that the line pattern of the two line segments may not always j oin exactly in the 
corners. This effect is more prominent with some patterns but less noticeable in others. 

 MI6 

Figure 4. Wow line tacture wiled as the tine style for a square. 
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button under 'Line texture' to 'Apply line texture'. Next, click the button 'Choose texture' to select the
specific line texture you wish to use.

Most line textures require a sufficiently large line thickness to feel the characteristics of the pattern. The
tactile result may vary for each embosser model or type of swellpaper, so it is advisable to experiment
with different textures and sizes to get a feel for which settings work best for your embosser or printer.

Squares, triangles and polygons have straight lines that meet at the corners. Depending on the length of
the line segment, the line pattern repeats a certain number of times and starts again on the next line
segment. This means that the line pattern of the two line segments may not always join exactly in the
corners. This effect is more prominent with some patterns but less noticeable in others.

Figure 4. Wave line texture applied as the line style for a square.
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Surface properties part 1: FiJi style - Texture 

The Fill style will give you a wide variety of textures that add a tactilepattern in to the surface of the 
object. Thepattern can be selected based on thepreview. The patterns axe made of repeated tiles. The tile 
size can be set to determine the fineness of the texture. The pattern can have its own rotation within the 
object, independent from theposition and rotation of the object This enables even more variation in 
textures, as the same texture can be used in various rotations, giving a different tactile experience. 

In the dialog that opens you can set the fill properties, including selecting the fill texture style as well as 
its size and rotation angle. 

If you wish to add a fill texture to the selected object, select the object. and choose 'Fill style; texture from 
theproperties toolbar or context menu. In the dialog that opens, select the 'Use texture fill' radio button. 
Next, click on the Choose texture' button to open the list of available textures. Choose a texture from the 
list and click 'OK' to confirm. A preview of the chosen texture appeats in the 'Fill style dialog. 

Use the 'Tile size and Texture rotation angle edit boxes to scale and rotate the texture. The relief height 
of the texture as well as the surface area in between can be adjusted when supported for the selected 
embosser. When you are finished making changes, choose 'OK' to apply the fill style. 

Figure 5. Squares with different fill styles: no fill style (default) and diagonal lines. 

'Fillstyle: texture' icon: • 
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Surface properties part 1: Fill style - Texture

The Fill style will give you a wide variety of textures that add a tactile pattern in to the surface of the
object. The pattern can be selected based on the preview. The patterns are made of repeated tiles. The tile
size can be set to determine the fineness of the texture. The pattern can have its own rotation within the
object, independent from the position and rotation of the object. This enables even more variation in
textures, as the same texture can be used in various rotations, giving a different tactile experience.

In the dialog that opens you can set the fill properties, including selecting the fill texture style as well as
its size and rotation angle.

If you wish to add a fill texture to the selected object, select the object and choose 'Fill style: texture' from
the properties toolbar or context menu. In the dialog that opens, select the 'Use texture fill' radio button.
Next, click on the 'Choose texture' button to open the list of available textures. Choose a texture from the
list and click 'OK' to confirm. A preview of the chosen texture appears in the 'Fill style' dialog.

Use the 'Tile size' and 'Texture rotation angle' edit boxes to scale and rotate the texture. The relief height
of the texture as well as the surface area in between can be adjusted when supported for the selected
embosser. When you are finished making changes, choose 'OK' to apply the fill style.

Figure 5. Squares with different fill styles: no fill style (default) and diagonal lines.

'Fill style: texture' icon: 
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Surface properties part 2: Transparency 

The transparency of an object determines whether or not it will cow underlying object. In case the object 
is transparent, only the border is visible. All parts of tic design that are overlapped by the object are still 
visible. 

In case the object is non-transparent, all that is inside the object is covered by the white iffier surface of 
the non-transparent object. Keep in mind that nen-transparent objects might (completely) cow other 
elements in the design. You can change the order in which they are presented to determine which one is 
on top of the other. 

See also: Innapnexiadthaszelaagriange 

Mate olject transparent' icon: 

'Mate °Wet:non-transparent' y'ea n: fZ1

Surface properties part 3: Fill style - colour 

For production of tic design on swellpaper, objects can have a colour as well. Select the desired colour 
from the dialog 'Fill style: Colour'. Keep in mind that most embossers do not support priming in 
(coloured} ink, so this function does net apply to production with braille only. 

'nil style: colour' icon:
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Surface properties part 2: Transparency

The transparency of an object determines whether or not it will cover underlying object. In case the object
is transparent, only the border is visible. All parts of the design that are overlapped by the object are still
visible.

In case the object is non-transparent, all that is inside the object is covered by the white inner surface of
the non-transparent object. Keep in mind that non-transparent objects might (completely) cover other
elements in the design. You can change the order in which they are presented to determine which one is
on top of the other.

See also: 'Transparency and object stacking'

'Make object transparent' icon: 

'Make object non-transparent' icon: 

Surface properties part 3: Fill style - colour

For production of the design on swellpaper, objects can have a colour as well. Select the desired colour
from the dialog 'Fill style: Colour'. Keep in mind that most embossers do not support printing in
(coloured) ink, so this function does not apply to production with braille only.

'Fill style: colour' icon: 
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Audio information 

The 'Audio style function is used to add audible information to an object, giving the object an extra gayer' 
of information. This layer consists of a text. that is pronounced by a speech synthesizer (1  This 
functionality is used to create an audio-tactile diagram and can be explored using the TgetileView 
ClickPad or TactiPad combined with the TgetileView digital pen. 

See also: 'Using audio sty12 

9  
Audio style' icon:

Relief height 

The relief height for the outline, surface and texture of obj ects can be selected separately. Keep in mind 
that. this functionality is only available in the properties toolbar when using an embosser that supports 
variable dot height. 

See also: thing variable relief height 

Relit(' height: line, surface and texture' icons: 

Deleting objects 

  iii 

You can delete the entire object by selecting 'Delete' in the properties toolbar or context menu, or by 
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Audio information

The 'Audio style' function is used to add audible information to an object, giving the object an extra 'layer'
of information. This layer consists of a text that is pronounced by a speech synthesizer (TTS). This
functionality is used to create an audio-tactile diagram and can be explored using the TactileView
ClickPad or TactiPad combined with the TactileView digital pen.

See also: 'Using audio styles'

'Audio style' icon: 

Relief height

The relief height for the outline, surface and texture of objects can be selected separately. Keep in mind
that this functionality is only available in the properties toolbar when using an embosser that supports
variable dot height.

See also: Using variable relief height

'Relief height: line, surface and texture' icons:   

 

Deleting objects

You can delete the entire object by selecting 'Delete' in the properties toolbar or context menu, or by
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using the Delete key. When you only want to remove parts of an object, you first have to fuse it with the 
bitmap (Ctrl+B or 'Fuse with bitmap' from the properties toolbar or context menu). After this you can use 
the eraser tool to remove parts from the object. 

'Delete' icon: x 
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using the Delete key. When you only want to remove parts of an object, you first have to fuse it with the
bitmap (Ctrl+B or 'Fuse with bitmap' from the properties toolbar or context menu). After this you can use
the eraser tool to remove parts from the object.

'Delete' icon: 
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6.14 Using audio styles 

Audio styles a great way to add more information to a drawing without having to make it larger to 
accommodate more text or graphical information. The audio information is accessed by using tic file in 
explore mode, either on screen with a mouse or on a tactile copy on the Click pad or Tactipad with tic 
digital pen. For more information on explore made, please refer to the Using Explore Mode and Using tic 
Pen in Explore Mode with the Clickpad or Tacapad tutorials. 

Audio styles can be added to any type of drawing object in TactileView (figures, squares, circles, dots, 
detected area, etc.). Audio styles may not be added to test labels, because test labels are automatically 
voiced by text-to-speech when tic file is used in I:apiary nude (tic text contents of the label is used as an 
audio style). 

Adding an audio style to be voiced by text-to-speech 

To aid an audio style to be voiced by text-to-speed to an object, select the object and then choose tic 
'Audio style' icon from the properties toolbar on the left aide of the screen or right-click the object and 
Oleo= 'Audio style' from the context menu. This will blanch an audio style dialog, the top section of 
which allows you to specify the text to be voiced by synthetic speech from one of several winces. 

The default choice is the 'Self defined text' radio button, which allows you to type tic text you want 
voiced into the text field on the dialog. If you have text saved in a text file that you would like voiced 
instead, you can select the 'Text from local file' radio button, tin choose tic 'Browse' button to browse to 
and select your text file (.txt file). Once you have specified the text, you can check hew the audio style 
will sound by selecting tic Test audio style' button. Win you are finished making changes, choose the 
'OK' button to close the dialog and apply the audio style. Tic object will be shaded light pink to indicate 
that an audio style is associated with it. 

• • 

• • 

Figure 1. The light pink colour signtges an audio style is associated with the circle. 
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6.14 Using audio styles

Audio styles a great way to add more information to a drawing without having to make it larger to
accommodate more text or graphical information. The audio information is accessed by using the file in
explore mode, either on screen with a mouse or on a tactile copy on the Clickpad or Tactipad with the
digital pen. For more information on explore mode, please refer to the Using Explore Mode and Using the
Pen in Explore Mode with the Clickpad or Tactipad tutorials.

Audio styles can be added to any type of drawing object in TactileView (figures, squares, circles, dots,
detected area, etc.). Audio styles may not be added to text labels, because text labels are automatically
voiced by text-to-speech when the file is used in explore mode (the text contents of the label is used as an
audio style).

Adding an audio style to be voiced by text-to-speech

To add an audio style to be voiced by text-to-speech to an object, select the object and then choose the
'Audio style' icon from the properties toolbar on the left side of the screen or right-click the object and
choose 'Audio style' from the context menu. This will launch an audio style dialog, the top section of
which allows you to specify the text to be voiced by synthetic speech from one of several sources.

The default choice is the 'Self defined text' radio button, which allows you to type the text you want
voiced into the text field on the dialog. If you have text saved in a text file that you would like voiced
instead, you can select the 'Text from local file' radio button, then choose the 'Browse' button to browse to
and select your text file (.txt file). Once you have specified the text, you can check how the audio style
will sound by selecting the 'Test audio style' button. When you are finished making changes, choose the
'OK' button to close the dialog and apply the audio style. The object will be shaded light pink to indicate
that an audio style is associated with it.

Figure 1. The light pink colour signifies an audio style is associated with the circle.
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Attaching an existing sound file to an object 

You can also attach an existing sound file to an object to have it played when the object is clicked while 
the file is in explore mode. In the audio style dialog, the bottom section allows you to specify a sound file 
to be used as an audio style. 

The default choice is the 'Local file' radio button, which is used to attach a sound file to the object as an 
audio style. Select the 'Browse URL' button, locate the sound file you would like to use on your computer 
and select it. The file path to the sound file will now appear in the text field below the sound file type 
selection radio buttons. You can check how the audio style will sound by selecting the 'Test audio style' 
button. When you are fmished making changes, choose the 'OK' button to close the dialog and apply the 
audio style. The light pink colour will now indicate an audio style is associated with the object. 

NOTE: 
If you have both a text-to-speech audio style and a sound file audio style attached to the same object, the 
text-to-speech will be voiced first and the sound file will play after it. 

Recording an audio style from a microphone 

Audio styles recorded from a microphone are played when the object is clicked with the mouse or digital 
pen while using the file in explore mode. Recorded styles are played after any text-to-speech styles are 
voiced. Before recording, you will need to ensure that you have a microphone connected to your 
computer. You can connect your microphone via the 'Microphone' dialog in the Settings menu. 

When you have connected a microphone to your computer, you can record an audio style for an object by 
selecting the object, then choosing the 'Record microphone' icon from the properties toolbar on the left 
side of the screen, or by right-clicking the object and choosing 'Record microphone' from the context 
menu. As soon as you select this, recording begins and the icon in the tool bar changes to the 'Stop 
recording' icon. When you have finished speaking into the microphone, choose the 'Stop recording' icon 
from the tool bar or right-click the object and select 'Stop recording' from the context menu to stop the 
recording. Your recording will play back automatically as soon as you stop the recording, and the object 
will be shaded light pink to indicate that an audio style is associated with it. 
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Attaching an existing sound file to an object

You can also attach an existing sound file to an object to have it played when the object is clicked while
the file is in explore mode. In the audio style dialog, the bottom section allows you to specify a sound file
to be used as an audio style.

The default choice is the 'Local file' radio button, which is used to attach a sound file to the object as an
audio style. Select the 'Browse URL' button, locate the sound file you would like to use on your computer
and select it. The file path to the sound file will now appear in the text field below the sound file type
selection radio buttons. You can check how the audio style will sound by selecting the 'Test audio style'
button. When you are finished making changes, choose the 'OK' button to close the dialog and apply the
audio style. The light pink colour will now indicate an audio style is associated with the object.

NOTE:
If you have both a text-to-speech audio style and a sound file audio style attached to the same object, the
text-to-speech will be voiced first and the sound file will play after it.

Recording an audio style from a microphone

Audio styles recorded from a microphone are played when the object is clicked with the mouse or digital
pen while using the file in explore mode. Recorded styles are played after any text-to-speech styles are
voiced. Before recording, you will need to ensure that you have a microphone connected to your
computer. You can connect your microphone via the 'Microphone' dialog in the Settings menu. 

When you have connected a microphone to your computer, you can record an audio style for an object by
selecting the object, then choosing the 'Record microphone' icon from the properties toolbar on the left
side of the screen, or by right-clicking the object and choosing 'Record microphone' from the context
menu. As soon as you select this, recording begins and the icon in the tool bar changes to the 'Stop
recording' icon. When you have finished speaking into the microphone, choose the 'Stop recording' icon
from the tool bar or right-click the object and select 'Stop recording' from the context menu to stop the
recording. Your recording will play back automatically as soon as you stop the recording, and the object
will be shaded light pink to indicate that an audio style is associated with it.
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NOTE: 
Each object may only have one text-to-speech audio style and one recorded or sound file audio style 
associated with it. If you record an audio style for an object, it will replace any existing sound file you 
may have associated with that object previously. 

Editing an existing audio style 

To edit any type of audio style, select the object with the audio style you want to edit and then choose the 
Audio Style icon from the tool bar on the left side of the screen or right-click the object and choose Audio 
Style from the context menu. This will launch the same audio style dialog you used to create a text-to-
speech audio style or attach an existing sound file. 

To edit a synthesized speech audio style from self-defined text, edit the text in the text field. You can also 
remove the text-to-speech audio style by deleting the text from the text field in the top section of the 
dialog. 

To edit a synthesized speech audio style from text from a local file, you will need to edit the text within 
the text file itself. To load text from a different file, select the Browse button, locate the new text file you 
would like to use and select it. You can also remove this audio style by deleting the file path to the local 
file from the text field in the top section of the dialog. 

To edit an audio style played from a sound file, choose the 'Browse URL' button, browse to a different 
sound file on your computer and select it. It will replace the previous sound file, including any sound file 
recorded from a microphone, as the audio style for that object. To remove the sound file audio style, 
delete the file path of the sound file from the text field in the bottom section of the dialog. 

When you are finished making changes, choose the 'OK' button to close the dialog and apply your 
changes. 

If you would like to re-record an audio style from your microphone, simply follow the steps given above 
for recording from a microphone. You do not need to open the audio style dialog to do this. Please 
remember that recording an audio style for an object from the microphone will overwrite any other sound 
file audio style for that object. 
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NOTE:
Each object may only have one text-to-speech audio style and one recorded or sound file audio style
associated with it. If you record an audio style for an object, it will replace any existing sound file you
may have associated with that object previously.

Editing an existing audio style

To edit any type of audio style, select the object with the audio style you want to edit and then choose the
Audio Style icon from the tool bar on the left side of the screen or right-click the object and choose Audio
Style from the context menu. This will launch the same audio style dialog you used to create a text-to-
speech audio style or attach an existing sound file.

To edit a synthesized speech audio style from self-defined text, edit the text in the text field. You can also
remove the text-to-speech audio style by deleting the text from the text field in the top section of the
dialog.

To edit a synthesized speech audio style from text from a local file, you will need to edit the text within
the text file itself. To load text from a different file, select the Browse button, locate the new text file you
would like to use and select it. You can also remove this audio style by deleting the file path to the local
file from the text field in the top section of the dialog.

To edit an audio style played from a sound file, choose the 'Browse URL' button, browse to a different
sound file on your computer and select it. It will replace the previous sound file, including any sound file
recorded from a microphone, as the audio style for that object. To remove the sound file audio style,
delete the file path of the sound file from the text field in the bottom section of the dialog.

When you are finished making changes, choose the 'OK' button to close the dialog and apply your
changes.

If you would like to re-record an audio style from your microphone, simply follow the steps given above
for recording from a microphone. You do not need to open the audio style dialog to do this. Please
remember that recording an audio style for an object from the microphone will overwrite any other sound
file audio style for that object.
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6.15 Using variable relief height 

Some braille embosser models allow you to use different relief heights for the braille dots. In 
TactileView, this relief height can be applied to the blue objects (squares, blue lima, triangles, etc.) as 
well as the Detect shape tool, tables and graphs. 

To find out which embossers are capable of embossing different dot heights, see' Properties of different 
braille embossers. 

For a full overview of all object properties, sea FAiting object propertio. 

Relief height line, surface and texture 

Normally, objects will be embossed using the highest dot height, as this usually gives tic beat tactile 
quality. In tic case of image files, the colours of the image will be converted to different dot heights, 
where lighter colours result in lower dot Icight. This is the default setting for relief height and can always 
be selected as dot height by choosing 'Standard' as the value. 

In TactileView, the relief height can be selected separately for the different components of objects. 
Firstly, you can select a dot height for the outline of the object Secondly, tic surf= area of the object 
(i.e. the area within the outline of tic object) can be given a separate height. Finally, if the object has a 
texture fill style, it can have a different relief height as well. 

You can directly edit the relief height for the line, surface and tekture by selecting 'Relief height: line, 
'Relief height: surface' or 'Relief height: texture' from the properties toolbar or the context mural of the 
object The dot height for the line can also be found in tic 'Lily style' dialog, whereas the dot height for 
the surf= and texture can be found in tic 'Fill style texture' dialog. 

The different dot heights are shown in the design using different shades of blue a lighter shade signifies a 
low dot height, whereas a darker shade corresponds with a higher dot height. 

For graphs, you can select the relief height for the grid lines to make them less prominent and distinguish 
them from tic axes and graph lines. By default, these grid lima will already have a lower value you can 
edit the relief lcight by selecting 'Size and position' from the graph's properties toolbar or context menu. 

  -g4!Retie-height line, nuface and te:cture" 'cuts: n iii 
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6.15 Using variable relief height

Some braille embosser models allow you to use different relief heights for the braille dots. In
TactileView, this relief height can be applied to the blue objects (squares, blue lines, triangles, etc.) as
well as the Detect shape tool, tables and graphs.

To find out which embossers are capable of embossing different dot heights, see: Properties of different
braille embossers.

For a full overview of all object properties, see: Editing object properties.

Relief height: line, surface and texture

Normally, objects will be embossed using the highest dot height, as this usually gives the best tactile
quality. In the case of image files, the colours of the image will be converted to different dot heights,
where lighter colours result in lower dot height. This is the default setting for relief height and can always
be selected as dot height by choosing 'Standard' as the value.

In TactileView, the relief height can be selected separately for the different components of objects.
Firstly, you can select a dot height for the outline of the object. Secondly, the surface area of the object
(i.e. the area within the outline of the object) can be given a separate height. Finally, if the object has a
texture fill style, it can have a different relief height as well.

You can directly edit the relief height for the line, surface and texture by selecting 'Relief height: line',
'Relief height: surface' or 'Relief height: texture' from the properties toolbar or the context menu of the
object. The dot height for the line can also be found in the 'Line style' dialog, whereas the dot height for
the surface and texture can be found in the 'Fill style: texture' dialog.

The different dot heights are shown in the design using different shades of blue: a lighter shade signifies a
lower dot height, whereas a darker shade corresponds with a higher dot height.

For graphs, you can select the relief height for the grid lines to make them less prominent and distinguish
them from the axes and graph lines. By default, these grid lines will already have a lower value; you can
edit the relief height by selecting 'Size and position' from the graph's properties toolbar or context menu.

'Relief height: line, surface and texture' icons:   
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Figure 1. Different dot heights are shown with different shades of blue in the design. 

F
Figure 2. The grid bates in a graph have a lower dat hetet: than the axes as shown with the lighter blue 
colour. 

Use contrast for tactile usability 

Although the dot height can be set to 8 different heights, in reality the increments between these steps are 
very small. This means there will nut be a distinguishable twine difference between a dot height of 3 and 
4. It is advisable to use sufficient contrast in relief height between different elements; for example, a value 
of 8 for the outline of as object and value of 2 for its surfer-v. 
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Figure 1. Different dot heights are shown with different shades of blue in the design.

Figure 2. The grid boxes in a graph have a lower dot height than the axes, as shown with the lighter blue
colour.

Use contrast for tactile usability

Although the dot height can be set to 8 different heights, in reality the increments between these steps are
very small. This means there will not be a distinguishable tactile difference between a dot height of 3 and
4. It is advisable to use sufficient contrast in relief height between different elements; for example, a value
of 8 for the outline of an object and value of 2 for its surface.
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Compatibility with other embossers 

The relief height properties of objects are only available when you have a printer selected that supports 
variable dot height via menu File > Print Setup. A message will notify you when a document is opened 
that contains objects with variable relief height, but the selected embosser does not support this property. 
The variable relief height will still be visible in the design using lighter and darker shades of blue, but it is 
important to remember that the tactile output of the embosser or printer will differ: the outline and texture 
of the object will be embossed, but the relief height of the object's surface will have no relief height. 

In this situation, you can only edit the relief height for existing objects with a relief height not set to 
'default'. Once you set it to 'default', the relief height property of the object will no longer be available 
until you have an embosser selected that does support variable dot height. 
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Compatibility with other embossers

The relief height properties of objects are only available when you have a printer selected that supports
variable dot height via menu File > Print Setup. A message will notify you when a document is opened
that contains objects with variable relief height, but the selected embosser does not support this property.
The variable relief height will still be visible in the design using lighter and darker shades of blue, but it is
important to remember that the tactile output of the embosser or printer will differ: the outline and texture
of the object will be embossed, but the relief height of the object's surface will have no relief height.

In this situation, you can only edit the relief height for existing objects with a relief height not set to
'default'. Once you set it to 'default', the relief height property of the object will no longer be available
until you have an embosser selected that does support variable dot height.
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7.01 Differences between the text tools 

In TactileView, there are 3 drawing tools that allow you to place tactile tests in your design, each with a 
distinctly different application: 

1. Text labels; regular braille tests using one of the following input methods: 

• Computer keyboard input; regular text input converted to braille output 
• Braille keyboard input: direct input of braille characters using Perkins style braille keyboard 
• Math input; use an equation editor or the keyboard as input for mathematical braille notation 

2. Mammoth braille. greatly enlarged braille characters 
3. Draw letters and digits large visual test characters 

Once a text label is placed in the design it is preceded by a round coloured marker that signifies the input 
method. Computer keyboard input is signified by a green marker, braille keyboard input with orange and 
math input with blue-grey. By hovering over the marker with the mouse, a tooltip will show extra 
information about the text label. A marker with a white centre indicates the label is transparent. 

'Canputerkeyboani input' lain: r6c 

'Muffle laybowd input' icon: !In."1

'Math input' icon: TS*

Printing braille text 
The braille output differs slightly for each production method (swellpaper or different models of 
embossers). See the manual =lions Prialing_wittudnuillaambunna or niniinLeamaillpain to find out 
the specific settings for your procluction method. 
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7.01 Differences between the text tools

In TactileView, there are 3 drawing tools that allow you to place tactile texts in your design, each with a
distinctly different application:

1. Text labels; regular braille texts using one of the following input methods:

Computer keyboard input; regular text input converted to braille output
Braille keyboard input; direct input of braille characters using Perkins style braille keyboard
Math input; use an equation editor or the keyboard as input for mathematical braille notation

2. Mammoth braille; greatly enlarged braille characters
3. Draw letters and digits; large visual text characters

Once a text label is placed in the design it is preceded by a round coloured marker that signifies the input
method. Computer keyboard input is signified by a green marker, braille keyboard input with orange and
math input with blue-grey. By hovering over the marker with the mouse, a tooltip will show extra
information about the text label. A marker with a white centre indicates the label is transparent.

'Computer keyboard input' icon: 

'Braille keyboard input' icon: 

'Math input' icon: 

Printing braille text
The braille output differs slightly for each production method (swellpaper or different models of
embossers). See the manual sections Printing with a braille embosser or Printing on swellpaper to find out
the specific settings for your production method.
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7.02 Settings - Braille tables 

With the 6 dots of regular braille, only 63 different combinations can be made (not including the space 
character). However, the languages from around the world use a far larger amount of letters and 
punctuation marks. To accommodate these differences using only the 63 available braille characters, each 
language or country uses a specific braille table (sometimes called rule-set, braille code or mapping). 

This way, a braille character in one language can have a different meaning in another. It is crucial, 
therefore, to select the correct braille table for the visual impaired reader. 

Once the braille table is chosen, TactileView will automatically produce the correct braille for text labels 
according to the inherent properties of braille script. 

Braille table settings dialog 

Via menu Settings > Braille tables, you can select your braille table of choice. There are three sets of 
braille tables: 

- TactileView braille tables: these tables are currently only used for uploading designs to the TactileView 
catalog, but will be replaced completely in future releases; 
- Liblouis braille tables: an open-source braille translator that contains a large number of languages and 
braille codes. 
- Japanese braille table from Extra: a translator for Japanese braille that can be purchased from Extra. 

The selected braille table will be your main braille table, which is used as a default for all new text labels 
that are placed in your design (including the title label). When you change your main braille table, all 
labels that are designated as such will be changed to the new table. 

Braille Table 

Select a Braille table from the list. The main Braille table determines the primary table used in the entire design. The list of additional 
Braille tables can be used to change the table of specific text labels. 
Liblouis tables generally have extension utb for grade 1 braille and ctb for contracted braille. If a table name exists with both a utb 
and a ctb extension, the version with ctb is probably the newer and preferred version. 

Select main Braille table 

0 Use TactileView Braille table 

(:)q...14121 2!AaPr2!!!2.10*) 
Use Japanese Braille table from Extra 

List of additional tables (maximum 6): 

=1_ 
en-us-gl.ctb 
en-us-g2.ctb 
de-de-g1.ctb 
en-gb-comp8.ctb 
en-GB-g2.ctb 

nl-NL-g 1.ctb 

Select list of additional tables 

Info and Settings for Japanese Braille ... 

V Edit Braille table ... 

OK Cancel 

L 
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7.02 Settings - Braille tables

With the 6 dots of regular braille, only 63 different combinations can be made (not including the space
character). However, the languages from around the world use a far larger amount of letters and
punctuation marks. To accommodate these differences using only the 63 available braille characters, each
language or country uses a specific braille table (sometimes called rule-set, braille code or mapping).

This way, a braille character in one language can have a different meaning in another. It is crucial,
therefore, to select the correct braille table for the visual impaired reader.

Once the braille table is chosen, TactileView will automatically produce the correct braille for text labels
according to the inherent properties of braille script.

Braille table settings dialog

Via menu Settings > Braille tables, you can select your braille table of choice. There are three sets of
braille tables:

- TactileView braille tables: these tables are currently only used for uploading designs to the TactileView
catalog, but will be replaced completely in future releases;
- Liblouis braille tables: an open-source braille translator that contains a large number of languages and
braille codes.
- Japanese braille table from Extra: a translator for Japanese braille that can be purchased from Extra.

The selected braille table will be your main braille table, which is used as a default for all new text labels
that are placed in your design (including the title label). When you change your main braille table, all
labels that are designated as such will be changed to the new table.
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Figure 1. Braille tables settings dialog; click on the image to enlarge. 

Choosing which braille table to use 

The large list of Liblouis braille tables is recommended over the TactileView tables, as they are now only 
used for uploading designs to the TactileView catalog or in cases where personal adaptations of a braille 
table are required. 

Liblouis is an open-source braille translator containing an extensive list of braille tables for a wide range 
of countries and languages. For some there is just a single braille table available, whereas others (most 
notably English) have several alternatives. In general, they use the following elements in the table names 
to distinguish them: 
- g0 or 'comp' for computer braille; 
- gl for uncontracted braille (letter by letter transcription); 
- g2 for contracted braille (using abbreviations and contractions); 
- g3 for non-standardised personal shorthands (rarely used). 

Most of the braille tables without a specified grade will either be grade 1, or a specialised braille table 
such as mathematical braille notation. 

The Japanese braille from Extra is only available once this package has been bought separately. 

Once you have chosen your preferred braille table, click 'OK' confirm to save the selected main braille 
table. The main table is also recorded in the document when saved. 

Using multiple braille tables in one document 

By default, your main braille table is selected for new text labels. However, you can choose to use another 
braille table for individual text labels. This is useful for example when combining regular text with 
mathematical equations, or texts in different languages in their corresponding braille tables. 

There are two ways of changing the braille table for a selected text label: 
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Figure 1. Braille tables settings dialog; click on the image to enlarge.

Choosing which braille table to use

The large list of Liblouis braille tables is recommended over the TactileView tables, as they are now only
used for uploading designs to the TactileView catalog or in cases where personal adaptations of a braille
table are required.

Liblouis is an open-source braille translator containing an extensive list of braille tables for a wide range
of countries and languages. For some there is just a single braille table available, whereas others (most
notably English) have several alternatives. In general, they use the following elements in the table names
to distinguish them:
- g0 or 'comp' for computer braille;
- g1 for uncontracted braille (letter by letter transcription);
- g2 for contracted braille (using abbreviations and contractions);
- g3 for non-standardised personal shorthands (rarely used).

Most of the braille tables without a specified grade will either be grade 1, or a specialised braille table
such as mathematical braille notation.

The Japanese braille from Extra is only available once this package has been bought separately.

Once you have chosen your preferred braille table, click 'OK' confirm to save the selected main braille
table. The main table is also recorded in the document when saved.

Using multiple braille tables in one document

By default, your main braille table is selected for new text labels. However, you can choose to use another
braille table for individual text labels. This is useful for example when combining regular text with
mathematical equations, or texts in different languages in their corresponding braille tables.

There are two ways of changing the braille table for a selected text label:
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- From theproperties toolbar or context menu, choose 'Select braille table and select your/referred table 
from the list; you can choose from your main table, the 5 moat recent tables or the complete list of 
Liblouis tables via 'More braille tables 
- Choose the braille table from the list of Liblouis table in the Text and position' dialog. 

To get an overview of all the braille tables that are used in the document, first make sure nothing is 
selected. Neat, choose 'Show used braille tables' from thepropertiea toolbar, this option can also be found 
in the context me= that opens when right clicking in an empty part of the design. When this option is 
selected, the colour of the markers of all teat labels in your design will signify the used tables; the legend 
near the top left cornershows which colour conesponds with which table. 

MI main table DUTCH200S (1) 
en-us-gl.ctb (1) 
de-de-gl.ctb (1) 
Es-Es-gl.utb (1) 

 a • r;  • t  • • • h
• H • • C • • I 

• • 
S a---. 

• • • • • • . . h • , • E n ri • 
 I•
• I. • ••• • •  • • • • • - - a 

•Ge•r• • • • hma nei 
• A0-•, • •p • •a c• • .m F.;• •• •

.Figure 2. Overview cf the braille tables that we seed is the design. 

Mathematical braille notation 
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- From the properties toolbar or context menu, choose 'Select braille table' and select your preferred table
from the list; you can choose from your main table, the 5 most recent tables or the complete list of
Liblouis tables via 'More braille tables';
- Choose the braille table from the list of Liblouis table in the 'Text and position' dialog.

To get an overview of all the braille tables that are used in the document, first make sure nothing is
selected. Next, choose 'Show used braille tables' from the properties toolbar; this option can also be found
in the context menu that opens when right clicking in an empty part of the design. When this option is
selected, the colour of the markers of all text labels in your design will signify the used tables; the legend
near the top left corner shows which colour corresponds with which table.

Figure 2. Overview of the braille tables that are used in the design.

Mathematical braille notation
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When it comes to mathematical notation in braille, there is a number of additional aspects that come into 
play. These axe also supported in TactileView. For a full ova-view, real the manual sections 7ntrozbiclinn
on mathematical notations' and ̀ Add mathematical label (equation)'. 

1-x x 
• •• • • •• • •• •• • • • •• • • • .. •• •• 
•• • •• • •   •• • • • •• •• .•  • • • • •• •• • • 
• • 

r r l 

Figure 3. Mathematical tad kibeL 

Text label representation on screen 

By default, the braille characters are shown on screen on top of the entered text to give the designer an 
idea of the occupied space. Forbetter readability, the braille can also be disabled on screen by selecting 
'Hide braille dots on screen' from the properties toolbar or context menu of the design or a selected text 
label. Choose 'Show braille dots on screen' to make them visible again. Alternatively, the braille can also 
be disabled via menu Setting!. > Text label presentation: on screen. See manual section 'Editing text 
Ala'. 

.: • • 
'ffide braille duis on screen' icon: 

• • • 
Show braille dats on screen' lam: 

Opening documents with a different main braille table 

When opening a document that was saved using a main table that is different from your current arr., you 
can choose between: 
- applying your current braille table to the document; 
- use the original braille table in the document; 
- use the original braille table and make this your default main braille table. 
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When it comes to mathematical notation in braille, there is a number of additional aspects that come into
play. These are also supported in TactileView. For a full overview, read the manual sections 'Introduction
on mathematical notations' and 'Add mathematical label (equation)'.

Figure 3. Mathematical text label.

Text label representation on screen

By default, the braille characters are shown on screen on top of the entered text to give the designer an
idea of the occupied space. For better readability, the braille can also be disabled on screen by selecting
'Hide braille dots on screen' from the properties toolbar or context menu of the design or a selected text
label. Choose 'Show braille dots on screen' to make them visible again. Alternatively, the braille can also
be disabled via menu Settings > Text label presentation: on screen. See manual section 'Editing text
labels'.

'Hide braille dots on screen' icon: 

'Show braille dots on screen' icon: 

Opening documents with a different main braille table

When opening a document that was saved using a main table that is different from your current one, you
can choose between:
- applying your current braille table to the document;
- use the original braille table in the document;
- use the original braille table and make this your default main braille table.
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7.03 Braille tables - Inherent braille properties 

In braille, many different conventions and variations are used. Below, you will find an overview of the 
aspects ofbraille that are supported in TactileView. By using text labels in TactileView with the conect 
braille table selected, in-depth knowledge of braille to still produce conect braille texts is not required. 
However, below you will find a list of the most prominent inherent properties of braille script that 
determine the layout ofbraille text labels in your designs. 

Braille cell size, white space and composition signs 

TactileView automatically ensures the braille is sized comedy (following the most commonly used 
distance of approx. 2,5 = —1110 inch between braille dots) as well as using the conect distance 
between braille characters (approx. 6 =) and lima of text (approx. 10 inn). A white spree around the 
braille makes sure that there is enough space between adjacent objects or axis to ensure they can easily 
be distinguished with your fingertip. Tic braille grid can be used as a layout tool for alignment using 
these standard dimensions, see Braille grid (tat alignment). 

Other aspects that are specific to braille such as braille composition signs (capital letter sign, number sign, 
symbols, etc.) are also applied automatically. These composition signs are highlighted on screen with a 
light grey background. Remember that these composition signs differ significantly between different 
languages andbraille tables. 

2,5 mm 6 mm 

10 mm 

O 0 0 0 0 0 

O 0 0 0 0 0 

O 0 0 0 0 0 

O 0 0 0 0 0 

O 0 0 0 0 0 

O 0 0 0 0 0 

Figsdre I. Braille cell sizes. 
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7.03 Braille tables - Inherent braille properties

In braille, many different conventions and variations are used. Below, you will find an overview of the
aspects of braille that are supported in TactileView. By using text labels in TactileView with the correct
braille table selected, in-depth knowledge of braille to still produce correct braille texts is not required.
However, below you will find a list of the most prominent inherent properties of braille script that
determine the layout of braille text labels in your designs.

Braille cell size, white space and composition signs

TactileView automatically ensures the braille is sized correctly (following the most commonly used
distance of approx. 2,5 mm = 1/10 inch between braille dots) as well as using the correct distance
between braille characters (approx. 6 mm) and lines of text (approx. 10 mm). A white space around the
braille makes sure that there is enough space between adjacent objects or texts to ensure they can easily
be distinguished with your fingertip. The braille grid can be used as a layout tool for alignment using
these standard dimensions, see Braille grid (text alignment).

Other aspects that are specific to braille such as braille composition signs (capital letter sign, number sign,
symbols, etc.) are also applied automatically. These composition signs are highlighted on screen with a
light grey background. Remember that these composition signs differ significantly between different
languages and braille tables.

Figure 1. Braille cell sizes.
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Figure 2. Capital sings as an example cf composition signs; the rules for these signs vary between 
different kveguages and braille tables. 

Six dots and eight dots 

With the introduction of refreshaNe braille displays, two extra dots were added to form 8-dot braille. This 
way, using 255 braille characters are available (not including the space character) instead of the regular 
63, allows a larger range of characters to be denoted in braille, such as mathematical symbols. Other 
notable differences with 6-dot braille are found in the braille composition signs. 

For more consistency, braille display users that are familiar with reading 8-dot braille can use an 8-dot 
braille table producing designs from TratileView as well. Text labels (including the white since behind 
the braille) will automatically be higher to accommodate the addition of tic two extra dots. 

• ..av ; s.g t::g ; s 
�’�� c4r t:g g 

Figure 3. Comparison between 6-dot and 8-dot braille (example: LihItnds tables en-us-gl.ctis and en-us-
co/vac-4. 

Uncamtracted (grade 1) versus contracted (grade 2) braille tables 

To save space in an embossed braille document, frequently used syllables or entire words can be 
represented by a shorter combination of braille character or even a single character. This is called 
contracted braille or grade 2 braille, 

As an example, the word 'the would be denoted with three braille characters in urvontracted English 
braille. In contracted braille however, this is shortened to just a single character. 
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Figure 2. Capital sings as an example of composition signs; the rules for these signs vary between
different languages and braille tables.

Six dots and eight dots

With the introduction of refreshable braille displays, two extra dots were added to form 8-dot braille. This
way, using 255 braille characters are available (not including the space character) instead of the regular
63, allows a larger range of characters to be denoted in braille, such as mathematical symbols. Other
notable differences with 6-dot braille are found in the braille composition signs.

For more consistency, braille display users that are familiar with reading 8-dot braille can use an 8-dot
braille table producing designs from TactileView as well. Text labels (including the white space behind
the braille) will automatically be higher to accommodate the addition of the two extra dots.

Figure 3. Comparison between 6-dot and 8-dot braille (example: LibLouis tables en-us-g1.ctb and en-us-
comp8.ctb).

Uncontracted (grade 1) versus contracted (grade 2) braille tables 

To save space in an embossed braille document, frequently used syllables or entire words can be
represented by a shorter combination of braille character or even a single character. This is called
contracted braille or grade 2 braille.

As an example, the word 'the' would be denoted with three braille characters in uncontracted English
braille. In contracted braille however, this is shortened to just a single character.
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When using a contracted Liblouis table, these contractions and abbreviations are applied automatically. 
The reader must be familiar with these conventions to be able to read contracted braille. On screen and 
when the design is also printed in ink, the font size of the visible text is reduced to match the text position 
with the braille characters. 

• .11e. .tz• I: a b ed: vm• 0.6:Co•r5:t: a Ct::6•61: 15 i!•a i••l: 

• T:a.a:t: : I: a LI VP WJA:r:.g VaiN: 

Figure 4. Length difference between contracted and uncontracted braille. 
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When using a contracted Liblouis table, these contractions and abbreviations are applied automatically.
The reader must be familiar with these conventions to be able to read contracted braille. On screen and
when the design is also printed in ink, the font size of the visible text is reduced to match the text position
with the braille characters.

Figure 4. Length difference between contracted and uncontracted braille.
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7.04 Text label - Computer keyboard Input 

To read a twine diagram with ease, it is very helpful to add text information to the design. For example 
the different parts of a flow or rooms in a building can be labelled in the design to grad descriptive 
information to the image. 

Once the text label is added to your document, it can be edited at any time; see PAiting text lihela, For the 
all= input methods for text labels, see Text label - Br lle keyboard input and Text label - Math input. 

Text label placement 
To place a text label, click on the 'Add text label' icon in the drawing tools, en move tic mouse to the 
desired position in tic design and click again. You can start typing right away or use Cal+V to paste a 
copied text. 
A text label can be positioned anywhere in the design. Leave enough space around texts labels to ensure 
the braille dots can be distinguished easily, so make sure that text label are not too close to lines in your 
design. This way you will maintain optimal tactile usability. 

When placing a text label, the width of the text label is automatically adjusted to fit within the ahzet of 
paper or within the alignment fiame when this is enabled. 

. : 
Add Text Label icon; ' 

t e 

Figure I. tick in the design to place a test label 
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7.04 Text label - Computer keyboard input

To read a tactile diagram with ease, it is very helpful to add text information to the design. For example
the different parts of a flower or rooms in a building can be labelled in the design to add descriptive
information to the image.

Once the text label is added to your document, it can be edited at any time; see Editing text labels. For the
other input methods for text labels, see Text label - Braille keyboard input and Text label - Math input.

Text label placement
To place a text label, click on the 'Add text label' icon in the drawing tools, then move the mouse to the
desired position in the design and click again. You can start typing right away or use Ctrl+V to paste a
copied text.
A text label can be positioned anywhere in the design. Leave enough space around texts labels to ensure
the braille dots can be distinguished easily, so make sure that text label are not too close to lines in your
design. This way you will maintain optimal tactile usability.

When placing a text label, the width of the text label is automatically adjusted to fit within the sheet of
paper or within the alignment frame when this is enabled.

Add Text Label icon: 

Figure 1. Click in the design to place a text label.
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Precise placement: centre or align (snap) 
Two fiuctiors in the optima toolbar allow for more precise placement of text 'Aids. The 'Centre 
fiuction will horizontally place the label in the middle of the design. 
With Tat label alignment' turned on, text labels can be aligned with previously placed labels. Cu 
dotted lines appear in the design when placing or moving a label close to the vertical or horizontal 
position of other labels. The tact label you are adding or moving will then snap to the green line. 

You can also use the braille grid as a layout tool foraligmnent of text labels throughout the document 

Text label ah-gninent icon: 

Centre text label icon: 

•  e• t e 
  • •  1.. a b fey 

 • 
- r H - I-

I I I I I I

• 

Figure 2. Text label alignment with green dotted lines. 

Adjusting label dimenskum using word wrap length 
Word wrap length is the maximum number of characters per line of text in a text label. For =ample, a 
word wrap length of 10 will divide a text of 25 braille characters into three lines of teat Line breaks will 
bepliced at the position of spaces to avoid breaking up words. The lines of braille text have a fixed 
height that matches the standards:xi height of embossed braille text. 
The word wrap length can be act wed by dragging the aides of a text label. The tooltip will display the 
value of the word wrap length. Alternatively, select Text and position' fiom the properties toolbar or 
context mom of the selected text label to enter a value for the word wrap length. 
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Precise placement: centre or align (snap)
Two functions in the options toolbar allow for more precise placement of text labels. The 'Centre'
function will horizontally place the label in the middle of the design.
With 'Text label alignment' turned on, text labels can be aligned with previously placed labels. Green
dotted lines appear in the design when placing or moving a label close to the vertical or horizontal
position of other labels. The text label you are adding or moving will then snap to the green line.

You can also use the braille grid as a layout tool for alignment of text labels throughout the document.

Text label alignment icon: 

Centre text label icon: 

Figure 2. Text label alignment with green dotted lines.

Adjusting label dimensions using word wrap length
Word wrap length is the maximum number of characters per line of text in a text label. For example, a
word wrap length of 10 will divide a text of 25 braille characters into three lines of text. Line breaks will
be placed at the position of spaces to avoid breaking up words. The lines of braille text have a fixed
height that matches the standardised height of embossed braille text.
The word wrap length can be adjusted by dragging the sides of a text label. The tooltip will display the
value of the word wrap length. Alternatively, select 'Text and position' from the properties toolbar or
context menu of the selected text label to enter a value for the word wrap length.
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Figure 3. Adjusting the wont wrap size by dragging the sides of the text label; the tooltip signifies the 
word wrap length. 

Text label presentation on screen 
The text label is presented on screen by a combination of green characters with black dots that represent 
the braille characters that will be printed on the braille embosser or on swellpaper. With this setup you are 
able to have an eye on the braille characters. You can change how text labels are displayed on screen by 
selecting 'Text label presentation: on screen' in the toolbar or via the context menu. 

+•" 
Text label presentation on screen icon: cpt-' 

Automatically correct braille: braille tables 
The guidelines (so-called braille tables) for how texts are displayed in braille differ internationally. By 
selecting the correct default braille table via Settings > Braille Tables, the braille in your text labels will 
automatically be correct. This means that you do not need to have any knowledge of braille to get 
accurate braille in your designs. For example, braille composition signs for capital letters or numbers are 
automatically included. 
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Figure 3. Adjusting the word wrap size by dragging the sides of the text label; the tooltip signifies the
word wrap length.

 
Text label presentation on screen
The text label is presented on screen by a combination of green characters with black dots that represent
the braille characters that will be printed on the braille embosser or on swellpaper. With this setup you are
able to have an eye on the braille characters. You can change how text labels are displayed on screen by
selecting 'Text label presentation: on screen' in the toolbar or via the context menu.

Text label presentation on screen icon: 

 
Automatically correct braille: braille tables
The guidelines (so-called braille tables) for how texts are displayed in braille differ internationally. By
selecting the correct default braille table via Settings > Braille Tables, the braille in your text labels will
automatically be correct. This means that you do not need to have any knowledge of braille to get
accurate braille in your designs. For example, braille composition signs for capital letters or numbers are
automatically included.

.
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White space behind labeb (transparency) 
By default, labels have a white space behind and around the braille text to ensure that other design 
elements do not interfere with the braille. Keep in mind that lines can be covered by the white space if the 
label is placed too close. 
By switching off the white space (making the label transparent) you are able to place the text label on top 
of lines, but make sure they do not disturb the braille. 

'Add/remove while space' icon: 

(1:§ ri • e• 

o (:)- t:: t:: ri • a (.1: §. ri • e• t:• 

Figure 4. Diffeivice in text label transparency; notice that the line is visible below the top text label, but 
is covered by the white space of the second label. 
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White space behind labels (transparency)
By default, labels have a white space behind and around the braille text to ensure that other design
elements do not interfere with the braille. Keep in mind that lines can be covered by the white space if the
label is placed too close.
By switching off the white space (making the label transparent) you are able to place the text label on top
of lines, but make sure they do not disturb the braille.

'Add/remove white space' icon: 

Figure 4. Difference in text label transparency; notice that the line is visible below the top text label, but
is covered by the white space of the second label.
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7.05 Text label - Braille keyboard input 

There are three input methods for text labels; for tic other two input methods, see Text label - Corgwuter 
keyboard input and Text label - Math input. 

The computer keyboard input method is used to enter texts similar to using a Perkins style braille 
keyboard. This works by simultaneously pressing tic keys that represent the 6 or 8 dots of a braille 
character (see Braille tables — Inherent braille properties). 

To place a text label with braille keyboard input, first select 'Add text label' from the drawing tools 
toolbar and choose 'Text and position: braille keyboard input from tic properties toolbar or context 
menu. Next, click on the position in the design where you wish to place the text in braille. You can now 
type your text directly in your design. 

Test Zak!: braiAe keyboard input' icon: 

Entering braille text 

When entering tic braille text, tic letter keys f, d and a correspond to braille dots 1, 2 and 3 respectively-, 
keys j, k and 1 with dots 4, 5 and 6. Key& a and ; can be used to type dots 7 and 8 when using 8-dot braille. 
The space bar is used for spaces in braille text as well. 

  ( L /  G H 1 D J K 

N1 O O I/ 

2 O O 5

3 O O 6 

(7) O O (8) 

[Li 

Figure I. Oveniew cf which letter keys correspond with the dais in a brairle thangaer. 

To enter a character, press all letter keys simultaneously, then release them at the same time. For example, 
to enter the letter n in braille containing dots 1345, press f, a, j and lc. 

The typed text will apical- as black braille characters on screen, but without tic visual text characters that 
are shown for text labels with computer keyboard input. The orange dot in front of the text label signifies 
that the braille keyboard was used as input. 

Once the text label is placed in tic design, it cannot be converted to another input method. 
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7.05 Text label - Braille keyboard input

There are three input methods for text labels; for the other two input methods, see Text label - Computer
keyboard input and Text label - Math input.

The computer keyboard input method is used to enter texts similar to using a Perkins style braille
keyboard. This works by simultaneously pressing the keys that represent the 6 or 8 dots of a braille
character (see Braille tables – Inherent braille properties).

To place a text label with braille keyboard input, first select 'Add text label' from the drawing tools
toolbar and choose 'Text and position: braille keyboard input' from the properties toolbar or context
menu. Next, click on the position in the design where you wish to place the text in braille. You can now
type your text directly in your design.

'Text label: braille keyboard input' icon: 

Entering braille text

When entering the braille text, the letter keys f, d and s correspond to braille dots 1, 2 and 3 respectively;
keys j, k and l with dots 4, 5 and 6. Keys a and ; can be used to type dots 7 and 8 when using 8-dot braille.
The space bar is used for spaces in braille text as well.

Figure 1. Overview of which letter keys correspond with the dots in a braille character.

To enter a character, press all letter keys simultaneously, then release them at the same time. For example,
to enter the letter n in braille containing dots 1345, press f, s, j and k.

The typed text will appear as black braille characters on screen, but without the visual text characters that
are shown for text labels with computer keyboard input. The orange dot in front of the text label signifies
that the braille keyboard was used as input.

Once the text label is placed in the design, it cannot be converted to another input method.
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7.06 Text label - Math input 

When using mathematical text labels, some knowledge of mathematical notation in braille is required. 
This is covered in the manual section on mathetics in TactileView. See: Introduction on mathematical 
notations. 

To read all about placing and editing a text label with math input, see: Text label - math input (equation in 
braille). 
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7.06 Text label - Math input

When using mathematical text labels, some knowledge of mathematical notation in braille is required.
This is covered in the manual section on mathetics in TactileView. See: Introduction on mathematical
notations.

To read all about placing and editing a text label with math input, see: Text label - math input (equation in
braille).
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7.07 Editing text labels (braille) 

Any text label placed in the design can still be edited later on. You can change the contents of tic label or 
adjust the size and position in tic design. 
Please note that labels may only be edited according to the input method used to create them. For 
example, a text label entered via braille (six-key) input may only be edited using aix-key, and a raised 
print character label may only be edited as a raised print character label, labels cannot be converted from 
one type of label to another. 

For more details on placing and aligning a text label in the design, ace: Add tact label or Braille grid (tact 
aligna 

Editing text label content 

Text labels may only be edited using the same entry method with which they were created (computer 
keyboard entry or braille keyboard entry). To edit the content of the computer keyboard entry text label, 
double-click the label to place the cursor in the text and edit tic content as desired directly in the design 
area. Win this edit mode is active, you can drag with the mouse ?cross the text or use the Shift key 
combined with tic Home, End or arrow keys. to make a text selection. 
You can also right-click tic label and choose 'Text and position: computer keyboard input' or click on the 
correapnlin,g icon in the toolbar to bring up a text and position dialog. Make the desired changes and 
choose Or to update the text in the label. 

To edit the contents of a braille keyboard (six-key) entry label, double-click on tic label to edit it directly 
in tic design. Alternatively, you can right-click and choose Text and position: braille keyboard input' to 
bring up the text and position dialog. Edit the label content as desired using six-key entry. Win you are 
finished, deselect the label when editing in the design or choose 'OK' to close tic dialog and update the 
label. 

Figure 1. Double cfick on a tact label for direct editing 
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7.07 Editing text labels (braille)

Any text label placed in the design can still be edited later on. You can change the contents of the label or
adjust the size and position in the design.
Please note that labels may only be edited according to the input method used to create them. For
example, a text label entered via braille (six-key) input may only be edited using six-key, and a raised
print character label may only be edited as a raised print character label. Labels cannot be converted from
one type of label to another.

For more details on placing and aligning a text label in the design, see: Add text label or Braille grid (text
alignment).

Editing text label content
Text labels may only be edited using the same entry method with which they were created (computer
keyboard entry or braille keyboard entry). To edit the content of the computer keyboard entry text label,
double-click the label to place the cursor in the text and edit the content as desired directly in the design
area. When this edit mode is active, you can drag with the mouse across the text or use the Shift key
combined with the Home, End or arrow keys to make a text selection.
You can also right-click the label and choose 'Text and position: computer keyboard input' or click on the
corresponding icon in the toolbar to bring up a text and position dialog. Make the desired changes and
choose 'OK' to update the text in the label.

To edit the contents of a braille keyboard (six-key) entry label, double-click on the label to edit it directly
in the design. Alternatively, you can right-click and choose 'Text and position: braille keyboard input' to
bring up the text and position dialog. Edit the label content as desired using six-key entry. When you are
finished, deselect the label when editing in the design or choose 'OK' to close the dialog and update the
label.

Figure 1. Double click on a text label for direct editing.
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Adjusting word wrap length 
Word wrap length is the maximum number of characters per line of text in a text label. For example, a 
word wrap length of 10 will divide a text of 25 braille characters into three lines of text. Line breaks will 
be placed at the position of spaces to avoid breaking up words. The lines of braille text have a fixed 
height that matches the standardised height of embossed braille text. 
The word wrap length can be adjusted by dragging the sides of a text label. The tooltip will display the 
value of the word wrap length. Alternatively, select Text and position' from the properties toolbar or 
context menu of the selected text label to enter a value for the word wrap length. 

With the alignment frame enabled, the word wrap length will only be automatically be adjusted when 
placing a new label. If the label should fit within the limits of the alignment frame once placed in the 
design, the wrap length will have to be changed manually in the design or via the option 'Automatically 
adjust word wrap length' in the Text and position' dialog. 

• Nit icnt • a. wit!. a 

Figure 3. Adjusting the wont wrap size by dragging the sides of the text label; the tooltip signifies the 
word wrap length. 

Text label presentation on screen 
The braille component of text labels can be hidden on screen for better readability. To view only the text 
of the labels in your document, select a text label and choose 'Hide braille dots on screen' from the 
properties toolbar. This setting will be applied to all text labels in the document. Choose 'Show braille 
dots on screen' to show braille on screen again. 
For a complete list of settings for the way text labels are displayed on screen, select Text label 
presentation: on screen' either from the properties toolbar of a selected text label, or from the Settings 
menu. You can adjust the font colour, enable enlarged text for selected text labels and hide the text or 
braille component of text labels. 

Note: Braille dots for text labels can be disabled on print seperately via Text label presentation: on print'. 
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Adjusting word wrap length
Word wrap length is the maximum number of characters per line of text in a text label. For example, a
word wrap length of 10 will divide a text of 25 braille characters into three lines of text. Line breaks will
be placed at the position of spaces to avoid breaking up words. The lines of braille text have a fixed
height that matches the standardised height of embossed braille text.
The word wrap length can be adjusted by dragging the sides of a text label. The tooltip will display the
value of the word wrap length. Alternatively, select 'Text and position' from the properties toolbar or
context menu of the selected text label to enter a value for the word wrap length.

With the alignment frame enabled, the word wrap length will only be automatically be adjusted when
placing a new label. If the label should fit within the limits of the alignment frame once placed in the
design, the wrap length will have to be changed manually in the design or via the option 'Automatically
adjust word wrap length' in the 'Text and position' dialog.

Figure 3. Adjusting the word wrap size by dragging the sides of the text label; the tooltip signifies the
word wrap length.

Text label presentation on screen
The braille component of text labels can be hidden on screen for better readability. To view only the text
of the labels in your document, select a text label and choose 'Hide braille dots on screen' from the
properties toolbar. This setting will be applied to all text labels in the document. Choose 'Show braille
dots on screen' to show braille on screen again.
For a complete list of settings for the way text labels are displayed on screen, select 'Text label
presentation: on screen' either from the properties toolbar of a selected text label, or from the Settings
menu. You can adjust the font colour, enable enlarged text for selected text labels and hide the text or
braille component of text labels.

Note: Braille dots for text labels can be disabled on print seperately via 'Text label presentation: on print'.
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nowIllide braiAe ebb on screen' icons: 

Addilicmal line spacing 
You can choose to use extra line spacing between lines of tett throughout the document. For example, a 
value of 0.5 will add an empty space of half the height of a braille character between two lines of text. 
This can be selected by choosing 'Additional line spacing fin the properties toolbar or context menu of 
a selected text label. 

Culling, copying, patting and deleting labels (ail label types) 
The fastest way to copy, cut, paste or delete a label is using hotkeys. To cut a label, select it and press 
CTRL-EX on the keyboard. Cutting tic label removes it from the file but stores it on the clipboard 
allowing you to paste it elsewhere in the file. The cut label can only be pasted until you cut or copy a 
different label or object. 
To copy a label, select it and press crRufc. Copying leaves tic original label but keeps a copy of it that 
you can paste somewhere else in the file. To paste a cut or copied label, press CTRL+V. To delete a 
selected label, press tic Delete key on tic keyboard. 

Moving Labels (all label types) 
Once your label is selected, you can move it by clicking the center said dragging it to a new position. A 
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'Text label presentation on screen' icon: 

'Show/Hide braille dots on screen' icons: 

 

Additional line spacing
You can choose to use extra line spacing between lines of text throughout the document. For example, a
value of 0.5 will add an empty space of half the height of a braille character between two lines of text.
This can be selected by choosing 'Additional line spacing' from the properties toolbar or context menu of
a selected text label.

Cutting, copying, pasting and deleting labels (all label types)
The fastest way to copy, cut, paste or delete a label is using hotkeys. To cut a label, select it and press
CTRL+X on the keyboard. Cutting the label removes it from the file but stores it on the clipboard
allowing you to paste it elsewhere in the file. The cut label can only be pasted until you cut or copy a
different label or object.
To copy a label, select it and press CTRL+C. Copying leaves the original label but keeps a copy of it that
you can paste somewhere else in the file. To paste a cut or copied label, press CTRL+V. To delete a
selected label, press the Delete key on the keyboard.

Moving labels (all label types)
Once your label is selected, you can move it by clicking the center and dragging it to a new position. A
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four pointed arrow cursor indicates you can move tic label. 
You can also easily move the label to tic center of the design area by right-clicking it and selecting 
Center from tic context menu. You can move it only horizontally or only vertically by right-clicking it, 
selecting 'Move tic label or object only horizontally or vertically' and then dragging it up or down to 
move it vertically without changing its horizontal position, or left or right to move it horizontally without 
changing its vertical position. 

0:6•1•&• • 5  6 &ill 
I 

Figure 3. The anew with four arrows indicates the test label will k moved when dragged 

'Centre tact label' icon: 

"Move horizontally/vertically" icon. 

Reeizing labels (mammoth braille labels and :Weed print character labels only) 
You can maize a mammoth braille label in one of two ways. Tic first way is to scale a mammoth braille 
label manually. To do this., select it, then click a purple marker in one of the corners of the label and drag 
it diagonally until the label is the desired size. This resizes the mammoth braille inside tic label to fit the 
new label size. Tic other way to maize a mammoth braille label is to right-crick it and choose 'Braille dot 
size, which brings up a dialog on which you can specify the size of the mammoth braille relative to 
standard braille as a percentage. The default percentage is 300, which means the mammoth braille is three 
times larger than standard braille. Enter the desired size of the mammoth braille and choose OK to close 
the dialog, ma the mammoth braille size and automatically maize the label to fit the new size of the 
mammoth braille. 

Raised print character labels may aim be resized in one of two ways. The first way is the same as for 
mammoth braille labels; select the raised print character label, then click a purple square in one of the 
cornea of the label and drag it diagonally until the label is the desired size. This resizes the raised print 
characters inside the label. The other way is to right-click the raised print character label and choose Pont 
type' and size from the context menu. This launches a dialog that allows you to choose any font on your 
computer for the label, to specify any available font style for that font and to define the desired font size. 
Once you have finished making selections, choose OK on this dialog to apply your choices to the label 
text. The raised print character label will be resized to fit the new size of the text 
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four pointed arrow cursor indicates you can move the label.
You can also easily move the label to the center of the design area by right-clicking it and selecting
Center from the context menu. You can move it only horizontally or only vertically by right-clicking it,
selecting 'Move the label or object only horizontally or vertically' and then dragging it up or down to
move it vertically without changing its horizontal position, or left or right to move it horizontally without
changing its vertical position.

Figure 3. The cursor with four arrows indicates the text label will be moved when dragged.

'Centre text label' icon: 

'Move horizontally/vertically' icon: 

Resizing labels (mammoth braille labels and raised print character labels only)
You can resize a mammoth braille label in one of two ways. The first way is to scale a mammoth braille
label manually. To do this, select it, then click a purple marker in one of the corners of the label and drag
it diagonally until the label is the desired size. This resizes the mammoth braille inside the label to fit the
new label size. The other way to resize a mammoth braille label is to right-click it and choose 'Braille dot
size', which brings up a dialog on which you can specify the size of the mammoth braille relative to
standard braille as a percentage. The default percentage is 300, which means the mammoth braille is three
times larger than standard braille. Enter the desired size of the mammoth braille and choose OK to close
the dialog, adjust the mammoth braille size and automatically resize the label to fit the new size of the
mammoth braille.

Raised print character labels may also be resized in one of two ways. The first way is the same as for
mammoth braille labels; select the raised print character label, then click a purple square in one of the
corners of the label and drag it diagonally until the label is the desired size. This resizes the raised print
characters inside the label. The other way is to right-click the raised print character label and choose 'Font
type' and size from the context menu. This launches a dialog that allows you to choose any font on your
computer for the label, to specify any available font style for that font and to define the desired font size.
Once you have finished making selections, choose OK on this dialog to apply your choices to the label
text. The raised print character label will be resized to fit the new size of the text.
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NOTE: 
Because braille characters have a fixed size, text labels created using either computer keyboard entry or 
braille keyboard entry may not be resiaecl. However, you can determine tic width of the text by adjusting 
the word wrap length of the text label. Read more > 
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Figure 4. Afanunath braille or letlen and digits am be resized using the purple markers. 

Rotating labels (all label types) 
To rotate a label, right-click it and then choose ̀ Rotation' from the context menu or click the icon in the 
toolbar of tic selected label. On tic dialog that appears, enter the desired angle of rotation in degrees and 
choose OK to rotate the label. You can also use SHIFT-I-scroll wheel on a mouse to notate a selected label. 

Please keep in mind that embossers that print in a fixed grid of braille dots are not suitable for printing 
braille characters at an angle. 

ii 
Rotation' law 

Editing letters and digits 
To edit tic content of a raised print character label, simply double click on it to open tic edit dialog. 
Alternatively, choose 'Text and position' from the context menu or properties toolbar. Edit the label 
content as desired, then choose 'OK' to close the dialog and update tic text 
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NOTE:
Because braille characters have a fixed size, text labels created using either computer keyboard entry or
braille keyboard entry may not be resized. However, you can determine the width of the text by adjusting
the word wrap length of the text label. Read more >

Figure 4. Mammoth braille or letters and digits can be resized using the purple markers.

Rotating labels (all label types)
To rotate a label, right-click it and then choose 'Rotation' from the context menu or click the icon in the
toolbar of the selected label. On the dialog that appears, enter the desired angle of rotation in degrees and
choose OK to rotate the label. You can also use SHIFT+scroll wheel on a mouse to rotate a selected label.

Please keep in mind that embossers that print in a fixed grid of braille dots are not suitable for printing
braille characters at an angle.

'Rotation' icon: 

Editing letters and digits
To edit the content of a raised print character label, simply double click on it to open the edit dialog.
Alternatively, choose 'Text and position' from the context menu or properties toolbar. Edit the label
content as desired, then choose 'OK' to close the dialog and update the text.
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Editing mammoth braille 
To edit the content of a mammoth braille label, simply double click on it to open the edit dialog. 
Alternatively, choose 'Text and position' from the context menu or properties toolbar. Edit the label 
content as desired, then choose 'OK' to close the dialog and update the mammoth braille label. 
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Editing mammoth braille
To edit the content of a mammoth braille label, simply double click on it to open the edit dialog.
Alternatively, choose 'Text and position' from the context menu or properties toolbar. Edit the label
content as desired, then choose 'OK' to close the dialog and update the mammoth braille label.
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8.01 Introduction on mathematical notations 

Equations for sighted users are usually written in a spatial arrangement, in such a way that the 
components and their relations can be understood from their relative positioning. For example, a division 
is depicted by placing the dividend above the divisor, separated by a horizontal division line. 

For printing in braille, this spatial arrangement has to be converted into a continuous line of braille 
characters. Mathematical symbols such as (large) brackets, square roots and many other non-thy-to-thy 
symbols have to be converted as well. 

Mathematical notations and braille tables 

Since computers began to playa role in math and science, it has become even more a necessity to find an 
unambiguous way of presenting the results (in braille as well). Many of the equation editors use MathML 
as their universal language to store and manipulate mathematical equations. This language is also used to 
add equations to your design in TactileView. 

In order to get the correct equation printed in braille, a 2-step conversion is required: applying 
mathematical notation rules and applying a braille table to translate the characters into the corresponding 
braille dots. 

I - => 
....• •:.: 

:"E: I... • :i 4-21. - I 

Original equation Mathematical rules Braille table applied Mathematical text label in 
applied -actileView design 

Figure 1. Conversion from an equation in MathType to a mathematical text label in TactileView, by 
applying the chosen mathematical notation (in this case LaTeX) and braille table (en-us-comp8.atb). 

A math notation applies a set of rules that convert the spatial elements from the graphical lay-out 
(MathML) into a continuous line of text. Extra characters need to be inserted to indicate the relationship 
of the parts, to depict special mathematical symbols or to signify the logical order of the elements. 
Amongst other, the Nemeth, Unified English Braille, LaTeX, Marburg and Dedicon are some of the 
better known math notations and are available in TactileView. 

The result of the first conversion step is that the equation has become readable as text in a linear instead 
of a spatial arrangement. During the second step, a braille translator' (in TactileView, the open source 
project LibLouis is used) applies the desired braille table to convert the linear text of the equation into the 
corresponding braille characters. 

Keyboard entry of mathematical formulas 

When entering a mathematical formula in TactileView, it is important to use the correct syntax for text-
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8.01 Introduction on mathematical notations

Equations for sighted users are usually written in a spatial arrangement, in such a way that the
components and their relations can be understood from their relative positioning. For example, a division
is depicted by placing the dividend above the divisor, separated by a horizontal division line.

For printing in braille, this spatial arrangement has to be converted into a continuous line of braille
characters. Mathematical symbols such as (large) brackets, square roots and many other non-day-to-day
symbols have to be converted as well.

Mathematical notations and braille tables

Since computers began to play a role in math and science, it has become even more a necessity to find an
unambiguous way of presenting the results (in braille as well). Many of the equation editors use MathML
as their universal language to store and manipulate mathematical equations. This language is also used to
add equations to your design in TactileView.

In order to get the correct equation printed in braille, a 2-step conversion is required: applying
mathematical notation rules and applying a braille table to translate the characters into the corresponding
braille dots.

Figure 1. Conversion from an equation in MathType to a mathematical text label in TactileView, by
applying the chosen mathematical notation (in this case LaTeX) and braille table (en-us-comp8.ctb).

A math notation applies a set of rules that convert the spatial elements from the graphical lay-out
(MathML) into a continuous line of text. Extra characters need to be inserted to indicate the relationship
of the parts, to depict special mathematical symbols or to signify the logical order of the elements.
Amongst other, the Nemeth, Unified English Braille, LaTeX, Marburg and Dedicon are some of the
better known math notations and are available in TactileView.

The result of the first conversion step is that the equation has become readable as text in a linear instead
of a spatial arrangement. During the second step, a 'braille translator' (in TactileView, the open source
project LibLouis is used) applies the desired braille table to convert the linear text of the equation into the
corresponding braille characters.

Keyboard entry of mathematical formulas

When entering a mathematical formula in TactileView, it is important to use the correct syntax for text-
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only mathematical notation on a computer. The spatial arrangement of the elements in a mathematical 
expression has to be entered using a combination of specific symbols and applying parenthesis where 
necessary. The list below gives an overview of which mathematical elements are supported for use in 
formulas in TactileView. The examples show how to apply and combine these elements. 

Mathematical element or 
function 

Symbol Example 

Separation between multiple 
formulas 

; Y= 

Formula parameter x y=x 
Operators 
Addition + y=x+1 
Subtraction - y=x-3 
Multiplication * y=2*x 
Division / y=x/3 
Exponentiation A y=2^x 
Parentheses ( ) y= (x+2)/(x-3) 
Functions 
Absolute value abs( ) y=abs(x+2) 
Square root sqrt( ) y=sqrt(2*x) 
Natural logarithm with base e ln( ) y=ln(x-1) 
Logarithm with base 10 log( ) y=log(x+1) 
Exponent with base e exp( ) y=exp(x^2-2*x) 
Sine sin( ) sin(2*x) 
Cosine cos( ) cos(2*x) 
Tangent tan( ) tan(2*x) 
Arcsine, arccosine or arctangent asin( ), acos( ), atan( ) y=asin(x-1) 
Hyperbolic sine, cosine or tangent sinh( ),cosh( ),tanh( ) y=sinh(x-1) 
Hyperbolic arcsine,arccosine or 
arctangent 

asinh( ),acosh( ),atanh( ) y=asinh(x-1) 

Constants 
Decimal sign . y=1.5*x 
Natural logarithm base e y=e^(x^2-2*x) 
Pi pi y=sin(2*pi*x) 
Phi (golden ratio) phi y=2*phi*x 
Derivatives 
First derivative , y=(x^2-3*x+4)' 
Second derivative and higher multiple ' y=(sin(2*x+1))" 
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only mathematical notation on a computer. The spatial arrangement of the elements in a mathematical
expression has to be entered using a combination of specific symbols and applying parenthesis where
necessary. The list below gives an overview of which mathematical elements are supported for use in
formulas in TactileView. The examples show how to apply and combine these elements.

Mathematical element or
function

Symbol Example

Separation between multiple
formulas

; y=

Formula parameter x y=x
Operators
Addition + y=x+1
Subtraction - y=x-3
Multiplication * y=2*x
Division / y=x/3
Exponentiation ^ y=2^x
Parentheses ( ) y= (x+2)/(x-3)
Functions
Absolute value abs( )  y=abs(x+2)
Square root sqrt( ) y=sqrt(2*x)
Natural logarithm with base e ln( ) y=ln(x-1)
Logarithm with base 10 log( ) y=log(x+1)
Exponent with base e exp( ) y=exp(x^2-2*x)
Sine sin( ) sin(2*x)
Cosine cos( ) cos(2*x)
Tangent tan( ) tan(2*x)
Arcsine, arccosine or arctangent asin( ), acos( ), atan( )  y=asin(x-1)
Hyperbolic sine, cosine or tangent sinh( ),cosh( ),tanh( ) y=sinh(x-1)
Hyperbolic arcsine,arccosine or
arctangent

asinh( ),acosh( ),atanh( ) y=asinh(x-1)

Constants
Decimal sign . y=1.5*x
Natural logarithm base e y=e^(x^2-2*x)
Pi pi y=sin(2*pi*x)
Phi (golden ratio) phi y=2*phi*x
Derivatives
First derivative ' y=(x^2-3*x+4)'
Second derivative and higher multiple ' y=(sin(2*x+1))"
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8.02 Text label - Math input (equation hi braille) 

Currently, there are three options for entering a mathematical text label in your TactileView design: 

1. Enter tic equation in a regular text label, using the corresponding braille table; 
2. Use aix-key entry (braille keyboard) to directly enter the math in braille; 
3. Enter tic mathematical expression using a math editor (MathType). 

Options 1 and 2 require knowledge about the mathematical braille notation you are using in at to enter 
the equation comedy. Option 3 allows you to enter math and convert it automatically to the desired 
notation in braille, but this requires MathType as a math editor. In the upcoming service release, a fourth 
method will be included, which allows you to enter the equation in linzar notation and have it converted 
automatically (ie. this will not require knowledge of the braille notation or a mathematical editor). 

1. Using a regular text label 

When you know the rules of the mathematical braille notation you wish to use, you can use a regular text 
label to enter it in your design. Select 'Add text label' from the drawing tools icon bar, then select Text 
and position: computer keyboard input' from the properties toolbar. Click in tic design where you want to 
place the equation. Make sure to include the correct sprees, parentheses and other specific sweets of the 
maticmatical notation. MathType is required when you wish to use symbols that are not on your 
keyboard. 

Next, make sure to select the correct braille table for the notation you are using. You can select the braille 
table by choosing 'Select braille table' from tic properties toolbar or context menu. Tic following braille 
tables are recommended for the different mathematical notations: 

• nemeth.ctb forNemeth; 
• ukmaths.ctb for UKmaths; 
• marburg.ctb for Marburg notation; 
• en-us-compactb or similar for LaTeX; 
• Dutch braille table for Dedicon notation. 

Add tact label' icon: 
YoY

'computer keyboard input, icon; 5t,t2 

= 
Select braille table' icon: 
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8.02 Text label - Math input (equation in braille)

Currently, there are three options for entering a mathematical text label in your TactileView design:

1. Enter the equation in a regular text label, using the corresponding braille table;
2. Use six-key entry (braille keyboard) to directly enter the math in braille;
3. Enter the mathematical expression using a math editor (MathType).

Options 1 and 2 require knowledge about the mathematical braille notation you are using in order to enter
the equation correctly. Option 3 allows you to enter math and convert it automatically to the desired
notation in braille, but this requires MathType as a math editor. In the upcoming service release, a fourth
method will be included, which allows you to enter the equation in linear notation and have it converted
automatically (i.e. this will not require knowledge of the braille notation or a mathematical editor).

1. Using a regular text label

When you know the rules of the mathematical braille notation you wish to use, you can use a regular text
label to enter it in your design. Select 'Add text label' from the drawing tools icon bar, then select 'Text
and position: computer keyboard input' from the properties toolbar. Click in the design where you want to
place the equation. Make sure to include the correct spaces, parentheses and other specific aspects of the
mathematical notation. MathType is required when you wish to use symbols that are not on your
keyboard.

Next, make sure to select the correct braille table for the notation you are using. You can select the braille
table by choosing 'Select braille table' from the properties toolbar or context menu. The following braille
tables are recommended for the different mathematical notations:

nemeth.ctb for Nemeth;
ukmaths.ctb for UKmaths;
marburg.ctb for Marburg notation;
en-us-comp8.ctb or similar for LaTeX;
Dutch braille table for Dedicon notation.

 

'Add text label' icon: 

'Computer keyboard input' icon: 

'Select braille table' icon: 
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2. Using six-key entry 

If you kixwe the mathematical braille code and wish to simply use braille keyboard (six-key) entry for 
direct input of the desired characters, please refer to the 'lliffininklagatouratdabeili section for 
instructions on adding text labels through six-key entry. 

Braille keyboard input' icon: 

3. Equation with math editor (MathType) 

You can use MathType as a math editor to automatically convert the entered equation to tic desired 
braille notation. The math editor is also required to enter math that is too complex to be entered in linear 
format or when symbols are required that are not available on tic keyboard. For more information on 
using MathType to enter mathematical expressions, please visit their websiW. 

Once you have entered the equation in MathType, select it said copy it to the clipboard (Ctri+C). Switch 
to TactileView, select 'Add text label' and choose 'Text and position: math input' from the properties 
toolbar. Click in tic design where you wish to position your mathematical label. 

In the dialog that appears, select the preferred mathematical notation and click on Taste math equation 
from clipboard'. The equation will now be displayed in both visual (linear and spatial) and braille format. 

The dialog also allows you to adjust tic location in which you would like to insert the label (if different 
than where you originally clicked in the file) by filling in the distance fields. You can size the label by 
specifying tic maximum number of characters you would like it to have before tic text wraps to the next 
line. Choose 'OK' to confirm and close tic dialog. 

Mathematical text labels may be moved and edited the same as other text labels. For more information, 
please refer to the 'Editing test laliele section. 

"Math repot" icvn: 
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2. Using six-key entry

If you know the mathematical braille code and wish to simply use braille keyboard (six-key) entry for
direct input of the desired characters, please refer to the 'Different types of text labels' section for
instructions on adding text labels through six-key entry.

'Braille keyboard input' icon: 

3. Equation with math editor (MathType)

You can use MathType as a math editor to automatically convert the entered equation to the desired
braille notation. The math editor is also required to enter math that is too complex to be entered in linear
format or when symbols are required that are not available on the keyboard. For more information on
using MathType to enter mathematical expressions, please visit their website.

Once you have entered the equation in MathType, select it and copy it to the clipboard (Ctrl+C). Switch
to TactileView, select 'Add text label' and choose 'Text and position: math input' from the properties
toolbar. Click in the design where you wish to position your mathematical label.

In the dialog that appears, select the preferred mathematical notation and click on 'Paste math equation
from clipboard'. The equation will now be displayed in both visual (linear and spatial) and braille format.

The dialog also allows you to adjust the location in which you would like to insert the label (if different
than where you originally clicked in the file) by filling in the distance fields. You can size the label by
specifying the maximum number of characters you would like it to have before the text wraps to the next
line. Choose 'OK' to confirm and close the dialog.

Mathematical text labels may be moved and edited the same as other text labels. For more information,
please refer to the 'Editing text labels' section.

'Math input' icon: 
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Figure 1. A mathematical equation in TactileView; LaTeX and en-us-comp8.ctb were used as
mathematical notation and braille table.

                                167 / 226



TactileView software manual 
Visit us at https://thinkable.nl 

8.03 Graph properties for best tactile usability 

When it comes to tactile graphs, there are several properties that together determine the tactile usability. 
The three elements in a graph (the equation in braille, grid paper with coordinate system and the curve of 
the formula) can be configured individually to achieve the optimal tactile result. Personal preferences of 
the VIP reader as well as the properties of the printer that will be used both need to be taken into account. 
Therefore we advise you to test the settings described below first to find what works best for you. 

Choosing the best graph properties 

The mathematical formula(s) and range of the axes are generally the most important elements when you 
create a new graph. All other aspects of the grid are for tactile presentation purposes. Reading a tactile 
graph can be complex enough on its own, so choosing the optimal settings for your production method 
(swellpaper or the type of braille embosser) is important. This works best if you can imagine the result of 
each setting in advance. The list below gives an overview of all the settings that are related to a tactile 
graph. 

Graph properties 

1. Coordinate system and grid paper 

The coordinate system (the axes of the graph) and grid paper (the regular grid that indicates the values of 
the graph) form the frame in which the graph will be plotted. 
Select 'Positions and appearance' from the properties toolbar or context menu of the graph to access the 
'Appearance' settings for the coordinate system and grid paper. 

Coordinate system — X and Y axis 

- Line thickness of the axis; thicker axis lines can be used to distinguish the axes more easily from the 
thinner grid lines, but also take up more space and tear more easily on some embossers. 

Grid paper 

- Draw border to surround the axis; this places a rectangular frame around the entire grid. 

- Style of auxiliary lines for grid boxes; you can choose from: line, cross, dot, dash and none. 

- Thickness of the auxiliary lines for grid boxes; use thinner lines to make the grid boxes less prominent 
for better contrast with the formula lines. 

- Relief height of auxiliary lines for grid boxes; you can make the grid lines less prominent and more 
easily distinguished from the axes and formulas by lowering the line height. This is only available for 
embossers that support variable dot height. 
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8.03 Graph properties for best tactile usability

When it comes to tactile graphs, there are several properties that together determine the tactile usability.
The three elements in a graph (the equation in braille, grid paper with coordinate system and the curve of
the formula) can be configured individually to achieve the optimal tactile result. Personal preferences of
the VIP reader as well as the properties of the printer that will be used both need to be taken into account.
Therefore we advise you to test the settings described below first to find what works best for you.

Choosing the best graph properties

The mathematical formula(s) and range of the axes are generally the most important elements when you
create a new graph. All other aspects of the grid are for tactile presentation purposes. Reading a tactile
graph can be complex enough on its own, so choosing the optimal settings for your production method
(swellpaper or the type of braille embosser) is important. This works best if you can imagine the result of
each setting in advance. The list below gives an overview of all the settings that are related to a tactile
graph.

Graph properties

1. Coordinate system and grid paper

The coordinate system (the axes of the graph) and grid paper (the regular grid that indicates the values of
the graph) form the frame in which the graph will be plotted.
Select 'Positions and appearance' from the properties toolbar or context menu of the graph to access the
'Appearance' settings for the coordinate system and grid paper.

Coordinate system – X and Y axis

- Line thickness of the axis; thicker axis lines can be used to distinguish the axes more easily from the
thinner grid lines, but also take up more space and tear more easily on some embossers.

Grid paper

- Draw border to surround the axis; this places a rectangular frame around the entire grid.

- Style of auxiliary lines for grid boxes; you can choose from: line, cross, dot, dash and none.

- Thickness of the auxiliary lines for grid boxes; use thinner lines to make the grid boxes less prominent
for better contrast with the formula lines.

- Relief height of auxiliary lines for grid boxes; you can make the grid lines less prominent and more
easily distinguished from the axes and formulas by lowering the line height. This is only available for
embossers that support variable dot height.
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Figure 1. Differences in line thickness are used for easy tactile distinction between the grid boxes and
axes.

Figure 2. A border is used around the edges of the graph.
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Figure 4. A lower line height; indicated with a lighter blue colour, care k used for easy distindion of the 
grid boxes. 

2. X and Y axes 

Thew settings can be adjusted separately for the horizontal (X) said vertical (Y) axis. 

- Extreme values for the axis; this determines the range in which the graph is shown. 

- Subdivision of tic axis; units per grid box said units per tick; you can choose the interval that is used for 
the grid boxes and ticks along the axis to =fly read the values of tic graph. 

- Ticks per text label; you can choose whether a numeric value should be placed at each tick, more spaced 
out (e.g. I text label for every 2 ticks) or only at the origin/ends. 

- Number of decimals of the values along the axis; some graphs might require more decimal numbers. 

- Position of the labels relative to the graph's border, this allows you to create enough space between the 
grid and value labels along the axis. In tic design, you can also drag the purple marker below or left of 
the values to move them to the required position with the mouse. 
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Figure 3. Four different grid box styles: line, dash, cross and dot.

Figure 4. A lower line height, indicated with a lighter blue colour, can be used for easy distinction of the
grid boxes.

2.  X and Y axes

These settings can be adjusted separately for the horizontal (X) and vertical (Y) axis.

- Extreme values for the axis; this determines the range in which the graph is shown.

- Subdivision of the axis: units per grid box and units per tick; you can choose the interval that is used for
the grid boxes and ticks along the axis to easily read the values of the graph.

- Ticks per text label; you can choose whether a numeric value should be placed at each tick, more spaced
out (e.g. 1 text label for every 2 ticks) or only at the origin/ends.

- Number of decimals of the values along the axis; some graphs might require more decimal numbers.

- Position of the labels relative to the graph's border; this allows you to create enough space between the
grid and value labels along the axis. In the design, you can also drag the purple marker below or left of
the values to move them to the required position with the mouse.
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- Name for the axis; by default, these are 'x' and 'y', but you can change this to suit the graph (e,g. 
'Number purchased' am Trice). 

- Horizontal and vertical position of the axis name; these determine the position of the axis name label. In 
the design, you can drag this label to the required position with the mouse. Double click on a formula 
label to edit it. 

- A thickness of the axes of 0 pixels allows you to produce a formula line without any coordinate system, 
when only the shape of the mathematical function is important without the corresponding values. For this 
application, it is best to disable the grid boxes and the border surrounding the graph. 
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Figure 5. The range for the axes and positions tithe ticks, grid boxes and value labels determines the 
layout of the axes of the graph 
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- Name for the axis; by default, these are 'x' and 'y', but you can change this to suit the graph (e.g.
'Number purchased' and 'Price').

- Horizontal and vertical position of the axis name; these determine the position of the axis name label. In
the design, you can drag this label to the required position with the mouse. Double click on a formula
label to edit it.

- A thickness of the axes of 0 pixels allows you to produce a formula line without any coordinate system,
when only the shape of the mathematical function is important without the corresponding values. For this
application, it is best to disable the grid boxes and the border surrounding the graph.

Figure 5. The range for the axes and positions of the ticks, grid boxes and value labels determines the
layout of the axes of the graph
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Figure 6. The axes can be labeled individually (X and Y are the default labels).

Figure 7. A graph using a thickness of 0 pixels for the axes shows only the formula lines.

3.  Formula lines
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The goings for each formula line that is presented in the graph can be adjusted separately. 

- Formula syntax; enter the mathematical equation that will be plotted. 

- Text label representation of the formula; the legend above the graph shows which formulas are 
presented. You can choose from an number of mathematical representations; alternatively, you can 
choose to enter your own name (e.g. 'Surface area') or choose not to include a label. 

- Line style for the formula; by default, each formula guts a different tactile line style to distinguish 
multiple formulas in a graph. This line style is also presented in the formula legend above the graph. 
Different colours are used on screen for easy visual recognition. 

- Position of the text label; by default, the text labels for the formulas are placed above the graph. In the 
design, you can also move these with the mouse. 
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The settings for each formula line that is presented in the graph can be adjusted separately.

- Formula syntax; enter the mathematical equation that will be plotted.

- Text label representation of the formula; the legend above the graph shows which formulas are
presented. You can choose from an number of mathematical representations; alternatively, you can
choose to enter your own name (e.g. 'Surface area') or choose not to include a label.

- Line style for the formula; by default, each formula gets a different tactile line style to distinguish
multiple formulas in a graph. This line style is also presented in the formula legend above the graph.
Different colours are used on screen for easy visual recognition.

- Position of the text label; by default, the text labels for the formulas are placed above the graph. In the
design, you can also move these with the mouse.
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Figure 8. Different line styles are used for the formulas in the graph, as signified in the fomula legend. 
Different colours are used on screen to easyly distinguish the formulas visually. 
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Figure 8. Different line styles are used for the formulas in the graph, as signified in the fomula legend.
Different colours are used on screen to easyly distinguish the formulas visually.
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8.04 Creating a graph 

TactileView offers a very powerful graphing feature, which allows you to enter formulas and have them 
graphed over a specified range. TactileView gives you precise control over the styles used in your graph 
for the functions, axes, gridlines, labels and more. You can also move and resize your graph like any 
other drawing object. 

There are several possible approaches of creating a new graph. You can choose an empty grid as a basis 
(see paragraph 1), select one of the TactileView graph examples and adapt it to form your own (see 
paragraphs 2 and 3), or create a new graph based on the entered formula (see paragraphs 4 and 5). You 
can also save any graph as 'MyGrid' for reuse in later designs (see section 'Save graph as MyGrid for later 
use'). 

You can read an overview of all the tactile properties that determine the tactile usability of a graph in the 
'Graph properties' section. For more information on the different mathematical notations in braille, read 
the 'Introduction on mathematical notations' section. 

1. Coordinate system (no functions) 

To enter an empty coordinate system (empty grid paper without any graphed formulas), select 'Draw 
graph' from the drawing tools icon bar, then choose 'Coordinate system (no functions)' from the properties 
toolbar. This option can also be found in the Graphs menu. 

Once this option is selected, an empty grid will appear in the design. By default, this grid is square and 
ranges from -4 to 4 on both the x- and y-axis, with straight grid lines at an interval of 1 unit. You can use 
the options in the properties toolbar or context menu to adjust the properties of the grid or add a graphed 
formula. 

Coordinate system (no functions) icon: 
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8.04 Creating a graph

TactileView offers a very powerful graphing feature, which allows you to enter formulas and have them
graphed over a specified range. TactileView gives you precise control over the styles used in your graph
for the functions, axes, gridlines, labels and more. You can also move and resize your graph like any
other drawing object.

There are several possible approaches of creating a new graph. You can choose an empty grid as a basis
(see paragraph 1), select one of the TactileView graph examples and adapt it to form your own (see
paragraphs 2 and 3), or create a new graph based on the entered formula (see paragraphs 4 and 5). You
can also save any graph as 'MyGrid' for reuse in later designs (see section 'Save graph as MyGrid for later
use').

You can read an overview of all the tactile properties that determine the tactile usability of a graph in the
'Graph properties' section. For more information on the different mathematical notations in braille, read
the 'Introduction on mathematical notations' section.

1. Coordinate system (no functions)

To enter an empty coordinate system (empty grid paper without any graphed formulas), select 'Draw
graph' from the drawing tools icon bar, then choose 'Coordinate system (no functions)' from the properties
toolbar. This option can also be found in the Graphs menu.

Once this option is selected, an empty grid will appear in the design. By default, this grid is square and
ranges from -4 to 4 on both the x- and y-axis, with straight grid lines at an interval of 1 unit. You can use
the options in the properties toolbar or context menu to adjust the properties of the grid or add a graphed
formula.

Coordinate system (no functions) icon: 
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Figure 1. Empty grid binned in a TactileView design. 

2. Funedems and formulas (examples) 

TactileView includes two sets of ready to use =ample grids. These have already been optimized to depict 
the selected formula. You can use these graphs as a basis for your own by simply changing the 
formula(s). 

Select Thaw graph' fin the drawing tools icon bar, then choose ̀ Functions and formulas (examples)' 
from the properties toolbar. Alternatively, this option can also be found in the Graphs menu. 

In the dialog that appears you will find a list of sample graphs which each include one formula, ranging 
from simple to more complex. By Gila using Change formula', you can edit the formula to create your own 
graph based on the sample. Change coordinate system' allows you to adjust the settings for the grid style 
and properties of the axes (such as the range). Use 'Multiple formulas' to add extra formulas to the grid 
(for more information on including multiple formulas in one grid, read the 'Graphing multiple lima' 
section). 

Dace you have selected a sample graph or when you are satisfied with the adjustments, you can choose to 
insert the graph a blank new document (click 'Save in new document') or place it in tic currently active 
document (click 'Save in current document). You can also choose to replace tic most recent grid in the 
current document (click 'Replace the last grid). 

"F'undirms and formulas (e:rumples)" icon: 
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Figure 1. Empty grid inserted in a TactileView design.

2. Functions and formulas (examples)

TactileView includes two sets of ready to use example grids. These have already been optimized to depict
the selected formula. You can use these graphs as a basis for your own by simply changing the
formula(s).

Select 'Draw graph' from the drawing tools icon bar, then choose 'Functions and formulas (examples)'
from the properties toolbar. Alternatively, this option can also be found in the Graphs menu.

In the dialog that appears you will find a list of sample graphs which each include one formula, ranging
from simple to more complex. By choosing 'Change formula', you can edit the formula to create your own
graph based on the sample. 'Change coordinate system' allows you to adjust the settings for the grid style
and properties of the axes (such as the range). Use 'Multiple formulas' to add extra formulas to the grid
(for more information on including multiple formulas in one grid, read the 'Graphing multiple lines'
section).

Once you have selected a sample graph or when you are satisfied with the adjustments, you can choose to
insert the graph a blank new document (click 'Save in new document') or place it in the currently active
document (click 'Save in current document'). You can also choose to replace the most recent grid in the
current document (click 'Replace the last grid').

'Functions and formulas (examples)' icon: 
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Select a Formula 

Select a formula from the list and change the values if necessary The 
graph is drawn on a grid that is suitable for tactile use. The properties of 
the grid and the X- and Y-axic can be adapted. 
When you choose to enter a new formula by changing a sample formula, 
you will find a list of the available functions and constants that can be 
used. 

Sample formulas, edit if necessary (39 items): 

y=x+2: -6<X<6, 4<f<4 
y=2.,c^2-30x-2: -4,"(<4 
y=0.5.x^3+0.5*x^2-30x+2: -4<X<4, -6<Y<6 
y=(0.5*x^3+0.5*x^2-30x+2)': -6,"Y<6 
y=(0.5.x^3+0.5*x^2-3. x+2)": -6,"Y<6 
y=(0.5. x^3+0.5*x^2-30x+2)"': -6,"Y<6 
y=sqrt(x): -1<Y<4 
y=i/sqrt(x): -2<x<e,„ -1<Y<4 
y=1/x: -4<Y<4 
y=1/x^2: -4.0(<4, 
y=(1+x)/(1-x): -4<Y<4 

Change Formula ... 

Change coordnate system ... 

Multiple Formulas ... 

- 9116 

.1f 

.10 

...if' ....Pt ,..14 10 .10 .10 x .11 

Select an option to close 

Save in new document 

Save in current document 

Sen!ace the last grid 
Carcel 

Figure 2. 'Functions and formulas (examples)' dialog; click on the image to enlarge. 

3. Grids and graphs (advanced examples) 

Similar to 'Functions and formulas, the 'Grids and graphs' dialog contains a list of sample grids that can 
be used as is, or adapted to create your own grids. The list contains a number of variations of empty grids, 
as well as a list of grids that contain one or more formulas (arranged from simple to more complex). 
These examples are labelled as numbered TVGrids. Below these TVGrids, you will find any grids that 
were saved for reuse as MyGrids. 

You can access this list of sample grids by selecting Draw graph' from the drawing tools icon bar, then 
choosing 'Grids and graphs (advanced examples)' from the properties toolbar. Alternatively, this option 
can also be found in the Graphs menu. 

The list of properties of the selected sample graph is shown in the second list box. If you wish to adjust 
any of the settings, select it from this list and click 'Change properties'. 

If you have selected one of the MyGrids from the list, you have the option to remove it from the list of 
saved grids. When you have adjusted the selected MyGrid, you have the option to either save it as a new 
MyGrid or replace the edited MyGrid. 

Once you have selected a sample graph, MyGrid or when you are satisfied with the adjustments, you can 
choose to insert the graph a blank new document (click 'Save in new document') or place it in the 
currently active document (click 'Save in current document'). You can also choose to replace the most 
recent grid in the current document (click 'Replace the last grid). 
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Figure 2. 'Functions and formulas (examples)' dialog; click on the image to enlarge.

3. Grids and graphs (advanced examples)

Similar to 'Functions and formulas', the 'Grids and graphs' dialog contains a list of sample grids that can
be used as is, or adapted to create your own grids. The list contains a number of variations of empty grids,
as well as a list of grids that contain one or more formulas (arranged from simple to more complex).
These examples are labelled as numbered TVGrids. Below these TVGrids, you will find any grids that
were saved for reuse as MyGrids.

You can access this list of sample grids by selecting 'Draw graph' from the drawing tools icon bar, then
choosing 'Grids and graphs (advanced examples)' from the properties toolbar. Alternatively, this option
can also be found in the Graphs menu.

The list of properties of the selected sample graph is shown in the second list box. If you wish to adjust
any of the settings, select it from this list and click 'Change properties'.

If you have selected one of the MyGrids from the list, you have the option to remove it from the list of
saved grids. When you have adjusted the selected MyGrid, you have the option to either save it as a new
MyGrid or replace the edited MyGrid.

Once you have selected a sample graph, MyGrid or when you are satisfied with the adjustments, you can
choose to insert the graph a blank new document (click 'Save in new document') or place it in the
currently active document (click 'Save in current document'). You can also choose to replace the most
recent grid in the current document (click 'Replace the last grid').
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'Grids and graphs (advanced examples)' icon: li-Er 

Select a Grid 

Below you will find a list of sample grids with blank grids or combinations of formulas. These grids can be modified to create your own tactile grids and can be saved 
as MyGrids. 

Select a sample grid (34 items): 
A 

TVGrids-Grid 2 Blank square coordinate system: -4<5<4, -4O<4; size: 15.32 x 15.32 an; grid boxes: 8 x 8; style: Line 
TVGrids-Grid 3 Blank square coordinate system, dots: -4<X<4, -4O<4; size: 15.32 x 15.32 an; gad boxes: 8 x 8; style: Dot 
TVGrids-Grid 4 Blank square coordinate system, dashed line: -4-::X<4 -4O<4. size: 15.32 x 15.32 an. gad boxes: 8 x 8. style: Dash 

Properties of the gad (8 items): 

Name: Grid 1 Gra • •a• -r 
Positions and Appearance: position: 4.57, 4.57 an; border yes; style: Line; line thickness 2; line height 8; formula thidaiess 2; axis thidaiess 2 
Horizontal (X) Axis: 0<3<18; size: 18.19 an; gad range: 1; tick size: 1; tidks per label: 0 
Vertical (Y) Axis: 0O<20; size: 19.99 an; gad range: 1; tick size: 1; ticks per label: 0 

• Formula 1: 
• Formula 2: 
• Formula 3: 

Change properties ... 

MyGrid Options 

Remove Grid from MyGrids 

Add modified grid to MyGrids 

Replace changed grid in MyGrids 

Select an option to dose 

Save in new document 

Save in current document 

Cancel 

Figure 3. 'Grids and graphs (advanced examples)' dialog; click on the image to enlarge. 

4. Add custom graph: equation editor 

This option allows you to create a graph based on a formula that is entered using MathType as an 
equation editor. The math editor is also required to enter math that is too complex to be entered in linear 
format or when symbols are required that are not available on the keyboard. For more information on 
using MathType to enter mathematical expressions, please visit their website. 

Once you have entered the equation in MathType, select it and copy it to the clipboard (Ctrl+C). Make 
sure that the entered formula is suitable for conversion to a graph. Next, switch to TactileView and select 
Draw graph' from the drawing tools icon bar, then choose 'Add custom graph: equation editor' from the 
properties toolbar. Alternatively, this option can also be found in the Graphs menu. 

In the dialog that appears, select the preferred mathematical notation and click on Taste math equation 
from clipboard'. The equation will now be displayed in both visual (linear and spatial) and braille format. 
Choose 'OK' to confirm. 

In the formula dialog that appears, the options below the formula as well as the buttons 'Positions and 
appearance', 'Horizontal (x) axis' and Vertical (y) axis' allow you to adjust all the grid properties, formula 
labels, line style and axis properties; you can read an overview in the 'Graph properties' section. Use the 
'Apply' button to refresh the graph preview after you have made any changes to the graph. 
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'Grids and graphs (advanced examples)' icon: 

Figure 3. 'Grids and graphs (advanced examples)' dialog; click on the image to enlarge.

4. Add custom graph: equation editor

This option allows you to create a graph based on a formula that is entered using MathType as an
equation editor. The math editor is also required to enter math that is too complex to be entered in linear
format or when symbols are required that are not available on the keyboard. For more information on
using MathType to enter mathematical expressions, please visit their website.

Once you have entered the equation in MathType, select it and copy it to the clipboard (Ctrl+C). Make
sure that the entered formula is suitable for conversion to a graph. Next, switch to TactileView and select
'Draw graph' from the drawing tools icon bar, then choose 'Add custom graph: equation editor' from the
properties toolbar. Alternatively, this option can also be found in the Graphs menu.

In the dialog that appears, select the preferred mathematical notation and click on 'Paste math equation
from clipboard'. The equation will now be displayed in both visual (linear and spatial) and braille format.
Choose 'OK' to confirm.

In the formula dialog that appears, the options below the formula as well as the buttons 'Positions and
appearance', 'Horizontal (x) axis' and 'Vertical (y) axis' allow you to adjust all the grid properties, formula
labels, line style and axis properties; you can read an overview in the 'Graph properties' section. Use the
'Apply' button to refresh the graph preview after you have made any changes to the graph.
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Once you are satisfied with the composed graph, select 'OK' to close the dialog and insert the graph in the 
design. 

elf= 

'Add custom graph: equation editor' icon: 3x2

Add mathematical equation —El 
Inserting mathematical equations using MathType: 
1. Launch MathType and compose an equation. 
2. Select the equation (ctrl.a) and copy it to the clipboard 
3. In TacbleView, add a new text label using the option Math input. 
4. Select the preferred mathematical notation and press the button Taste Math Equation from Cipboard". 
Please note: the brale representation of a mathematical equation is detenrined by a combination of the selected mathematical notation and 
the selected brale table. 

Select mathematical notation: Text representation: 

Linear Text 
Marburg 
Nemeth 
UKMaths V

Spatial representation: Braile representation: 

Distance to left edge (an): 

Distance to top edge (an): 

Wrap length (betneen 10 and 255 characters): 

0.00 

0.00 

30 

Paste Math Equation from Clipboard 

Image scale (%): 

Select Brale table for this text label: 

main table (DUTCH2O05) 

200 

V 

SSowthide underlying MathML 

°K Cancel 

Figure 4. 'Add custom graph: keyboard input' dialog; click on the image to enlarge. 

5. Add custom graph: keyboard input 

When you activate 'Add custom graph: keyboard input' from the Graphs menu or from the properties 
toolbar of Draw graph', a formula dialog will open. Enter the formula in the first entry field, making sure 
to use the correct syntax (e.g. 2*x instead of 2x, x^2 for x squared, etc.) similar to entering an equation in 
software such as Microsoft Excel. You can also select elements from the list of available functions and 
constants and insert them into the formula by double clicking on it or pressing the Enter key. 

Once again, the options below the formula as well as the buttons Positions and appearance', 'Horizontal 
(x) axis' and 'Vertical (y) axis' allow you to adjust all the grid properties, formula labels, line style and 
axis properties; you can read an overview in the 'Graph properties' section. Use the 'Apply' button to 
refresh the graph preview after you have made any changes to the graph. 
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Once you are satisfied with the composed graph, select 'OK' to close the dialog and insert the graph in the
design.

'Add custom graph: equation editor' icon: 

Figure 4. 'Add custom graph: keyboard input' dialog; click on the image to enlarge.

5. Add custom graph: keyboard input

When you activate 'Add custom graph: keyboard input' from the Graphs menu or from the properties
toolbar of 'Draw graph', a formula dialog will open. Enter the formula in the first entry field, making sure
to use the correct syntax (e.g. 2*x instead of 2x, x^2 for x squared, etc.) similar to entering an equation in
software such as Microsoft Excel. You can also select elements from the list of available functions and
constants and insert them into the formula by double clicking on it or pressing the Enter key.

Once again, the options below the formula as well as the buttons 'Positions and appearance', 'Horizontal
(x) axis' and 'Vertical (y) axis' allow you to adjust all the grid properties, formula labels, line style and
axis properties; you can read an overview in the 'Graph properties' section. Use the 'Apply' button to
refresh the graph preview after you have made any changes to the graph.
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Once you are satisfied with the composed graph, select 'OK' to close the dialog and insert the graph in the 
design. 

Add custom graph: keyboard input' icon: 

Formula 1 

Enter the correct syntax to get a plot of the List of available functions and constants; by double 
desired formula and select a mathematical clicking an element is inserted at the insertion point 
notation for the corresponding text label. in the selected formula: 
Make sure to check the settings for the X- and 
Y-axis for the range of the graph. 

Syntax of Formula 1: 

Y= 

Text label representation of Formula 1: 

Linear Text 

Text label of Formula 1: 
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Line style of Formula 1: 

Line 
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Figure 5. Add custom graph: keyboard input' dialog; click on the image to enlarge. 
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Once you are satisfied with the composed graph, select 'OK' to close the dialog and insert the graph in the
design.

'Add custom graph: keyboard input' icon: 

Figure 5. 'Add custom graph: keyboard input' dialog; click on the image to enlarge.
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8.05 Graphing multiple lines 

TactileView provides the ability to graph four or more formulas at the same time. In the 'Creating a graph' 
section you can read how to prepare a graph with a single formula, to which you can odd additional 
tornados as described below. 

Adding a formula 

Select the graph in your design to which you wish to odd a formula. Similar to creating a new graph, 
when adding a formula you need to choose which input method you wait to use: you can either enter tic 
formula with MathType as an equation editor, or use the keyboard to enter the formula From the 
properties toolbar or context menu of the selected graph, choose 'Add function: keyboard input or 'Add 
Auction: equation editor'. In the dialog that appears, you can enter your new formula in the same way as 
win you created the graph. 

Notice that by default a dashed line style is selected to distinguish the different formulas fin each other, 
but you can change this to Line, Dot or Long/Short Broken if you wish. It is recommended to choose a 
different line style for each formula you enter. The legend above the graph shows which formula 
corresponds with which line style. On screen, four different colours are used to easily distinguish between 
the formulas. 

You can apply any changes in the graph preview on the right aide of the dialog at any time by choosing 
the 'Apply button. Win you are satisfied with the selected options for the new formula dialog, choose 
the 'OK' button to save your changes, close the dialog and update your graph. In the properties toolbar 
you will see that the icon for 'Formula 7 is no longer greyed out, indicating that a second formula is 
present in the graph. 

You can add a third or fourth formula by following this same process after selecting the graph and 
choosing 'Add Auction: keyboard input' or 'Add function: equation editor' from the properties toolbar or 
context menu. If you wish to include more than four formulas, you will need to add the remaining 
formulas to one of the first four, separated by a semicolon: eg. ain(x^2).,cos(x^2). These will be plotted as 
seperate lines, but with the same line style and other properties. 

•Y= 
Add function: keyboard input' icon: ' A' 

4y= 
Add fiaction: equation editor' icon: 3)(2

ti(x) f2(x) f3(x) 
Formula 1-4' icons: 
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8.05 Graphing multiple lines

TactileView provides the ability to graph four or more formulas at the same time. In the 'Creating a graph'
section you can read how to prepare a graph with a single formula, to which you can add additional
formulas as described below.

Adding a formula

Select the graph in your design to which you wish to add a formula. Similar to creating a new graph,
when adding a formula you need to choose which input method you want to use: you can either enter the
formula with MathType as an equation editor, or use the keyboard to enter the formula. From the
properties toolbar or context menu of the selected graph, choose 'Add function: keyboard input' or 'Add
function: equation editor'. In the dialog that appears, you can enter your new formula in the same way as
when you created the graph.

Notice that by default a dashed line style is selected to distinguish the different formulas from each other,
but you can change this to Line, Dot or Long/Short Broken if you wish. It is recommended to choose a
different line style for each formula you enter. The legend above the graph shows which formula
corresponds with which line style. On screen, four different colours are used to easily distinguish between
the formulas.

You can apply any changes in the graph preview on the right side of the dialog at any time by choosing
the 'Apply' button. When you are satisfied with the selected options for the new formula dialog, choose
the 'OK' button to save your changes, close the dialog and update your graph. In the properties toolbar
you will see that the icon for 'Formula 2' is no longer greyed out, indicating that a second formula is
present in the graph.

You can add a third or fourth formula by following this same process after selecting the graph and
choosing 'Add function: keyboard input' or 'Add function: equation editor' from the properties toolbar or
context menu. If you wish to include more than four formulas, you will need to add the remaining
formulas to one of the first four, seperated by a semicolon: e.g. sin(x^2);cos(x^2). These will be plotted as
seperate lines, but with the same line style and other properties.

'Add function: keyboard input' icon: 

'Add function: equation editor' icon: 

'Formula 1-4' icons: 
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Figure 1. Different line styles, such as dashed or dotted lines, are used to distinguish different formulas in
a graph; on screen, colours are used to signify these differences.
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8.06 Saving grids as MyGrids 

The example grids (empty grid paper as well as graphs) are called TVGrids. These examples can be 
modified to use them as the basis for your own graphs. Any grid can be added to this list by saving them 
as MyGrids. This allows you to easily store them for later use. You can find your saved MyGrids below 
the list of TVGrids in 'Grids and graphs (advanced examples)'. 

You can save a selected grid as MyGrid by selecting 'Add to MyGrids' from the properties toolbar or 
context menu. Enter agrid name as a reference, then click 'Yes' to save the grid. 

Add to MyGrids' icon: 
My 

Menu Graphs - Update MyGrids 

If you wish to modify or remove any of the saved MyGrids, select 'Update MyGrids' from the Graphs 
menu and select one from the list. 

To modify a MyGrid, select 'Change properties' to make the desired changes. After you have applied the 
changes, you can choose to save the modified grid as a new MyGrid by selecting 'Add modified grid to 
MyGrids' or overwrite the existing one by choosing 'Replace changed grid in MyGrids'. You can also 
choose to delete one of the MyGrids from the list by selecting 'Remove grid from MyGrids'. 
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8.06 Saving grids as MyGrids

The example grids (empty grid paper as well as graphs) are called TVGrids. These examples can be
modified to use them as the basis for your own graphs. Any grid can be added to this list by saving them
as MyGrids. This allows you to easily store them for later use. You can find your saved MyGrids below
the list of TVGrids in 'Grids and graphs (advanced examples)'.

You can save a selected grid as MyGrid by selecting 'Add to MyGrids' from the properties toolbar or
context menu. Enter agrid name as a reference, then click 'Yes' to save the grid.

'Add to MyGrids' icon: 

Menu Graphs - Update MyGrids

If you wish to modify or remove any of the saved MyGrids, select 'Update MyGrids' from the Graphs
menu and select one from the list.

To modify a MyGrid, select 'Change properties' to make the desired changes. After you have applied the
changes, you can choose to save the modified grid as a new MyGrid by selecting 'Add modified grid to
MyGrids' or overwrite the existing one by choosing 'Replace changed grid in MyGrids'. You can also
choose to delete one of the MyGrids from the list by selecting 'Remove grid from MyGrids'.
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Update MyGrids 

Below you will find a list of sample grids with blank grids or combinations of formulas. These grids can be modified to create your own tactile grids and can be saved 
as MyGrids. 

Select a sample grid (38 items): 

MyGrids-Exercise 1: -4<X<4, -4O<4; size: 5.00 x 5.00 inch; grid boxes: 8 x 8; style: Line 
MyGrids-Exercise 2: -4<0<4, -4O[4; size: 5.00 x 5.00 inch; grid boxes: 8 x 8; style: Line 
MyGrids-Exerdse 3: -4‹..X<4 -4O<4. size: 5.00 x 5.00 inch; grid boxes: 8 x 8. style: Line 

Properties of the grid (8 items): 

Name: Sine wave 
Positions and Appearance: position: 1.80, 1.80 inch; border yes; style: Line; line thickness 2; bee height 3; formula thickness 2; axis thickness 6 
Horizontal (X) Axis: -4‹.X<4; size: 5.00 inch; grid range: 1; tick size: 1; tid<s per label: 1 
Vertical (Y) Axis: -4O<4; size: 5.00 inch; grid range: 1; tick size: 1; tid<s per label: 1 

�v Formula 1: y=sin(x), style: Line 
�v��Formula 2: 
MFormula 3: 

Change properties ... 

MyGrid Options 

Remove Grid from MyGrids 

Add modified grid to MyGrids 

Replace changed grid in MyGrids 

Close 1 

Figure 1. The 'Update MyGrids' dialog allows you to edit the list of saved graphs; click on the image to 
enlarge. 
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Figure 1. The 'Update MyGrids' dialog allows you to edit the list of saved graphs; click on the image to
enlarge.
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9.01 Inserting graphics in Duxbury Braille Translator (DBT) 

When you have both TactileView 2.200 or higher, and Duxbury Braille Translator (DBT) 11.3 or higher 
installed, you will be able to insert a TactileView design into a text in DBT. This produces a document 
containing both text and graphics. You can choose to add a completely new design or use an existing file. 
The available space for the image will automatically be taken into account. 

For TactileView version 2.250 or higher, an update is required for DBT to support high resolution 
graphics for Index V4 and V5 embossers. Select 'Check for Updates' from the Help menu in DBT to 
download and install this update. 

If you do not have DBT installed yet, please visit their website.

1. Preparing DBT document 
Launch DBT, create a new document and add the text in which you wish to insert tactile graphics. You 
can find more information on working in DBT, creating files and producing the correct braille translation 
on their website.

2. Inserting existing images 
In order to insert a design, move the caret to the position in the DBT text where you want to insert an 
image. Select Layout > Picture > Add.., then select the desired TactileView design (.bpx file) and click 
Open. The tactile image is now inserted in the DBT text file. The small yellow logo in the upper right 
corner of the image indicates that the graphic was created in TactileView. 
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9.01 Inserting graphics in Duxbury Braille Translator (DBT)

When you have both TactileView 2.200 or higher, and Duxbury Braille Translator (DBT) 11.3 or higher
installed, you will be able to insert a TactileView design into a text in DBT. This produces a document
containing both text and graphics. You can choose to add a completely new design or use an existing file.
The available space for the image will automatically be taken into account.

For TactileView version 2.250 or higher, an update is required for DBT to support high resolution
graphics for Index V4 and V5 embossers. Select 'Check for Updates' from the Help menu in DBT to
download and install this update.

If you do not have DBT installed yet, please visit their website.

1. Preparing DBT document
Launch DBT, create a new document and add the text in which you wish to insert tactile graphics. You
can find more information on working in DBT, creating files and producing the correct braille translation
on their website.

2. Inserting existing images
In order to insert a design, move the caret to the position in the DBT text where you want to insert an
image. Select Layout > Picture > Add.., then select the desired TactileView design (.bpx file) and click
Open. The tactile image is now inserted in the DBT text file. The small yellow logo in the upper right
corner of the image indicates that the graphic was created in TactileView.
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3. Image positioning 
You can choose to insert an image either before or after translation of the braille document (ctri+T). 
Either way, the amount of space needed on the page for the image is automatically taken into account. If 
the image is too large to fit on the current page, it will be placed at the top of the following page. Any 
empty white space around the edges of the TactileView design will be removed automatically for optimal 
use of space. For the best results, make sure that the same embosser and paper size are selected in 
TactileView and DBT. In TactileView, the red border indicates the available printable area for the 
selected combination of embosser and paper size. 
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3. Image positioning
You can choose to insert an image either before or after translation of the braille document (ctrl+T).
Either way, the amount of space needed on the page for the image is automatically taken into account. If
the image is too large to fit on the current page, it will be placed at the top of the following page. Any
empty white space around the edges of the TactileView design will be removed automatically for optimal
use of space. For the best results, make sure that the same embosser and paper size are selected in
TactileView and DBT. In TactileView, the red border indicates the available printable area for the
selected combination of embosser and paper size.
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4. Edidng Inserted images 
If you wish to edit the inserted tactile graphics, simply double click on the image in DBT. This will 
launch the TactileView software, in which you can make any desired adjustments. Once you are satisfied, 
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4. Editing inserted images
If you wish to edit the inserted tactile graphics, simply double click on the image in DBT. This will
launch the TactileView software, in which you can make any desired adjustments. Once you are satisfied,
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you can save the changes by clicking on the 'Insert design in external text file' icon in the top right corner 
of the canvas area, or select File > Insert design in external text file. 

Icon for Insert design in external text file: —

5. Removing images 
You can remove inserted images by moving the caret position right after the image and pressing 
backspace, or delete with the caret just before the image. 

6. Printing combined text and graphics files 
An embosser that supports printing tactile graphics is required for printing the DBT file containing the 
images. In TactileView, you can see a preview of the graphic output of the selected embosser by selecting 
menu View > Design mode: dot view, or by viewing the print preview. 
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you can save the changes by clicking on the 'Insert design in external text file' icon in the top right corner
of the canvas area, or select File > Insert design in external text file.

Icon for Insert design in external text file: 

5. Removing images
You can remove inserted images by moving the caret position right after the image and pressing
backspace, or delete with the caret just before the image.

6. Printing combined text and graphics files
An embosser that supports printing tactile graphics is required for printing the DBT file containing the
images. In TactileView, you can see a preview of the graphic output of the selected embosser by selecting
menu View > Design mode: dot view, or by viewing the print preview.
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10.01 Accessibility with a screen reader (introduction) 

The TactileView software is fully accessible with a screen reader. Due to its visual nature, creating a 
tactile design from scratch is very challenging for VIP users. However, many other aspects of the 
software can be used without the need for a sighted designer. This section will give an overview of the 
suitability for screen reader users of different aspects of TactileView. 

Accessible menus 

All menus and dialogs are accessible. Some of the menus are specially designed for screen reader users. 
Extra messages besides those of the screen reader itself are read out to provide additional explanations 
where appropriate. 

Make sure the Settings menu Speech has been covered to make full use of these audible messages. 

Mouse/freehand drawing vs. Menu driven design 

To follow see the mouse on screen in the drawing area of the software is virtually impossible, even if the 
position of the mouse would be announced frequently. Keeping track of the created design is impossible 
with only speech and/or braille. 

Existing images can be explored by analysing the colour composition, but how they are curved or the way 
how the lines intersect cannot be explored without printing the design. Therefore, creating or modifying 
`free-hand' drawing is a step too far. 

As an alternative, objects such as squares, circles and straight lines can be added to the design. Their 
positions are indicated by their properties (Ctrl+J). 

Placing such an object can be done with the menu driven design menu (Ctrl+l). 

Things that work really well for a screen reader 

Below you will find some of the ways to create a tactile diagram while using a screen reader that work 
really well. 

Creating digital designs by hand 

Using the TactiPad drawing board would be a great alternative for creating tactile images as a VIP. Using 
this board, you can create a tactile drawing by hand. When combined with a camera, you can take a 
picture and digitally save your drawing or send it by mail. As a more advanced way of drawing, you can 
digitize your manual drawing using the TactileView Digital pen. 

Download and Edit Design from Catalog (Portal menu) 

You can use the catalog to find and download suitable tactile diagrams by selecting a category or 
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10.01 Accessibility with a screen reader (introduction)

The TactileView software is fully accessible with a screen reader. Due to its visual nature, creating a
tactile design from scratch is very challenging for VIP users. However, many other aspects of the
software can be used without the need for a sighted designer. This section will give an overview of the
suitability for screen reader users of different aspects of TactileView.

Accessible menus

All menus and dialogs are accessible. Some of the menus are specially designed for screen reader users.
Extra messages besides those of the screen reader itself are read out to provide additional explanations
where appropriate.

Make sure the Settings menu Speech has been covered to make full use of these audible messages.

Mouse/freehand drawing vs. Menu driven design

To follow see the mouse on screen in the drawing area of the software is virtually impossible, even if the
position of the mouse would be announced frequently. Keeping track of the created design is impossible
with only speech and/or braille.

Existing images can be explored by analysing the colour composition, but how they are curved or the way
how the lines intersect cannot be explored without printing the design. Therefore, creating or modifying
‘free-hand’ drawing is a step too far.

As an alternative, objects such as squares, circles and straight lines can be added to the design. Their
positions are indicated by their properties (Ctrl+J).

Placing such an object can be done with the menu driven design menu (Ctrl+l).

Things that work really well for a screen reader

Below you will find some of the ways to create a tactile diagram while using a screen reader that work
really well.

Creating digital designs by hand

Using the TactiPad drawing board would be a great alternative for creating tactile images as a VIP. Using
this board, you can create a tactile drawing by hand. When combined with a camera, you can take a
picture and digitally save your drawing or send it by mail. As a more advanced way of drawing, you can
digitize your manual drawing using the TactileView Digital pen.

Download and Edit Design from Catalog (Portal menu)

You can use the catalog to find and download suitable tactile diagrams by selecting a category or
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searching for keywords in the title, textlabels or description. 

Especially the alternate text that was given by the designer to describe the design can help to determine if 
this is the required design. The alternate text or description can be extended by any visitor of the catalog 
to make the description more detailed. 

See also the section 'Using the TactileView online catalog'. 

Compose map (Portal menu) 

To create a tactile map, choose 'Compose map' from the Portal menu. This will open a browser window 
with the website www.routetactile.com, on which you can create a map of any specified area. You can 
find a detailed description of all that is involved to create a tactile usable map in the Tactile Maps section. 

Create mathematical graphs (Graphs menu) 

With a screen reader, you can create a graph of any mathematical formula. You can either enter an 
equation to create your graph or start from one of the sample graphs in the software. See also the category 
Graphs and math in the TactileView manual. 

Printing designs 

You can also print designs on swellpaper or with a braille embosser by choosing 'Print' from the File 
menu. You can read more in the Printing section of the manual. 
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searching for keywords in the title, textlabels or description.

Especially the alternate text that was given by the designer to describe the design can help to determine if
this is the required design. The alternate text or description can be extended by any visitor of the catalog
to make the description more detailed.

See also the section 'Using the TactileView online catalog'.

Compose map (Portal menu)

To create a tactile map, choose 'Compose map' from the Portal menu. This will open a browser window
with the website www.routetactile.com, on which you can create a map of any specified area. You can
find a detailed description of all that is involved to create a tactile usable map in the Tactile Maps section.

Create mathematical graphs (Graphs menu)

With a screen reader, you can create a graph of any mathematical formula. You can either enter an
equation to create your graph or start from one of the sample graphs in the software. See also the category
Graphs and math in the TactileView manual.

Printing designs

You can also print designs on swellpaper or with a braille embosser by choosing 'Print' from the File
menu. You can read more in the Printing section of the manual.
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10.02 Settings - Speech 

In most cases, screen reader users will have a speech output for general computer access. For specific 
applications, screen readers have functionality to monitor certain areas on the screen in order to provide 
speech output. 

The TactileView software can also provide information that is helpful for a screen reader user from the 
status line of the software or info related to all the many tools and objects. 

When the TactileView software is extended with the TactileView digital pen and either the TactileView 
ClickPad or the TactiPad drawing board, additional options for exploring audio-tactile diagrams or 
creating digital drawings become available. 

The operation of these additional options greatly depends on using a screen reader. The speech settings 
are applied while using these extensions as well. 

See also the sections in the category 'Digital pen, TactiPad and ClickPad' 

Language selection and Text-To-Speech (TTS) 

Textlabels and messages are displayed in the language that was selected in the 'Language' dialog in the 
Settings menu. 

For announcing these texts, a text to speech (TTS) synthesizer has to be selected. Microsoft supplies a 
few TTS engines with the Windows operating system. Extra TTS synthesisers can be installed from 
Eloquence, Nuance, L&H or other vendors. 

Volume and rate 

The volume and rate of spoken messages can be set to find a match with the volume and rate with the 
speech output of the screen reader. Use the 'Speak' button to test the selected voice, rate and volume. 

Speak application messages (select checked) 

The software can provide messages in addition to a screen reader. These messages contain status 
information about the drawing tools and properties of the objects. When you use TactileView with a 
screen reader, the option 'Use text to speech for application messages and audio style' should be checked. 

Speak audio style or text label upon object selection (Select checked) 

When an object gets the focus (is selected) the type of object and some properties are announced. For 
screen reader usage, 'Speak audio style or text label upon object selection' should be checked. 

Text to speech for different languages 
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10.02 Settings - Speech

In most cases, screen reader users will have a speech output for general computer access. For specific
applications, screen readers have functionality to monitor certain areas on the screen in order to provide
speech output.

The TactileView software can also provide information that is helpful for a screen reader user from the
status line of the software or info related to all the many tools and objects.

When the TactileView software is extended with the TactileView digital pen and either the TactileView
ClickPad or the TactiPad drawing board, additional options for exploring audio-tactile diagrams or
creating digital drawings become available.

The operation of these additional options greatly depends on using a screen reader. The speech settings
are applied while using these extensions as well.

See also the sections in the category 'Digital pen, TactiPad and ClickPad'

Language selection and Text-To-Speech (TTS)

Textlabels and messages are displayed in the language that was selected in the 'Language' dialog in the
Settings menu.

For announcing these texts, a text to speech (TTS) synthesizer has to be selected. Microsoft supplies a
few TTS engines with the Windows operating system. Extra TTS synthesisers can be installed from
Eloquence, Nuance, L&H or other vendors.

Volume and rate

The volume and rate of spoken messages can be set to find a match with the volume and rate with the
speech output of the screen reader. Use the 'Speak' button to test the selected voice, rate and volume.

Speak application messages (select checked)

The software can provide messages in addition to a screen reader. These messages contain status
information about the drawing tools and properties of the objects. When you use TactileView with a
screen reader, the option 'Use text to speech for application messages and audio style' should be checked.

Speak audio style or text label upon object selection (Select checked)

When an object gets the focus (is selected) the type of object and some properties are announced. For
screen reader usage, 'Speak audio style or text label upon object selection' should be checked.

Text to speech for different languages
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Some designs may contain texts in different languages, making the text to speech difficult to understand. 
If possible, it is best to use the TTS that matches the text label language. 

For any languages in the list that show 'not defined', the default TTS synthesiser will be used. To apply a 
specific TTS synthesiser for a certain language, select the language from the list, then select the TTS you 
wish to use in the list below. 
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Some designs may contain texts in different languages, making the text to speech difficult to understand.
If possible, it is best to use the TTS that matches the text label language.

For any languages in the list that show 'not defined', the default TTS synthesiser will be used. To apply a
specific TTS synthesiser for a certain language, select the language from the list, then select the TTS you
wish to use in the list below.
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10.03 Drawing tools - Menu driven design (Ctrl+L) 

TactileView is designed to allow the user to create and edit objects solely through the use of the menus, a 
feature referred to as 'menu-driven design'. This method of creating graphics takes some practice, as you 
must decide where to place objects based on the distance of a specified critical point for each type of 
object away from the top and left edges of the design. 

Menu-driven design may be used to edit existing graphics or to create new ones. This tutorial describes 
common functions for adding and editing objects in a drawing. 

Adding objects 

The drawing tools have been designed to use a coordinate-based drawing system. This means that each 
time you select a drawing tool, a dialog will appear that lets you specify the location in which the object 
will be inserted by inputting position and size information for that object. 

Drawing straight lines 

To draw a straight line, choose the 'Draw Straight Line' option from the Drawing tools menu. This will 
bring up a dialog allowing you to specify the position of the start and end points of the line you want to 
insert. Fill in the horizontal and vertical positions for the start and end points and enter the desired line 
length, then choose the 'OK' button to close the dialog and insert the line. 

Drawing squares and rectangles 

To draw a square or rectangle, select the 'Draw Square-Rectangle' option from the Drawing tools menu. 
This will bring up a dialog allowing you to specify the size and position of the square or rectangle you 
want to insert. Fill in the desired position of the upper left corner of the shape. To specify the size, first 
choose the Enlarge/reduce radio button if you want to insert square or the Stretch radio button if you want 
to insert a rectangle. Specify the width of the object. If you are inserting a square, you do not need to 
specify the height. If you are inserting a rectangle, enter the desired height of the object. Select the 'OK' 
button to close the dialog and insert the object. 

Drawing circles and ovals 

To draw a circle or oval, choose the 'Draw Circle-Ellipse' option from the Drawing tools menu. The 
dialog that comes up allows you to specify the size and position of the circle or oval you want to insert. 
Enter the position of the center of the circle. Next, choose either the Enlarge/reduce radio button to create 
a circle or the Stretch radio button to create an oval. Specify the width of your object. If you are inserting 
a circle, you do not need to enter the height. If you are inserting an oval, enter the desired height of the 
oval. Select the 'OK' button to close the dialog and insert the object into your file. 

Drawing polygons 

To insert a polygon, choose the 'Draw Polygon' item from the Drawing tools menu. A dialog appears, 
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10.03 Drawing tools - Menu driven design (Ctrl+L)

TactileView is designed to allow the user to create and edit objects solely through the use of the menus, a
feature referred to as 'menu-driven design'. This method of creating graphics takes some practice, as you
must decide where to place objects based on the distance of a specified critical point for each type of
object away from the top and left edges of the design.

Menu-driven design may be used to edit existing graphics or to create new ones. This tutorial describes
common functions for adding and editing objects in a drawing.

Adding objects

The drawing tools have been designed to use a coordinate-based drawing system. This means that each
time you select a drawing tool, a dialog will appear that lets you specify the location in which the object
will be inserted by inputting position and size information for that object.

Drawing straight lines

To draw a straight line, choose the 'Draw Straight Line' option from the Drawing tools menu. This will
bring up a dialog allowing you to specify the position of the start and end points of the line you want to
insert. Fill in the horizontal and vertical positions for the start and end points and enter the desired line
length, then choose the 'OK' button to close the dialog and insert the line.

Drawing squares and rectangles

To draw a square or rectangle, select the 'Draw Square-Rectangle' option from the Drawing tools menu.
This will bring up a dialog allowing you to specify the size and position of the square or rectangle you
want to insert. Fill in the desired position of the upper left corner of the shape. To specify the size, first
choose the Enlarge/reduce radio button if you want to insert square or the Stretch radio button if you want
to insert a rectangle. Specify the width of the object. If you are inserting a square, you do not need to
specify the height. If you are inserting a rectangle, enter the desired height of the object. Select the 'OK'
button to close the dialog and insert the object.

Drawing circles and ovals

To draw a circle or oval, choose the 'Draw Circle-Ellipse' option from the Drawing tools menu. The
dialog that comes up allows you to specify the size and position of the circle or oval you want to insert.
Enter the position of the center of the circle. Next, choose either the Enlarge/reduce radio button to create
a circle or the Stretch radio button to create an oval. Specify the width of your object. If you are inserting
a circle, you do not need to enter the height. If you are inserting an oval, enter the desired height of the
oval. Select the 'OK' button to close the dialog and insert the object into your file.

Drawing polygons

To insert a polygon, choose the 'Draw Polygon' item from the Drawing tools menu. A dialog appears,
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allowing you to enter the number of points you want in your polygon and define their positions. By 
default the polygon starts with three points. Select each point from the anchor points list and specify its 
location. The software calculates the angle from the previous point and the distance to the previous point 
for you. You can add more points by choosing the 'Add anchor point' button, and you can remove 
unnecessary points by choosing 'Delete anchor point'. When you are finished, choose the 'OK' button to 
close the dialog and insert the shape. 

NOTE: Points in the polygon can be added and deleted later when editing the shape with either the 
context menu options or the mouse. 

Drawing triangles 

To insert a triangle into your drawing, select the 'Draw Triangle' option from the Drawing Tools menu. 
The dialog that appears allows you to select the type of triangle you want to insert (right, isosceles, 
equilateral or scalene) and enter the positions of the points of the triangle. Select each point from the 
anchor points list and enter the desired position. The software calculates the length of each line segment 
touching the point, as well as the angle between them. When you are finished, choose OK to close the 
dialog and insert the triangle into your file. 

Adding arows and other figures 

To add arrows or other commonly used shapes, choose 'Add Figure' from the Drawing tools menu. A 
dialog containing a list of available figure categories including arrows, electrical symbols and more 
appears. (NOTE: You can also add your own commonly used shapes as figures so that you can easily 
insert them into files. Please refer to the Adding Figures to the Figure Library tutorial for more 
information.) Browse through the categories and select a figure to add, then choose 'OK'. 

Next a size and position dialog appears, allowing you to specify the position of the figure in your 
drawing. Choose the Enlarge/reduce radio button if you want to lock the object's height with respect to 
the width when choosing the size, or choose the Stretch radio button if you want to define the width and 
height separately. Choose the 'OK' button to close the dialog and insert the object into your file. 

Drawing freehand lines 

A true freehand line can be drawn accessibly using the digital pen with the software. However, you can 
draw a line or closed shape point by point with the menu-driven design by choosing the 'Draw Freehand 
Line-Closed Shape' option from the Drawing tools menu. The same dialog that appears for the 'Draw 
Polygon' function appears for drawing freehand lines, allowing you to enter the number of points you 
want in your line or shape and define their positions. By default the line or shape starts with four points. 
Select each point from the anchor points list and specify its location. The software calculates the angle 
from the previous point and the distance to the previous point for you. You can add more points by 
choosing the 'Add anchor point' button, and you can remove unnecessary points by choosing 'Delete 
anchor point'. When you are finished, choose the 'OK' button to close the dialog and insert the shape. 

NOTE: Points in the line or shape can be added and deleted later when editing it. 
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allowing you to enter the number of points you want in your polygon and define their positions. By
default the polygon starts with three points. Select each point from the anchor points list and specify its
location. The software calculates the angle from the previous point and the distance to the previous point
for you. You can add more points by choosing the 'Add anchor point' button, and you can remove
unnecessary points by choosing 'Delete anchor point'. When you are finished, choose the 'OK' button to
close the dialog and insert the shape.

NOTE: Points in the polygon can be added and deleted later when editing the shape with either the
context menu options or the mouse.

Drawing triangles

To insert a triangle into your drawing, select the 'Draw Triangle' option from the Drawing Tools menu.
The dialog that appears allows you to select the type of triangle you want to insert (right, isosceles,
equilateral or scalene) and enter the positions of the points of the triangle. Select each point from the
anchor points list and enter the desired position. The software calculates the length of each line segment
touching the point, as well as the angle between them. When you are finished, choose OK to close the
dialog and insert the triangle into your file.

Adding arows and other figures

To add arrows or other commonly used shapes, choose 'Add Figure' from the Drawing tools menu. A
dialog containing a list of available figure categories including arrows, electrical symbols and more
appears. (NOTE: You can also add your own commonly used shapes as figures so that you can easily
insert them into files. Please refer to the Adding Figures to the Figure Library tutorial for more
information.) Browse through the categories and select a figure to add, then choose 'OK'.

Next a size and position dialog appears, allowing you to specify the position of the figure in your
drawing. Choose the Enlarge/reduce radio button if you want to lock the object's height with respect to
the width when choosing the size, or choose the Stretch radio button if you want to define the width and
height separately. Choose the 'OK' button to close the dialog and insert the object into your file.

Drawing freehand lines

A true freehand line can be drawn accessibly using the digital pen with the software. However, you can
draw a line or closed shape point by point with the menu-driven design by choosing the 'Draw Freehand
Line-Closed Shape' option from the Drawing tools menu. The same dialog that appears for the 'Draw
Polygon' function appears for drawing freehand lines, allowing you to enter the number of points you
want in your line or shape and define their positions. By default the line or shape starts with four points.
Select each point from the anchor points list and specify its location. The software calculates the angle
from the previous point and the distance to the previous point for you. You can add more points by
choosing the 'Add anchor point' button, and you can remove unnecessary points by choosing 'Delete
anchor point'. When you are finished, choose the 'OK' button to close the dialog and insert the shape.

NOTE: Points in the line or shape can be added and deleted later when editing it.
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Text labels 

You may add text format labels to a file at any time. There are several formats of labels available for use 
in TactileView. The most commonly used type of label in TactileView is referred to simply as a 'text 
label'. Text labels may be entered in plain text and be automatically translated to braille when they appear 
in the document, or they may be entered directly in braille through six-key input. 

In addition to text labels, TactileView offers the option to add mammoth braille labels or print character 
labels that will be embossed as raised text. 

NOTE: Labels may only be edited according to the input method used to create them. For example, a text 
label entered via braille (six-key) input may only be edited using six-key, and a raised print character 
label may only be edited as a raised print character label. Labels can't be converted from one type of 
label to another. 

Adding text labels 

The most commonly used type of label in TactileView is referred to simply as a 'text label'. Text labels 
may be entered in plain text, and then they are automatically translated to braille when they appear in the 
document. 

When using menu-driven design, text labels can be added either by choosing 'Add Text Label' from the 
Drawing Tools menu of the software, or by opening the List of Objects (Ctrl+L), choosing the 'Add Text 
Label or Object' button and selecting 'Add Text Label' from the list of options. 

A dialog will appear, allowing you to enter the text for your label, select the braille table to use for 
translation and input position information. 

Enter the text you want to use in your label into the Contents box. Select the braille table to use for 
translation from the Select Braille Table for this Label combo box. 

Enter the location for the text label by editing in the Distance to Left Edge and Distance to Top Edge 
fields. You can also control the width of the text label by specifying the maximum number of characters 
you'd like it to have before the text wraps to the next line. Choose 'OK' to close the dialog and insert the 
label. 

Adding text labels through six-key entry 

Currently this option is only available accessibly through the use of the digital pen. Please refer to the 
Accessible Drawing Using the Digital Pen tutorial. 

Adding mammoth braille labels 

When using menu-driven design, mammoth braille labels can be added either by choosing 'Draw 
Mammoth Braille' from the Drawing Tools menu of the software, or by opening the List of Objects 
(Ctrl+L), choosing the 'Add Text Label or Object' button and selecting 'Draw Mammoth Braille' from the 
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Text labels

You may add text format labels to a file at any time. There are several formats of labels available for use
in TactileView. The most commonly used type of label in TactileView is referred to simply as a 'text
label'. Text labels may be entered in plain text and be automatically translated to braille when they appear
in the document, or they may be entered directly in braille through six-key input.

In addition to text labels, TactileView offers the option to add mammoth braille labels or print character
labels that will be embossed as raised text.

NOTE: Labels may only be edited according to the input method used to create them. For example, a text
label entered via braille (six-key) input may only be edited using six-key, and a raised print character
label may only be edited as a raised print character label. Labels can’t be converted from one type of
label to another.

Adding text labels

The most commonly used type of label in TactileView is referred to simply as a 'text label'. Text labels
may be entered in plain text, and then they are automatically translated to braille when they appear in the
document.

When using menu-driven design, text labels can be added either by choosing 'Add Text Label' from the
Drawing Tools menu of the software, or by opening the List of Objects (Ctrl+L), choosing the 'Add Text
Label or Object' button and selecting 'Add Text Label' from the list of options.

A dialog will appear, allowing you to enter the text for your label, select the braille table to use for
translation and input position information.

Enter the text you want to use in your label into the Contents box. Select the braille table to use for
translation from the Select Braille Table for this Label combo box.

Enter the location for the text label by editing in the Distance to Left Edge and Distance to Top Edge
fields. You can also control the width of the text label by specifying the maximum number of characters
you’d like it to have before the text wraps to the next line. Choose 'OK' to close the dialog and insert the
label.

Adding text labels through six-key entry

Currently this option is only available accessibly through the use of the digital pen. Please refer to the
Accessible Drawing Using the Digital Pen tutorial.

Adding mammoth braille labels

When using menu-driven design, mammoth braille labels can be added either by choosing 'Draw
Mammoth Braille' from the Drawing Tools menu of the software, or by opening the List of Objects
(Ctrl+L), choosing the 'Add Text Label or Object' button and selecting 'Draw Mammoth Braille' from the
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list of options. In the dialog that appears, enter the text you wish to appear in mammoth braille and 
specify the position in which it should be inserted. Choose 'OK' to close the dialog and insert the 
mammoth braille label into your file. 

Adding raised print character labels 

When using menu-driven design, raised print character labels can be added either by choosing Draw 
Letters and Digits from the Drawing Tools menu of the software, or by opening the List of Objects 
(Ctrl+L), choosing the Add Text Label or Object button and selecting Draw Letters and Digits from the 
list of options. This launches a dialog that allows you to enter the text you wish to appear as print 
characters and specify its location in the drawing. Set the options as desired and choose 'OK' to close the 
dialog and insert the label into your file. 

Editing objects 

Selecting objects 

To select an object in the current drawing, open the List of Objects dialog either by choosing Menu 
Driven Design from the Drawing Tools menu (Alt+T, then M) or with the hotkey Ctrl+L. The List of 
Objects dialog shows the complete list of drawing objects in the current drawing by object type and gives 
identifying information about each object. To select an object, arrow through the list until you locate the 
object you want to work with. 

If, after selecting an object, you select the OK button on the List of Objects dialog, the dialog closes and 
the object you chose is selected. However, most common editing functions may also be performed 
directly from the List of Objects dialog, and this is the recommended method when using menu-driven 
design. 

Copying, pasting and deleting objects 

To copy an object, first press Ctrl+L to bring up the List of Objects dialog. Locate the object you wish to 
copy, choose the Open Context Menu button and select Copy. The object has now been copied to the 
clipboard. 

To paste an object from the clipboard, choose Paste from the Edit menu (Alt+E, P) or press Ctrl+V. This 
pastes the object centered at the upper left corner of the design. 

To delete an object, first press Ctrl+L to bring up the List of Objects dialog. Locate the object you wish to 
delete, choose the Open Context Menu button and select Delete. 

Moving and resizing objects 

Select the object you wish to move or resize from the List of Objects dialog and choose the Open Context 
Menu button. The context menu is slightly different depending on what object type is selected, but the 
position dialog can always be accessed through the first context menu item, which will be Size and 
Position, Text and Position or Positions of anchor points. Select this item to bring up the same dialog used 
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list of options. In the dialog that appears, enter the text you wish to appear in mammoth braille and
specify the position in which it should be inserted. Choose 'OK' to close the dialog and insert the
mammoth braille label into your file.

Adding raised print character labels

When using menu-driven design, raised print character labels can be added either by choosing Draw
Letters and Digits from the Drawing Tools menu of the software, or by opening the List of Objects
(Ctrl+L), choosing the Add Text Label or Object button and selecting Draw Letters and Digits from the
list of options. This launches a dialog that allows you to enter the text you wish to appear as print
characters and specify its location in the drawing. Set the options as desired and choose 'OK' to close the
dialog and insert the label into your file.

Editing objects

Selecting objects

To select an object in the current drawing, open the List of Objects dialog either by choosing Menu
Driven Design from the Drawing Tools menu (Alt+T, then M) or with the hotkey Ctrl+L. The List of
Objects dialog shows the complete list of drawing objects in the current drawing by object type and gives
identifying information about each object. To select an object, arrow through the list until you locate the
object you want to work with.

If, after selecting an object, you select the OK button on the List of Objects dialog, the dialog closes and
the object you chose is selected. However, most common editing functions may also be performed
directly from the List of Objects dialog, and this is the recommended method when using menu-driven
design.

Copying, pasting and deleting objects

To copy an object, first press Ctrl+L to bring up the List of Objects dialog. Locate the object you wish to
copy, choose the Open Context Menu button and select Copy. The object has now been copied to the
clipboard.

To paste an object from the clipboard, choose Paste from the Edit menu (Alt+E, P) or press Ctrl+V. This
pastes the object centered at the upper left corner of the design.

To delete an object, first press Ctrl+L to bring up the List of Objects dialog. Locate the object you wish to
delete, choose the Open Context Menu button and select Delete.

Moving and resizing objects

Select the object you wish to move or resize from the List of Objects dialog and choose the Open Context
Menu button. The context menu is slightly different depending on what object type is selected, but the
position dialog can always be accessed through the first context menu item, which will be Size and
Position, Text and Position or Positions of anchor points. Select this item to bring up the same dialog used
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to create the object initially, in which you can enter new locations for critical points in the object if you 
wish to move the object, or enter new height and width settings for objects if you wish to resize them. 

You can also center an object horizontally in the drawing by selecting it, choosing the Open Context 
Menu button and choosing Center. This will only automatically center the object horizontally; it will keep 
the same vertical position on the page. 

Rotating objects 

Select the object you wish to rotate from the List of Objects dialog, choose the Open Context Menu 
button and select Rotation. On the dialog that appears, enter the desired angle of rotation in degrees and 
choose OK to rotate the object. 

Changing object line properties 

Select the object you wish to edit from the List of Objects dialog, choose the Open Context Menu button 
and select Line Style. This opens a dialog from which you can set the line properties for the object, 
including the line pattern (solid or dashed) and thickness. The drop-down list for the line pattern describes 
the number of pixels of black + the number of pixels of white that make up the line. For example, 2+2 
means that the line will have two pixels of black followed by two pixels of white, while 5+3 will have 
five pixels of black followed by three pixels of white (so that the line is a pattern of longer black lines 
with shorter white spaces in between). Once you select the line patter, choose the thickness of the line in 
pixels. Choose OK to apply your changes to the object and close the dialog. 

Changing object fill properties 

Select the object you wish to edit from the List of Objects dialog, choose the Open Context Menu button 
and select Fill Style. This opens a dialog from which you can set the fill properties, including selecting a 
fill texture, scaling the size of the fill tiles and rotating the texture within the object. 

If you would like to add a fill texture to your object, select the Use Texture Fill radio button. Choose the 
Change Texture button to bring up a dialog containing a list of textures that can be used. Select a texture 
from the list of options and choose OK. Use the Tile Size in Pixels edit box to scale the texture larger or 
smaller. You can also rotate the texture using the Texture Rotation Angle edit box. When you are finished 
making changes, choose OK to apply the fill to your object. 

Adding audio labels 

Audio labels are a great way to add more information to a drawing without having to make it larger to 
accommodate more text or graphical information. The audio information is accessed by using the file in 
explore mode, either on screen with a mouse or on a tactile copy on the Clickpad or Tactipad with the 
digital pen. For more information on explore mode, please refer to the Using Explore Mode and Using the 
Pen in Explore Mode with the Clickpad or Tactipad tutorials. 

Audio labels can be added to any type of drawing object in TactileView, and to mammoth braille or 
raised print character labels. Audio labels may not be added to text labels, because text labels are 
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to create the object initially, in which you can enter new locations for critical points in the object if you
wish to move the object, or enter new height and width settings for objects if you wish to resize them.

You can also center an object horizontally in the drawing by selecting it, choosing the Open Context
Menu button and choosing Center. This will only automatically center the object horizontally; it will keep
the same vertical position on the page.

Rotating objects

Select the object you wish to rotate from the List of Objects dialog, choose the Open Context Menu
button and select Rotation. On the dialog that appears, enter the desired angle of rotation in degrees and
choose OK to rotate the object.

Changing object line properties

Select the object you wish to edit from the List of Objects dialog, choose the Open Context Menu button
and select Line Style. This opens a dialog from which you can set the line properties for the object,
including the line pattern (solid or dashed) and thickness. The drop-down list for the line pattern describes
the number of pixels of black + the number of pixels of white that make up the line. For example, 2+2
means that the line will have two pixels of black followed by two pixels of white, while 5+3 will have
five pixels of black followed by three pixels of white (so that the line is a pattern of longer black lines
with shorter white spaces in between). Once you select the line patter, choose the thickness of the line in
pixels. Choose OK to apply your changes to the object and close the dialog.

Changing object fill properties

Select the object you wish to edit from the List of Objects dialog, choose the Open Context Menu button
and select Fill Style. This opens a dialog from which you can set the fill properties, including selecting a
fill texture, scaling the size of the fill tiles and rotating the texture within the object.

If you would like to add a fill texture to your object, select the Use Texture Fill radio button. Choose the
Change Texture button to bring up a dialog containing a list of textures that can be used. Select a texture
from the list of options and choose OK. Use the Tile Size in Pixels edit box to scale the texture larger or
smaller. You can also rotate the texture using the Texture Rotation Angle edit box. When you are finished
making changes, choose OK to apply the fill to your object.

Adding audio labels

Audio labels are a great way to add more information to a drawing without having to make it larger to
accommodate more text or graphical information. The audio information is accessed by using the file in
explore mode, either on screen with a mouse or on a tactile copy on the Clickpad or Tactipad with the
digital pen. For more information on explore mode, please refer to the Using Explore Mode and Using the
Pen in Explore Mode with the Clickpad or Tactipad tutorials.

Audio labels can be added to any type of drawing object in TactileView, and to mammoth braille or
raised print character labels. Audio labels may not be added to text labels, because text labels are
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automatically voiced by text-to-speech when the file is used in explore mode. 

Adding an audio label to be voiced by text-to-speech 

Select the object you wish to add an audio label to from the List of Objects dialog, choose the Open 
Context Menu button and choose Audio Style. This will launch an audio label dialog, the top section of 
which allows you to specify the text to be voiced by synthetic speech from one of several sources. 

In the "Text or document in synthetic speech (TTS) section of the dialog, the default choice is the Self 
Defined Text radio button, which allows you to type the text you want voiced into the text field on the 
dialog. If you have text saved in a text file that you would like voiced instead, you can select the Text 
from Local File radio button, then choose the Browse button to browse to and select your text file. Once 
you have specified the text, you can check how the label will sound by selecting the Test Audio Label 
button. When you are fmished making changes, choose the OK button to close the dialog and apply the 
audio label. 

Attaching an existing sound file to an object 

You can also attach an existing sound file to an object to have it played when the object is clicked while 
the file is in explore mode. To do this, select the object you wish to add an audio label to from the List of 
Objects dialog, choose the Open Context Menu button and choose Audio Style. This will launch an audio 
label dialog, the bottom section of which allows you to specify a sound file to play when the object is 
clicked in explore mode. 

In the "Insert sound sample from" section of the dialog, the default choice is the Local File radio button, 
which is the one needed to attach a sound file to the object as a label. Select the Browse URL button, 
locate the sound file you would like to use on your computer and select it. The file path to the sound file 
will now appear in the text field below the sound file type selection radio buttons. You can check how the 
audio label will sound by selecting the Test Audio Label button. When you are finished making changes, 
choose the OK button to close the dialog and apply the audio label. 

NOTE: If you have both a text-to-speech audio label and a sound file audio label attached to the same 
object, the text-to-speech will be voiced first and the sound file will play after it. 

Recording an audio label from a microphone 

Audio labels recorded from a microphone are played when the object is clicked with the mouse or digital 
pen while using the file in explore mode. Recorded labels are played after any text-to-speech labels are 
voiced. 

Before recording, you will need to ensure that you have a microphone connected to your computer. When 
you have connected a microphone to your computer, you can record an audio label for an object by 
selecting the object from the List of Objects dialog, choosing the Open Context Menu button and 
selecting Record Microphone. An Audio Recording dialog appears, allowing you to select the 
microphone from which you wish to record, the format in which to record the sound, the location in 
which to store the recording and the volume percentage at which to record. To begin recording, choose 
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automatically voiced by text-to-speech when the file is used in explore mode.

Adding an audio label to be voiced by text-to-speech

Select the object you wish to add an audio label to from the List of Objects dialog, choose the Open
Context Menu button and choose Audio Style. This will launch an audio label dialog, the top section of
which allows you to specify the text to be voiced by synthetic speech from one of several sources.

In the “Text or document in synthetic speech (TTS) section of the dialog, the default choice is the Self
Defined Text radio button, which allows you to type the text you want voiced into the text field on the
dialog. If you have text saved in a text file that you would like voiced instead, you can select the Text
from Local File radio button, then choose the Browse button to browse to and select your text file. Once
you have specified the text, you can check how the label will sound by selecting the Test Audio Label
button. When you are finished making changes, choose the OK button to close the dialog and apply the
audio label.

Attaching an existing sound file to an object

You can also attach an existing sound file to an object to have it played when the object is clicked while
the file is in explore mode. To do this, select the object you wish to add an audio label to from the List of
Objects dialog, choose the Open Context Menu button and choose Audio Style. This will launch an audio
label dialog, the bottom section of which allows you to specify a sound file to play when the object is
clicked in explore mode.

In the “Insert sound sample from” section of the dialog, the default choice is the Local File radio button,
which is the one needed to attach a sound file to the object as a label. Select the Browse URL button,
locate the sound file you would like to use on your computer and select it. The file path to the sound file
will now appear in the text field below the sound file type selection radio buttons. You can check how the
audio label will sound by selecting the Test Audio Label button. When you are finished making changes,
choose the OK button to close the dialog and apply the audio label.

NOTE: If you have both a text-to-speech audio label and a sound file audio label attached to the same
object, the text-to-speech will be voiced first and the sound file will play after it.

Recording an audio label from a microphone

Audio labels recorded from a microphone are played when the object is clicked with the mouse or digital
pen while using the file in explore mode. Recorded labels are played after any text-to-speech labels are
voiced.

Before recording, you will need to ensure that you have a microphone connected to your computer. When
you have connected a microphone to your computer, you can record an audio label for an object by
selecting the object from the List of Objects dialog, choosing the Open Context Menu button and
selecting Record Microphone. An Audio Recording dialog appears, allowing you to select the
microphone from which you wish to record, the format in which to record the sound, the location in
which to store the recording and the volume percentage at which to record. To begin recording, choose
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the Start Recording button. To stop recording, press enter. To play back your recording, choose the Play 
Recording button. If you wish to re-record your audio label, just repeat the recording process. Only the 
most recent recording will be attached as the audio label for the file. 

NOTE: Each object may only have one text-to-speech audio label and one recorded or sound file audio 
label associated with it. If you record an audio label for an object, it will replace any existing sound file 
you may have associated with that object previously. 

Editing an existing audio label 

You may edit any type of audio label by repeating the steps used to create the audio label. 
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the Start Recording button. To stop recording, press enter. To play back your recording, choose the Play
Recording button. If you wish to re-record your audio label, just repeat the recording process. Only the
most recent recording will be attached as the audio label for the file.

NOTE: Each object may only have one text-to-speech audio label and one recorded or sound file audio
label associated with it. If you record an audio label for an object, it will replace any existing sound file
you may have associated with that object previously.

Editing an existing audio label

You may edit any type of audio label by repeating the steps used to create the audio label.
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10.04 Browsing and selecting objects (Tab or Shift+Tab) 

All objects that have been placed in the design with one of the drawing tools are grouped in the objects 
list (Ctrl+M). From this list, the respective context menus can be opened to change the properties of the 
object. 

You can select an object or text label in the design by choosing it from this list, then pressing 'OK'. 

Cycle through text labels and objects with Tab or Shift+Tab 

To conveniently cycle through the objects and text labels that are present in the design, use Tab (cycle 
forward) or Shift+Tab (cycle backwards). One by one, the objects and text labels will get the focus (will 
be selected). The name and position of the object or label will be announced. 

This way you can cycle from top to bottom through the design. If any objects are horizontally aligned, the 
objects further to the left will come first. 

Use Ctrl+K or the enter key to open the context menu if you wish to make any changes to the object. 
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10.04 Browsing and selecting objects (Tab or Shift+Tab)

All objects that have been placed in the design with one of the drawing tools are grouped in the objects
list (Ctrl+M). From this list, the respective context menus can be opened to change the properties of the
object.

You can select an object or text label in the design by choosing it from this list, then pressing 'OK'.

Cycle through text labels and objects with Tab or Shift+Tab

To conveniently cycle through the objects and text labels that are present in the design, use Tab (cycle
forward) or Shift+Tab (cycle backwards). One by one, the objects and text labels will get the focus (will
be selected). The name and position of the object or label will be announced.

This way you can cycle from top to bottom through the design. If any objects are horizontally aligned, the
objects further to the left will come first.

Use Ctrl+K or the enter key to open the context menu if you wish to make any changes to the object.
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10.05 View - Context menu (Ctrl+K or Enter) 

Any objects that were placed in the design can be edited later on. Opening the context menu of a selected 
object or drawing tool gives access to all the properties that can be changed. Read 'Browsing and 
selecting objects' to find out how to make your object selection. 

View - Open context menu (Ctrl+K or Enter) 

Once you have selected an object in the design, you can open the context menu by choosing 'Context 
menu' from the View menu. Alternatively, you can press Ctrl+K or the Enter key as a shortcut to open the 
context menu. 

Open context menu via Object list (Ctrl+M) 

The object list shows all object that are present in the design. Choose 'Open context menu' in this object 
list dialog. The respective context menu will open, in which you will find all options to edit the properties 
of the selected object. 

See also the section Editing object properties. 
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10.05 View - Context menu (Ctrl+K or Enter)

Any objects that were placed in the design can be edited later on. Opening the context menu of a selected
object or drawing tool gives access to all the properties that can be changed. Read 'Browsing and
selecting objects' to find out how to make your object selection.

View - Open context menu (Ctrl+K or Enter)

Once you have selected an object in the design, you can open the context menu by choosing 'Context
menu' from the View menu. Alternatively, you can press Ctrl+K or the Enter key as a shortcut to open the
context menu.

Open context menu via Object list (Ctrl+M)

The object list shows all object that are present in the design. Choose 'Open context menu' in this object
list dialog. The respective context menu will open, in which you will find all options to edit the properties
of the selected object.

See also the section Editing object properties.
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10.06 View - Show properties (Ctrl+J) 

When an object is selected in the design, it can be very useful for screen reader users to get a quick list of 
all the properties. To can select an object in your design, choose either 'Menu driven design' from the 
Drawing tools menu (Ctrl+L), or 'List of objects' from the View menu (Ctrl+M). In either list, select the 
object and press 'OK'. The object now has the selection. The properties list of the selected object can be 
opened by selecting 'Show properties' in the View menu, or by pressing Ctrl+J. 

The list of properties include aspects such as size, position in the design, etc. Use the button 'Speak 
properties' to hear the properties in a spoken message. If you wish to make any changes to the object, 
choose 'Open context menu'. 
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10.06 View - Show properties (Ctrl+J)

When an object is selected in the design, it can be very useful for screen reader users to get a quick list of
all the properties. To can select an object in your design, choose either 'Menu driven design' from the
Drawing tools menu (Ctrl+L), or 'List of objects' from the View menu (Ctrl+M). In either list, select the
object and press 'OK'. The object now has the selection. The properties list of the selected object can be
opened by selecting 'Show properties' in the View menu, or by pressing Ctrl+J.

The list of properties include aspects such as size, position in the design, etc. Use the button 'Speak
properties' to hear the properties in a spoken message. If you wish to make any changes to the object,
choose 'Open context menu'.

                                202 / 226



TactileView software manual 
Visit us at https://thinkable.nl 

10.07 View - Play audio style (Ctrl+I) 

When the selected object has been provided with an audio style, it can be played using the shortcut Ctrl+I 
or by selecting 'Play audio style' from the View menu. 

In the section 'Using audio styles' you can read more about the use of audio styles. 
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10.07 View - Play audio style (Ctrl+I)

When the selected object has been provided with an audio style, it can be played using the shortcut Ctrl+I
or by selecting 'Play audio style' from the View menu.

In the section 'Using audio styles' you can read more about the use of audio styles.
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11.01 Introduction and preparation steps 

Introduction 

TactileView tactile graphics suite for VIP users. 

In the sections in this category we elaborate on using the combination of all components of the 
TactileView tactile graphics suite by a visually impaired person (VIP). The assumption is that the user is 
using a screen reader with speech and/or braille output. 

The addition of the TactileView software with a digital pen and either a TactiPad drawing board or a 
TactileView ClickPad brings new possibilities with respect to tactile diagrams: creating digital designs by 
a VIP and exploring audio tactile diagrams with more than just tactile information. 

Skill level 

Please be informed that using the TactileView digital pen requires a high level of experience. We strongly 
suggest to follow the steps below in order to develop the necessary skills before starting to use the 
product combinations with the digital pen. By following the steps, you will not be discouraged by the 
learning curve that is involved. 

You can read more about the aspects of using the digital pen in the 'Considerations' section. 

Preparation steps 

As the skill level of using the digital pen to operate TactileView and draw on the TactiPad is relatively 
high, it is very useful to build up a good comprehension of the different aspects separately before using 
them together. The following steps will give an overview of the best approach to master using the digital 
pen as a VIP user. By breaking it down into individual steps, we encourage you to explore the increasing 
possibilities that the combinations of the products in the Tactile graphics suite 

1. Basic understanding - TactileView tactile graphics 

1.1 It is a big advantage when you already have a good understanding for tactile diagrams in 
general. Therefore we suggest to first to download and print pre-made designs from the 
TactileView catalog, compose a map with RouteTactile or print graphs based on any equation. 
This allows you to 'get a feeling' for exploring a tactile diagram with your fingertips. 

1.2 Make sure you can operate the software with a screen reader. Get familiar with navigating 
through the menus and dialogs in the software using a screen reader and practise operating the 
software with by downloading and printing designs from catalog. 

2. Basic understanding - TactiPad 

2.1 Practise creating a complete tactile drawing by hand on the TactiPad with a regular pen. You 
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11.01 Introduction and preparation steps

Introduction

TactileView tactile graphics suite for VIP users.

In the sections in this category we elaborate on using the combination of all components of the
TactileView tactile graphics suite by a visually impaired person (VIP). The assumption is that the user is
using a screen reader with speech and/or braille output.

The addition of the TactileView software with a digital pen and either a TactiPad drawing board or a
TactileView ClickPad brings new possibilities with respect to tactile diagrams: creating digital designs by
a VIP and exploring audio tactile diagrams with more than just tactile information.

Skill level 

Please be informed that using the TactileView digital pen requires a high level of experience. We strongly
suggest to follow the steps below in order to develop the necessary skills before starting to use the
product combinations with the digital pen. By following the steps, you will not be discouraged by the
learning curve that is involved.

You can read more about the aspects of using the digital pen in the 'Considerations' section.

Preparation steps

As the skill level of using the digital pen to operate TactileView and draw on the TactiPad is relatively
high, it is very useful to build up a good comprehension of the different aspects separately before using
them together. The following steps will give an overview of the best approach to master using the digital
pen as a VIP user. By breaking it down into individual steps, we encourage you to explore the increasing
possibilities that the combinations of the products in the Tactile graphics suite

1. Basic understanding - TactileView tactile graphics

1.1 It is a big advantage when you already have a good understanding for tactile diagrams in
general. Therefore we suggest to first to download and print pre-made designs from the
TactileView catalog, compose a map with RouteTactile or print graphs based on any equation.
This allows you to 'get a feeling' for exploring a tactile diagram with your fingertips.

1.2 Make sure you can operate the software with a screen reader. Get familiar with navigating
through the menus and dialogs in the software using a screen reader and practise operating the
software with by downloading and printing designs from catalog.

2. Basic understanding - TactiPad

2.1 Practise creating a complete tactile drawing by hand on the TactiPad with a regular pen. You
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could start with a basic sketch to get a feeling for drawing by hand. Make sure to get familiar with 
using the pen and drawing tools to create a tactile image. 

You can use the 'TactiPad user manual' as a guide. 

3. Preparing the hardware - Digital pen and TactiPad 

3.1 Place the batteries in the digital pen. 

3.2 Place the pen's receiver in its holder and with its magnets position it on the side of the 
TactiPad. 

3.3 Connect the USB cable to the receiver and your computer. 

See the 'Digital pen user manual' for all details on steps 3.1 to 3.3. 

4. Preparing the software 

4.1 Cover the different parts of the dialog 'TactileView digital pen' in menu Settings. 

4.2 In the 'TactileView digital pen' settings dialog, test the connection of the digital pen. 

4.3 How and where to place the receiver relative to the TactiPad or ClickPad and orientation 
(landscape, portrait). 

4.4 Calibrate the pen within the space for the TactiPad or ClickPad 

Read " for a complete guide through steps 4.1 to 4.4. 

5. Understanding the various actions and responses of the pen 

5.1 Make sure you know where to point and how to click to navigate through the software using 
the digital pen. Learn how to access context menus and select the menu options. 

5.2 Make yourself familiar with the sounds and messages that signify over 20 pen functions. Be 
aware of the state of the digital pen at all times (sounds and messages; the pen can have over 20 
different functions; this is a sub set of the functions that are available in the menus) 

5.3 Understand how the surface (dimensions) of the TactiPad relates to the size of the drawing 
area on the screen and vice versa. 

5.4 Know when to use the computer keyboard or the menus that are accessible with the pen. There 
is no need to use the computer keyboard when operating the software with the pen, except for 
entering texts. 
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could start with a basic sketch to get a feeling for drawing by hand. Make sure to get familiar with
using the pen and drawing tools to create a tactile image.

You can use the 'TactiPad user manual' as a guide.

3. Preparing the hardware - Digital pen and TactiPad

3.1 Place the batteries in the digital pen.

3.2 Place the pen's receiver in its holder and with its magnets position it on the side of the
TactiPad.

3.3 Connect the USB cable to the receiver and your computer.

See the 'Digital pen user manual' for all details on steps 3.1 to 3.3.

4. Preparing the software

4.1 Cover the different parts of the dialog 'TactileView digital pen' in menu Settings.

4.2 In the 'TactileView digital pen' settings dialog, test the connection of the digital pen.

4.3 How and where to place the receiver relative to the TactiPad or ClickPad and orientation
(landscape, portrait).

4.4 Calibrate the pen within the space for the TactiPad or ClickPad

Read '' for a complete guide through steps 4.1 to 4.4.

5. Understanding the various actions and responses of the pen

5.1 Make sure you know where to point and how to click to navigate through the software using
the digital pen. Learn how to access context menus and select the menu options.

5.2 Make yourself familiar with the sounds and messages that signify over 20 pen functions. Be
aware of the state of the digital pen at all times (sounds and messages; the pen can have over 20
different functions; this is a sub set of the functions that are available in the menus)

5.3 Understand how the surface (dimensions) of the TactiPad relates to the size of the drawing
area on the screen and vice versa.

5.4 Know when to use the computer keyboard or the menus that are accessible with the pen. There
is no need to use the computer keyboard when operating the software with the pen, except for
entering texts.
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6. Start creating digital tactile drawings 

6.1 Start by creating basic drawings with a limited number of objects using 'Menu driven design'. 
Creating or modifying an image by a VIP can only be done with a good comprehension of the 
tools and their effects on an image. Using the TactileView digital pen requires that you understand 
the tools from the 'Drawing tools' menu and are able to investigate the screen from the 'List of 
objects' in the View menu. Explore what the different objects will look like when they are printed. 

In general, you do not really use the tools such as ruler, protractor and triangle to create an exact 
drawing, but your drawing is based on the status information (object type, position etc.) in speech. 
When drawing objects with the TactileView digital pen, you are not physically drawing the lines 
of the objects on the TactiPad, but you are working with tactile reference points to mark the 
various objects that you want to add to the digital design. The various objects are added to the 
design and positioned aligned to these reference markers. 
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6. Start creating digital tactile drawings

6.1 Start by creating basic drawings with a limited number of objects using 'Menu driven design'.
Creating or modifying an image by a VIP can only be done with a good comprehension of the
tools and their effects on an image. Using the TactileView digital pen requires that you understand
the tools from the 'Drawing tools' menu and are able to investigate the screen from the 'List of
objects' in the View menu. Explore what the different objects will look like when they are printed.

In general, you do not really use the tools such as ruler, protractor and triangle to create an exact
drawing, but your drawing is based on the status information (object type, position etc.) in speech.
When drawing objects with the TactileView digital pen, you are not physically drawing the lines
of the objects on the TactiPad, but you are working with tactile reference points to mark the
various objects that you want to add to the digital design. The various objects are added to the
design and positioned aligned to these reference markers.
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11.02 TactileView graphics suite products 

Functions of the digital pen in the design mode and in the explore mode 

In this section, the basic operation of the different products is described. In separate sections, the 
functionality will be explained when the pen and receiver are connected to create a drawing (design 
mode) or exploring a audio-tactile diagram (explore mode). 

TactileView digital pen 

The digital pen enhances the functionality of the TactileView software for a visually impaired user. It 
replaces and extends the use of a regular mouse. 

The digital pen acts as a mouse to operate the software (by clicking opening menus and selecting options) 
or as a pen in a bordered area, similar to a digitizer. 

The digital pen itself resembles an ordinary ballpoint pen. In the tip we can find a tiny transmitter that 
transfers a signal to a receiver. The receiver is placed alongside the TactiPad or the ClickPad and is 
connected via USB to the computer. Via the receiver, the position of where the pen is within the surface 
of the pad is transmitted. Just like a regular mouse, you can click by pressing down with the pen 
anywhere on the surface (the tip is pushed inward slightly). 

See also the section 'Operating the TactileView digital pen'. 

TactiPad drawing board 

The TactiPad can be used to create free-hand drawings or more exact drawings with the help of the tools 
(ruler, protractor, triangle and compasses). The GraphGrid and CircleFrame accessories extend the range 
of drawings that can be made even further. These devices can be used by all age groups, starting from the 
age of 4. 

Depending on the age and the purpose of the diagram, it can be more exact for teaching basic concepts, 
for explaining and teaching math and science or for fun drawing in which preciseness is required. On the 
other hand, the TactiPad can also be used for a quick sketch. 

The TactiPad is specifically useful as a valuable and convenient method of communication between a 
VIP and a sighted person. 

See also www.tactipad.nl 

TactileView ClickPad 

The ClickPad holds printed audio-tactile diagrams (tactile graphics that contain audio information objects 
with audio style) and is available in various sizes for different paper sizes. For more information, read the 
section 'What is an audio tactile diagram'. 
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11.02 TactileView graphics suite products

Functions of the digital pen in the design mode and in the explore mode

In this section, the basic operation of the different products is described. In separate sections, the
functionality will be explained when the pen and receiver are connected to create a drawing (design
mode) or exploring a audio-tactile diagram (explore mode).

TactileView digital pen

The digital pen enhances the functionality of the TactileView software for a visually impaired user. It
replaces and extends the use of a regular mouse.

The digital pen acts as a mouse to operate the software (by clicking opening menus and selecting options)
or as a pen in a bordered area, similar to a digitizer.

The digital pen itself resembles an ordinary ballpoint pen. In the tip we can find a tiny transmitter that
transfers a signal to a receiver. The receiver is placed alongside the TactiPad or the ClickPad and is
connected via USB to the computer. Via the receiver, the position of where the pen is within the surface
of the pad is transmitted. Just like a regular mouse, you can click by pressing down with the pen
anywhere on the surface (the tip is pushed inward slightly).

See also the section 'Operating the TactileView digital pen'.

TactiPad drawing board

The TactiPad can be used to create free-hand drawings or more exact drawings with the help of the tools
(ruler, protractor, triangle and compasses). The GraphGrid and CircleFrame accessories extend the range
of drawings that can be made even further. These devices can be used by all age groups, starting from the
age of 4.

Depending on the age and the purpose of the diagram, it can be more exact for teaching basic concepts,
for explaining and teaching math and science or for fun drawing in which preciseness is required. On the
other hand, the TactiPad can also be used for a quick sketch.

The TactiPad is specifically useful as a valuable and convenient method of communication between a
VIP and a sighted person.

See also www.tactipad.nl

TactileView ClickPad

The ClickPad holds printed audio-tactile diagrams (tactile graphics that contain audio information objects
with audio style) and is available in various sizes for different paper sizes. For more information, read the
section 'What is an audio tactile diagram'.
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TactileView design — and production software 

The software is in the first place aimed towards a sighted user. However, it is fully accessible with a 
screen reader. All menus and dialogs have short cut keys. The software has functionality to support screen 
reader users. Extra menus become available in the software when the digital pen is connected. 
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TactileView design – and production software

The software is in the first place aimed towards a sighted user. However, it is fully accessible with a
screen reader. All menus and dialogs have short cut keys. The software has functionality to support screen
reader users. Extra menus become available in the software when the digital pen is connected.
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11.03 Considerations 

As mentioned in 'Introducing the TactileView tactile graphics suite', using the TactileView digital pen in 
most cases requires a high level of experience. We strongly suggest to practise the various skills in a 
certain order to develop the necessary skills before starting to use and combine the products in the 
TactileView Graphics Suite. 

Depending on the amount of support at hand, we recommend to take care of some preconditions to avoid 
disappointment in using the TactileView digital pen. Make sure all sections in the category 'Using 
TactileView with a screen reader' are mastered as well. 

Why drawing with the digital pen on the TactiPad? 

Do you wish to digitize the drawing that you create on the TactiPad drawing board? Do you want to share 
your digital designs with others for further processing? Or do you want to use the objects in TactileView 
for more accuracy in your drawings? 

If you answered 'yes' to any of these questions, there are specific advantages to using the digital pen to 
combine the functionality of both TactileView and the TactiPad. In other cases, the separate use of both 
products will usually be sufficient. 

Keep in mind that the skill level of the combination of products is 

Please note, we bring up this question while the effort involved in to creating a digital design is relative 
high. 

Why using a TactileView ClickPad? 

By its nature, braille characters have a fixed size that takes up a relatively large amount of space in a 
tactile graphic. For diagrams in which many (braille) text labels are required, the addition of an audio 
information layer can help to reduce the amount of space needed for text information. Specific areas in 
design can be provided with audio labels that provide spoken information. When clicking with the digital 
pen on the position of the audio style, its content will be pronounced. The audio content can be text (using 
Text to speech) as well as music or microphone recordings (.mp3 files). 

See the section 'Adding audio style' to find out how audio styles can be added to the design. 
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11.03 Considerations

As mentioned in 'Introducing the TactileView tactile graphics suite', using the TactileView digital pen in
most cases requires a high level of experience. We strongly suggest to practise the various skills in a
certain order to develop the necessary skills before starting to use and combine the products in the
TactileView Graphics Suite.

Depending on the amount of support at hand, we recommend to take care of some preconditions to avoid
disappointment in using the TactileView digital pen. Make sure all sections in the category 'Using
TactileView with a screen reader' are mastered as well.

Why drawing with the digital pen on the TactiPad?

Do you wish to digitize the drawing that you create on the TactiPad drawing board? Do you want to share
your digital designs with others for further processing? Or do you want to use the objects in TactileView
for more accuracy in your drawings?

If you answered 'yes' to any of these questions, there are specific advantages to using the digital pen to
combine the functionality of both TactileView and the TactiPad. In other cases, the separate use of both
products will usually be sufficient.

Keep in mind that the skill level of the combination of products is

Please note, we bring up this question while the effort involved in to creating a digital design is relative
high.

Why using a TactileView ClickPad?

By its nature, braille characters have a fixed size that takes up a relatively large amount of space in a
tactile graphic. For diagrams in which many (braille) text labels are required, the addition of an audio
information layer can help to reduce the amount of space needed for text information. Specific areas in
design can be provided with audio labels that provide spoken information. When clicking with the digital
pen on the position of the audio style, its content will be pronounced. The audio content can be text (using
Text to speech) as well as music or microphone recordings (.mp3 files).

See the section 'Adding audio style' to find out how audio styles can be added to the design.

                                209 / 226



TactileView software manual 
Visit us at https://thinkable.nl 

11.04 TactileView digital pen - Basic operation 

Initial rest state 

Initially, the digital pen will be in its 'rest state', in which nothing will be drawn in the software when 
moving or pressing down with the pen. This way, any unintentional 'pen contact' (pressing down with the 
pen tip) will not yet cause any changes in the design. The rest state of the pen is announced by a tinkling 
sound when pressing down. 

In order to change the operation/function of the pen, open the context menu by pressing the pen down 
anywhere on the surface for 1 second. You will hear a sound of five ascending tones. After the fifth tone, 
the context menu is opened. Releasing the pen before the last tone was played will not open the context 
menu. This allows you to cancel before unintentionally opening the menu. 

Selecting an option from the context menu 

After the context menu has opened, the pen is used to operate the software by cycling through the 
available options and making a selection. The selected option will be pronounced by the screen reader. 

The context menu both contains functions for drawing on the TactiPad, as well as exploring audio tactile 
diagrams on the ClickPad. 

Audio reading system with TactileView digital pen and ClickPad 

In the explore mode (Ctrl+E), the audio information in audio-tactile diagrams can be explored. The 
printed design is placed on the ClickPad and the corresponding digital design is opened in TactileView. 
By clicking with the pen in the tactile diagram, any audio information that is present at this position is 
activated. 
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11.04 TactileView digital pen - Basic operation

Initial rest state

Initially, the digital pen will be in its 'rest state', in which nothing will be drawn in the software when
moving or pressing down with the pen. This way, any unintentional 'pen contact' (pressing down with the
pen tip) will not yet cause any changes in the design. The rest state of the pen is announced by a tinkling
sound when pressing down.

In order to change the operation/function of the pen, open the context menu by pressing the pen down
anywhere on the surface for 1 second. You will hear a sound of five ascending tones. After the fifth tone,
the context menu is opened. Releasing the pen before the last tone was played will not open the context
menu. This allows you to cancel before unintentionally opening the menu.

Selecting an option from the context menu

After the context menu has opened, the pen is used to operate the software by cycling through the
available options and making a selection. The selected option will be pronounced by the screen reader.

The context menu both contains functions for drawing on the TactiPad, as well as exploring audio tactile
diagrams on the ClickPad.

Audio reading system with TactileView digital pen and ClickPad

In the explore mode (Ctrl+E), the audio information in audio-tactile diagrams can be explored. The
printed design is placed on the ClickPad and the corresponding digital design is opened in TactileView.
By clicking with the pen in the tactile diagram, any audio information that is present at this position is
activated.
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11.05 Using Explore Mode (ClickPad) 

Explore mode allows you to interact with a TactileView file the way a user will. For example, when you 
click a text label in a file while using explore mode, the text label will be voiced via text-to-speech 
instead of becoming selected so that you can edit it like it does in design mode. Similarly, the audio labels 
for drawing objects will play when the object is clicked, instead of the object becoming selected for 
editing. 

Limited options for changing audio information in the file are available within explore mode, but 
otherwise files cannot be edited from this mode. If you would like to make changes to anything else in the 
file, you must switch back to design mode to do so. 

You can control some user settings from explore mode, such as selecting a voice or initiating digital pen 
calibration. For information on calibrating the digital pen or using it with a file in explore mode, please 
refer to the Connecting and Calibrating the Digital Pen and Using Explore Mode with the Digital Pen 
tutorials. 

Entering explore mode 

In order to use a file in explore mode, you must first open it in TactileView, which defaults to design 
mode when a file is opened. Once you have a file open, explore mode can be activated in one of three 
ways: by selecting the Explore with Speech and Sound icon from the tool bar across the top of the screen, 
by selecting the Explore with Speech and Sound option from the View menu or by pressing CTRL+E. 

Exploring a file 

When you first open a file in explore mode, certain information about the file is automatically voiced. 
The name of the currently selected speech voice is spoken, as well as the title of the file. TactileView also 
tells you how many audio styles (audio labels) are in the file when you first enter explore mode. 

You can explore the file by clicking different items in the file with the mouse. The digital pen provides an 
accessible way to explore the file. For more information on using the digital pen with TactileView files in 
explore mode, please refer to the Using Explore Mode with the Digital Pen tutorial. 

When you click on a text label, the text in the label is spoken via text-to-speech. When you click on an 
object with an audio label, the audio label is played. If the audio label contains both synthesized speech 
and a sound file, the synthesized speech will begin first and then the sound file will play. Clicking on a 
blank area or on an object other than a text label that does not have an audio label will cause TactileView 
to voice "empty." 

Changing an object's audio label 

If you discover an object that does not have an audio label and want to add one, you can right-click it and 
choose Change Audio Style for Object option from the context menu. This brings up the audio label 
properties dialog, which allows you to create an audio label the same way you would in design mode. For 
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11.05 Using Explore Mode (ClickPad)

Explore mode allows you to interact with a TactileView file the way a user will. For example, when you
click a text label in a file while using explore mode, the text label will be voiced via text-to-speech
instead of becoming selected so that you can edit it like it does in design mode. Similarly, the audio labels
for drawing objects will play when the object is clicked, instead of the object becoming selected for
editing.

Limited options for changing audio information in the file are available within explore mode, but
otherwise files cannot be edited from this mode. If you would like to make changes to anything else in the
file, you must switch back to design mode to do so.

You can control some user settings from explore mode, such as selecting a voice or initiating digital pen
calibration. For information on calibrating the digital pen or using it with a file in explore mode, please
refer to the Connecting and Calibrating the Digital Pen and Using Explore Mode with the Digital Pen
tutorials.

Entering explore mode

In order to use a file in explore mode, you must first open it in TactileView, which defaults to design
mode when a file is opened. Once you have a file open, explore mode can be activated in one of three
ways: by selecting the Explore with Speech and Sound icon from the tool bar across the top of the screen,
by selecting the Explore with Speech and Sound option from the View menu or by pressing CTRL+E.

Exploring a file

When you first open a file in explore mode, certain information about the file is automatically voiced.
The name of the currently selected speech voice is spoken, as well as the title of the file. TactileView also
tells you how many audio styles (audio labels) are in the file when you first enter explore mode.

You can explore the file by clicking different items in the file with the mouse. The digital pen provides an
accessible way to explore the file. For more information on using the digital pen with TactileView files in
explore mode, please refer to the Using Explore Mode with the Digital Pen tutorial.

When you click on a text label, the text in the label is spoken via text-to-speech. When you click on an
object with an audio label, the audio label is played. If the audio label contains both synthesized speech
and a sound file, the synthesized speech will begin first and then the sound file will play. Clicking on a
blank area or on an object other than a text label that does not have an audio label will cause TactileView
to voice “empty.”

Changing an object’s audio label

If you discover an object that does not have an audio label and want to add one, you can right-click it and
choose Change Audio Style for Object option from the context menu. This brings up the audio label
properties dialog, which allows you to create an audio label the same way you would in design mode. For
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more information on the options on this dialog, please refer to the Adding and Editing Audio Labels 
tutorial. When you are done making changes, choose the OK button to close the dialog and apply your 
audio label. 

You can also edit existing audio labels for an object by right-clicking the object and choosing Change 
Audio Style for Object from the context menu to bring up the audio label properties dialog. Make any 
desired changes on this dialog, then choose the OK button to close the dialog and apply your changes to 
the audio label. 

Adding a voice memo 

Sometimes it can be useful to add an audio label without attaching it to a drawing object. This is 
especially true when the file you're working with is a fused bitmap, because nothing in a fused bitmap is 
selectable. This type of audio label, called a voice memo, is shown in the file and can be clicked to hear 
the audio information, but it will not be embossed in the drawing when the file is embossed. 

To add a voice memo, right-click anywhere in the file and choose the Place Voice Memo option from the 
context menu. To define your voice memo area as a small circle, click the place in the file where you'd 
like the voice memo to be. To create a line as the voice memo area, click and drag the mouse to draw the 
line, then release it. To create a freehand closed shape as the voice memo area, click and drag the mouse 
to draw the shape, releasing the mouse button close to the starting point of the freehand shape object. 

As soon as you have defined the voice memo area, the software will begin recording from the computer's 
microphone to create the voice memo content. If you wish to record from the microphone for your voice 
memo, begin speaking into the microphone immediately and then click anywhere in the file to finish 
recording. If you would like to create a different type of voice memo, simply click anywhere in the file 
after defining the voice memo area to quickly end the recording process, then right-click the voice memo 
area to bring up the standard audio label properties dialog and define your audio label as desired. 

Setting the voice for text-to-speech 

To choose a different voice for synthesized speech for audio and text labels, right-click anywhere in the 
file, pick the Select a voice option from the context menu and choose the desired voice from the pull-
down list to the right. TactileView will immediately begin using the newly-selected voice for synthesized 
speech. 

Exiting explore mode 

When you wish to return to design mode, press ESC on the keyboard or right-click anywhere in the file 
and choose Quit Explore Mode in the context menu. 
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more information on the options on this dialog, please refer to the Adding and Editing Audio Labels
tutorial. When you are done making changes, choose the OK button to close the dialog and apply your
audio label.

You can also edit existing audio labels for an object by right-clicking the object and choosing Change
Audio Style for Object from the context menu to bring up the audio label properties dialog. Make any
desired changes on this dialog, then choose the OK button to close the dialog and apply your changes to
the audio label.

Adding a voice memo

Sometimes it can be useful to add an audio label without attaching it to a drawing object. This is
especially true when the file you’re working with is a fused bitmap, because nothing in a fused bitmap is
selectable. This type of audio label, called a voice memo, is shown in the file and can be clicked to hear
the audio information, but it will not be embossed in the drawing when the file is embossed.

To add a voice memo, right-click anywhere in the file and choose the Place Voice Memo option from the
context menu. To define your voice memo area as a small circle, click the place in the file where you’d
like the voice memo to be. To create a line as the voice memo area, click and drag the mouse to draw the
line, then release it. To create a freehand closed shape as the voice memo area, click and drag the mouse
to draw the shape, releasing the mouse button close to the starting point of the freehand shape object.

As soon as you have defined the voice memo area, the software will begin recording from the computer’s
microphone to create the voice memo content. If you wish to record from the microphone for your voice
memo, begin speaking into the microphone immediately and then click anywhere in the file to finish
recording. If you would like to create a different type of voice memo, simply click anywhere in the file
after defining the voice memo area to quickly end the recording process, then right-click the voice memo
area to bring up the standard audio label properties dialog and define your audio label as desired.

Setting the voice for text-to-speech

To choose a different voice for synthesized speech for audio and text labels, right-click anywhere in the
file, pick the Select a voice option from the context menu and choose the desired voice from the pull-
down list to the right. TactileView will immediately begin using the newly-selected voice for synthesized
speech.

Exiting explore mode

When you wish to return to design mode, press ESC on the keyboard or right-click anywhere in the file
and choose Quit Explore Mode in the context menu.
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12.01 Printing with a braille embosser 

Before printing a file from TactileView, ensure that the driver for your embosser has been installed on the 
computer, see Properties ofdifferentbrgille embossers for instructions for each supported embosser 
model or Prnhnsaer driver installation for an ova-view of the tactile properties of the embossers. 

To check if your embosser is ready for printing go to the Windows Control Panel ami select 'Devices and 
printers'. If the embosser is installed correctly, you should we it online in the list of available printers. 

---...„;;;;Or 

Figure 1. Offline (left) and online �S�y�L�Q�W�H�U��icons in Windows Control panel 

Print setup 
Once you have verified that the printer driver is installed on the computer, select 'Print setup' from the file 
menu. In the dialog that opens, select your embosser from tic printer name list. Next, select the paper size 
you want to emboss on, and choose the print orientation. Click OK' to apply your selling to the 
document and close the dialog. 
If you changed any of the options on the screen, this will affect how the active document will be printed. 
Depending on the size of your design and tic selected paper size and orientation, the design may not 
make full use of the available space on tic paper, or the design may run over onto a second page; see the 
manual sections Paper size vs. design size and Changing design orientation and size. 

Print preview 
Check how your document will print by selecting 'Print preview' from the File menu or tic corresponding 
icon in the top horizontal icon bar. This will open a preview of how your document will print and 
represents the =act embossed and/or printed output. 
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12.01 Printing with a braille embosser

Before printing a file from TactileView, ensure that the driver for your embosser has been installed on the
computer; see Properties of different braille embossers for instructions for each supported embosser
model or Embosser driver installation for an overview of the tactile properties of the embossers.

To check if your embosser is ready for printing, go to the Windows Control Panel and select 'Devices and
printers'. If the embosser is installed correctly, you should see it online in the list of available printers.

Figure 1. Offline (left) and online printer icons in Windows Control panel.

Print setup
Once you have verified that the printer driver is installed on the computer, select 'Print setup' from the file
menu. In the dialog that opens, select your embosser from the printer name list. Next, select the paper size
you want to emboss on, and choose the print orientation. Click 'OK' to apply your settings to the
document and close the dialog.
If you changed any of the options on the screen, this will affect how the active document will be printed.
Depending on the size of your design and the selected paper size and orientation, the design may not
make full use of the available space on the paper, or the design may run over onto a second page; see the
manual sections Paper size vs. design size and Changing design orientation and size.

Print preview
Check how your document will print by selecting 'Print preview' from the File menu or the corresponding
icon in the top horizontal icon bar. This will open a preview of how your document will print and
represents the exact embossed and/or printed output.
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You can use the buttons above the preview to examine the document as it will be printed, including the 
number of pages and ink version if applicable. 

When you wish to get a preview of the dot placement directly in your design, active the Pesign mode' dot 
view from the second horizontal toolbar. 

Print preview' law 

Print' icon: 

Print document 
When your document appears in the preview the way you want it to print, select 'Print' from the file 
menu orpress ClitL4-P to bring up the Print dialog. This is a standard Windows print dialog, which 
allows you to select which pages to print and how many copies. Mae the desired selections, then choose 
the 'OK' button to close the dialog and print the file. 

Print' icon: 
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You can use the buttons above the preview to examine the document as it will be printed, including the
number of pages and ink version if applicable. 

When you wish to get a preview of the dot placement directly in your design, active the Design mode: dot
view from the second horizontal toolbar.

'Print preview' icon: 

'Print' icon: 

Print document
When your document appears in the preview the way you want it to print, select 'Print' from the File
menu or press CTRL+P to bring up the Print dialog. This is a standard Windows print dialog, which
allows you to select which pages to print and how many copies. Make the desired selections, then choose
the 'OK' button to close the dialog and print the file.

'Print' icon: 
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12.02 Properties of different braille embossers 

Below, you will find an overview of the braille embossers that are supported in TactileView. Some 
embossers on the market are only capable of printing braille texts, whereas these all support printing both 
text and graphics. 

An overview of the installation instructions for all embosser models can be found in the  • nue' section 
Embosser driver installation 

The embossers from different manufacturers are produced with varying technical specifications. For 
example, the shape and size of the braille dots varies, as well as the possibilities for dot placement on the 
paper. This results in differences in the tactile properties of the graphics that can be produced. The 
specific properties for the selected embosser can be viewed in TactileView by enabling Design mode: dot 
view'; see. Design mode: dot view/line view 

For a mine extensive list of the technical specifications such as printing speed or supported paper sizes, 
visit the respective websites of the listed manufacturers. 

Differences in printing methods: dot matrix vs. floating point 

One of the most notable differences between the various embosser models is the way the dots are 
positioned to create the tactile graphics. The majority of embossers will place the dots in a fixed matrix. 
Any curves in the image will be built up of small interconnected horizontal and/or vertical line segments. 
The resolution of this two-dimensional matrix of dots determines the level of detail that can be achieved 
in the tactile image. 

In some cases, the dots are not evenly spaced in the horizontal direction of the dot matrix. This is derived 
from the positions of the dots in braille characters, where no dots have to be placed in between two 
characters. This results in a less continuous dot spacing when printing graphics. 

Other models are not restricted to a fixed matrix of dots, but instead can freely place dots at any position 
on the page. This is often called 'floating point' graphics. As a result, the images have much more 
continuous, smooth curves allowing fora relatively high level of detail and accuracy. 
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12.02 Properties of different braille embossers

Below, you will find an overview of the braille embossers that are supported in TactileView. Some
embossers on the market are only capable of printing braille texts, whereas these all support printing both
text and graphics.

An overview of the installation instructions for all embosser models can be found in the manual section 
Embosser driver installation.

The embossers from different manufacturers are produced with varying technical specifications. For
example, the shape and size of the braille dots varies, as well as the possibilities for dot placement on the
paper. This results in differences in the tactile properties of the graphics that can be produced. The
specific properties for the selected embosser can be viewed in TactileView by enabling 'Design mode: dot
view'; see: Design mode: dot view/line view.

For a more extensive list of the technical specifications such as printing speed or supported paper sizes,
visit the respective websites of the listed manufacturers.

Differences in printing methods: dot matrix vs. floating point

One of the most notable differences between the various embosser models is the way the dots are
positioned to create the tactile graphics. The majority of embossers will place the dots in a fixed matrix.
Any curves in the image will be built up of small interconnected horizontal and/or vertical line segments.
The resolution of this two-dimensional matrix of dots determines the level of detail that can be achieved
in the tactile image.

In some cases, the dots are not evenly spaced in the horizontal direction of the dot matrix. This is derived
from the positions of the dots in braille characters, where no dots have to be placed in between two
characters. This results in a less continuous dot spacing when printing graphics.

Other models are not restricted to a fixed matrix of dots, but instead can freely place dots at any position
on the page. This is often called 'floating point' graphics. As a result, the images have much more
continuous, smooth curves allowing for a relatively high level of detail and accuracy.
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Figure 1. A comparison of different embossing techniques: dot matrix (left), non-uniform dot matrix 
(middle; note the difference in horizontal and vertical dot placement) and floating point (right). 

Embosser properties overview 

Manufacturer (click 
for website) 

Model Print method Resolution Other information 

Index Braille Basic-D Floating point - -
Everest Floating point - - 
Braillebox Floating point - - 

ViewPlus EmBraille Dot matrix 17 DPI Variable dot height 
Cub Dot matrix 20 DPI Variable dot height 
Max Dot matrix 20 DPI Variable dot height 
SpotDot 
(previously called 
EmPrint) 

Dot matrix 20 DPI Variable dot height, 
coloured ink & 
braille 

Elite Dot matrix 20 DPI Variable dot height, 
black ink & braille 

Columbia Dot matrix 100 dpi Variable dot height, 
double-sided 
interpoint braille 

EmFuse 
(discontinued) 

Dot matrix 20 DPI Variable dot height, 
coloured ink & 
braille 

Brailletec Elotype 4E Floating point - -
Puma Floating point - Printing plates 

Enabling Cyclone Dot matrix 17 DPI -
Technologies 

Phoenix Dot matrix 17, 20 or 25 DPI -
Trident Dot matrix 17 DPI -
Romeo Attaché Pro Dot matrix 12,5 or 17 DPI -

Nippon Telesoft Gemini Super Dot matrix Approx. 13 DPI Non-uniform matix 
in horizontal 
direction 

Harpo Mountbattan 
Brailler 

Dot matrix Approx. 10 DPI Graphics resolution 
limited to braille 
character size 

Design aspects in TactileView for different embossers 

Below, you will find a list of the effects on a TactileView design of the printing properties of the different 
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Figure 1. A comparison of different embossing techniques: dot matrix (left), non-uniform dot matrix
(middle; note the difference in horizontal and vertical dot placement) and floating point (right).

 

Embosser properties overview

Manufacturer (click
for website)

Model Print method Resolution Other information

Index Braille Basic-D Floating point - -
Everest Floating point - -
Braillebox Floating point - -

ViewPlus EmBraille Dot matrix 17 DPI Variable dot height
Cub Dot matrix 20 DPI Variable dot height
Max Dot matrix 20 DPI Variable dot height
SpotDot
(previously called
EmPrint)

Dot matrix 20 DPI Variable dot height,
coloured ink &
braille

Elite Dot matrix 20 DPI Variable dot height,
black ink & braille

Columbia Dot matrix 100 dpi Variable dot height,
double-sided
interpoint braille

EmFuse
(discontinued)

Dot matrix 20 DPI Variable dot height,
coloured ink &
braille

Brailletec Elotype 4E Floating point - -
Puma Floating point - Printing plates

Enabling
Technologies

Cyclone Dot matrix 17 DPI -

Phoenix Dot matrix 17, 20 or 25 DPI -
Trident Dot matrix 17 DPI -
Romeo Attaché Pro Dot matrix 12,5 or 17 DPI -

Nippon Telesoft Gemini Super Dot matrix Approx. 13 DPI Non-uniform matix
in horizontal
direction

Harpo Mountbattan
Brailler

Dot matrix Approx. 10 DPI Graphics resolution
limited to braille
character size

Design aspects in TactileView for different embossers

Below, you will find a list of the effects on a TactileView design of the printing properties of the different
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embossers. 

Viewplus 

All models support variable dot height, which can be set individually for the lines, surface and texture of 
all blue objects in TactileView. These dot heights are shown on screen in different shades of blue. 
See also: Using variable relief height 

The SpotDot (previously called EmPrint) and EmFuse models support printing in braille as well as black 
or coloured ink. In TactileView, the 'Design mode: dot view' will show the design as it will be printed in 
ink, whereas the 'Design mode: dot view' will show the tactile output. 

Index Braille 

The floating point method that is used in the Index embosser models allows for smooth curves and a 
relatively high level of detail in your designs. 

Brailletec 

The floating point method that is used in the Brailletec embosser models allows for smooth curves and a 
relatively high level of detail in your designs. 

Enabling Technologies 
The following discontinued models are still supported in TactileView: Juliet, Romeo Pro and Romeo 
Attaché. 

For the Juliet (discontinued) and Phoenix embossers, you have the option to select the embossing 
resolution by selecting 'Print setup' from the File menu. 

Nippon Telesoft 

The dot matrix for the Gemini embosser is based on the positions of the dots in braille text. The matrix 
therefore has a relatively low resolution and will not be uniform in horizontal direction; keep in mind that 
this allows you to use a limited level of detail when creating your designs. 

Harpo 

The dot matrix for the Mountbattan Brailler is based on the positions of the dots in braille text. The matrix 
therefore has a relatively low resolution and will not be uniform in horizontal direction; keep in mind that 
this allows you to use a limited level of detail when creating your designs. 
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embossers.

Viewplus

All models support variable dot height, which can be set individually for the lines, surface and texture of
all blue objects in TactileView. These dot heights are shown on screen in different shades of blue.
See also: Using variable relief height

The SpotDot (previously called EmPrint) and EmFuse models support printing in braille as well as black
or coloured ink. In TactileView, the 'Design mode: dot view' will show the design as it will be printed in
ink, whereas the 'Design mode: dot view' will show the tactile output.

Index Braille

The floating point method that is used in the Index embosser models allows for smooth curves and a
relatively high level of detail in your designs.

Brailletec

The floating point method that is used in the Brailletec embosser models allows for smooth curves and a
relatively high level of detail in your designs.

Enabling Technologies
The following discontinued models are still supported in TactileView: Juliet, Romeo Pro and Romeo
Attaché.

For the Juliet (discontinued) and Phoenix embossers, you have the option to select the embossing
resolution by selecting 'Print setup' from the File menu.

Nippon Telesoft

The dot matrix for the Gemini embosser is based on the positions of the dots in braille text. The matrix
therefore has a relatively low resolution and will not be uniform in horizontal direction; keep in mind that
this allows you to use a limited level of detail when creating your designs.

Harpo

The dot matrix for the Mountbattan Brailler is based on the positions of the dots in braille text. The matrix
therefore has a relatively low resolution and will not be uniform in horizontal direction; keep in mind that
this allows you to use a limited level of detail when creating your designs.
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12.03 Embosser driver installation 

In TactileView, a wide variety of different braille embossers is supported (for an overview of their 
embossing properties, see Properties of different braille embossers). 

It is essential to install the corresponding printer driver for your embosser model in order to produce the 
correct tactile graphics. The two steps of the 'Embosser driver installation' dialog will guide you through 
the installation of the correct driver. 

TactileView driver versus manufacturer supplied driver 

Some embossers require installing a driver that is supplied by the manufacturer. For the remaining 
supported embossers, TactileView supplies a specialised graphics driver. 
To install the correct driver for your embosser model, open the dialog by selecting menu File > Install 
printer driver. In the first step you will be prompted with the list of supported braille embossers. Choose 
your particular model from the list, then click 'Next'. In the second step, depending on your embosser 
type, you can either directly install the TactileView driver, or follow the written instructions to install a 
driver supplied by the manufacturer. 

Option 1- Driver supplied by TactileView 

Some embossers are capable of creating tactile graphics, but are not supplied with a driver that supports 
this by default. In these cases, TactileView supplies a separate driver that needs to be installed via step 2 
of the 'Embosser driver installation' dialog. 
Please note that some models require additional settings, such as language selection. If required, this will 
be presented in the dialog. 

Option 2 - Driver supplied by manufacturer 

For a number of embossers, the driver that is supplied by the manufacturer also supports producing tactile 
graphics with TactileView. In this case, the driver will not be installed via TactileView, but using an 
installer file (.exe) that you receive with your embosser or download from the supplier's website. 
You will find complete instructions in step 2 of the 'Embosser driver installation' dialog for the installing 
driver and selecting the embosser in TactileView. 
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12.03 Embosser driver installation

In TactileView, a wide variety of different braille embossers is supported (for an overview of their
embossing properties, see Properties of different braille embossers). 

It is essential to install the corresponding printer driver for your embosser model in order to produce the
correct tactile graphics. The two steps of the 'Embosser driver installation' dialog will guide you through
the installation of the correct driver.

TactileView driver versus manufacturer supplied driver

Some embossers require installing a driver that is supplied by the manufacturer. For the remaining
supported embossers, TactileView supplies a specialised graphics driver.
To install the correct driver for your embosser model, open the dialog by selecting menu File > Install
printer driver. In the first step you will be prompted with the list of supported braille embossers. Choose
your particular model from the list, then click 'Next'. In the second step, depending on your embosser
type, you can either directly install the TactileView driver, or follow the written instructions to install a
driver supplied by the manufacturer.

Option 1 - Driver supplied by TactileView

Some embossers are capable of creating tactile graphics, but are not supplied with a driver that supports
this by default. In these cases, TactileView supplies a separate driver that needs to be installed via step 2
of the 'Embosser driver installation' dialog.
Please note that some models require additional settings, such as language selection. If required, this will
be presented in the dialog.

Option 2 - Driver supplied by manufacturer

For a number of embossers, the driver that is supplied by the manufacturer also supports producing tactile
graphics with TactileView. In this case, the driver will not be installed via TactileView, but using an
installer file (.exe) that you receive with your embosser or download from the supplier's website.
You will find complete instructions in step 2 of the 'Embosser driver installation' dialog for the installing
driver and selecting the embosser in TactileView.
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12.04 Effect of printing properties on tactile usability 

The tactile characteristics vary significantly between the different printing methods that are supported in 
TactileView. These differences have major influence on the tactile usability (how easily elements can be 
distinguished) of a design. 

The printing methods can be divided into three broad groups: embossers with dots in a fixed matrix 
pattern, embossers with floating graphics and swellpaper. See Properties of different braille embossers for 
an overview of the properties of each supported embosser model. 

Read the Drawing tools section in the TactileView manual to learn how to adjust the properties of the 
drawing tools, such as filters, retouching tools and the line thickness, line style and textures of objects.

Original objects in 
the design 

Printed on swellpaper 

Embosser with dots 
in a matrix 

Lines with increasing line 
thickness 

...
...

...
...

...
...

...
...

 
...

...
...

...
...

...
...

...
 

• a 0 • *0 
• a a ••• os • a • ore 
• • 
• a es o ow f . 0•  :: 
• 
• • a•  

• • O. •• 
Embosser with 

• 0 
• a •

0: 
• 

 00 
00 

• 0 • 9: 00 
floating graphics • 0 0. •• • •• 

• : 0
•

•• 
• o o 'a es 
• • • 

••
••

• 0 • O. 00 
• a • S. •• • 
• • • •• •• 

...
...

...
...

...
...

.. 

Diagonal lines Circle 

•• 
• 

f •  •• 

• •••• 

.• : •• •• 
• 

• • • •• 
• • • i• 
• • • • 

a • • •• 

.* ."  ••

• . . ." 

• • • 

0 

• a 

• 

• • • 

0 

.. 

• • a 

• • • 

..-- • • a ir • 0 0 • • • 0 if• 0 • 
• • • 40-
• 0 0 •

• 

• • a e • • • •
0 6 

• 0 0 •• ,* 

•• 

•••• 

•• 

•• 

•••• 

• • 
• 

• 

• 
• 
• 
• 

••• 

••• 

• 
• 
• 

• 
• 
• 

• 
• 

• 

••• 
••• 

e a • • •••••• 

• 
.. 04.4m4,4°

•
• 

• 

• 
• 
• 

So
o 

219/226 

TactileView software manual
Visit us at https://thinkable.nl

12.04 Effect of printing properties on tactile usability

The tactile characteristics vary significantly between the different printing methods that are supported in
TactileView. These differences have major influence on the tactile usability (how easily elements can be
distinguished) of a design.

The printing methods can be divided into three broad groups: embossers with dots in a fixed matrix
pattern, embossers with floating graphics and swellpaper. See Properties of different braille embossers for
an overview of the properties of each supported embosser model.

Read the Drawing tools section in the TactileView manual to learn how to adjust the properties of the
drawing tools, such as filters, retouching tools and the line thickness, line style and textures of objects.
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Figure 1. Comparison between the tactile properties of different printing methods. 

Embossers with fixed dot matrix 

In many braille embossers, the positioning of the dots that form the tactile graphic is limited to a matrix 
pattern of braille dots with a fixed distance between the rows/columns dots. The tactile graphics are 
limited to a comparatively low resolution because of the minimum size of a braille dot and their 
placement in the matrix. An empty space of at least 1 braille dot (or preferably more) is required to 
distinguish between neighbouring lines and shapes. 

Line thickness Limited to a multiple of dots with a minimum of 1 
braille dot 

Diagonal lines and curves Composed of small vertical and horizontal line 
sections 

Distance between lines Minimum of 1 braille dot between neighbouring 
lines 

Line styles Limited to relatively coarse line styles, as the gaps 
and dashes in the line pattern need to be at least the 
size of 1 braille dot 

Textures Limited to coarse textures due to the matrix pattern 
and minimum size of texture lines/elements and the 
empty space between them 

Embossers with free dot positioning 

A number of braille embossers do not have a fixed dot matrix but instead allow the dots to be placed 
anywhere on the page with high accuracy. This way, the dots can follow curves very accurately. The size 
of the braille dots still limits the level of detail to a certain degree in order to avoid overlap with adjacent 
dots. 

Line thickness Minimum thickness of 1 braille dot, with 
undulating ('zigzag') lines or multiple 

Diagonal lines and curves Perfect diagonal lines and curves due to the floating 
point positioning 

Distance between lines Can be positioned freely, but an empty space of at 
least the thickness of a braille dot is recommended 

Line styles Limited to relatively coarse line styles, as the gaps 
and dashed in the line pattern have to be at least the 
size of 1 braille dot 

Textures The minimum size of texture lines/elements and the 
distance between them results in a relatively coarse 
texture 
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Figure 1. Comparison between the tactile properties of different printing methods.

Embossers with fixed dot matrix

In many braille embossers, the positioning of the dots that form the tactile graphic is limited to a matrix
pattern of braille dots with a fixed distance between the rows/columns dots. The tactile graphics are
limited to a comparatively low resolution because of the minimum size of a braille dot and their
placement in the matrix. An empty space of at least 1 braille dot (or preferably more) is required to
distinguish between neighbouring lines and shapes.

Line thickness Limited to a multiple of dots with a minimum of 1
braille dot

Diagonal lines and curves Composed of small  vertical and horizontal line
sections

Distance between lines Minimum of 1 braille dot between neighbouring
lines

Line styles Limited to relatively coarse line styles, as the gaps
and dashes in the line pattern need to be at least the
size of 1 braille dot

Textures Limited to coarse textures due to the matrix pattern
and minimum size of texture lines/elements and the
empty space between them

Embossers with free dot positioning

A number of braille embossers do not have a fixed dot matrix but instead allow the dots to be placed
anywhere on the page with high accuracy. This way, the dots can follow curves very accurately. The size
of the braille dots still limits the level of detail to a certain degree in order to avoid overlap with adjacent
dots.

Line thickness Minimum thickness of 1 braille dot, with
undulating ('zigzag') lines or multiple

Diagonal lines and curves Perfect diagonal lines and curves due to the floating
point positioning

Distance between lines Can be positioned freely, but an empty space of at
least the thickness of a braille dot is recommended

Line styles Limited to relatively coarse line styles, as the gaps
and dashed in the line pattern have to be at least the
size of 1 braille dot

Textures The minimum size of texture lines/elements and the
distance between them results in a relatively coarse
texture
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Swellpaper 

When printing on swellpaper, the TactileView design is printed directly in ink without any reduction in 
resolution (in contrast to the lower resolution of braille dots). This enables you to use fine details that are 
still distinguishable by touch. 

Line thickness Can be varied in steps of 1 pixel 
Diagonal lines and curves Perfect curves without limitations 
Distance between lines Relatively small gaps between adjacent lines can 

still be distinguished due to the high resolution 
Line styles Detailed line styles can be used as the minimum 

size of gaps and line segments can be very small 
Textures Detailed textures can be used as the minimum size 

of the texture lines/elements and the empty space in 
between can be very small 

Variable relief height for enhanced tactile usability 

Some embossers support variable dot height as an additional method of distinguishing the lines in your 
design. For example, a lower dot height is applied to the grid lines in a graph in order to discriminate 
them from the axes and formula line. 

This functionality is only available when supported by your embosser; see Properties of different braille 
embossers for an overview of embossers that support variable dot height and Editing object properties to 
find out how to apply variable dot height. 
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Swellpaper

When printing on swellpaper, the TactileView design is printed directly in ink without any reduction in
resolution (in contrast to the lower resolution of braille dots). This enables you to use fine details that are
still distinguishable by touch.

Line thickness Can be varied in steps of 1 pixel
Diagonal lines and curves Perfect curves without limitations
Distance between lines Relatively small gaps between adjacent lines can

still be distinguished due to the high resolution
Line styles Detailed line styles can be used as the minimum

size of gaps and line segments can be very small
Textures Detailed textures can be used as the minimum size

of the texture lines/elements and the empty space in
between can be very small

Variable relief height for enhanced tactile usability

Some embossers support variable dot height as an additional method of distinguishing the lines in your
design. For example, a lower dot height is applied to the grid lines in a graph in order to discriminate
them from the axes and formula line.

This functionality is only available when supported by your embosser; see Properties of different braille
embossers for an overview of embossers that support variable dot height and Editing object properties to
find out how to apply variable dot height.
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12.05 Printing on swellpaper (microcapsule paper) 

Swellpaper (also called microcapsule, puff or fuser paper) is a heat sensitive paper and contains chemical 
ingredients that swell up to form a raised texture. Whereas braille embossers will use lines made up of 
individual braille dots, designs printed on swellpaper have more fluid, continuous lines that retain more 
detail. 
Once the design has been printed with an inkjet printer, the paper has to be heated in a special oven in 
order to produce the braille texts and tactile images. In this process, any areas on the paper with black ink 
will swell to form the relief. 
Laser printers are not recommended for swellpaper as the high-temperature environment can cause the 
paper to swell inside the printer, resulting in a serious paper jam. 

Optimise braille dot diameter 
Swell-paper produced by various companies (such as Tangible Magic Paper, ZyTex, Flexi-Paper and 
Matsumoto) are all suitable for tactile graphics. Each brand has slightly different properties in terms of 
the required temperature and duration of heating. It takes some experience to fmd the optimal settings for 
the particular paper that you are using, so make sure do some thorough tests to find out which 
combination of temperature and heating time works best. 
Depending on the oven temperature, the braille dots might raise either too much or not sufficiently, 
making them no longer distinguishable as individual braille dots. To compensate for this effect, the 
diameter of the dots can be adjusted by choosing `Text label presentation: on print' from the Settings 
menu and increasing or decreasing the size of braille dots. 

Printing text combining visual font with braille 
The normal font (visual characters) of braille labels can be printed in a lighter colour. To avoid the text 
being raised when heated in the oven, make sure to select a colour other than black in `Text label 
presentation: on print' as the 'Text colour on print'. For example, a green or blue works well for visual 
readability. 
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12.05 Printing on swellpaper (microcapsule paper)

Swellpaper (also called microcapsule, puff or fuser paper) is a heat sensitive paper and contains chemical
ingredients that swell up to form a raised texture. Whereas braille embossers will use lines made up of
individual braille dots, designs printed on swellpaper have more fluid, continuous lines that retain more
detail.
Once the design has been printed with an inkjet printer, the paper has to be heated in a special oven in
order to produce the braille texts and tactile images. In this process, any areas on the paper with black ink
will swell to form the relief.
Laser printers are not recommended for swellpaper as the high-temperature environment can cause the
paper to swell inside the printer, resulting in a serious paper jam.

Optimise braille dot diameter
Swell-paper produced by various companies (such as Tangible Magic Paper, ZyTex, Flexi-Paper and
Matsumoto) are all suitable for tactile graphics. Each brand has slightly different properties in terms of
the required temperature and duration of heating. It takes some experience to find the optimal settings for
the particular paper that you are using, so make sure do some thorough tests to find out which
combination of temperature and heating time works best.
Depending on the oven temperature, the braille dots might raise either too much or not sufficiently,
making them no longer distinguishable as individual braille dots. To compensate for this effect, the
diameter of the dots can be adjusted by choosing ‘Text label presentation: on print’ from the Settings
menu and increasing or decreasing the size of braille dots.

Printing text combining visual font with braille
The normal font (visual characters) of braille labels can be printed in a lighter colour. To avoid the text
being raised when heated in the oven, make sure to select a colour other than black in ‘Text label
presentation: on print’ as the 'Text colour on print'. For example, a green or blue works well for visual
readability.
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12.06 Printing multiple designs; booklet 

TactileView includes a convenient tool that allows you to consecutively print multiple designs. This 
option can be accessed by choosing 'Print multiple designs' from the File menu. 

Tip: a bound booklet can already signify the page orientation, so in some cases it may be beneficial to 
switch off the right-up marker for the document. 

Preparing the print list as a TXT file 

In a few steps, you can easily create a print list. You can choose between a direct selection of the printed 
files (la) or preparing the print list in advance (lb). 

la. Multiple file selection 

In the dialog that opens, you can select the files that you wish to include in your print list. Hold down Ctrl 
to add single designs to the selection, or hold Shift to add consecutive files. Once you have all the files 
selected, click 'Open'. 

The next dialog allows you to save the file selection as a .txt print list. This list needs to be saved in the 
same folder that contains the selected designs. Enter a file name and click 'Save' to confirm. If you do not 
wish to use the print list again later on you can also skip by clicking 'Cancel'. 

lb. Use a previously prepared print list (TXT file) 

You can create a print list in advance with any text editor such as Word or Notepad, or select a print list 
that was created previously following the steps in 1 a. 

Each line in the print list must contain one file name, including the .bpx file extension. If the file is 
located in a subfolder, include this before the file name, followed by a forward slash. Make sure that all 
file names are correct, including any spaces or punctuation marks. Designs can be included multiple times 
if necessary. Your print list should look like this: 

file name 1.bpx 
subfoldername/file name 2.bpx 
file name 3.bpx 

Save your print list as a .txt file in the folder that contains the TactileView designs. In TactileView, select 
'Print multiple designs' from the file menu, then choose 'Single selection: list with file names (*.txt)' and 
select your saved print list. Click 'Open' to continue. 

2. Select print order 

In the next dialog, you can select the order in which the designs should be printed. You can choose 
'Original order' to print the designs in the order in which they are included in the print list. 'Reversed 
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12.06 Printing multiple designs; booklet

TactileView includes a convenient tool that allows you to consecutively print multiple designs. This
option can be accessed by choosing 'Print multiple designs' from the File menu.

Tip: a bound booklet can already signify the page orientation, so in some cases it may be beneficial to
switch off the right-up marker for the document.

Preparing the print list as a TXT file

In a few steps, you can easily create a print list. You can choose between a direct selection of the printed
files (1a) or preparing the print list in advance (1b).

1a. Multiple file selection

In the dialog that opens, you can select the files that you wish to include in your print list. Hold down Ctrl
to add single designs to the selection, or hold Shift to add consecutive files. Once you have all the files
selected, click 'Open'.

The next dialog allows you to save the file selection as a .txt print list. This list needs to be saved in the
same folder that contains the selected designs. Enter a file name and click 'Save' to confirm. If you do not
wish to use the print list again later on you can also skip by clicking 'Cancel'.

1b. Use a previously prepared print list (TXT file)

You can create a print list in advance with any text editor such as Word or Notepad, or select a print list
that was created previously following the steps in 1a.

Each line in the print list must contain one file name, including the .bpx file extension. If the file is
located in a subfolder, include this before the file name, followed by a forward slash. Make sure that all
file names are correct, including any spaces or punctuation marks. Designs can be included multiple times
if necessary. Your print list should look like this:

file name 1.bpx
subfoldername/file name 2.bpx
file name 3.bpx

Save your print list as a .txt file in the folder that contains the TactileView designs. In TactileView, select
'Print multiple designs' from the file menu, then choose 'Single selection: list with file names (*.txt)' and
select your saved print list. Click 'Open' to continue.

2. Select print order

In the next dialog, you can select the order in which the designs should be printed. You can choose
'Original order' to print the designs in the order in which they are included in the print list. 'Reversed
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original order' can be used to ensure the last file in the print list is on the bottom of the stack. 
'Alphabetical order' and 'Reversed alphabetical order' can be especially useful is the file names already 
include ordered numbering. 

Any files in the list that cannot be located will not be printed. The print job will continue with the next 
file name in the list. 

Text and graphics combination 

TactileView has the option to embed designs in a text document that was created with the Duxbury 
Braille Translator (DBT). When using DBT, you can use more advanced lay-out features such as page 
numbering, headers and footers, etc. 

See: Inserting graphics in Duxbury Braille Translator 
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original order' can be used to ensure the last file in the print list is on the bottom of the stack.
'Alphabetical order' and 'Reversed alphabetical order' can be especially useful is the file names already
include ordered numbering.

Any files in the list that cannot be located will not be printed. The print job will continue with the next
file name in the list.

Text and graphics combination

TactileView has the option to embed designs in a text document that was created with the Duxbury
Braille Translator (DBT). When using DBT, you can use more advanced lay-out features such as page
numbering, headers and footers, etc.

See: Inserting graphics in Duxbury Braille Translator
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12.07 Troubleshooting common printing issues 

This page collects the most common errors that can occur when embossing TactileView designs. 

Index embossers - Paper length settings in Index firmware (Error 213) 

When printing a TactileView design using Index V4 embossers with firmware version 1.5.3 or earlier, the 
embosser may prompt you with an audible 'Error 213' message. This is caused by an incorrect maximum 
number of lines per page in the firmware of the embosser. For example, the firmware uses 26 instead of 
the correct 27 lines for letter or 11 inch paper, or 28 instead of 29 lines for A4 paper. 

Read more 

When you select an Index V4 embosser in File > Print setup, you will be prompted with a 'Paper length 
settings in Index firmware' dialog that allows you to avoid or solve this error. You can also access this 
dialog via Help > Configuration wizard, then proceed to step 2. 

To test whether you will encounter this error when embossing, first make sure to select the same paper 
size in TactileView and in the embosser. Next, click the button 'Test printer for error 213' and wait at least 
10 seconds. If you hear no error message from the embosser, you do not have to take any further action 
and will not encounter the error when embossing a design. If you are prompted with error 213 however, 
press the 'Off button on the embosser control panel and follow these steps: 

1. Update the embosser firmware to firmware version 1.5.4 or higher. Check the Index website for 
availability and instructions. 

2. If updating the firmware is not possible, follow the instructions on the Index website on 'Error 213 -
How to adjust to fit DBT lines/page'. 

3. If step 1 and 2 do not resolve the problem, you can temporarily reduce the number of lines per page in 
your TactileView designs. To do this, select 'Reduce TactileView design height by 1 line per page' in the 
'Paper length settings in Index firmware' dialog. Important: if you execute step 1 or 2 later on, you will 
have to make sure the reduced design height option is no longer selected. 

Index embossers - Error caused by mismatched paper size settings 

When printing on an Index braille embosser, it is important to match both the design size and settings in 
the embosser with the size of paper you wish to print on. If these settings do not match each other, the 
embosser will report an error and the document will not be embossed correctly or will not be printed at 
all. 
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12.07 Troubleshooting common printing issues

This page collects the most common errors that can occur when embossing TactileView designs.

Index embossers - Paper length settings in Index firmware (Error 213)

When printing a TactileView design using Index V4 embossers with firmware version 1.5.3 or earlier, the
embosser may prompt you with an audible 'Error 213' message. This is caused by an incorrect maximum
number of lines per page in the firmware of the embosser. For example, the firmware uses 26 instead of
the correct 27 lines for letter or 11 inch paper, or 28 instead of 29 lines for A4 paper.

Read more

When you select an Index V4 embosser in File > Print setup, you will be prompted with a 'Paper length
settings in Index firmware' dialog that allows you to avoid or solve this error. You can also access this
dialog via Help > Configuration wizard, then proceed to step 2.

To test whether you will encounter this error when embossing, first make sure to select the same paper
size in TactileView and in the embosser. Next, click the button 'Test printer for error 213' and wait at least
10 seconds. If you hear no error message from the embosser, you do not have to take any further action
and will not encounter the error when embossing a design. If you are prompted with error 213 however,
press the 'Off' button on the embosser control panel and follow these steps:

1. Update the embosser firmware to firmware version 1.5.4 or higher. Check the Index website for
availability and instructions.

2. If updating the firmware is not possible, follow the instructions on the Index website on 'Error 213 -
How to adjust to fit DBT lines/page'.

3. If step 1 and 2 do not resolve the problem, you can temporarily reduce the number of lines per page in
your TactileView designs. To do this, select 'Reduce TactileView design height by 1 line per page' in the
'Paper length settings in Index firmware' dialog. Important: if you execute step 1 or 2 later on, you will
have to make sure the reduced design height option is no longer selected.

 

Index embossers - Error caused by mismatched paper size settings

When printing on an Index braille embosser, it is important to match both the design size and settings in
the embosser with the size of paper you wish to print on. If these settings do not match each other, the
embosser will report an error and the document will not be embossed correctly or will not be printed at
all.
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Read more 

To solve this problem, check whether all paper size settings are set to the correct paper size. In 
TactileView, go to File > Print Setup and select the desired paper size. 

Please read the Index Braille manual for your embosser for specific instructions on entering the right page 
formatting settings in your embosser model. 

226 / 226 

TactileView software manual
Visit us at https://thinkable.nl

Read more

To solve this problem, check whether all paper size settings are set to the correct paper size. In
TactileView, go to File > Print Setup and select the desired paper size.

Please read the Index Braille manual for your embosser for specific instructions on entering the right page
formatting settings in your embosser model.
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